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Introduction

Introduction

Welcome, and thank you for selecting Fortinet products for your network.

The FortiADC D-series family of application delivery controllers (ADC) optimizes the availability, user experience,
performance and scalability of enterprise application delivery.

An ADC is like an advanced server load balancer. An ADC routes traffic to available destination servers based on health
checks and load-balancing algorithms; full-featured ADC like FortiADC also improve application performance by
assuming some of the server task load. Server tasks that can be handled by the FortiADC appliance include SSL
encryption/decryption, WAF protection, Gzip compression, and routing processes, such as NAT.

Features

FortiADC uses Layer 4 and Layer 7 session information to enable an ADC policy and management framework for:

» Serverload balancing
« Link load balancing
» Global load balancing
o Security

The FortiADC D-series family includes physical appliances and virtual appliances.

Basic network topology

Your network routing infrastructure should ensure that all network traffic destined for the backend servers is directed to
the FortiADC appliance. Usually, clients access backend servers from the Internet through a firewall such as a FortiGate,
so the FortiADC appliance should be installed between your servers and the firewall.

Basic network topology on page 16 shows a basic Router Mode deployment.

Basic network topology
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Introduction

Note: The deployment topology might be different for global load balancing (GLB) or high availability (HA) clusters. Refer
to those chapters for a description of features and illustrations.

Scope

This document describes how to use the web user interface to:

» Get started with your deployment.

« Configure feature options.

» Configure network and system settings.
« Monitor the system.

« Troubleshoot issues.

The following topics are covered elsewhere:

» Appliance installation—Refer to the QuickStart Guide for your appliance model.
« Virtual appliance installation—Refer to the FortiADC-VM Install Guide.

o CLI commands—Refer to the FortiADC CLI Reference. In parts of this manual, brief CLI command examples or CLI
syntax are shown to help you understand how the web Ul configuration pages are related to the CLI commands.
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Chapter 1: What's New

Chapter 1: What's New

This chapter lists features and enhancements introduced in the FortiADC 7.2.0 release.

Global Load Balance

DNS over HTTP, HTTPS and TLS support

FortiADC now supports DoH (DNS over HTTP/HTTPS) and DoT (DNS over TLS) to increase user privacy and security
by using the HTTP/HTTPS or TLS protocol to encrypt the DNS queries. You can now enable DNS over HTTP, HTTPS or
TLS through the GLB Zone Tools general settings.

Server Load Balance

New AUTH class Lua scripting function

The BEFORE_AUTH function has been added to trigger the event before authentication is performed to enable the user-
group specified by the function to override the authentication result of the original authentication policy. This allows users
to apply different levels of authentication based on the client information via script.

HTTP persistence Lua scripting function enhancements

Enhancements have been made to the HTTP persistence Lua scripting functions:

» HTTP:persist() function extended to support HTTP_REQUEST event to enable access to other HTTP elements in
PERSISTENCE.

+ New LB:get_value_routing() function added to enable users to obtain an alternative backend.
» New LB:get_current_routing() function added to show the currently allocated backend.
+ New LB:method_assign_server() function added to obtain the server through the current load balance method.

New addrbook check added to avoid port conflict with named default port 53

Port 53 has been added to the addrbook when GLB is enabled to place a port limitation on port 53 when it is used in GLB
as the named port and in GLB licd.

Layer 4 server load balance debug flow enhancements

The Layer 4 server load balance diagnose debug flow has been enhanced to support the following:

« Filtering by virtual server name and/or the traffic pattern.
« Layer 4 flow debug messages for error cases.
» Enhanced help string filtering to match the protocol number with the protocol.

FortiADC 7.2.0 Handbook
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Chapter 1: What's New

Improvements to Layer 4 FTP profile

To minimize the impact of Layer 4 FTP virtual servers on Layer 7 virtual servers, L4 NAT/FulINAT will now only listen on
port 21, and L4 Direct Routing/Tunneling will listen to ports 21/1024-65535.

In scenarios where the L4 load balance module cannot find an existing session or a service for an FTP data packet with
port 20 or 1024-64435, the L4 load balance module would search for an FTP virtual server with the same IP. As the L4
load balance module is listening to port 20/1024-64435, as well as port 21 for L4 FTP virtual servers, it interferes with L7
virtual servers if the L7 VS has port 1024-65535, and the IP happens to be the same as the L4 FTP VS.

Security

New Bot Mitigation sub-modules for the Web Application Firewall

Two new Bot Mitigation sub-modules have been added to the FortiADC Web Application Firewall:

» Threshold Based Detection detects the occurrence of suspicious behaviors within a specified time frame to
determine whether the request is coming from a human or a bot.

» Biometrics Based Detection detects client events, such as mouse movement, keyboard, screen touch, and scroll
within a specified period to determine whether the request is coming from a human or a bot.

ZTNA enhancements in FortiView

New columns have been added to the FortiView > ZTNA page to enhance the real-time status monitoring of the
endpoints registered to FortiClient EMS. The new columns include: Public IP, Tags, MAC, OS Type, and OS Version.

System

FortiADC AWS Auto Scaling support

FortiADC now supports Auto Scaling on AWS. Multiple FortiADC-VM instances can form an Auto Scaling Group (ASG)
to provide highly efficient clustering at times of high workloads. You can now deploy FortiADC-VMs to support Auto
Scaling on AWS using the AWS Cloud Formation Template (CFT) as part of a manual deployment process.

Automations workflow redesign and enhancements

The FortiADC Automations workflow has now been redesigned with the following enhancements:

» Triggers and Actions are now configured separately and referenced in the Automation configuration.

» System predefined configurations that were previously uneditable can now be modified and applied as user-defined
configurations.

» System predefined configuration templates are now available to be cloned and used as templates for user-defined
configurations.

TACACS+ remote authentication support

FortiADC now supports Terminal Access Controller Access-Control System (TACACS+) as a remote authentication
option. TACACS+ is a remote authentication protocol that provides access control for routers, network access servers,
and other network computing devices via one or more centralized servers.
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Declarative REST APl enhancements

Declarative API capabilities have been enhanced to allow verifications of uploaded declarations and an easy means of
getting a snapshot of the current system.
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This chapter includes the following topics:

» Serverload balancing on page 22

o Link load balancing on page 25

» Global load balancing on page 25

o Security on page 25

« High availability on page 26

 Virtual Domain (VDOM) and Administrative Domain (ADOM) on page 26

Server load balancing

Server load balancing (SLB) features are designed to give you flexible options for maximizing performance of your
backend servers. The following topics give an overview of SLB features:

o Feature summary
o Authentication

» Caching

o Compression

o Decompression
« Content rewriting
o Contentrouting
» Scripting

o SSL transactions

Feature summary

The table below summarizes server load balancing features.

Server load balancing features

Features Summary

Methods ¢ Round robin
¢ Weighted round robin
¢ Least connections
e Fastest response
e Hash of URI, domain, host, destination IP

Health check Checks based on Layer 3, Layer 4, or Layer 7 data.
Server management e Warm up
FortiADC 7.2.0 Handbook 22
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Features Summary

» Rate limiting
¢ Maintenance mode with session ramp down

Persistence Based on:
¢ Cookies
¢ TCP/IP header matches
¢ Ahash of TCP/IP header values
e TLS/SSL session ID
¢ RADIUS attribute
« RDP Session Broker cookie
e SIP caller ID

Layer7 Profiles: HTTP, HTTPS, HTTP Turbo, RADIUS, RDP, SIP, TCPS, SMTP, FTP, Diameter,
RTSP, RTMP, MySQL, MSSQL

Content routing: HTTP Host, HTTP Referer, HTTP Request URL, SNI hostname, Source IP

address

Content rewriting: URL redirect, 403 Forbidden, or HTTP request/response rewrite
Layer4 Profiles: FTP, TCP, UDP

Content routing: Source IP address
Layer 2 Profiles: HTTP, HTTPS, TCP, TCPS, UDP, FTP

Note: Layer 2 load balancing is useful when the request’s destination IP is unknown and
you need to load balance connections between multiple next-hop gateways.

For detailed information, see Chapter 4: Server Load Balancing.

Authentication

FortiADC SLB supports offloading authentication from backend servers. The auth policy framework supports
authentication against local, LDAP, and RADIUS authentication servers, and it enables you to assign users to groups
that are authorized to access protected sites.

For configuration details, see Configuring authentication policies.

Caching

FortiADC SLB supports both static and dynamic caching. Caching reduces server overload, bandwidth saturation, high
latency, and network performance issues.

When caching is enabled for a virtual server profile, the FortiADC appliance dynamically stores application content such
as images, videos, HTML files and other file types to alleviate server resources and accelerate overall application
performance.

For configuration details, see Using caching features.
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Compression

FortiADC SLB supports compression offloading. Compression offloading means the ADC handles compression
processing instead of the backend servers, allowing them to dedicate resources to their own application processes.

When compression is enabled for a virtual server profile, the FortiADC system intelligently compresses HTTP and
HTTPS traffic. Reducing server reply content size accelerates performance and improves response times. FortiADC
supports both industry standard GZIP and DEFLATE algorithms.

For configuration details, see Configuring compression rules.

Decompression

FortiADC SLB also supports decompression of HTTP request body before sending it to the Web Application Firewall
(WAF) for scanning according to the content-encoding header. Upon receiving a compressed HTTP request body,
FortiADC first uses the zlib library to extract the HTTP body to a temporary buffer and then sends the buffer to the WAF
engine for scanning.

Content rewriting

FortiADC SLB supports content rewriting rules that enable you to rewrite HTTP requests and responses so that you can
cloak the details of your internal network. You can also create rules to redirect requests.

For configuration details and examples, see Using content rewriting rules.

Content routing

FortiADC SLB supports content routing rules that direct traffic to backend servers based on source IP address or HTTP
request headers.

For configuration details, see Configuring content routes.
Scripting

FortiADC SLB supports Lua scripts to perform actions that are not currently supported by the built-in feature set. Scripts
enable you to use predefined script commands and variables to manipulate the HTTP request/response or select a

content route. The multi-script support feature enables you to use multiple scripts by setting their sequence of execution.

For configuration details, see Using HTTP scripting.

SSL transactions

FortiADC SLB supports SSL offloading. SSL offloading means the ADC handles SSL decryption and encryption
processing instead of the backend servers, allowing the backend servers to dedicate resources to their own application
processes.
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SSL offloading results in improved SSL/TLS performance. On VM models, acceleration is due to offloading the
cryptographic processes from the backend server. On hardware models with ASIC chips, cryptography is also hardware-
accelerated: the system can encrypt and decrypt packets at better speeds than a backend server with a general-purpose
CPU.

FortiADC SLB also supports SSL decryption by forward proxy in cases where you cannot copy the server certificate and
private key to the FortiADC, either because it is impractical or impossible (in the case of outbound traffic to unknown
Internet servers).

For detailed information, see Chapter 17: SSL Transactions.

Link load balancing

Link load balancing (LLB) features are designed to manage traffic over multiple ISP or WAN links. This enables you to
provision multiple links, resulting in reduced risk of outages and additional bandwidth to relieve traffic congestion.

For detailed information, see Chapter 5: Link Load Balancing.

Global load balancing

Global load balancing (GLB) makes your network reliable and available by scaling applications across multiple data
centers to improve application response times and be prepared for disaster recovery.

You can deploy DNS to direct traffic based on application availability and location.

For detailed information, see Chapter 6: Global Load Balancing.

Security

In most deployment scenarios, we recommend you deploy FortiGate to secure your network. Fortinet includes security
functionality in the FortiADC system to support those cases when deploying FortiGate is impractical. FortiADC includes
the following security features:

« Firewall—Drop traffic that matches a source/destination/service tuple you specify.

» Security connection limit—Drop an abnormally high volume of traffic from a source/destination/service match.
 |P Reputation service—Drop or redirect traffic from source IPs that are on the FortiGuard IP Reputation list.

o Geo IP—Drop or redirect traffic from source IPs that correspond with countries in the FortiGuard Geo IP database.

« Web application firewall—Drop or alert when traffic matches web application firewall attack signatures and
heuristics.

» AntiVirus—Provide protection against a variety of threats, including both known and unknown malicious codes
(malware) and Advanced Target Attacks (ATA).

» Denial of service protection—Drop half-open connections to protect the system from a SYN flood attack.

For detailed information, see Chapter 7: Network Security.
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High availability

The FortiADC appliance supports high availability features like active-passive, active-active cluster, active-active-VRRP
cluster, failure detection, and configuration synchronization. High availability deployments can support 99.999% service
level agreement uptimes. For detailed information, see Chapter 15: High Availability Deployments.

Virtual Domain (VDOM) and Administrative Domain (ADOM)

A Virtual Domain (VDOM) is a complete FortiADC instance that runs on the FortiADC platform. VDOM configuration
objects contain all of the system and feature configuration options of a full FortiADC instance and can be used to divide a
FortiADC into two or more virtual units that function independently, allowing it to support multi-tennant deployments.

The VDOM feature supports two Virtual Domain Modes that allow the VDOMs to function independently with its own
networking or as Administrative Domains (ADOMs) with shared networking between all ADOMs. When the VDOM is in
the Independent Network mode, you can provision an administrator account with privileges to access and manage only
their assigned VDOM. The VDOM user can then configure their VDOM as desired untethered to other VDOMs.
Alternatively, when the VDOM is in Share Network mode, it functions as an ADOM that shares the same networking
interfaces and routing between all the ADOMs. The ADOM functionality enables the administrator to constrain access
privileges to a subset of server load-balancing servers by defaulting all interface settings to the root ADOM. For detailed
information, see Chapter 16: Virtual Domain.

FortiADC 7.2.0 Handbook
Fortinet Inc.

26



Chapter 3: Getting Started
Chapter 3: Getting Started

This chapter provides the basic workflow for getting started with a new deployment.

Basic steps:

1. Install the appliance.
2. Configure the management interface.
3. Configure the following basic network settings:
« New administrator password (required)
» System date and time
« Network interfaces
« DNS
Test connectivity.
Complete product registration, install your license, and update the firmware.
Configure a basic load balancing policy.
Test the deployment with load to verify expected behavior.
Back up this basic configuration so that you have a restore point.

©® N a M

Tips:
« Configuration changes are applied to the running configuration as soon as you
NP save them.
- - ¢ Configuration objects are saved in a configuration management database. You
9 cannot change the name of a configuration object after you have initially saved
= it.

¢ You cannot delete a configuration object that is referenced in another
configuration object (for example, you cannot delete an address ifitis used in a
policy).

Step 1: Install the appliance

This Handbook assumes you have already installed the appliance into a hardware rack or the virtual appliance into a
VMware environment.

For information on hardware appliances, refer to the FortiADC hardware manuals.
For information on the virtual appliance, refer to the FortiADC-VM Install Guide.
To download these documents, go to:

http://docs.fortinet.com/fortiadc-d-series/hardware
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Step 2: Configure the management interface

You use the management port for administrator access. It is also used for management traffic (such as SNMP or syslog).
If your appliance has a dedicated management port, that is the port you configure as the management interface;
otherwise, it is the convention to use port1 for the management interface.

You configure the following basic settings to get started so that you can access the web Ul from a remote location (like
your desk):

« Static route—Specify the gateway router for the management subnet so you can access the web Ul from a host on
your subnet.

« IP address—You typically assign a static IP address for the management interface. The IP address is the host
portion of the web Ul URL. For example, the default IP address for the management interface is 192.168.1.99 and
the default URL for the web Ul is https://192.168.1.99.

» Access—Services for administrative access. We recommend HTTPS, SSH, SNMP, PING.
Before you begin:
« You must know the IP address for the default gateway of the management subnet and the IP address that you plan
to assign the management interface.

» You need access to the machine room in which a physical appliance has been installed. With physical appliances,
you must connect a cable to the management port to get started.

« You need a laptop with an RJ-45 Ethernet network port, a crossover Ethernet cable, and a web browser (a recent
version of Chrome or Firefox).

« Configure the laptop Ethernet port with the static IP address 192.168.1.2 and a netmask of 255.255.255.0. These
settings enable you to access the FortiADC web Ul as if from the same subnet as the FortiADC in its factory
configuration state.

To connect to the web Ul:

1. Use the crossover cable to connect the laptop Ethernet port to the FortiADC management port.

2. Onyour laptop, open the following URL in your web browser:
https://192.168.1.99/

The system presents a self-signed security certificate, which it presents to clients whenever they initiate an HTTPS
connection to it.

3. Verify and accept the certificate, and acknowledge any warnings about self-signed certificates.
The system displays the administrator login page. See Login page on page 28.

Login page

FortiADC 7.2.0 Handbook
Fortinet Inc.

28



Chapter 3: Getting Started

Log In

¥5.1.0 HYY Buila0227,18070;

4. Enterthe username admin and set up a new password.

The system displays the dashboard. See Dashboard after initial login on page 29.

Dashboard after initial login
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To complete the procedures in this section using the CLI:

d

Use an SSH client such as PuTTY to make an SSH connection to 192.168.1.99

(port 22).

Acknowledge any warnings and verify and accept the FortiADC SSH key.
Enter the username admin and create a new password.
Use the following command sequence to configure the static route:

config router static

edit 1

set gateway <gateway ipv4>
end

end

Use the following command sequence to configure the management interface:

config system interface
edit <interface name>

set ip <ipé&netmask>

set allowaccess {http https ping snmp ssh telnet}

end

end

The system processes the update and disconnects your SSH session because
the interface has a new IP address. At this point, you should be able to connect
to the CLI from a host on the management subnet you just configured. You can

verify the configuration remotely.
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Step 3: Configure basic network settings

The system supports network settings for various environments.
To get started, you configure the following basic settings:

o Administrator password—You must change the password for the admin account.
« System date and time—We recommend you use NTP to maintain the system time.

» Network interfaces—You must configure interfaces to receive and forward the network traffic to and from the
destination servers.

« DNS—You must specify a primary and secondary server for system DNS lookups.

Before you begin:

« You must know the IP address for the NTP servers your network uses to maintain system time.
» You must know the IP addresses that have been provisioned for the traffic interfaces for your FortiADC deployment.
» You must know the IP address for the primary and secondary DNS servers your network uses for DNS resolution.

To change the admin password:

1. Go to System > Administrator to display the configuration page.

2. Double-click the key icon % in the row for the user admin to display the change password editor. See System
administrator change password editor on page 31.

3. Change the password and save the configuration.

For detailed information on configuring administrator accounts, refer to the online help or see Manage administrator
users.

System administrator change password editor

New Password

Confirm Password

CLI commands:

FortiADC-VM # config system admin
FortiADC-VM (admin) # edit admin
FortiADC-VM (admin) # set password <string>
Current password for '‘admin':

FortiADC-VM (admin) # end
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To configure system time:

1. Go to System > Settings.
2. Click the Maintenance tab to display the configuration page. See System time configuration page on page 32.
3. Enter NTP settings and save the configuration.

For detailed information, refer to the online help or see Configuring system time.

System time configuration page

System Time

2018,

(700 AEERTIN SEEET RN |

Daylight Saving Time

Time Zone

CLI commands:

config system time ntp

set ntpsync enable

set ntpserver {<server fqgdn> | <server ipv4d>}
set syncinterval <minutes int>

end

Or use a command syntax similar to the following to set the system time manually:

config system time manual

set zone <timezone index>

set daylight-saving-time {enable | disable}
end

execute date <MM/DD/YY> <HH:MM:SS>

To configure network interfaces:

1. Go to Networking > Interface to display the configuration page.

2. Double-click the row for port2, for example, to display the configuration editor. See Network interface configuration
page on page 32.

3. Enter the IP address and other interface settings and save the configuration.
For detailed information, refer to the online help or see Configuring network interfaces.

Network interface configuration page
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= Management Interface

Management Status

y
=9

Management Interface

poet! v

Management IP Allow Access
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@ SSH W SHMP

Management |P
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Management MAC Address
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@ HITP @ Teinat

CLI commands:
config system interface

edit <interface name>

set ip <ipé&netmask>

set allowaccess {http https ping snmp ssh telnet}
end

end

To configure DNS:

1. Go to System > Settings to display the Basic configuration page. See DNS configuration page on page 33.
2. Enterthe IP address for a primary and secondary DNS server; then save the configuration.

For detailed information on configuring DNS, refer to the online help or see Configuring basic system settings.

DNS configuration page

Hostname

FADTHF3615000004
Language

HTTPS Port
243

HTTPS Server Cert

Factory v

S5H Port

22

Primary DNS

WE91.11253

Virtual Domain

Serial Number

FADVO40000132844
Idle Timeout

HTTP Port

Default Intermediate CA Group

Click 1o sele, v
Talnet Port

.
Secondary DNS.

2089111252

Config Sync

Cancel
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CLI commands:
config system dns

set primary <address_ ipv4>
set secondary <address_ ipvé4>

end

Step 4: Test connectivity to destination servers

Use ping and traceroute to test connectivity to destination servers.

To test connectivity from the FortiADC system to the destination server:

Run the following commands from the CLI:
execute ping <destination ip4>

execute traceroute <destination ipvi4>

To test connectivity from the destination server to the FortiADC system:

1. Enable ping on the network interface.
2. Use the ping and traceroute utilities available on the destination server to test connectivity to the FortiADC network
interface IP address.

For troubleshooting tips, see Chapter 20: Troubleshooting.

Step 5: Complete product registration, licensing, and upgrades

Your new FortiADC appliance comes with a factory image of the operating system (firmware). However, if a new version
has been released since factory imaging, you might want to install the newer firmware before continuing the system
configuration.

Before you begin:
» Register—Registration is required to log into the Fortinet Customer Service & Support site and download firmware

upgrade files. For details, go to http://kb.fortinet.com/kb/documentLink.do?externallD=12071.

» Check the installed firmware version—Go to the dashboard. See Step 5: Complete product registration, licensing,
and upgrades on page 34.

» Check for upgrades—Major releases include new features, enhancements, and bug fixes. Patch releases can
include enhancements and bug fixes.

« Download the release notes at http://docs.fortinet.com/fortiadc-d-series/.
« Download firmware upgrades at https://support.fortinet.com/.
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To upgrade your license:

1. Gotothe System > FortiGuard.
2. Under Status, click Upgrade License to upload or locate the license file.

To upgrade your firmware:

1. Gotothe System > FortiGuard.
2. Onthe Maintenance tab, navigate to the Firmware section.
3. Click Upgrade Firmware.

For detailed information, refer to the online help or see Updating firmware.

Validating a VM license with no internet connection

If a FortiADC-VM is in a standalone environment with no Internet connection, it will not be able to connect to the
FortiGuard Distribution Network (FDN) to validate its license. To validate the license of a standalone FortiADC-VM with
no Internet connection, you must configure the FortiADC-VM to send the license request to a proxy server that is
connected to the Internet. The proxy server will then send the license request to the FDN and return the license status to
the FortiADC-VM.

Before you begin, you must:

» Have a proxy server connected to the Internet.
» Have Read-Write permission for System settings.

To configure a proxy server to validate a FortiADC-VM license:

Go to System > FortiGuard.

Under the Update Schedule pane, find the edit function (pencil icon) on the top right.
Go into the window enable Tunneling status.

Complete the configuration as described in the table below.

P obN-=

Proxy server configuration

Settings Guidelines

Tunneling address Enter the IP address of the proxy server.

Tunneling port Enter the port of the proxy server.
Tunneling If access control is enabled on the proxy server, enter the proxy server's username.
username

Tunneling password  If access control is enabled on the proxy server, enter the proxy server's password.

5. Click Save.

You can also configure the FortiADC-VM to communicate with the proxy server using the CLI. For more information, see
the CLI Reference:

http://docs.fortinet.com/fortiadc-d-series/reference
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Step 6: Configure a basic server load balancing policy

A FortiADC server load balancing policy has many custom configuration options. You can leverage the predefined health

check, server profile, and load balancing method configurations to get started in two basic steps:

1.

Configure the real server pool.

2. Configure the virtual server features and options.

For complete information on server load balancing features, start with Server load balancing basics.

To configure the server pool:

o bd-=

6.

Go to Server Load Balance > Real Server Pool to display the configuration page.

Click Create New to display the configuration editor. See Real server pool basic configuration page on page 36.

Complete the basic configuration and click Save.

Go to your new server pool, and click on the edit function. It will open up the a dialogue where you can add
members.

Under Member, click Create New to display the Edit Member configuration editor. See Step 6: Configure a basic
server load balancing policy on page 36.

Complete the member configuration and click Save.

For detailed information, refer to the online help or see Configuring real server pools.

Real server pool basic configuration page

= Real Server Pool x

Name
Address Type
IPvE

Health Check

Real Server SSL Profile
NONE

m —

To configure the virtual server:

1.
2,

3.

Go to Server Load Balance > Virtual Server to display the configuration page.

Click Create New to display the configuration editor. Choose between Advanced Mode and Basic Mode. See
Virtual server configuration page on page 37.

Complete the configuration and click Save.

For detailed information, refer to the online help or see Configuring virtual servers.
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Virtual server configuration page

= Virtual Server

Basic General Monitoring
Name Type
Layer 7 Iml Layer 2

Status Address Type

Disable m Maintain m IPvé |

Traffic Group

default
Specifics

Schedule Pocl

Content Routing

Packet Forwarding Method

DMAT

“ e

Step 7: Test the deployment

You can test the load balancing deployment by emulating the traffic flow of your planned production deployment. Basic
network topology on page 37 shows a basic network topology.

Basic network topology
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' SNMP, syslog, efc.

T .
o

Admin

To test basic load balancing:

1. Send multiple client requests to the virtual server IP address.
2. Go to the dashboard to watch the dashboard session and throughput counters increment.
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3. GotoLog & Report > Log Browsing > Event Log > Health Check to view health check results.

4. GotoLog & Report > Log Browsing > Traffic Log > SLB HTTP (for example) to view traffic log. It includes throughput
per destination IP address.

5. GotoLog & Report > Report to view reports. It has graphs of top N policies and servers.

Step 8: Back up the configuration

Once you have tested your basic installation and verified that it functions correctly, create a backup. This “clean” backup
is a reference point that has many benefits, including:

» Troubleshooting—You can use a diff tool to compare a problematic configuration with this baseline configuration.

» Restarting—You can rapidly restore your system to a simple yet working point.

« Rapid deployment—You can use the configuration file as a template for other FortiADC systems. You can edit use
any text editor to edit the plain text configuration file and import it into another FortiADC system. You should change
unique identifiers, such as IP address and sometimes other local network settings that differ from one deployment to
another.

To backup the system configuration:

1. Go to System > Settings.
2. Click the Backup & Restore tab to display the backup and restore page.
3. Click Back Up.

For detailed information, refer to the online help or see Backing up and restoring configuration.
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Chapter 4: Server Load Balancing

This chapter includes the following topics:

» Serverload balancing basics on page 40

» Serverload balancing configuration overview on page 45
» Configuring virtual servers on page 48

« Using content rewriting rules on page 59

e HSTS and HPKP support on page 71

» Configuring content routes on page 74

» Using source pools on page 76

» Using schedule pools on page 89

» Using clone pools on page 90

» Configuring Application profiles on page 93

» Configuring MySQL profiles on page 119

» Configuring client SSL profiles on page 126

o Configuring HTTP2 profiles on page 132

» Configuring load-balancing (LB) methods on page 133
« Configuring persistence rules on page 134

» Configuring error pages on page 141

» Configuring decompression rules on page 143

» Creating a PageSpeed configuration on page 148

» Creating PageSpeed profiles on page 150

o PageSpeed support and restrictions on page 152

« Configuring compression rules on page 152

» Using caching features on page 154

» Usingreal server pools on page 157

« Configuring real servers on page 164

» Configuring real server SSL profiles on page 165

e Using HTTP scripting on page 172

» Configuring an L2 exception list on page 182

« Creating a Web Filter Profile configuration on page 183
« Using the Web Category tab on page 184

» Configuring certificate caching on page 185

Server load balancing basics

An application delivery controller (ADC) is like an advanced server load balancer. An ADC routes traffic to available
destination servers based on health checks and load-balancing algorithms. ADCs improve application availability and
performance, which directly improves user experience.

FortiADC 7.2.0 Handbook
Fortinet Inc.



Chapter 4: Server Load Balancing

The physical distance between clients and the servers in your backend server farm has a significant impact on server
response times. Besides physical distance, the most important factors contributing to server performance are:

« Number of simultaneous connections and requests that the servers can handle
» Load distribution among the servers

The purpose of an ADC is to give you multiple methods for optimizing server response times and server capacity.
After you have deployed an ADC, traffic is routed to the ADC virtual serverinstead of the destination real servers.

Basic network topology on page 41 shows an example of a basic load balancing deployment. The FortiADC appliance is
deployed in front of a server farm, and the network interfaces are connected to three subnets: a subnet for management
traffic; a subnet that hosts real servers A, B, and C; and a different subnet that hosts real servers D, E, and F. The
FortiADC system performs health checks on the real servers and distributes traffic to them based on system logic and
user-defined settings.

Basic network topology
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' SNMP, syslog, efc.

=,

Admin

Optionally, you can further improve application security and performance by offloading system processes from the
server and having them handled transparently by the ADC. Server tasks that can be handled by the FortiADC appliance
include SSL encryption/decryption, WAF protection, Gzip compression, and routing processes, such as NAT.
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FortiADC processing on page 43 shows the order in which the FortiADC features process client-to-server and server-to-
client traffic.

FortiADC processing
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SNI/Certificates

Virtual Server

1. WAF
Decrypt 2. Rewriting
NAT

HTTP Response

: Persistence Cookie
Security 3. Caching

1. Firewall

2. DoS

3. Firewall Connection Limit
4. DNAT

Virtual Server

1. IP Reputation

2. Geo IP block list

3. WAF

4. Auth policy

5. Caching

6. Destination determined by
Persistence or
Load Balance or
Content Route or
Scapt

7. Rewnting (NAT, HTTP Request)

8. Re-encryption (if enabled)

Compress

In the client-to-server direction:
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If SNI or SSL decryption is applicable, the system acts on those exchanges.
Then, security module rules filter traffic, and traffic not dropped continues to the virtual server module.
Virtual server security features are applied. Traffic not dropped continues for further processing.

If a caching rule applies, the FortiADC cache serves the content and the request is not forwarded to a backend
server.

If the system selects a destination server based on a persistence rule, content route, or script, the load balancing
rules are not applied.

After selecting a server, the system performs any rewriting and re-encryption actions that are applicable, and then
forwards the packets to the server.

In the server-to-client direction:

« WAF HTTP response, NAT, rewriting, persistence, and caching rules are applied.
« If applicable, the FortiADC compresses and encrypts the server response traffic.

Server load balancing configuration overview

The configuration object framework supports the granularity of FortiADC application delivery control rules. You can
configure specific options and rules for one particular type of traffic, and different options and rules for another type.

Server load balancing configuration steps on page 47 shows the configuration objects used in the server load balancing
configuration and the order in which you create them.

Basic steps

1.

Configure health check rules and real server SSL profiles.

This step is optional. In many cases, you can use predefined health check rules and predefined real server SSL
profiles. If you want to use custom rules, configure them before you configure the pools of real servers.

Configure server pools.

This step is required. Server pools are the backend servers you want to load balance and specify the health checks
used to determine server availability.

Configure persistence rules, optional features and policies, profile components, and load balancing methods.

You can skip this step if you want to select from predefined persistence rules, profiles, and methods.

Configure the virtual server.

When you configure a virtual server, you select from predefined and custom configuration objects.

Example workflow

For a members-only HTTPS web server farm, you might have a workflow similar to the following:

1.

A

Configure security module firewall rules that allow only HTTPS traffic from untrusted subnets to the virtual server.
Import server SSL certificates, configure a local certificate group, and a certificate verification policy.
Configure HTTPS health checks to test the availability of the web servers.
Configure the server pools, referencing the health check configuration object.
Configure authentication:
» Create a RADIUS or LDAP server configuration.
» Create user groups.
« Create an authentication policy.
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6. Configure an HTTPS profile, referencing the certificate group and certificate verification policy and setting SSL
version and cipher requirements.

7. Configure an application profile and client SSL profile if needed.

8. Configure the virtual server, using a combination of predefined and user-defined configuration objects:
« Predefined: WAF policy, Persistence, Method
» User-defined: Authentication Policy, Profile
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Server load balancing configuration steps

Health Check

Real Server SSL Profile

Real Server
& Real Server Pool

Persistence

Source Pool

Content Route

Content Rewriting

Authentication Policy

WAF Profile

Error Messages

=

Scripting

Required with predefined profile
Required
Optional with predefined profile

Optional

Profile Components

Compression

Application Profile

Client SSL Profile

GEO IP Block

GEO IP Whitelist

IP Reoutation

LB Methods

o Virtual Server
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Configuring virtual servers

The virtual server configuration supports three classes of application delivery control:
o Layer 7—Persistence, load balancing, and routing are based on Layer-7 objects, such as HTTP headers, cookies,
and soon.

» Layer 4—Persistence, load balancing, and network address translation are based on Layer-4 objects, such as
source and destination IP addresses.

o Layer 2—This feature is useful when the request’s destination IP is unknown and you need to load-balance
connections among multiple next-hop gateways.

Before you begin:

« You must have a deep understanding of the backend servers and your load-balancing objectives.

« You must have configured a real server pool and other configuration objects that you can incorporate into the virtual
server configuration, such as persistence rules, user-defined profiles, content routes and rewriting rules, error
messages, authentication policies, and source IP address pools if you are deploying NAT.

« You must have Read-Write permission for load-balance configurations.

Unlike virtual IPs on FortiGate or virtual servers on FortiWeb, virtual servers on
FortiADC are activated as soon as you have configured them and set their status to
Enable. You do not need to apply them by selecting them in a policy.

Two Options for virtual server configuration

FortiADC provides two options for configuring virtual servers—Basic Mode and Advanced Mode.

In Basic Mode, you are required to specify only the basic parameters needed to configure a virtual server. FortiADC
automatically configures those advanced parameters using the default values when you click the Save button. The Basic
Mode is for less experienced users who may not have the skills required to configure the advanced features on their
own.

The Advanced Mode, on the other hand, is ideal for experienced or "power" users who are knowledgeable and
comfortable enough to configure all the advanced features, in addition to the basic ones, on their own.

All virtual servers you have added, whether they are configured through Basic Mode or Advanced Mode, end up on the
Load Balance > Virtual Server page. You can view the configuration details of a virtual server by clicking the entry.

Basic virtual server configuration
This option is used mostly for beginners who have less experience with FortiADC.

To configure a virtual server using Basic Mode:

Click Server Load Balance > Virtual Server.

Click Create New > Basic Mode to open the Basic Mode configuration editor.

Complete the configuration as described in Virtual server configuration Basic Mode on page 49.
Click Save.

o bN-=
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Virtual server configuration Basic Mode

Settings Guidelines

Name

Application

Address
Port

Interface
Real Server Pool

SSL

FortiADC 7.2.0 Handbook
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Specify a unique name for the virtual server configuration object. Valid characters are 2-7, a-
z, 0-9, ,and -. No space is allowed. This name appears in reports and in logs as the SLB
“policy”.

Note: Once saved, the name of a virtual server configuration cannot be changed

Select an application from the list menu:
¢ Microsoft SharePoint Application
¢ Microsoft Exchange Server Application
e IS
e Apache
¢ Windows Remote Desktop
e HTTPSH2
¢ HTTPSH2C
e HTTP(S)

e TCPS

e HTTP Turbo
¢ RADIUS

« DNS

e SIP

e TCP

« UDP

e FTP

e IP

e RTSP

* RTMP

e SMTP

¢ DIAMETER
e [SO8583

e L7TCP

* L7UDP
Specify the IP address provisioned for the virtual server.

Accept the default port number (80) or specify a port, ports, or a range of ports of your
preference.

Note: The virtual server will use the specified port or ports to listen for client requests. You
can specify up to eight ports or port ranges separated by space. Valid values are from 0 to
65535. Port 0 applies to Layer-4 virtual servers only,

Select a network interface from the list menu, or specify a new one.
Select areal server pool (if you have one already configured) or create a new one.

Applicable to HTTP(S) applications only.

Note: SSL is disabled by default, you must check the check box to enable it. Once SSL is
enabled, you must select an profile from the Client SSL Profile drop-down menu below.
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Settings Guidelines

Client SSL Profile Note: This setting applies to HTTPS, TCPS, HTTP2 H2, and SMTP applications only. In the

case of HTTPS, it becomes available only when SSL is enabled.
Select a client SSL profile from the drop-down menu.

Protocol Note: This setting becomes available only when Application is set to IP.

Enter up to eight numeric values or value ranges corresponding to the protocols you'd like to
use, separated by space.

Domain Name Note: This field becomes available only when Application is set to SMTP.

Specify the FQDN.

Advanced virtual server configuration

This option is used mostly by advanced users of FortiADC.

To configure a virtual server using the Advanced Mode:

1. Goto Server Load Balance > Virtual Server.

2. Click Create New > Advanced Mode to display the Advanced Mode configuration editor.
The settings for Advanced Mode are separated into tabs to configure specific virtual server functionality.

Basic

General

Security

SSL Traffic Mirror (only available for Layer 7 HTTPS and TCPS server load-balancing profiles)
Application Optimization (only available for Layer 7 HTTP and HTTPS server load-balancing profiles)
Monitoring

3. Configure and save the settings in the Basic tab.

Setting Description

Name Enter a unique name for the virtual server. Valid characters are A-7, a-z, 0-9,

_,and -. No space is allowed. This name appears in reports and in logs as the
SLB “policy”.

Note: Once you have saved the configuration, you cannot edit the virtual
server name.

Type e Layer 7 — Persistence, load balancing, and routing are based on Layer-7

objects, such as HTTP headers, cookies, and so on.
¢ Layer 4 — Persistence, load balancing, and network address translation
are based on Layer-4 objects, such as source and destination IP
addresses.
¢ Layer 2 — This feature is useful when the request’s destination IP is
unknown and you need to load-balance connections among multiple next-
hop gateways.
Depending on your Type selection, the Layer 7, Layer 4, or Layer 2 Specifics
configuration section will appear.
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Setting Description

Status ¢ Enable — The virtual server can receive new sessions.
¢ Disable — The server does not receive new sessions and closes any
current sessions as soon as possible.
¢ Maintain — The server does not receive new sessions, but maintains its
current connections.

Address Type o |Pv4
¢ |Pv6
Note: IPv6 is not supported for FTP, HTTP Turbo, RDP, or SIP profiles.

Comment A string used to describe the purpose of the configuration

FortiADC 7.2.0 Handbook
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a. Ifthe Typeis Layer 7, configure the following Layer 7 Specifics settings:

Setting Description

Schedule Pool Enable/disable the Schedule Pool. This is disabled by default.
Note: If Schedule Pool is enabled, Content Routing becomes unavailable.

Schedule Pool List The Schedule Pool List option appears if Schedule Pool is enabled.
Select the schedule pool(s) and arrange them in a desired order.

Content Routing Enable/disable the Content Routing. This is disabled by default.
Note:
¢ When content routing is enabled, FortiADC will route packets to
backend servers based on IP address (Layer-4 content) or HTTP
header (Layer-7 content).
¢ Content-routing rules override static or policy routes.
¢ This option does NOT apply to SIP profiles.

Content Routing List The Content Routing List option appears if Content Routing is enabled.
Select the content-routing rules and arrange them in a desired order.
Note:

You can select multiple content routing rules in virtual server configuration.
Rules that you add are checked from top to bottom. The first rule to match
is applied. If the traffic does not match any of the content-routing rule
conditions specified in the virtual server configuration, the system will show
some unexpected behaviors. Therefore, it is important that you create a
“catch-all” rule that has no match conditions. In the virtual server
configuration, this rule should be ordered last so it can be used to forward
traffic to a default pool.

See Configuring content routes.

Content Rewriting Enable/disable the Content Rewriting. This is disabled by default.
Note:
e This option applies to Layer-7 only.
¢ This option does NOT apply to SIP profiles.

Content Rewriting List The Content Rewriting List option appears if Content Rewriting is
enabled.

Select the content rewriting rules and arrange them in a desired order.

Note: You can select multiple content rewriting rules in the virtual server
configuration. Rules that you add are consulted from top to bottom. The
first rule to match is applied. If the traffic does not match any of the content
rewriting rule conditions, the header is not rewritten.

See Using content rewriting rules.

NAT Source Pool List Select one or more source pool configuration objects and arrange them in
a desired order. See Using source pools.
Note:
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Setting Description

By default, the same IP pool cannot be set up in different virtual servers.
However, you can enable IP address sharing through the CLI to allow the
source pool to be set up in different virtual servers.
To enable IP address sharing:
config system global

set share-ip-address enable
end

Transaction Rate Limit Note: This setting applies to Layer-7 virtual servers only. It is not supported
for HTTP Turbo profiles.
Set a limit to the number of HTTP requests per second that the virtual
server can process. Valid values are from 0 to 1,048,567. The defaultis 0
(disabled).
The system counts each client HTTP request against the limit. When the
HTTP request rate exceeds the limit, the virtual server sends an HTTP 503
error response to the client.

b. Ifthe Type is Layer 4, configure the following Layer 4 Specifics settings:

Setting Description

Schedule Pool Enable/disable the Schedule Pool. This is disabled by default.
Note: If Schedule Pool is enabled, Content Routing becomes unavailable.

Schedule Pool List The Schedule Pool List option appears if Schedule Pool is enabled.
Select the schedule pool(s) and arrange them in a desired order.

Content Routing Enable/disable the Content Routing. This is disabled by default.
Note:
¢ When content routing is enabled, FortiADC will route packets to
backend servers based on IP address (Layer-4 content) or HTTP
header (Layer-7 content).
¢ Content-routing rules override static or policy routes.
¢ This option does NOT apply to SIP profiles.

Content Routing List The Content Routing List option appears if Content Routing is enabled.
Select the content-routing rules and arrange them in a desired order.
Note:

You can select multiple content routing rules in virtual server configuration.
Rules that you add are checked from top to bottom. The first rule to match
is applied. If the traffic does not match any of the content-routing rule
conditions specified in the virtual server configuration, the system will show
some unexpected behaviors. Therefore, it is important that you create a
“catch-all” rule that has no match conditions. In the virtual server
configuration, this rule should be ordered last so it can be used to forward
traffic to a default pool.

See Configuring content routes.

Packet Forwarding Method Note: This setting applies to Layer-4 virtual servers only.
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Setting Description

Select one of the following packet forwarding methods:
¢ Direct Routing — Forwards the source and destination IP addresses
with no changes.
Note: For FTP profiles, when Direct Routing is selected, you must also
configure a persistence method.
 DNAT — Replaces the destination IP address with the IP address of
the backend server selected by the load balancer.
The destination IP address of the initial request is the IP address of the
virtual server. Be sure to configure FortiADC as the default gateway on the
backend server so that the reply goes through FortiADC and can also be
translated.
¢ Full NAT — Replaces both the destination and source IP addresses.
IPv4 to IPv4 or IPv6 to IPv6 translation.
¢ Tunneling — (For Layer-4 IPv4 virtual servers) Allows FortiADC to
send client requests to real servers through Layer-4 IP tunnels. See
Layer-4 Virtual server IP tunneling on page 1.
¢ NAT46 — (If Address Tpye is IPv4) Replaces both the destination and
source |IP addresses, translating IPv4 addresses to IPv6 addresses.
* NAT64 — (If Address Type is IPv6) Replaces both the destination and
source |IP addresses, translating IPv6 addresses to IPv4 addresses.
For Full NAT, NAT46, and NAT64, the source IP address is replaced by an
IP address from the pool you specify. The destination IP address is
replaced with the IP address of the backend server selected by the load
balancer

NAT Source Pool List If you are configuring a Layer 4 virtual server and enable Full NAT or
NATA46, select one or more source pool configuration objects. See Using
source pools.

Note:

By default, the same IP pool cannot be set up in different virtual servers.
However, you can enable IP address sharing through the CLI to allow the
source pool to be set up in different virtual servers.

To enable IP address sharing:
config system global

set share-ip-address enable
end

c. Ifthe Typeis Layer 2, configure the following Layer 2 Specifics settings:

Setting Description

Schedule Pool Enable/disable the Schedule Pool. This is disabled by default.
Note: If Schedule Pool is enabled, Content Routing becomes unavailable.

Schedule Pool List The Schedule Pool List option appears if Schedule Pool is enabled.
Select the schedule pool(s) and arrange them in a desired order.

Content Routing Enable/disable the Content Routing. This is disabled by default.
Note:
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Setting Description

¢ When content routing is enabled, FortiADC will route packets to
backend servers based on IP address (Layer-4 content) or HTTP
header (Layer-7 content).

¢ Content-routing rules override static or policy routes.

¢ This option does NOT apply to SIP profiles.

Content Routing List The Content Routing List option appears if Content Routing is enabled.
Select the content-routing rules and arrange them in a desired order.
Note:

You can select multiple content routing rules in virtual server configuration.
Rules that you add are checked from top to bottom. The first rule to match
is applied. If the traffic does not match any of the content-routing rule
conditions specified in the virtual server configuration, the system will show
some unexpected behaviors. Therefore, it is important that you create a
“catch-all” rule that has no match conditions. In the virtual server
configuration, this rule should be ordered last so it can be used to forward
traffic to a default pool.

See Configuring content routes.

4. Configure and save the settings in the General tab.

Setting Description

Configuration

Address Enter the IP address provisioned for the virtual server.

Note:

You do not specify an IP address for a Layer 2 virtual server. A Layer 2 virtual
server is not aware of IP addresses. Instead of routing data for a specific
destination, this type of server simply forwards data from the specified network
interface and port.

Port Accept the default port or specify a port, ports, or port ranges of your
preference.
Note: The virtual server will use the specified port or ports to listen for client
requests. You can specify up to eight ports or port ranges separated by space.
Valid values are from 0 to 65535. Port 0 applies to Layer-4 virtual servers only,
The port range option is useful in deployments where it is desirable to have a
virtual IP address with a large number of virtual ports, such as data centers or
web hosting companies that use port number to identify their specific
customers.
Statistics and configurations are applied to the virtual port range as a whole
and not to the individual ports within the specified port range.
Note: If a Layer 2 virtual server is assigned a network interface that uses port
80 or 443, ensure that the HTTPS and HTTP administrative access options
are not enabled for the interface. Setting a port range is not supported for FTP,
HTTP Turbo, RADIUS, or Layer 2 TCP profiles.
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Setting Description

Connection Limit Set a limit to the number of concurrent connections. The defaultis 0 (disabled).
Valid values are from 1 to 100,000,000.

You can apply a connection limit per real server and per virtual server. Both
limits are enforced. Attempted connections that are dropped by security rules
are not counted.

Note: This feature is NOT supported for FTP or SIP profiles.

Connection Rate Limit This option is available if Layer 4 is selected as the Type in the Basic settings.
With Layer 4 profiles you can limit the number of new connections per second.
The default is 0 (disabled). Valid values are from 1 to 86,400.
You can apply a connection rate limit per real server and per virtual server.
Both limits are enforced. Attempted connections that are dropped by security
rules are not counted.

Note: Not supported for FTP profiles.

Interface Network interface that receives client traffic for this virtual server.
Resources
Profile Select a predefined or user-defined profile configuration object. See

Configuring Application profiles.

Note: Only TCP, UDP and IP profiles are available for Layer 2 VS Type with
IPv6 Address.

Client SSL Profile Note: This setting applies to HTTPS, TCPS, HTTP2 H2, SMTP, and FTPS
applications only. In the case of HTTPS, it becomes available only when SSL
is enabled.

Select a client SSL profile from the drop-down menu.

Note: If a ZTNA Profile is referenced in the VS, ensure the client SSL profile
has enabled client certificate verification for the corresponding EMS CA
certificate object. See Configuring client SSL profiles on page 126.

Persistence Select a predefined or user-defined persistence configuration object. See
Configuring persistence rules.

Note: The persistence rule with Match Across Virtual Servers enabled
works only with L4 virtual servers or the L7 virtual server whose profile is LB_
PROF_RADIUS.

Method Select a predefined or user-defined method configuration object. See
Configuring load-balancing (LB) methods on page 133.

Real Server Pool Select a real server pool configuration object. See Configuring real server
pools.

Note: For Layer 2 VS Type, the available real server pools are dependent on
the Address (IPv4 or IPv6) selected in Basic settings.

Clone Pool Select a configuration object. See Configuring a clone pool on page 91.

Note: This option is not available if the VS Type is Layer 2 and Address is
IPv6.
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Setting Description

Auth Policy This option is available if Layer 7 is selected as the Type in the Basic settings.
Select an authentication policy configuration object. HTTP/HTTPS only.
See Configuring authentication policies.

Scripting This option is available only if Scripting is enabled AND if Layer 7 is selected
as the Type in the Basic settings.

Select the scripting object(s) and arrange them in a desired order.

Note:

FortiADC allows you to combine multiple individual scripts into one combined
script so that you can execute them all at once. In that situation, you can set
the order in which the scripts are executed by assigning the scripts with
different priorities. For more information, see Support for multiple scripts.

AD FS Published Service This option is available if Layer 7 is selected as the Type in the Basic settings.
Select an AD FS configuration object. HTTPS only.
See Configuring AD FS Proxy on page 371.

L2 Exception List This option is available if Layer 2 is selected as the Type in the Basic settings
AND an HTTPS server load-balancing profile is selected.

Select an exception configuration object. See Configuring an L2 exception list.
HTTP Redirectto HTTPS This option becomes available when an HTTPS server load-balancing profile

is selected.

Enable/disable HTTP redirect to HTTPS. This option is disabled by default.

If enabled, it opens HTTP service on an HTTPS virtual server which
redirects traffic to an HTTP virtual server.

Redirect Service Port This option becomes available when HTTP Redirect to HTTPS is enabled.

You can either accept the default port (80), or specify up to eight ports or
ranges of ports of your preference.

Error Page (This section is only available for Layer 7 virtual servers)

Error Page Select an error page configuration object. See Configuring error pages.
Note: Not supported for SIP profiles.

Error Message If you do not use an error page, you can enter an error message to be returned
to clients in the event no server is available. Maximum 1023 bytes.

Note: Not supported for SIP profiles.

FortiGSLB (This section is not available for Layer 2 virtual servers)

Public IP Type Set the Public IP type for the virtual server as either IPv4 or IPv6.

Public IPv4/IPv6 Enter the virtual server public IP address.

One Click GSLB Server Enable/disable the FortiGSLB One Click GSLB server.

Host Name The Host Name option is available if One Click GSLB Server is enabled.

Enter the hostname part of the FQDN, such as www.

FortiADC 7.2.0 Handbook
Fortinet Inc.

57



Chapter 4: Server Load Balancing

Setting Description

Note: You can specify the @ symbol to denote the zone root. The value
substitute for @ is the preceding $ORIGIN directive.

Domain Name The Domain Name option is available if One Click GSLB Server is enabled.
The domain name must end with a period. For example, example.com.

5. Configure and save the settings in the Security tab. The security settings available are dependent on the virtual
server type selected in Basic settings and the server load-balancing profile in General settings.

Setting Description

WAF Profile Select a WAF profile configuration object or create a new one.
See Configuring a WAF Profile.

AV Profile Select an existing AV profile from the drop-down menu or create a new one.

AV profile can support HTTP/HTTPS/SMTP.
See Creating an AV profile on page 257.

DoS Protection Profile Select a DoS protection profile configuration object or create a new one.
See Configuring DoS Protection Profile on page 279.

Captcha Profile Select a Captcha configuration object.
See Configuring Captcha on page 147.

ZTNA Profile Note: This setting applies to Layer 7 HTTPS and TCPS applications only.
Select a ZTNA Profile object.
See Configuring a ZTNA Profile on page 276

6. Configure and save the settings in the SSL Traffic Mirror tab.
Note: The SSL Traffic Mirror settings are only accessible if Layer 7 is selected as the Type in the Basic settings AND
an HTTPS or TCPS server load-balancing profile is selected in General settings.

Setting Description
SSL Traffic Mirror Enable/disable SSL Traffic Mirror.
Mirror To The Mirror To field appears when SSL Traffic Mirror is enabled.

Select the ports from the list of Available Items.

7. Configure and save the settings in the Application Optimization tab.
Note: The Application Optimization settings are only accessible if Layer 7 is selected as the Type in the Basic
settings AND an HTTP or HTTPS server load-balancing profile is selected in General settings.

Setting Description

Page Speed Select a page speed optimization profile.

8. Configure and save the settings in the Monitoring tab.

Setting Description

Traffic Log Enable/disable to record traffic logs for this virtual server.
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Setting Description

Note: Local logging is constrained by available disk space. We recommend
that if you enable traffic logs, you monitor your disk space closely. We also
recommend that you use local logging during evaluation and verification of
your initial deployment, and then configure remote logging to send logs to a log

management repository.
FortiView Enable/disable to view this virtual server from FortiView.
WCCP The WCCP option is only available for Layer 7 virtual servers.

Enable/disable Web Cache Communications Protocol.

Using content rewriting rules

This section includes the following topics:

o Overview

« Configuring content rewriting rules

o Example: Redirecting HTTP to HTTPS

o Example: Rewriting the HTTP response when using content routing

o Example: Rewriting the HTTP request and response to mask application details
o Example: Rewriting the HTTP request to harmonize port numbers

Overview

You might rewrite the HTTP request/response and HTTP headers for various reasons, including the following:0

e Redirect HTTP to HTTPS
o External-to-internal URL translation
o Other security reasons

HTTP header rewriting on page 59 summarizes the HTTP header fields that can be rewritten.

HTTP header rewriting
HTTP Request ¢ Host
¢ Referer
HTTP Redirect Location
HTTP Response Location

The firstline of an HTTP request includes the HTTP method, relative URL, and HTTP version. The next lines are
headers that communicate additional information. The following example shows the HTTP request for the URL
http://www.example.com/index.html:

GET /index.html HTTP/1.1
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Host: www.example.com
Referer: http://www.google.com

The following is an example of an HTTP redirect including the HTTP Location header:

HTTP/1.1 302 Found
Location: http://www.lana.org/domains/example/

You can use literal strings or regular expressions to match traffic to rules. To match a request URL such as
http://www.example.com/index, you create two match conditions: one for the Host header www . example.comand
another for the relative URL thatis in the GET line: /index.html.

For HTTP redirect rules, you can specify the rewritten location as a literal string or as a regular expression. For all other
types or rules, you must specify the complete URL as a literal string.

Configuring content rewriting rules

Before you begin:

e You must have a good understanding of HTTP header fields.

» You must have a good understanding of Perl-compatible regular expressions (PCRE) if you want to use them in rule
matching or rewriting.

» You must have Read-Write permission for Load Balance settings.
After you have configured a content rewriting rule, you can select it in the virtual server configuration.

Note: You can select multiple content rewriting rules in the virtual server configuration. Rules you add to that
configuration are consulted from top to bottom. The first to match is applied. If the traffic does not match any of the
content rewriting rule conditions, the header is not rewritten.

To configure a content rewriting rule:

Go to Server Load Balance > Virtual Server.

Click the Content Rewriting tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Content rewriting rule guidelines on page 60.
Save the configuration.

a b obd-=

Content rewriting rule guidelines

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Comments A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Action Type Select whether to rewrite the HTTP request or HTTP response.
HTTP Request Rewrite Actions
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Settings Guidelines

Rewrite HTTP
Header

Redirect

Send 403 Forbidden
Add HTTP Header

Delete HTTP Header

Host—Rewrites the Host header by replacing the hostname with the string you specify. For
Host rules, specify a replacement domain and/or port.

URL—Rewrites the request URL and Host header using the string you specify. For URL rules,
specify a URL in one of the following formats:

e Absolute URL— https://example.com/content/index.html

¢ Relative URL — content/index.html
If you specify a relative URL, the host header is not rewritten.

Referer—Rewrites the Referer header with the URL you specify. For Referer rules, you must
specify an absolute URL.

Note: The rewrite string is a literal string. Regular expression syntax is not supported.

Sends a redirect with the URL you specify in the HTTP Location header field.

For Redirect rules, you must specify an absolute URL. For example:
https://example.com/content/index.html

Note: The rewrite string can be a literal string or a regular expression.
Sends a 403 Forbidden response instead of forwarding the request.

Adds user-defined HTTP header in content-rewriting rules in HTTP request.
Header Name—Specify the HTTP header name
Header Value—Specify the HTTP header value
Note:
e The HTTP header name and value must conform to RFC 2616.
e The HTTP header and value must conform to PCRE regular expression.
¢ This feature works with HTTP and HTTPS server load-balance profiles only.

Deletes user-defined HTTP header in content-rewriting rules in HTTP request.
Header Name—See above.

Header Value—See above

Note: See above.

HTTP Response Rewrite Actions

Rewrite HTTP
Location

Add HTTP Header

Delete HTTP Header

Match Condition
Object

FortiADC 7.2.0 Handbook
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Rewrites the Location header field in the server response.

For Location rules, you must specify an absolute URL. For example:
https://example.com/content/index.html

Note: The rewrite string is a literal string. Regular expression syntax is not supported.

Adds user-defined HTTP header in content-rewriting rules in HTTP response.
Note: Refer to HTTP Request Rewrite Actions > Add HTTP Header above.

Deletes user-defined HTTP header in content-rewriting rules in HTTP response.
Note: Refer to HTTP Request Rewrite Actions > Delete HTTP Header above.

Select content matching conditions based on the following parameters:
e HTTP Host Header
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Settings Guidelines

e HTTP Location Header

e HTTP Referer Header

¢ HTTP Request URL

¢ Source IP Address
Note: When you add multiple conditions, FortiADC joins them with an AND operator. For
example, if you specify both a HTTP Host Header and HTTP Request URL to match, the rule
is a match only for traffic that meets both conditions.

Type « String

* Regular Expression
Content Specify the string or PCRE syntax to match the header or IP address.
Reverse Rule matches if traffic does not match the expression.

Example: Redirecting HTTP to HTTPS

You can use the content rewriting feature to send redirects. One common case to use redirects is when the requested
resource requires a secure connection, but you accidentally type an HTTP URL instead of an HTTPS URL in the web
browser.

For HTTP redirect rules, you can specify the rewritten location as a literal string or regular expression.

Redirecting HTTP to HTTPS (literal string) on page 62 shows a redirect rule that matches a literal string and rewrites a
literal string. In the match condition table, the rule is set to match traffic that has the Host header domain example. com
and the relative URL /resource/index.html inthe HTTP request URL. The redirect action sends a secure URL in
the Location header: https://example.com/resource/index.html.

Redirecting HTTP to HTTPS (literal string)
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Content Rewriting

Name 100

Action Type Request

Action Rewrite HTTP Header v
Specifics

Rewrite Host »
Rewrite URL ® ]

Rewrite Referer (B
Comments

comments

Match Condition (Empty Match Condition will match anything)

+ Create New @ Add Fitter

x
1D “ | Object Type Content Reverse &
1 HTTP Host Header String match Disable & o
2 HTTP Host Header String match Disable & o
Showing 1 to 2 of 2 entries Show 25| entries Previous ‘ 2 Next

Cancel

Regular expressions are a powerful way of denoting all possible forms of a string. They are very useful when trying to
match text that comes in many variations but follows a definite pattern, such as dynamic URLs or web page content.

Redirecting HTTP to HTTPS (regular expression) on page 64 shows a redirect rule that uses PCRE capture and back
reference syntax to create a more general rule than the previous example. This rule sends a redirect for all connections
to the same URL but over HTTP. In the match condition table, the first regular expressionis (. *). This expression
matches any HTTP Host header and stores it as capture 0. The second regular expression is ~/ (. *) $. This expression

matches the path in the Request URL (the content after the /) and stores it as capture 1. The regular expression for the
redirect action uses the back reference syntax https://$0/51.
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Redirecting HTTP to HTTPS (regular expression)

Content Rewriting

Name 100
Action Type Request

Action Rewrite HTTP Header -
Specifics

Rewrite Host »
Rewrite URL ® ]

Rewrite Referer (B
Comments

comments

Match Condition (Empty Match Condition will match anything)

@ Delete ©Add Fitter

1D “ | Object Type
. HTTP Host Header String
2 HTTP Host Header String

Showing 1 to 2 of 2 entries Show (25| entries

Content

match

match

Cancel

Reverse &
Disable Fa Rl
Disable & o

Previous

'I‘Next

Common PCRE syntax elements on page 64 describes commonly used PCRE syntax elements.

PCRE examples submitted to the FortiGate Cookbook on page 67 gives examples of useful and relevant expressions
that were originally submitted to the FortiGate Cookbook. For a deeper dive, consult a PCRE reference.

Regular expressions can involve very computationally intensive evaluations. For
best performance, you should only use regular expressions where necessary, and

build them with care.

Common PCRE syntax elements

Pattern Usage

() Creates a capture group or sub-pattern for
back-reference or to denote order of
operations.

$0, $1, %2, ... Only $0, $1,..., $9 are supported.

FortiADC 7.2.0 Handbook
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Example

Text: /url/app/app/mapp

Regular expression: (/app)*

Matches: /app/app

Text: /url?paramA=valueA&paramB=valueB

Regular expression: (param)A=
(value)A&\0B\1B

Matches: paramA=valueA&paramB=valueB

Let’s say the regular expressions in a
condition table have the following capture
groups:

(a)(b)(c(d))(e)
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Pattern
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Usage

A back-reference is a regular expression
token such as $0 or $1 that refers to whatever
part of the text was matched by the capture
group in that position within the regular
expression.

Back-references are used whenever you
want the output/interpretation to resemble the
original match: they insert a substring of the
original matching text. Like other regular
expression features, back-references help to
ensure that you do not have to maintain a
large, cumbersome list of all possible URLs.
To invoke a substring, use sn (0 <=n<=9),
where n is the order of appearance of capture
group in the regular expression, from left to
right, from outside to inside, then from top to
bottom.

Escape character.

Except, if it is followed by an alphanumeric
character, the alphanumeric character is not
matched literally as usual. Instead, it is
interpreted as a regular expression token.
For example, \w matches a word, as defined
by the locale.

Except, if it is followed by regular expression
special character:

~[$2ROGM

When this is the case, the \ escapes
interpretation as a regular expression token,
and instead treats the character as a normal
letter.

For example, \\ matches the \ character.

Matches any single character except \r or \n.

Note: If the character is written by combining
two Unicode code points, such as a where
the core letter is encoded separately from the
accent mark, this will not match the entire
character: it will only match one of the code
points.

Repeatedly matches the previous character
or capture group, 1 or more times, as many
times as possible (also called “greedy”
matching) unless followed by a question
mark ( ?), which makes it optional.

Example

This syntax results in back-reference
variables with the following values:

$0—a

$1—b
$2—cd
$3—d
$4—e

Text: /url?parameter=value
Regular expression: \?param
Matches: ?param

Text: My cat catches things.
Regular expression: c.t
Matches: cat cat

Text: www.example.com
Regular expression: w+
Matches: www
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Pattern
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Usage

Does not match if there is not at least 1
instance.

Repeatedly matches the previous character
or capture group, 0 or more times. Depending
on its combination with other special
characters, this token could be either:

* — Match as many times as possible (also
called “greedy” matching).

*? — Match as few times as possible (also
called “lazy” matching).

Makes the preceding character or capture
group optional (also called “lazy” matching).

This character has a different significance
when followed by =.

Looks ahead to see if the next character or
capture group matches and evaluate the
match based upon them, but does not include
those next characters in the returned match
string (if any).

This can be useful for back-references where
you do not want to include permutations of
the final few characters, such as matching
“cat” when it is part of “cats” but not when it is
part of “catch”.

Matches either:

the position of the beginning of a line (or, in
multiline mode, the first line), not the first
character itself

the inverse of a character, but only if ~ is the
first character in a character class, such as
["A]

This is useful if you want to match a word, but
only when it occurs at the start of the line, or
when you want to match anything that is not a
specific character.

Example

[T s ” o,

Would also match “w”, “ww”, “wwww”, or any
number of uninterrupted repetitions of the

character “w”.

Text: www.example.com

Regular expression: .*

Matches: www.example.com

All of any text, except line endings (\ r and
\n).

Text: www.example.com

Regular expression: (w)*?

Matches: www

Would also match common typos where the

TR ]

w” was repeated too few or too many times,
such as “ww” in w.example.com or “wwww” in
wwww.example.com. It would still match,

however, if no amount of “w” existed.

Text: www.example.com

Regular expression: (www\.)?example.com
Matches: www.example.com

Would also match example.com.

Text: /url?parameter=valuepack
Regular expression: p(?=arameter)

Matches: p, but only in “parameter, notin
“pack”, which does not end with “arameter”.

Text: /url?parameter=value
Regular expression: */url

Matches: /url, but only if it is at the beginning
of the path string. It will not match “/url” in
subdirectories.

Text: /url?parameter=value
Regular expression: [*u]
Matches: /rl?parameter=value
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Pattern

$

I

¢

Usage

Matches the position of the end of a line (or,
in multiline mode, the entire string), not the
last character itself.

Defines a set of characters or capture groups
that are acceptable matches.

To define a set via a whole range instead of
listing every possible match, separate the
first and last character in the range with a
hyphen.

Note: Character ranges are matched
according to their numerical code pointin the
encoding. For example, [@-B] matches any
UTF-8 code points from 40 to 42 inclusive:
@AB

Quantifies the number of times the previous
character or capture group may be repeated
continuously.

To define a varying number repetitions,
delimit it with a comma.

Turns on case-insensitive matching for
subsequent evaluation, until it is turned off or
the evaluation completes.

Matches either the character/capture group
before or after the pipe (| ).

PCRE examples submitted to the FortiGate Cookbook

Regular Expression Usage

Any alphanumeric character. ASCII only; e.g. does not match é or E.

[a-zA-Z0-9]
[#A?](.%)
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Example

Text: /url?parameter=value1
Regular expression: [012]
Matches: 1

Would also match 0 or 2.
Text: /url?parameter=valueB
Regular expression: [A-C]
Matches: B

Would also match “A” or “C”. It would not
match “b”.

Text: 1234567890

Regular expression: \d{3}
Matches: 123

Text: www.example.com
Regular expression: w{1,4}
Matches: www

If the string were a typo such as “ww ” or
“‘wwww”, it would also match that.

Text: /url?Parameter=value
Regular expression: (?i)param
Matches: Param

Would also match pArAM etc.

Text: Host: www.example.com
Regular expression: (\r\n)\n|\r

Matches: The line ending, regardless of
platform.

All parameters that follow a question mark or hash mark in the URL.
e.g. #pageView or ?param1=valueA&param2=valueB...;

In this expression, the capture group does not include the question
mark or hash mark itself.
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Regular Expression

Usage

\b10\.1\.1\.1\b

\b(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\.(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\.(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\.(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\b

(?)\b.*\.(a(c|d|e(ro)?|f|glilm|n|o]q]|r|s
(ia)?[tly|w|x|z)
|b(albld|elflg|hli(z)?j|m|n]|o]r|s|tlvIw]y|z)
|c(a(t)?|c|d|flglhlilk|ljm[n[o((m)?
(op)?)Irls|ulvixly|z)

|d(eljlkIm|o]z)

le(c|dule|g]hr|s|t|u)

If(iljlk|mlo|r)
l9(albldlelf|glhlillim[n|ov]plq]ris|tjulw]y)
[h(k|min]rlt|u)

li(dle|llm|n(fo)?(t)?|olq]r|s]|t)
li(e[mlo(bs)?|p)
[k(elglhlilm[n|p|rlwly|z)
[I@alblclilk|r|s|t|u]vy)
Im(alcldle|g|hlil|k]lim[n]o(bi)?|p|q|r|s|t|u
(seum)?|v|w|x|y|z)
In(a(me)?|cle(t)?|f|glill|o[p|r|u|z)
|o(m]rg)
Ip(alelflglhlk]llm[n|r(o)?|s|tlwly)

lga

|r(eo]s|ulw)
Is(alblc|d|e|g|hliljIk[l|m|n|olr|s[t|ulv]y|z)

It(c|d|ellflglhljlk[l|mn[o|p|r(avel)?|t|v|w|z)

lu(alglklsly|z)
[v(alcle|gliln]|u)
|w(fls)

[xxx

ly(e[tju)
|z(alm|w))\b

(?i)\bwww\.example\.com\b

(?)\b(.*)\.example\.com\b

A specific IPv4 address.
Any IPv4 address.

Any domain name.

A specific domain name.

Any sub-domain name of example.com.

Example: Rewriting the HTTP response when using content routing

Itis standard for web servers to have external and internal domain names. You can use content-based routing to forward
HTTP requests to example.com to a server pool that includes server1.example.com, server2.example.com, and
server3.example.com. When you use content routing like this, you should also rewrite the Location header in the HTTP
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response so that the client receives HTTP with example.com in the header and not the internal domain
server1.example.com.

Rewriting the HTTP response when masking internal server names on page 69 shows an HTTP response rule that
matches a regular expression and rewrites a literal string. In the match condition table, the rule is set to match the regular
expression server. *\ .example\ .cominthe HTTP Location header in the response. The rewrite action specifies the
absolute URL http://www.example.com.

Rewriting the HTTP response when masking internal server names

Content Rewriting

Name CWR1
Action Type Response
Action Rewrite HTTP Location =

Specifics

Location http:/example.com

Comments

comments

Match Condition (Empty Match Condition will match anything)

M Delete < Create New OAdd Fiiter x
1D “* | Object Type Content Reverse &
1 HTTP Request URL Regular Expression match Disable P ]

Showing 1to 1of 1entries Show 25 entries Previous 1 Next

Cancel

Example: Rewriting the HTTP request and response to mask application details

Another use case for external-to-internal URL translation involves masking pathnames that give attackers information
about your web applications. For example, the unmasked URL for a blog might be
http://www.example.com/wordpress/?feed=rss2, which exposes that the blog is a wordpress application. In this case,
you want to publish an external URL that does not have clues of the underlying technology. For example, in your web
pages, you create links to http://www.example.com/blog instead of the backend URL.

On FortiADC, you create two rules: one to rewrite the HTTP request to the backend server and another to rewrite the
HTTP response in the return traffic.

Rewriting the HTTP request when you mask backend application details on page 70 shows an HTTP request rule. In the
match condition table, the rule is set to match traffic that has the Host header domain example.com and the relative
URL /blog inthe HTTP request URL. The rule action rewrites the request URL to the internal URL
http://www.example.com/wordpress/?feed=rss2.
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Rewriting the HTTP request when you mask backend application details

Content Rewriting

Name CWR1

Action Type Response

Action Rewrite HTTP Location -
Specifics

Location http:/fexample.com

Comments

comments

Match Condition (Empty Match Condition will match anything)

1D “* | Object Type Content Reverse &
1 HTTP Request URL Regular Expression match Disable & g

Showing1to 1of lentries  Show 25 entries Previous | 1 | Next

Cancel

Rewriting the HTTP response when you mask backend application details on page 70 shows the rule for the return
traffic. In the match condition table, the rule is set to match traffic that has the string
http://www.example.com/wordpress/?feed=rss2 in the Location header of the HTTP response. The action
replaces that URL with the public URL http://www.example.org.

Rewriting the HTTP response when you mask backend application details

Content Rewriting

Name 1

Action Type

Action Rewrite HTTP Location -
Specifics

Location htip://fexample.com

Comments

| commentscommentscommentscommentscommentscomme =
ntscommentscommentscommentscommentscommentscom
mentscommentscommentscommentscommentscommentsc |

Match Condition (Empty Match Condition will match anything)

@ Delete © Add Filter | x
1D “* | Object Type Content Reverse £+
2 HTTP Location Header String match Disahle & o &

Showing 1to 1 of 1 entries Show [25| entries Previous 1 | Next

Example: Rewriting the HTTP request to harmonize port numbers

The HTTP Host header contains the domain name and port. You might want to create a rule to rewrite the port so you
can harmonize port numbers that are correlated with your application service. For example, suppose you want to avoid
parsing reports on your backend servers that show requests to many HTTP service ports. When you review your
aggregated reports, you have records for port 80, port 8080, and so on. You would rather have all HTTP requests served
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on port 80 and accounted for on port 80. To support this plan, you can rewrite the HTTP request headers so that all the
Host header in all HTTP requests shows port 80.

Rewriting the HTTP request port number on page 71 shows an HTTP request rule that uses a regular expression to
match HTTP Host headers for www.example.com with any port number and change it to port 80.

Rewriting the HTTP request port number

Content Rewriting

Name

Action Type  [RE I

Action Rewrite HTTP Header -
Specifics

Rewrite Host [ &

Host Content www.example.com

Rewrite URL @ ]

Rewrite Referer (B

Comments

commentsconmentscommentscommentscommentscomime
ntscommentscommentscommentscommentscommentscom
mentscommentscommentscommentscommentscommentsc

Match Condition (Empty Match Condition will match anything)

©Add Filter x
In] * | Object Type Content Reverse &
1 HTTP Host Header Regular Expression www.example.org Disable S Mm@
Showing 1to 1of 1 entries Show (25| entries Previous 1 Next

HSTS and HPKP support

Starting from its 4.8.1 release, FortiADC supports HSTS and HPKP to offer enhanced web security to its users.

HSTS

HSTS, or HTTP Strict Transport Security, is a web security mechanism used to guard websites against

malicious attacks, such as protocol downgrading and cookie hijacking. Once implemented, HSTS enables the web
server to force web browsers to use secure HTTPS connections when interacting with it, and prohibit the use of insecure
HTTP connections.

An HSTS-enabled web application server communicates its HSTS policy to web browsers via an HTTPS header field
called "Strict-Transport-Security". The policy dictates that web browsers should only connect to the server via a secure
connection during the period of time (i.e., max-age) specified in the policy. Based on the HSTS policy, compliant web
browsers either automatically convert insecure (i.e., HTTP) connections to secure (i.e., HTTPS) ones or show an error
message and bar the user from accessing the server if it cannot ensure the security of the connection.

HSTS is used to address SSL/TSL-stripping attacks and prevent hackers from stealing your cookie-based web login
credentials.
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HSTS syntax:

o Strict-Transport-Security: max-age=<expire-time> [; includeSubDomains] [; preload]
» Preload validation and registration:
e https://www.chromium.org/hsts

e https://hstspreload.org

HPKP

HPKP, or HTTP Public Key Pinning, is a web security mechanism used to prevent HTTPS websites from impersonation
via mis-issued or fraudulent security certificates.

The first time a client browser accesses an HTTPS web application server, the server sends to the client a set of public
keys, which are the only ones that should be trusted for connections to the domain. This list of "pinned" public key
hashes are used for subsequent connections between the client and the server, and are valid only for the period of time
that is specified in the HPKP policy.

HPKP syntax

o Public-Key-Pins: pin-sha256="<pin-value>"; pin-sha256="“<backup-pin-value>"; max-
age=expireTime [; includeSubDomains][; report-uri="reportURI"]

o Public-Key-Pins-Report-Only: pin-sha256="<pin-value>"; pin-sha256="“<backup-pin-value>";
max-age=<expire-time> [; includeSubDomains] [; report-uri="<uri>"]

HPKP note and validation

» Note a host as the known pinned host:

« Identified only by its domain name, but never IP

« Three conditions:
o PKP received over an error-free TLS, including possible HPKP validation
« Atleast oneintersection
e The host must set a backup pin.

« Pin Validation:

« Ignore superfluous certificates

o Check intersection, at least one

« Can be disabled for some hosts according to local policy

Good HPKP practices

« Ifused incorrectly, HPKP could lock out users for a long period of time. Using backup certificates and/or pinning the
CA certificate is recommended.

o Use small value for max-age.
« When a certificate expires, generate a new certificate using the old key if pinning is done on the server certificate.
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HPKP calculation

Use the following OpenSSL commands to calculate HPKP fingerprints:

openssl rsa -in my-rsa-key-file.key -outform der -pubout | openssl dgst -sha256 -
binary | openssl enc -base64

openssl ec -in my-ecc-key-file.key -outform der -pubout | openssl dgst -sha256 -
binary | openssl enc -base64

openssl req -in my-signing-request.csr -pubkey -noout | openssl pkey -pubin -
outform der | openssl dgst -sha256 -binary | openssl enc -base64

openssl x509 -in my-certificate.crt -pubkey -noout | openssl pkey -pubin -outform
der | openssl dgst -sha256 -binary | openssl enc -base64

openssl s _client -servername www.example.com -connect www.example.com:443 | openssl

x509 -pubkey -noout | openssl pkey -pubin -outform der | openssl dgst -sha256 -
binary | openssl enc -base64

Implementation of HSTS/HPKP

Support for HSTS and HPKP can be implemented for both SSL offloading and forward proxy.

SSL offloading

On the Server Load Balance>Virtual Server>Content Rewriting page, do the following:
1.

(Optional) Add a content rewriting rule to delete the HSTS or HPKP header received from the real server. Skip this
step if the real server did not send any HSTS or HPKP header. See Delete HTTP header (optional) on page 73.

Add one content rewriting to add an HSTS or HPKP header, customize the max-age and other optional fields. See
Add HTTP header on page 74.

Delete HTTP header (optional)

Content Rewriting

Name sa

Action Type Request

Il‘«ctw'on Delete HTTP Header -

Specifics

Header Name header-name

Header Value Specify the header value.

Comments

comments

Match Condition (Empty Match Condition will match anything)

Showing 1to 1 of 1 entries Show 25| entries

fi Delete © Add Filter ®
m} ID * | Object Type Content Reverse o
(] 1 HTTP Host Header String match Disable & W A

]
Previous | 1 | Next
Ll
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Add HTTP header

== Content Rewriting o

Content Rewriting

Name add_hsts
Actlon Add HTTP Header E
Specifics
Header Name Strict-Transport-Security
Header Value max-age=999; includeSubDomains

Forward proxy

On the Server Load Balance>Virtual Server>Content Rewriting page, do the following:

1. (Optional) Add a content rewriting rule to delete the HSTS or HPKP header received from the real server. Skip this
step if the real server did not send any HSTS or HPKP header.

2. Do nothing to HSTS header (let it pass through).

Configuring content routes

You can use the content routes configuration to select the backend server pool based on matches to TCP/IP or HTTP
header values.

Layer 7 content route rules are based on literal or regular expression matches to the following header values:

e HTTP Host

o HTTP Referer

e HTTP Request URL

« SNI

» Source IP address
You might want to use Layer 7 content routes to simplify front-end coding of your web pages or to obfuscate the precise
server names from clients. For example, you can publish links to a simple URL named example.com and use content

route rules to direct traffic for requests to example.com to a server pool that includes server1.example.com,
server2.example.com, and server3.example.com.

Layer 4 content route rules are based on literal or regular expression matches to the following header values:
e Source IP address
Before you begin:

¢ You must have a good understanding of HTTP header fields.
» You must have a good understanding of Perl-compatible regular expressions (PCRE) if you want to use them in rule
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matching.
» You must have Read-Write permission for Load Balance settings.

After you have configured a content routing rule, you can select it in the virtual server configuration.

Note: You can select multiple content routing rules in the virtual server configuration. Rules you add to that configuration
are consulted from top to bottom. The first rule to match is applied. If the traffic does not match any of the content routing
rule conditions specified in the virtual server configuration, the system behaves unexpectedly. Therefore, it is important
that you create a “catch all” rule that has no match conditions. In the virtual server configuration, this rule should be
ordered last so it can be used to forward traffic to a default pool.

To configure a content route rule:

Go to Server Load Balance > Virtual Server.

Click the Content Routing tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Content routes configuration guidelines on page 75.
Save the configuration.

o obd-=

Content routes configuration guidelines

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Type + Layer4
e Layer7
Real Server Select areal server pool.
Persistence Inherit Enable to use the persistence object specified in the virtual server configuration.
Persistence If not using inheritance, select a session persistence type.
Method Inherit Enable to use the method specified in the virtual server configuration.
Method If not using inheritance, select a load balancing method type.
Comments A string to describe the purpose of the configuration, to help you and other administrators

more easily identify its use.

Layer 4 Specifics
IPv4/Mask Address/mask notation to match the source IP address in the packet header.
IPv6/Mask Address/mask notation to match the source IP address in the packet header.

Layer 7 Match Condition

Object Select content matching conditions based on the following parameters:
e HTTP Host Header
e HTTP Referer Header
e HTTP Request URL
e SNI
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Settings Guidelines

* Source IP Address
Note: When you add multiple conditions, FortiADC joins them with an AND operator. For
example, if you specify both a HTTP Host Header and HTTP Request URL to match, the rule
is a match only for traffic that meets both conditions.

Type e String
¢ Regular Expression
Content Specify the string or PCRE syntax to match the header or IP address.
Note: An empty match condition matches any HTTP request.
Reverse Rule matches if traffic does not match the expression.
Ignore Case Allows user to let the match be case sensitive. Default is ignore case, disabled.

Using source pools

This topic includes a procedure for configuring the source IP address pools used in NAT, and examples of NAT
deployments. It includes the following sections:

Configuring source pools

Example: DNAT

Example: full NAT

Example: NAT46 (Layer 4 virtual servers
Example: NAT64 (Layer 4 virtual servers
Example: NAT46 (Layer 7 virtual servers
Example: NAT64 (Layer 7 virtual servers

—_ — ~— ~—

Configuring source pools

You use the Source Pool page to create configuration objects for source IP addresses used for NAT in Layer 4 virtual
server configurations.

In a Layer 4 virtual server configuration, you select a “packet forwarding method” that includes the following network
address translation (NAT) options:

Direct Routing—Does not rewrite source or destination IP addresses.
DNAT—Rewrites the destination IP address for packets before it forwards them.

Full NAT—Rewrites both the source and destination IP addresses. Use for standard NAT, when client and server IP
addresses are all IPv4 or all IPv6.

NAT46—Rewrites both the source and destination IP addresses. Use for NAT 46, when client IP addresses are
IPv4 and server |IP addresses are IPVv6.

NAT64—Rewrites both the source and destination IP addresses. Use for NAT 64, when client IP addresses are
IPv6 and server |IP addresses are IPv4.

In a Layer 7 virtual server configuration, you do not select a packet forwarding option. Layer 7 virtual servers use NAT46
and NAT64 to support those traffic flows, but they do not use the Source Pool configuration.
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See the examples that follow the procedure for illustrated usage.

Before you begin:

« You must have a good understanding of NAT. You must know the address ranges your network has provisioned for
NAT.

» Be sure to configure the backend servers to use the FortiADC address as the default gateway so that server
responses are also rewritten by the NAT module.

¢ You must have Read-Write permission for Load Balance settings.

After you have configured a source pool IP address range configuration object, you can select it in the virtual server
configuration. You can assign a virtual server multiple source pools (with the same or different source pool interface
associated with it).

There are no validation checks for duplicate addresses in the NAT source pool for
HA synchronization, SNAT, 1-to-1 NAT, and VIP, as the ha-mgmt-ip is not
synchronized between the HA nodes. For these configurations, ensure the starting
and ending IPs in the address range of the NAT source pool are not duplicates.

To configure a source pool:

Go to Server Load Balance > Virtual Server.

Click the NAT Source Pool tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Source pool configuration on page 77.
Save the configuration.
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Source pool configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Interface Interface to receive responses from the backend server. The interface used for the initial client
traffic is determined by the virtual server configuration.

Address Type e |Pv4

e |IPv6
Address Range The first address in the address pool.
To The last address in the address pool.

Node Member

Name Create a node member list to be used in an HA active-active deployment. In an active-active
deployment, node interfaces are configured with a list of IP addresses for all nodes in the
cluster. You use this configuration to provision SNAT addresses for each of the nodes.

Name is a configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You
reference this name in the virtual server configuration.

FortiADC 7.2.0 Handbook 77
Fortinet Inc.



Chapter 4: Server Load Balancing

Settings Guidelines

Note: After you initially save the configuration, you cannot edit the name.

Pool Type IPv4 or IPv6.

Minimum IP The first address in the address pool.

Maximum IP The last address in the address pool.

Interface Interface to receive responses from the backend server. The interface used for the initial client

traffic is determined by the virtual server configuration.

HA Node Number Specify the HA cluster node ID.

Example: DNAT

Destination NAT on page 78 illustrates destination NAT (DNAT). The NAT module rewrites only the destination IP
address. Therefore, if you configure destination NAT, you do not need to configure a source pool. In this DNAT example,
the destination IP address in the packets it receives from the client request is the IP address of the virtual server—
192.168.1.101. The NAT module translates this address to the address of the real server selected by the load
balancer—in this example, 192.168.2.1. The system maintains this NAT table and performs the inverse translation when
it receives the server-to-client traffic.

Destination NAT
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¥ 192.168.1.1

\ Client

_ VS 192.168.1.101
ForiADC | %

Servers
192 168 2.1
Ingress Egress
DNAT SRC 192.168.11 192.168.11
DST 192.168.1.101 192.168.2.1

Example: full NAT

Full NAT on page 80 illustrates full NAT. The source IP / destination IP pair in the packets received is SRC 192.168.1.1/
DST 192.168.1.101. The NAT module translates the source IP address to the next available address in the source
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pool—in this example, 192.168.2.101. It translates the destination IP address to the address of the real server selected
by the load balancer—in this example, 192.168.2.1.

The system maintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

Full NAT

\ Client

© 192.168.1.1

VS 192.168.1.101
FortiADC

Source Pool

192.168.2.101
192.168.2.102
192.168.2.103
192.168.2.104

192.168.2.1
Ingress
Full NAT SRC 192.168.1.1 192.168.2.101
DST 192.168.1.101 192.168.2.1
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Example: NAT46 (Layer 4 virtual servers)

NAT46 (Layer 4 virtual servers) on page 81 illustrates full NAT with NAT46. The IPv6 client connects to the virtual server
IPv4 address. The source IP / destination IP pair in the packets received is SRC 192.168.1.1/DST 192.168.1.101. The
NAT module translates the source IP address to the next available IPv6 address in the source pool—in this example,
2002::2:1001. It translates the destination IP address to the IPv6 address of the real server selected by the load

balancer—in this example, 2002::2:1.

The system maintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

NAT46 (Layer 4 virtual servers)
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."\-\.5_

) __ Client
Y 19216811

FortiADC [S VS 192168 1.101

Source Pool
20022101
200222102
2002::2:103
20022104

Servers
2002::2-1 1 '
Ingress Egress
NAT46 src | 192.168.1.1 2002::2:101
DST 192 168.1.101 2002:-21
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Limitations: NAT46 (Layer 4 virtual servers)

Features Notes

Profile Not Supported: FTP
ICMP ICMP traffic is dropped.

Example: NAT64 (Layer 4 virtual servers)

NAT64 (Layer 4 virtual servers) on page 83 illustrates full NAT with NAT64. The IPv6 client connects to the virtual server
IPv6 address. The source IP / destination IP pair in the packets received is SRC 2001::1:1/DST 2001::1:101. The NAT
module translates the source IP address to the next available IPv4 address in the source pool—in this example,
192.168.2.101. It translates the destination IP address to the IPv4 address of the real server selected by the load

balancer—in this example, 192.168.2.1.

The system maintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

NATG64 (Layer 4 virtual servers)
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VS 2001::1:101

“ Source Pool
192 168.2.101
192.168.2.102
192 168.2.103
192 168.2.104
Servers
192 .168.2 1 @ g
Ingress Egress
NATG4 SRC 2001:1:1 192.168.2.101
DST 2001::1:101 192.168.2.1
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Limitations: NAT64 (Layer 4 virtual servers)

Profiles Not Supported: FTP
ICMP ICMP traffic is dropped.
Security Not Supported: IP Reputation, DoS protection, Security logs and reports

Example: NAT46 (Layer 7 virtual servers)

NAT46 (Layer 7 virtual servers) on page 85 illustrates full NAT with NAT46. The IPv4 client connects to the virtual server
IPv4 address. The source IP / destination IP pair in the packets received is SRC 192.168.1.1/DST 192.168.1.101. The
NAT module translates the source IP address to the IPv6 address of the egress interface that has IPv6 connectivity with
the real server—in this example, 2002::2:1001. It translates the destination IP address to the IPv6 address of the real
server selected by the load balancer—in this example, 2002::2:1.

The system maintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

NAT46 (Layer 7 virtual servers)
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VS 2001::1:101

egress interface

192.168.2.101
Servers
192.168.2 .1 ; I
Ingress Egress
NATG4 SRC 2001211 1921682101
DST 20011101 1921682 1
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Limitations: NAT46 (Layer 7 virtual servers)

Feature Note

Profiles Not Supported: RADIUS, HTTP Turbo

Profile options Not supported: Source Address (Using the original source IP address for the connection
to the real server is contrary to the purpose of NAT.)

Virtual server options Not supported: Connection Rate Limit

Real server pool options Not supported: Connection Rate Limit

Example: NAT64 (Layer 7 virtual servers)

NATG64 (Layer 7 virtual servers) on page 87 illustrates full NAT with NAT64. The IPv6 client connects to the virtual server
IPv6 address. The source IP / destination IP pair in the packets received is SRC 2001::1:1/DST 2001::1:101. The NAT
module translates the source IP address to the IPv4 address of the egress interface that has IPv4 connectivity with the
real server—in this example, 192.168.2.101. It translates the destination IP address to the IPv4 address of the real
server selected by the load balancer—in this example, 192.168.2.1.

The system maintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

NAT64 (Layer 7 virtual servers)
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VS 2001::1:101

egress interface

192.168.2.101
Servers
192.168.2 .1 ; I
Ingress Egress
NATG4 SRC 2001211 1921682101
DST 20011101 1921682 1
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Limitations: NAT64 (Layer 7 virtual servers)

Feature Note

Profiles Not Supported: RADIUS, HTTP Turbo

Profile options Not supported: Source Address (Using the original source IP address for the connection
to the real server is contrary to the purpose of NAT.)

Virtual server options Not supported: Connection Rate Limit
Real server pool options Not supported: Connection Rate Limit

Security Not Supported: IP Reputation, DoS protection, Security logs and reports

Using schedule pools

A schedule pool is a list of configuration objects, each of which is tied to a specific real-server pool and schedule group.
Used together with real-server pools, schedule groups, and content routing rules, schedule pools make it much easier
for you to streamline the operation and management of your real servers. You set or change the working schedules of
your real servers with ease.

The schedule pool feature takes the following two factors are taken into consideration:

First, there can be multiple pools in a virtual server or a content routing configuration. This does not mean to introduce a
traffic distributing hierarchy to load-balance across the pools because all the pools of different schedule pools in a virtual
server obey the same rule of traffic distribution. So the basic schema is not changed. The way it works is the same as a
single pool does. We have the following specific confines:

o The same real server pool is not allowed to be used in different schedule pools which are configured in the same
virtual server.

e The same real server is not allowed to be used in different real-server pools that are used by schedule pools
configured in the same virtual server.

» When multiple schedule pools are active, all the real-server pools within them (schedule pools) are active, and
traffic can be transmitted to all the real servers in the real-server pools as scheduled. In that case, all the real
servers are placed in different pools for scheduling.

o The backup real servers are backed up for all the current active real servers from multiple schedule pools of a virtual
server.

Second, a schedule pool can be scheduled inactive. The schedule daemon tracks the states of all the schedules. When
a schedule's state changes, the schedule daemon updates the new state to all the related daemons. As soon as the
state of a schedule pool goes active, the system will start to transmit traffic to members of the corresponding pool unless
there are some other mechanisms keeping the schedule pool or some members of the pool in “not work” state, as in the
case of health check failure or backup members of the pool. Once a schedule turns inactive, the system will stop
transmitting traffic to all the members of the corresponding pool. Some or all members of the pool may be in “not work”
state for various reasons when a schedule's state changes to inactive. Anyway, when members of a pool turn inactive,
the system will react in the same way as it does when they fail their health check — immediately removes the
connections involved and cuts off traffic to those connections at the same time.

The schedule-based pool can be applied to all kinds of virtual servers and all kinds of content routing configurations. It
should also work well with all packet-forwarding methods, and can handle all the protocols that FortiADC now supports.
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How to use the "schedule pool” feature

The following are the basic steps you need to follow to take advantage of the schedule pool feature:

Configure schedule groups (Shared Resources > Schedule Group).

Configure real servers (Server Load Balance > Real Server).

Configure real-server pools (Server Load Balance > Real Server Pool).

Configure schedule pools (Server Load Balance > Virtual Server > Schedule Pool).

Configure content routing rules (Server Load Balance > Virtual Server > Content Routing). (Optional)
Configure virtual servers (Server Load Balance > Virtual Server)
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Configuring schedule pools

The following instructions assume that you have properly configured schedule groups, real servers, and real server
pools, as mentioned in the preceding paragraph.

To configure schedule pools:

From the main menu, click Server Load Balance > Virtual Server.
Select the Schedule Pool tab.

Click Create New to open the Schedule Pool dialog box.

Specify a unique name for the schedule pool.

Select a real server pool.

Select a schedule group.

Click Save when done.

Repeat Steps 2 through 7 to create as many schedule pools as needed.

NSO GaRAODN-=

Using clone pools

A clone pool is a set of destinations, of monitor servers.

The FortiADC is tasked with protecting the real-server pools. Before allowing traffic to reach the servers, it will duplicate

the traffic, sending a copy towards the clone pool, which holds onto it.

As such, the clone pool is assigned to a virtual server. In the clone pool is a farm of monitor servers; some of these
monitor servers can be IDS servers - intrusion detection system (IDS) - which will analyze traffic to identify suspicious

patterns. The IDS server does not perform fire wall functions, like blocking the traffic. However, the IDS server will send

out, say, an email, indicating that the server
Important: A clone pool receives all of the same traffic that the server pool receives.

To configure a clone pool, you first create a pool of IDS or sniffer devices and then assign the pool as a clone pool to a

virtual server. The clone pool feature is the recommended method for copying production traffic to IDS systems or sniffer

devices. Note that when you create the clone pool, the service port that you assign to each node is irrelevant; you can
choose any service port. Also, when you add a clone pool to a virtual server, the system copies only new connections;
existing connections are not copied.

You can configure a virtual server to copy client-side traffic, server-side traffic, or both:
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« Aclient-side clone pool causes the virtual server to replicate client-side traffic (prior to address translation) to the
specified clone pool.

« Aserver-side clone pool causes the virtual server to replicate server-side traffic (after address translation) to the
specified clone pool.

Clone pool topology on page 91 illustrates how clone pools work.

Clone pool topology
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The following steps show the process in which FortiADC clones packets and sends them to the monitor servers:
1. Duplicates the packet data structure.

Looks up the route table by monitor server IP to find out the next-hop IP address and output device, if necessary.
Looks up the neighbors by the next-hop IP address, if necessary.

Updates packet headers with specified values or results of route and ARP look-up.

Sends the packets out to the monitor servers.

o~ owDd

Configuring a clone pool

Before starting to create clone pools, keep the following in mind:

« Only one clone pool can be configured for the virtual server.

» The clone pool can have at most four members. The traffic will be duplicated and sent to each of the members.
e Only IPv4 addresses are supported.

« There are four modes by which you may update and send the packets.
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« When the clone pool is added to the virtual server, the traffic (of old sessions and new) is duplicated and sent to the
monitor servers in the clone pool.

« The following is true:

« Ifthe virtual server is of the type L7, then the profiles TURBOHTTP, HTTP, HTTPS, TCPS, RDP, are
supported.

« Ifthe virtual server is of the type L2, then the profiles TCP, UDP, IP, HTTP, HTTPS, TCPS, are supported.
« Ifthe virtual server is of the type L4, then the profiles TCP, UDP, FTP, are supported.

« Traffic of both client and server sides may be cloned. For the client-side, traffic is replicated BEFORE the packet's
address undergoes Network Address Translation (NAT) such that it may reach the clone members. For the server-
side, however, NAT has already happened; the packet has already gone through the virtual server. Thus the traffic
is replicated AFTER the packet address has been translated.

To configure a clone pool:

The following instructions assume that you have properly configured schedule groups, real servers, and real server
pools.

Go to Server Load Balance > Virtual Server > Clone Pool.

Click Create New.

Return to Clone Pool tab and select your clone pool, and click edit.

Click Create New to create a member inside your clone pool. Create as many members as four.
Refer to the table below for entries and/or selections required for creating a clone pool.
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Parameters for clone pool configuration

[caption]
Clone Pool
Name Specify a unique clone pool name

Pool Member

Name Specify a unique pool member name.

Note: A pool member is a clone server. So this name is essentially the
name you give to the clone server.

Interface Select the interface (port) FortiADC uses to send out packets to the clone
server.
Mode The headers of duplicated packets need to be updated when sent to

monitor servers. There are several modes in which this occurs. Select one
of the following:
¢ Mirror Interface—This mode does not change the packet header at all.

Itis most commonly used; with it, the monitor does not look at the
content of the packet, neither does it receive the payload, it merely
looks at how much data is being passed, and counts the bytes of the
data. The original Layer 2 Destination Address (DA) or Source
Address (SA) and Layer 3 IP Addresses are left intact. In this mode
the FortiADC simply sends the packets "as is" out from the specified
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Entry/Selection Description

interface.

Mirror Destination MAC Address Update—This mode uses Layer 2
forwarding. With the incoming packet, the ADC replaces the
destination MAC address with the specified destination MAC address.
Itis preferred when connecting the ADC to end devices like the IDS.
Mirror Source MAC Update—This mode replaces the source MAC
address in the incoming packet with the specified MAC address on the
FortiADC device. This option is recommended where not changing the
source MAC address could cause a loop.

Mirror Source Destination MAC Update—This mode replaces both the
source and destination MAC addresses at Layer 2, but does not
change the Layer-3 IP addressing information.

Mirror IP Update—This mode replaces the incoming packet’s IP
address with the specified IP address and then forwards the
duplicated packet to those servers. This mode may also change the
Layer 4 source and destination ports. If the virtual server port isn't set
to wildcard port O while the port IS specified, the Layer 4 destination
port on the duplicated packets will be changed to the specified value.
This option is recommended for scenarios in which monitor servers
are not directly connected to the ACOS device.

Configuring Application profiles

An application profile is a configuration object that defines how you want the FortiADC virtual server to handle traffic for

specific protocols.

The Application Profile Usage table describes the usage by application profile type, including the compatible virtual
server types, load-balancing methods, persistence methods, and content routing types.

Application Profile Usage

Profile Usage

FTP Use with FTP servers.
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VS LB Methods Persistence

Type

Layer7, Layer7: Round Robin, Least Source Address, Source
Layer4, Connections Address Hash

Layer2 | ayer4: Same as Layer 7,
plus Fastest Response,
Dynamic Load

Layer 2: Same as Layer 7
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Profile

HTTP

HTTPS

TURBO
HTTP

RADIUS
RDP

Usage VS
Type

Use for standard, unsecured
web server traffic.

Layer7,
Layer 2

Use for secured web server
traffic when offloading
TLS/SSL from the backend
servers. You must import the
backend server certificates
into FortiADC and select
them in the HTTPS profile.

Layer7,
Layer 2

Use for unsecured HTTP
traffic that does not require
advanced features like
caching, compression,
content rewriting, rate
limiting, Geo IP blocking, or
source NAT. The profile can
be used with content routes
and destination NAT, but the
HTTP request must be in the
first data packet.

Layer7

This profile enables packet-
based forwarding that
reduces network latency and
system CPU usage.
However, packet-based
forwarding for HTTP is
advisable only when you do
not anticipate dropped
packets or out-of-order
packets.

Use with RADIUS servers. Layer7

Use with Windows Terminal
Service(remote desktop
protocol).

Layer7
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LB Methods

Layer 7: Round Robin, Least
Connections, URI Hash, Full
URI Hash, Host Hash, Host
Domain Hash, Dynamic
Load

Layer 2: Same as Layer 7,
plus Destination IP Hash

Same as HTTP

Round Robin, Least
Connections, Fastest
Response

Round Robin

Round Robin, Least
Connections

Persistence

Source Address, Source
Address Hash, Source
Address-Port Hash, HTTP
Header Hash, HTTP
Request Hash, Cookie
Hash, Persistent Cookie,
Insert Cookie, Embedded
Cookie, Rewrite Cookie,
Passive Cookie

Same as HTTP, plus SSL
Session ID

Source Address

RADIUS attribute

Source Address, Source
Address Hash, Source
Address-Port Hash, RDP
Cookie
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Profile

SIP

TCP

TCPS

UDP

DNS

SMTP

RTMP

Usage VS
Type

Use with applications that Layer7

use session initiation

protocol (SIP), such as VolP,

instant messaging, and

video.

Use for other TCP protocols. Layer 4,
Layer 2

Use for secured TCP when Layer7,

offloading TLS/SSL fromthe Layer2

backend servers. Like the

HTTPS profile, you must

import the backend server

certificates into FortiADC

and select them in the TCPS

profile.

Use with UDP servers. Layer4,
Layer 2

Combines with Layer 2 Layer 2

TCP/UDP/HTTP virtual

server to balance the rest of

the IP packets passed

through FortiADC. When

running the IP protocol 0 VS,

the traffic always tries to

match none protocol 0 VS

first.

Use with DNS servers. Layer7

Use with SMTP servers. Layer7

A TCP-based protocol used Layer7

for streaming audio, video,
and data over the Internet

FortiADC 7.2.0 Handbook

Fortinet Inc.

LB Methods

Round Robin, URI Hash,
Full URI Hash

Layer 4: Round Robin, Least
Connections, Fastest
Response, Dynamic Load

Layer 2: Round Robin, Least
Connections, Fastest
Response, Destination IP
Hash, Dynamic Load

Layer 7: Round Robin, Least
Connections, Dynamic Load
Layer 2: Round Robin, Least
Connections, Destination IP
Hash, Dynamic Load

Layer 4: Round Robin, Least
Connections, Fastest
Response, Dynamic Load
Layer 2: Same as Layer 4,
plus Destination IP Hash

Round Robin, Dynamic
Load

Round Robin, Least
Connections

Round Robin, Least
Connections

Round Robin, Least
Connection

Persistence

Source Address, Source
Address Hash, Source
Address-Port Hash, SIP
CallID

Source Address, Source
Address Hash

Source Address, Source
Address Hash, Source
Address-Port Hash, SSL
Session ID

Source Address, Source
Address Hash

Source Address, Source
Address Hash

Not supported yet.

Source Address, Source
Address Hash

Source Address, Source
Address Hash
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Profile Usage VS LB Methods Persistence
Type
1ISO8583 Use with ISO8583 servers Layer7 Round Robin N/A
RTSP A network control protocol Layer7 Round Robin, Least Source Address, Source
used for establishing and Connection Address Hash

controlling media sessions
between end points

MySQL MySQL network protocol Layer7 Round Robin, Least N/A
stack (i.e., MySQL-Proxy) Connection
which parses and builds
MySQL protocol packets

DIAMETER A successor to RADIUS, Layer7 Round Robin Source Address.
DIAMETER is the next- DIAMETER Session ID
generation Authentication, (default)

Authorization and
Accounting (AAA) protocol

widely used in IMS and LTE.

MSSQL MSSQL network protocol Layer7 Leastconnection N/A
stack, which parses and
builds MSSQL protocol

packets
EXPLICIT_ A simple explicit/forward Layer7 N/A N/A
HTTP HTTP proxy mode.

In this mode, you don’t need
to add backend real server
pool. The destination IP
address of the downstream

is specified by the URL or
Host field of the client
request.
L7 TCP Use for other TCP protocols. Layer7 Layer 7: Round Robin, Least Source Address, Source
Connections Address Hash
L7 UDP Use with UDP servers. Layer7 Layer 7: Round Robin, Least Source Address, Source
Connections Address Hash

The Predefine Profiles table lists the default values of each predefined profile. All values in the predefined profiles are
view-only, and cannot be modified. You can select predefined profiles in the virtual server configuration, or you can
create user-defined profiles to include configuration objects such as certificates, caching settings, compression options,
and IP reputation.

Predefined Profiles

Profile Defaults

LB_PROF_DIAMETER Origin Host—Blank
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Profile Defaults

Origin Realm—Blank
Vendor ID—0
Product Name—Blank

Idle Timeout—300 (seconds) (Note: This refers to the built-in session
ID persistence timeout.)

Server Close Propagation—OFF (Note: This means that the
connection on the client side stays open when the server closes any
connection on its side.)

Client SSL—Off

LB_PROF_TCP Timeout TCP Session—100
Timeout TCP Session after FIN—100
IP Reputation—Disabled
Geo IP block list—None
Geo IP Allowlist—None

LB_PROF_UDP Timeout UDP Session—100
IP Reputation—Disabled
Stateless—Disabled
Geo IP block list—None
Geo IP Allowlist—None

LB_PROF_HTTP Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—Blank
IP Reputation—Disabled
HTTP Mode—Keep Alive
Compression—None.
Decompression—None
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—http://
HTTP Send Timeout—5
HTTP2—None

LB_PROF_HTTP_SERVERCLOSE Client Timeout—50

FortiADC 7.2.0 Handbook
Fortinet Inc.

97



Chapter 4: Server Load Balancing

Profile Defaults

Server Timeout—50

Connect Timeout—5

Queue Timeout—5

HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Buffer Pool—Enabled

Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled

HTTP Mode—Server Close
Customized SSL Ciphers Flag—Disabled
Compression—None
Decompression—None
Caching—None

Geo IP Block List—None

Geo IP Allowlist—None

Geo IP Redirect URL—http://
HTTP Send Timeout—0
HTTP2—None

LB_PROF_TURBOHTTP Timeout TCP Session—100
Timeout TCP Session after FIN—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_FTP Timeout TCP Session—100
Timeout TCP Session after FIN—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None
Client Address—Off
Security Mode—None

LB_PROF_RADIUS Client Address—Off
Source Port—Off
Dynamic Auth—Disable
RADIUS Session—300
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_SIP SIP Max Size—65535
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Server Keepalive Timeout—30
Server Keepalive—Enabled
Client Keepalive—Disabled
Client Protocol—UDP
Server Protocol—None
Failed Client Type—Drop
Failed Server Type—Drop
Insert Client IP—Disabled
Geo IP Block List—None
Geo IP Allowlist—None
Client Address—Off

Media Address—0.0.0.0

LB_PROF_RDP Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
Source Address—Disabled
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_IP IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None
Timeout IP Session—100

LB_PROF_DNS Client Address—Off
DNS Cache Flag—Enabled
DNS Cache Ageout Time—3600
DNS Cache Size—10
DNS Cache Entry Size—512
DNS Cache Response Type—All Records
DNS Malform Query Action—Drop
DNA Max Query Length—512
DNS Authentication Flag—Disabled

LB_PROF_TCPS Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
Client Address—Disabled
IP Reputation—Disabled
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Geo IP block list—None

LB_PROF_HTTPS Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled
HTTP Mode—Keep Alive
SSL Proxy Mode—Disabled
Compression—None
Decompression—None
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—nhttp://
HTTP Send Timeout—0
HTTP2—None

LB_PROF_HTTPS_SERVERCLOSE Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled
HTTP Mode—Server Close
Compression—None
Decompression—None
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—nhttp://
HTTP Send Timeout—0
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HTTP2—None

LB_PROF_SMTP Starttls Active Mode—require
Forbidden Command—expn, turn, vrfy
Local Certificate Group—LOCAL_CERT_GROUP
Client Address—Disable
Forbidden Command Status—Enable
Domain Name—default.com
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_RTSP Max Header Size—Default is 4096. Valid values range from 2048 to
65536.

Client Address—Disabled by default. When enabled, FortiADC will
use the client address to connect to the server pool.

LB _PROF_RTMP Client Address—Disabled by default. When enabled, FortiADC will
use the client address to connect to the server pool.

LB_PROF_HTTP2_H2 Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Send Timeout—0
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
IP Reputation—Disabled
HTTP Mode—Keep Alive
Compression—None
Decompression—None
HTTP2—LB_HTTP2_PROFILE_DEFAULT
Caching—None
Geo IP Block List—None
Geo IP Allow list—None
Geo IP Redirect URL—nhttp://
Tune Buffer Size—17418
Max HTTP Headers—200
Response Half Closed Connection—Disabled

LB_PROF_HTTP2_H2C Client Timeout—50
Server Timeout—50
Connect Timeout—5
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Queue Timeout—5

HTTP Send Timeout—0

HTTP Request Timeout—50

HTTP Keepalive Timeout—50

Client Address—Disabled
X-Forwarded-For—Disabled

IP Reputation—Disabled

HTTP Mode—Keep Alive
Compression—None
Decompression—None
HTTP2—LB_HTTP2_PROFILE_DEFAULT
Caching—None

Geo IP Block List—None

Geo IP Allowlist—None

Geo IP Redirect URL—http://

Tune Buffer Size—17418

Max HTTP Headers—200

Response Half Closed Connection--Disabled

LB_PROF_IS0O8583 Timeout TCP Session—100
Message Encode Type—ASCII
Length Indicator Type—binary
Length Indicator Shift—0
Length Indicator Size—2
Optional Header Length—2
Optional Trailer Hex—None
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_EXPLICIT_HTTP Client Timeout—50
Server Timeout—50
Connect Timeout—50
Queue Timeout—50
HTTP Send Timeout—0
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled
HTTP Mode—Keep Alive
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Decompression—None

Geo IP Block List—None

Geo IP Allowlist—None

Geo IP Redirect URL—http://

Tune Buffer Size—8030

Max HTTP Headers—100

Response Half Closed Connection—Disabled

LB_PROF_L7_TCP Timeout TCP Session—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_L7 _UDP Timeout UDP Session—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

Before you begin:

« You must have already created configuration objects for certificates, caching, and compression if you want the
profile to use them.

» You must have Read-Write permission for Load Balance settings.

To configure custom profiles:

-—

Go to Server Load Balance > Application Resources. Click the Application Profile tab.
Click Create New to display the configuration editor.

Give the profile a name, select a protocol type; then complete the configuration as described in Profile configuration
guidelines on page 103.

4. Save the configuration.

Ladii

Ny You can clone a predefined configuration object to help you get started with a user-defined

- 9.—- configuration.
— To clone a configuration object, click the clone icon £l that appears in the tools column on
the configuration summary page.

Profile configuration guidelines

Profile Configuration Guidelines

TCP
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Profile Configuration Guidelines

Timeout TCP Session
Timeout TCP Session after
FIN

IP Reputation

Geo IP Block List
Geo IP Allowlist
IP

IP Reputation

Geo IP Block List
Geo IP Allowlist

Timeout IP Session

DNS
Client Address

DNS Cache Flag
DNS Cache Ageout Time

DNS Cache Size

DNS Cache Entry Size

DNS Cache Response Type

DNS Malform Query Action

DNS Max Query Length

DNS Authentication Flag
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Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The default is 100 seconds. The valid range is 1 to 86,400.

Client-side connection timeout. The default is 100 seconds. The valid range is 1 to
86,400.

Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.

Enable to apply FortiGuard IP reputation service. IP reputation. See Managing IP
Reputation policy settings.

Select a Geo IP block list configuration object. See Using the Geo IP block list.
Select an allowlist configuration object. See Using the Geo IP allowlist.

Client-side session timeout. The default is 100 seconds. The valid range is 1 to
86,400.

Enable/disable to use the original client IP address as the source address when
connecting to the real server.

Enable/disable the cache for the DNS virtual server.

Specify the cache age-out time (in seconds). The default is 3,600. The valid range is
0to 65,535.

Specify the maximum cache size (in Megabytes). The default is 10. The valid range
is 1to 100.

Specify the maximum cache entry size. The default is 512. The valid range is 256 to
4,096.

Select either of the following cache response types:
* AllRecord

¢ Round Robin

Select either of the following reactions for the malformed requests:
e Drop
* Forward

Specify the maximum query length. The defaultis 512. The valid range is 256 to
4,096.

Enable/disable to authenticate client by redirecting UDP query to TCP.
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Special Note

UDP
Stateless

Timeout UDP Session

IP Reputation

Geo IP Block List
Geo IP Allowlist
HTTP

Client Timeout

Server Timeout

Connect Timeout

Queue Timeout

HTTP Send Timeout

HTTP Request Timeout
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With the 4.8.1 release. FortiADC supports DNS zone transfer, i.e., DNS traffic over
TCP from servers and server-oriented requests from inside the server cluster.

Enable to apply UDP stateless function.

Client-side session timeout. The default is 100 seconds. The valid range is 1 to
86,400.

Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.

This timeout is counted as the amount of time when the client did not send a
complete request HTTP header to the FortiADC after the client connected to the
FortiADC. If this timeout expires, FortiADC will send a 408 message to client and
close the connection to the client.

This timeout is counted as the amount of time when the server did not send a
complete response HTTP header to the FortiADC after the FortiADC sent a request
to server. If this timeout expires, FortiADC will close the server side connection and
send a 503 message to the client and close the connection to the client.

This timeout is counted as the amount of time during which FortiADC tried to connect
to the server with TCP SYN. After this timeout, if TCP connection is not established,
FortiADC will drop this current connection to server and respond with a 503 message
to client side and close the connection to the client.

This timeout is counted as the amount of time during which the request is queued in
the dispatched queue. When the request cannot be dispatched to a server by a load
balance method (for example, the server's connection limited is reached), it will be
put into a queue. If this timeout expires, the request in the queue will be dropped and
FortiADC will respond with a 503 message to client side and close the connection to
the client.

This timeout is counted as the amount of time it took FortiADC to send a response
body data (not including the header); the time is counted starting from when the body
is transferred. If this timeout expires, FortiADC will close the connection of both side.

This timeout is counted as the amount of time the client did not send a complete
request (including both HTTP header and request body) to FortiADC after the client
connected to FortiADC. If this timeout expires, FortiADC will send a 408 message to
client and close the connection to the client.
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HTTP Keepalive Timeout

Client Address

X-Forwarded-For

X-Forwarded-For Header

IP Reputation

IP Reputation Redirect URL

HTTP Mode

Compression
Caching

Geo IP Block List
Geo IP Allowlist

Geo IP Redirect URL

Tune Buffer Size

FortiADC 7.2.0 Handbook
Fortinet Inc.

Profile Configuration Guidelines

This timeout is counted as the time FortiADC can wait for a new request after the
previous transaction is completed. This is an idle timeout if the client does not send
anything in this period. If this timeout expires, FortiADC will close the connection to
the client.

Use the original client IP address as the source address when connecting to the real
server.

Append the client IP address found in IP layer packets to the HTTP header that you
have specified in the X-Forwarded-For Header setting. If there is no existing X-
Forwarded-For header, the system creates it.

If you only enable http-x-forwarded-for and do not configure http-x-forwarded-for-
header, the default is to add such a header: X-Forwarded-For: <client's ip>

Specify the HTTP header to which to write the client IP address. Typically, this is the
X-Forwarded-For header, but it is customizable because you might support traffic
that uses different headers for this. Examples: Forwarded-For, Real-IP, or True-IP.
If http-x-forwarded-for-header <string> is configured, the added header is: <string>:
<client's ip>,

Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Type a URL including the FQDN/IP and path, if any, to which a client will be
redirected if the request violates the IP reputation policy.

» Server Close—Close the connection to the real server after each HTTP
transaction.

¢ Once Only— An HTTP transaction can consist of multiple HTTP requests
(separate requests for an HTML page and the images contained therein, for
example). To improve performance, the "once only" flag instructs the FortiADC
to evaluate only the first set of headers in a connection. Subsequent requests
belonging to the connection are not load balanced, but sent to the same server
as the first request.

¢ Keep Alive—Do not close the connection to the real server after each HTTP
transaction. Instead, keep the connection between FortiADC and the real server
open until the client-side connection is closed. This option is required for
applications like Microsoft SharePoint.

Select a compression configuration object. See Configuring compression rules.
Select a caching configuration object. See Using caching features.

Select a Geo IP block list configuration object. See Using the Geo IP block list.
Select an allowlist configuration object. See Using the Geo IP allowlist.

For HTTP, if you have configured a Geo IP redirect action, specify a redirect URL.

Adjust the value of the HTTP/HTTPS VS's connection buffer size.
e For every session, there are two connection buffers.
» The default size is 8030, it is not recommended that you edit it. It's hidden in the
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Max HTTP Headers

FTP

Timeout TCP Session

Timeout TCP Session after
FIN

Client Address

IP Reputation

Geo IP Block List
Geo IP Allowlist

Security Mode

RADIUS
Client Address

Source Port

Timeout RADIUS Session
Dynamic Auth

Dynamic Auth Port

Geo IP Block List

Geo IP Allowlist

RDP
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Advance tab, and when you edit it you will get a warning message.
¢ Tuning this option is dangerous because it may lead to concurrent session
number reduction or other unpredictable problems.

Adjust the max header number that HTTP/HTTPS VS can process for every request
or response. If a request or response has a header over this limit, it will be dropped,
and return error message 400.
e The default value is 100, it's not recommended that you edit it. It is hidden in the
Advance tab, and when you edit it you will get a warning message.
¢ Tuning this option is dangerous and may lead to concurrent session number
reduction or other unpredictable problems.

Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The defaultis 100 seconds. The valid range is 1 to 86,400.

Client-side connection timeout. The default is 100 seconds. The valid range is 1 to
86,400.

Use the original client IP address as the source address when connecting to the real
server.

Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Select a Geo IP block list configuration object. See Using the Geo IP block list.
Select an allowlist configuration object. See Using the Geo IP allowlist.

Select either of the following:
* None

* Explicit
e Implicit

Use the original client IP address as the source address when connecting to the real
server.

Use the original client port as the source port when connecting to the real server.
The default is 300 seconds. The valid range is 1 to 3,600.

Enable or disable Dynamic Authorization for RADIUS Change of Authorization(CoA)
Configures the UDP port for CoA requests. The defaultis 3799.

Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.
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Client Timeout

Server Timeout

Connect Timeout

Queue Timeout

Client Address

IP Reputation

Geo IP Block List
Geo IP Allowlist
TCPS

Client Timeout

Server Timeout

Connect Timeout

Queue Timeout

Client Address

IP Reputation

Geo IP Block List
Geo IP Allowlist
HTTPS

HTTPS

HTTP TURBO
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Client-side TCP connection timeout. The default is 50 seconds. The valid range is 1
to 3,600.

Server-side IP session timeout. The default is 50 seconds. The valid range is 1 to
3,600.

Multiplexed server-side TCP connection timeout. Usually less than the client-side
timeout. The default is 5 seconds. The valid range is 1 to 3,600.

Specifies how long connection requests to a backend server remain in a queue if the
server has reached its maximum number of connections. If the timeout period
expires before the client can connect, FortiADC drops the connection and sends a
503 error to the client. The default is 5 seconds. The valid range is 1 to 3,600.

Use the original client IP address as the source address in the connection to the real
server.

Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.

Client-side TCP connection timeout. The default is 50 seconds. The valid range is 1
to 3,600.

Server-side IP session timeout. The default is 50 seconds. The valid range is 1 to
3,600.

Multiplexed server-side TCP connection timeout. Usually less than the client-side
timeout. The default is 5 seconds. The valid range is 1 to 3,600.

Specifies how long connection requests to a backend server remain in a queue if the
server has reached its maximum number of connections. If the timeout period
expires before the client can connect, the system drops the connection and sends a
503 error to the client. The defaultis 5 seconds. The valid range is 1 to 3,600.

Use the original client IP address as the source address in the connection to the real
server.

Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.

Same as HTTP.
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Timeout TCP Session
Timeout TCP Session after
FIN

IP Reputation

Geo IP Block List

Geo IP Allowlist

SIP

SIP Max Size

Server Keepalive Timeout

Server Keepalive

Client Keepalive

Client Protocol

Server Protocol

Failed Client Type

Failed Server Type

Insert Client IP

Client Address

Media Address

Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The defaultis 100 seconds. The valid range is 1 to 86,400.

Client-side connection timeout. The default is 100 seconds. The valid range is from 1
to 86,400.

Enable to apply the FortiGuard IP reputation service.
Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.

Maximum message size. The default is 65535 bytes. The valid range is from 1 to
65,535.

Maximum wait for a new server-side request to appear. The default is 30 seconds.
The valid range is 5-300.

Enable/disable a keepalive period for new server-side requests. Supports CRLF
ping-pong for TCP connections. Enabled by default.

Enable/disable a keepalive period for new client-side requests. Supports CRLF ping-
pong for TCP connections. Disabled by default.

Client-side transport protocol:
e TCP
» UDP (default)

Server-side transport protocol.
e TCP
« UDP
Default is "unset", so the client-side protocol determines the server-side protocol.

Action when the SIP client cannot be reached:
e Drop—Drop the connection.
e Send—Drop the connection and send a message, for example, a status code
and error message.

Action when the SIP server cannot be reached:
¢ Drop—Drop the connection.
e Send—Drop the connection and send a message, for example, a status code
and error message.

Enable/disable option to insert the client source IP address into the X-Forwarded-For
header of the SIP request.

Use the original client IP address as the source address in the connection to the real
server.

Change the media address of SIP payload to specified address. 0.0.0.0 is default.

Client-Request-Header-Insert (maximum 4 members)

FortiADC 7.2.0 Handbook
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Type  Insert If Not Exist—Insert before the first header only if the header is not already
present.
 Insert Always—Insert before the first header even if the header is already
present.

» Append If Not Exist—Append only if the header is not present.
* Append Always—Append after the last header.

HeaderName:Value The header:value pair to be inserted.
Client-Request-Header-Erase (maximum 4 members)

Type e All—Parse all headers for a match.
* First—Parse the first header for a match.

HeaderName Header to be erased.

Client-Response-Header-Insert (maximum 4 members)

Type « Insert If Not Exist—Insert before the first header only if the header is not already
present.
 Insert Always—Insert before the first header even if the header is already
present.

» Append If Not Exist—Append only if the header is not present.
» Append Always—Append after the last header.

HeaderName:Value The header:value pair to be inserted.
Client-Response-Header-Erase (maximum 4 members)

Type e All—Parse all headers for a match.
» First—Parse the first header for a match.

HeaderName Header to be erased.

Server-Request-Header-Insert (maximum 4 members)

Type « Insert If Not Exist—Insert before the first header only if the header is not already
present.
* Insert Always—Insert before the first header even if the header is already
present.

e Append If Not Exist—Append only if the header is not present.
» Append Always—Append after the last header.

HeaderName:Value The header:value pair to be inserted.
Server-Request-Header-Erase (maximum 4 members)

Type ¢ All—Parse all headers for a match.
» First—Parse the first header for a match.

HeaderName Header to be erased.

Server-Response-Header-Insert (maximum 4 members)
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 Insert If Not Exist—Insert before the first header only if the header is not already
present.

 Insert Always—Insert before the first header even if the header is already
present.

» Append If Not Exist—Append only if the header is not present.

* Append Always—Append after the last header.

The header:value pair to be inserted.

Server-Response-Header-Erase (maximum 4 members)

Type

HeaderName
SMTP
Client Address

Starttls Active Mode

Forbidden Command Status

Forbidden Command

Geo IP Block List
Geo IP Allowlist
Domain Name
RTSP

Client Address

Max Header Size

RTMP
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» All—Parse all headers for a match.
* First—Parse the first header for a match.

Header to be erased.

Use the original client IP address as the source address in the connection to the real
server.

Note: When using the NAT Source Pool for SMTP VS, ensure the SMTP application
profile is disabled for Client Address. When the SMTP is enabled for Client Address,
it will use the original client IP address as the source address when connecting to the
real server, which cannot be done when the NAT source pool is used at the same
time.

Select one of the following:
¢ Allow—The client can either use or not use the STARTTLS command.
* Require—The STARTTLS command must be used to encrypt the connection
first.
¢ None—The STARTTLS command is NOT supported.

Enable/disable to forbid the command(s) selected in Forbidden Command.

Select any, all, or none of the commands (i.e., expn, turn, vrfy).

If selected, the command or commands will be rejected by FortiADC; otherwise, the
command or commands will be accepted and forwarded to the back end.

Select a Geo IP block list configuration object. See Using the Geo IP block list.
Select an allowlist configuration object. See Using the Geo IP allowlist.

Specify the domain name.

Use the original client IP address as the source address in the connection to the real
server.

Specify the maximum size of the RTSP header.
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Client Address

MySQL

MySQL Mode

Diameter

Origin Host

Origin Realm

Vendor ID

Product Name

Idle Timeout

Server Close Propagation

Client SSL

1ISO8583

Timeout TCP Session

Message Encode Type
Length Indicator Type
Length Indicator Shift
Length Indicator Size

Optional Header Length

Optional Trailer Hex
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Use the original client IP address as the source address in the connection to the real
server.

Note: The system does not provide default MyQSL profiles as it does with the other
protocols.

Select either of the following MySQL modes:
¢ Single Primary — The profile will use the single-primary mode. You will then
need to specify and configure the primary server and secondary servers.

» Sharding — The profile will use the sharding mode to load-balance MySQL
traffic.

FortiADC comes with a default load-balancing profile titled "LB_PROF_DIAMETER".
Ifitis selected, FortiADC will not change Diameter packets except the host
IP address AVP, which means that FortiADC functions as a relay agent.

Leave blank. If defined, FortiADC will change the Origin-Host AVP of the Diameter
packet.

Leave blank. If defined, FortiADC will change the Origin-Realm AVP of the Diameter
packet.

Leave blank. If defined, FortiADC will change the Vendor-ID AVP of the Diameter
packet.

Leave blank. If defined, FortiADC will change the Product-Name AVP of the
Diameter packet.

300 (seconds) by default. Valid values range from 1 to 86,400.

OFF by default, which means that the connection on the client side stays open when
the server closes the connection on its side.

Select a client SSL profile configuration. See Configuring client SSL profiles on page
126.

Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The default is 100 seconds. The valid range is 1 to 86,400
seconds.

Specify the encode type for protocol message, default ASCII.

Specify the encode type of length indicator, default binary.

Specify bytes to shift from the beginning of payload to read length value, range 0-32.
Specify total bytes reading to calculate length, range 0-8.

Specify length of optional header before MT], including the length-indicator, range 0-
32.

Specify hex string of optional trailer, maximum length 16, i.e. 8 bytes in binary
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Client Timeout

Server Age
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Geo IP Block List
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EXPLICIT_HTTP

Client Timeout

Server Timeout

Connect Timeout

Queue Timeout

HTTP Send Timeout

HTTP Request Timeout
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Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.

This timeout is counted as the amount of time when the client did not send a
complete request HTTP header to the FortiADC after the client connected to the
FortiADC. If this timeout expires, FortiADC will send a 408 message to client and
close the connection to the client. The default is 50 seconds. The valid range is 1 to
86,400 seconds.

Specify the maximum inactivity time for MS SQL server on the server side.

Specify the maximum connections that can connect to the MS SQL server on the
server side.

Select a Geo IP block list configuration object. See Using the Geo IP block list.

Select an allowlist configuration object. See Using the Geo IP allowlist.

This timeout is counted as the amount of time when the client did not send a
complete request HTTP header to the FortiADC after the client connected to the
FortiADC. If this timeout expires, FortiADC will send a 408 message to client and
close the connection to the client.

This timeout is counted as the amount of time when the server did not send a
complete response HTTP header to the FortiADC after the FortiADC sent a request
to server. If this timeout expires, FortiADC will close the server side connection and
send a 503 message to the client and close the connection to the client.

This timeout is counted as the amount of time during which FortiADC tried to connect
to the server with TCP SYN. After this timeout, if TCP connection is not established,
FortiADC will drop this current connection to server and respond with a 503 message
to client side and close the connection to the client.

This timeout is counted as the amount of time during which the request is queued in
the dispatched queue. When the request cannot be dispatched to a server by a load
balance method (for example, the server's connection limited is reached), it will be
put into a queue. If this timeout expires, the request in the queue will be dropped and
FortiADC will respond with a 503 message to client side and close the connection to
the client.

This timeout is counted as the amount of time it took FortiADC to send a response
body data (not including the header); the time is counted starting from when the body
is transferred. If this timeout expires, FortiADC will close the connection of both side.

This timeout is counted as the amount of time the client did not send a complete
request (including both HTTP header and request body) to FortiADC after the client
connected to FortiADC. If this timeout expires, FortiADC will send a 408 message to
client and close the connection to the client.
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HTTP Keepalive Timeout

Client Address

X-Forwarded-For

X-Forwarded-For Header

IP Reputation

IP Reputation Redirect URL

Decompression
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Geo IP Allowlist

Geo IP Redirect URL

Tune Buffer Size

Max HTTP Headers

Response Half Closed
Connection

L7 TCP
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This timeout is counted as the time FortiADC can wait for a new request after the
previous transaction is completed. This is an idle timeout if the client does not send
anything in this period. If this timeout expires, FortiADC will close the connection to
the client.

Use the original client IP address as the source address when connecting to the real
server.

Enable this option to append the client IP address found in IP layer packets to the
HTTP header, for example, Xx-forwarded-for: 192.168.161.100.

The default header name is Xx-forwarded-for. If you prefer a different name, use
X-Forwarded-For Header to define a custom name.

Specify a custom name for the HTTP header which carries the client IP address. Do
not include the 'X-' prefix. Examples: Forwarded-For, Real-IP, or True-IP.

Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Type a URL including the FQDN/IP and path, if any, to which a client will be
redirected if the request violates the IP reputation policy.

Select a compression configuration object. See Configuring compression rules.
Select a Geo IP block list configuration object. See Using the Geo IP block list.
Select an allowlist configuration object. See Using the Geo IP allowlist.

For HTTP, if you have configured a Geo IP redirect action, specify a redirect URL.

Adjust the value of the HTTP/HTTPS VS's connection buffer size.
e For every session, there are two connection buffers.
» The default size is 8030, it is not recommended that you edit it. It's hidden in the
Advance tab, and when you edit it you will get a warning message.
¢ Tuning this option is dangerous because it may lead to concurrent session
number reduction or other unpredictable problems.

Adjust the max header number that HTTP/HTTPS VS can process for every request
or response. If a request or response has a header over this limit, it will be dropped,
and error message 400 will be returned.
e The default value is 100, it's not recommended that you edit it. It is hidden in the
Advance tab, and when you edit it you will get a warning message.
¢ Tuning this option is dangerous and may lead to concurrent session number
reduction or other unpredictable problems.

Continue to response to the half-closed connections.

Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The defaultis 100 seconds. The valid range is 1 to 86,400.
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IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

L7 UDP

Timeout UDP Session Client-side session timeout. The default is 100 seconds. The valid range is 1 to
86,400 seconds.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

WebSocket load-balancing

The WebSocket protocol provides full duplex communication between client and server over a single TCP connection.
The initial handshake occurs over the HTTP protocol, while subsequent WebSocket message frames layer over the TCP
protocol, as illustrated in WebSocket load-balancing on page 115.

WebSocket load-balancing

Client Server
GET.-"H'I'I'P..-’EL_.l — 5 HITP/1.1101 Switching Protocols
Upgrade: Websocket = = Upgrade : Websocket
Connection: Upgrade o HTTP Request L om Connection: Upgrade
Host: www.example.com I R

5 3
o HTTP Response o
(3] - (3]
= =
% ol
m 3
WebSocket Message Frame -
Data Data

WebSocket Message Frame

&

1E 26 C6 87 G2 5G97 AD 92 EB

You can configure FortiADC in such as way that it is able to load-balance Layer-7 virtual servers with HTTP or
HTTPS profiles to the WebSocket protocol without any change to the default configuration. During the setup phase, the
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virtual server works in HTTP mode, processing Layer-7 information. It automatically detects the connection and upgrade
exchange, and is able to switch to tunnel mode when the upgrade negotiation succeeds. When the WebSocket is
established, and the virtual server fails over to tunnel mode in which no data is analyzed anymore (and anyway,
WebSocket does not communicate in HTTP). See WebSocket with FortiADC on page 116.

WebSocket with FortiADC

Client Server
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If you want to configure your FortiADC appliance to perform HTTP inspection and WebSocket traffic load-balancing, you
must use a Layer-7 virtual server with an HTTP profile. If WebSocket traffic is over the transport layer security protocol,
you must use a Layer-7 virtual server with an HTTPS profile and choose an appropriate server SSL profile in the real-
server pool.

If you only want WebSocket load-balancing, use a Layer-4 or Layer-7 virtual server with a TCP profile.

For more information, see https://en.wikipedia.org/wiki/WebSocket and http://tools.ietf.org/html/rfc6455.

Configuring MSSQL profiles

FortiADC (6.0.0 and later) supports MSSQL server load-balancing.

MSSQL application profiles are user-specific and must be configured only by the user on a case-by-case basis. For this
reason, FortiADC does not provide any default predefined MSSQL application profiles that you can use out of the box.
You must configure your own MSSQL load-balancing application profiles to take advantage of this feature.

Single-primary mode

The single-primary mode is a database server configuration in which a single primary MSSQL server is responsible for
all write operations (i.e., create, update, or delete requests), and one or more secondary servers handle all read-only
operations. The secondary server replicates data to the secondary servers in a close to real-time fashion. This mode can
improve database performance to a certain extent by offloading read-intensive operations to secondary servers. It is
ideal for load-balancing database traffic that involves more read operations.
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By default, FortiADC passes all write requests to the primary server and all read requests (such as select) to the
secondary servers. Once you have created a MSSQL server load-balancing profile, FortiADC will automatically apply
this default mode when load-balancing MSSQL traffic on the network.

Creating a MSSQL profile

Creating a MSSQL profile involves the following steps:
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1. Create a MSSQL configuration object.
2. Specify the existing user name and password of the MSSQL database to be used by the MSSQL profile
configuration object.

Note: You can create MSSQL profiles from either the GUI or the CLI. The following paragraphs discuss how to configure
a MSSQL profile using the GUL. For instructions on how to create MSSQL profiles from the CLI, refer to the CLI
Reference.

Before you begin:

» You must have already created MSSQL database objects to be used the MSSQL profile.
» You must have read-write permission for load-balance settings.

Creating a MSSQL configuration object

Go to Server Load Balance > Application Resources.

Select the Application Profile tab if it is not already selected.

Click Create New to open the Application Profile configuration editor.

In the Name field, enter a unique profile name.

In the Type field, click the down arrow and select MSSQL from the drop-down menu.

Click Save. Your newly created MSSQL profile configuration object is automatically appended to the bottom of the
Server Load Balancing > Application Resources > Application Profile page.

7. Click the newly created MSSQL profile to open it to see the MSSQL application profile configuration.

ok wDd-=

Application Profile

Name mssgl

Type MSESQL -
Specifics
Client Timeout
Default; 50 Range: 1-3600 seconds
600
Server Age
Default: 600 Range: 1-86400 seconds
10000
Server Max Size
Default: 10000 Range: 1-30000.
MSSGL Account
il Delete @ Add Filter x
D * | UserName -

1 userl ra B

Showing 1to 1 of 1 evtries Show 25 entries Previcus 1 Neset

Cancel

Specifying the MSSQL user account

Once a MSSQL profile is created, you must specify a MSSQL user account to be used with the profile by entering the
user name and password of that account.

Note that you are asked to provide the user name and password of an existing MSSQL account, so do not try to create a
new user account here.

To specify a MSSQL user account:

1. Inthe MSSQL User Password pane, click Create New. The Edit MSSQL User Password dialog opens.
2. Enterthe user name and password of the MSSQL database account,
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3. Click Save.

Parameter Description

Application Profile

Name A unique name for the MSSQL profile you are creating.

Type MSSQL

MSSQL Account

User Name The user name of the MSSQL database.

Password The password for the MSSQL user name you've entered above.
Specifics

Client Timeout Client connection timeout

Server Age Server connection timeout

Server Max Size The maximum size of server connection

Configuring MySQL profiles

FortiADC (Version 4.7.0 and later) supports MySQL server load-balancing.

MySQL application profiles are user-specific and must be configured only by the user on a case by case basis. For this
reason, FortiADC does not provide any default predefined MySQL application profiles that you can use out of the box. So
you must configure your own MySQL load-balancing application profiles to take advantage of this feature.

FortiADC supports two MySQL database load-balancing modes: single primary and data sharding.

Single-primary mode

The single-primary mode is a database server configuration in which a single primary MySQL server is responsible for all
write operations (i.e., create, update, or delete requests), and one or more secondary servers handle all read-only
operations. The primary server replicates data to the secondary servers in a close to real-time fashion. This mode can
improve database performance to a certain extent by offloading read-intensive operations to secondary servers. It is
ideal for load-balancing database traffic that involves more read operations.

Single-primary mode on page 119 illustrates the network topology of database server load-balancing in single-primary
mode.

Single-primary mode
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By default, FortiADC passes all write requests to the primary server and all read requests (such as select) to the
secondary servers. So once you have created a MySQL server load-balancing profile, FortiADC will automatically apply
this default mode when load-balancing MySQL traffic on the network. However, if you do not like the default behavior,
you can change it by setting up your own MySQL server load-balancing rules when configuring your MySQL application
profile. For more information, see Configuring MySQL rules on page 124.
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Sharding mode

Database sharding is a "shared-nothing" database partitioning technique that breaks down a large database involving a
number of database servers into small database chunks and spread them across a number of distributed servers. It's a
highly scalable approach to improving the throughput and performance of large enterprise business applications that are
transaction-extensive and database-centric because it provides scalability across independent servers, each having its
own CPU, memory, and disks.

Sharding mode on page 121 illustrates MySQL server load-balancing in data-sharding mode.

Sharding mode
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Client

In sharding mode, FortiADC stores global data on the primary Global—it sends all requests that do not belong to any
group to global servers. Using the keys that you have specified, it sends part of the requests to Group) and some to
Group 1. It supports split read/write in every group.

It must be noted that Data Manipulation Language (DDL) is not supported in sharding mode.
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Creating a MySQL profile

Creating a MySQL profile involves the following steps:

1.
2,

3.

Create a MySQL configuration object.

Specify the existing user name and password of the MySQL database to be used by the MySQL profile
configuration object.

Configure MySQL Rule (for single-primary mode, optional) or MySQL Sharding (for database sharding mode).

Note: You can create MySQL profiles from either the GUI or the CLI. The following paragraphs discuss how to configure
a MySAQL profile using the GUI. For instructions on how to create MySQL profiles from the CLI, refer to the
CLI Reference.

Before you begin:

e You must have already created MySQL database objects to be used the MySQL profile.
» You must have read-write permission for load-balance settings.

Creating a MySQL configuration object

2B

8.

Go to Server Load Balance > Application Resources.

Select the Application Profile tab if it is not already selected.

Click Create New to open the Application Profile configuration editor.

In the Name field, enter a unique profile name.

In the Type field, click the down arrow and select MySQL from the drop-down menu.

For MySQL Mode, select Single primary or Sharding. Refer to MySQL profile configuration guidelines on page
125.

Click Save. Your newly created MySQL profile configuration object is automatically appended to the bottom of the
Server Load Balancing > Application Resources > Application Profile page.

Click the newly created MySQL profile to open it. See MySQL application profile configuration on page 123.

MySQL application profile configuration

Application Profile

Name mysgl

Type MySQL -

Specifics
MySQLMode [T

MySGL Accourt

i Delete © Add Filter x
D “ | Username -3
1 admin £ m A
Showing 1to 1 of 1 entries Show 25 entries Proions 1 ‘ Next
MySQL Rule
1l Delete € Add Filter *

D ~ | Type Database List User List Table List -]

Mo data available in table

Showing 0to0 of 0 entries Show 25 entries Previous Next

Cancel
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Note: The image above shows a sample MySQL profile configuration object named "1". Once a MySQL profile is
created, you need to specify the MySQL database user account, and create MySQL Rule or Sharding depending on
which MySQL mode you choose to use. The following paragraphs discuss the procedures for each of those tasks.

Specifying the MySQL user account

Once a MySQLL profile is created, you must specify a MySQL user account to be used with the profile by entering the
user name and password of that account.

It's important to note that you are asked to provide the user name and password of an existing MySQL account. So do
not try to create a new user account here.

To specify a MySQL user account:

1. Inthe MySQL User Password pane (see the illustration above), click Create New. The Edit MySQL User Password
dialog opens.

2. Enterthe user name and password of the MySQL database account.
3. Click Save.

Configuring MySQL rules

When configuring a MySQL rule, you first need to decide whether you want FortiADC to send requests to the primary
database server or the secondary database server(s). Then you can set a few conditions (rules) to tell FortiADC how to
send the requests . It must be noted that all the conditions are of an "OR" relationship.

To configure a MySQL rule:

1. Inthe MySQL Rule pane, click Create New. The Application Profile > Edit MySQL Rule dialog opens.
2. Make the desired entries or selections as described in MySQL profile configuration guidelines on page 125.
3. Click Save.

Configuring sharding

FortiADC supports two types of database-sharding: by range or by hash. In the former case, FortiADC distributes the
data to different groups according to the key range. In the latter case, it first hashes the keys and then automatically
distributes the data to different groups.

To configure MySQL sharding:

1. Inthe MySQL Sharding pane, click Create New. The Application Profile > Edit MySQL Sharding dialog opens.
2. Make the desired entries or selections as described in MySQL profile configuration guidelines on page 125.
3. Click Save.

Note: When configuring pool members in the CLI to match the real server pool members on the GUI, you can use the
set mysgl-group-idcommand to set the groups that match the pool members:

config load-balance pool
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edit "sharding"

set real-server-ssl-profile NONE

config pool member

edit 1

set pool member service port 3306
set pool member cookie rs

set real-server primary

next
edit 2

set pool member service port 3306
set pool member cookie rs2

set real-server primary?2

set mysgl-group-id 1

next
edit 3

set pool member service port 3306

set pool member cookie rs3

set real-server secondary
set mysgl-read-only enable

next
edit 4

set pool member service port 3306

set pool member cookie rs4

set real-server secondary?2

set mysgl-read-only enable
set mysgl-group-id 1

next
end
next
end

s

You can clone a predefined configuration object to help you get started with a user-defined
configuration.

To clone a configuration object, click the clone icon £l
the configuration summary page.

that appears in the tools column on

MySQL profile configuration guidelines

Parameter

Description

Application Profile
Name

Type

MySQL Mode

FortiADC 7.2.0 Handbook
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A unique name for the MySQL profile you are creating.
MySQL

Select either of the following:

Single primary—If selected, FortiADC will configure the MySQL profile in single-
primary mode. See Single-primary mode.
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Parameter Description

Sharding—If selected, FortiADC will configure the MySQL profile in database-
sharding mode. See Sharding mode.

MySQL User Password
User Name The user name of the MySQL database.
Password The password for the MySQL user name you've entered above.
MySQL Rule
Type Select either of the following:
» Primary—If selected, FortiADC will send all data specified in the MySQL rule to
the primary MySQL database server.
¢ Secondary—If selected, FortiADC will send all data specified in the MySQL rule
to the secondary MySQL database server.
Database List Alist of up to eight MySQL database names separated by space
User List Alist of up to eight user names separated by space
Table List A list of up to eight MySQL Database tables separated by space
Client IP List A list of up to eight FortiADC client IP addresses separated by space
SQL List Alist of up to eight MySQL statements separated by space
Sharding
Type Select either of the following:
¢ Range—If selected, FortiADC will send data in the data tables to different groups
based on the specified range of the keys.
¢ Hash—If selected, FortiADC will perform hash calculations and then
automatically send data to different groups.
Database The database name
Table The table name
Key The column name
Group List Alist of up to eight group IDs

Note: The group IDs must match the real server pool members.

Configuring client SSL profiles

A client SSL profile is used to manage the SSL session between the client and the proxy. It allows FortiADC to accept
and terminate client requests sent via the SSL protocol. The Client SSL Profile page provides the settings for configuring
client-side SSL connections, and displays all the client SSL profiles that have been configured on the system.
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Before you begin creating a client SSL profile:

« You must have already created configuration objects for certificates, certificate caching, and certificate verify if you

want to include them in the profile.

» You must have Read-Write permission for Load Balance settings.

To configure custom profiles:

Ao b=

Save the configuration.

Go to Server Load Balance > Application Resources. Click the Client SSL Profile tab.
Click Create New to display the configuration editor.
Complete the configuration as described in Client SSL profile configuration guidelines on page 127.

sy

You can clone a predefined client SSL profile to help you get started with a user-defined

- 9- configuration.
- To clone a configuration object, click the clone icon

=

the configuration summary page.

that appears in the tools column on

Client SSL profile configuration guidelines

Profile Configuration Guidelines

Name Specify a unique name for the client SSL profile.

Customized SSL Ciphers Flag Enable or disable the use of user-specified cipher suites. If enabled, you must
specify a colon-separated, ordered list of a customized SSL cipher suites. See
below.

Customized SSL Ciphers Available only when the Customized SSL Cipher Flag is enabled (see above).

Specify a colon-separated, ordered list of a customized SSL cipher suites.
Note: FortiADC will use the default SSL cipher suite if the field is left empty.

SSL Ciphers Ciphers are listed from strongest to weakest:

FortiADC 7.2.0 Handbook
Fortinet Inc.

ECDHE-ECDSA-AES256-GCM-SHA384
ECDHE-ECDSA-AES256-SHA384
ECDHE-ECDSA-CAMELLIA256-SHA384
*ECDHE-ECDSA-AES256-SHA
ECDHE-ECDSA-AES128-GCM-SHA256
*ECDHE-ECDSA-AES128-SHA256
ECDHE-ECDSA-CAMELLIA128-SHA256
*ECDHE-ECDSA-AES128-SHA
ECDHE-ECDSA-DES-CBC3-SHA
ECDHE-ECDSA-RC4-SHA
ECDHE-RSA-AES256-GCM-SHA384
ECDHE-RSA-AES256-SHA384
ECDHE-RSA-CAMELLIA256-SHA384
*ECDHE-RSA-AES256-SHA
DHE-RSA-AES256-GCM-SHA384
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TLSv1.3 Cipher Suite List

Allowed SSL Versions

FortiADC 7.2.0 Handbook
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» *DHE-RSA-AES256-SHA256

e DHE-RSA-CAMELLIA256-SHA256

e *DHE-RSA-AES256-SHA

* DHE-RSA-CAMELLIA256-SHA

» AES256-GCM-SHA384

e *AES256-SHA256

* *AES256-SHA

» ECDHE-RSA-AES128-GCM-SHA256
e *ECDHE-RSA-AES128-SHA256

e ECDHE-RSA-CAMELLIA128-SHA256
e *ECDHE-RSA-AES128-SHA

e DHE-RSA-AES128-GCM-SHA256

» *DHE-RSA-AES128-SHA256

» DHE-RSA-CAMELLIA128-SHA256

» *DHE-RSA-AES128-SHA

e AES128-GCM-SHA256

* *AES128-SHA256

e *AES128-SHA

e ECDHE-RSA-RC4-SHA

e RC4-SHA

* RC4-MD5

» ECDHE-RSA-DES-CBC3-SHA

» EDH-RSA-DES-CBC3-SHA

e DES-CBC3-SHA

* eNULL

*These ciphers are fully supported by hardware SSL (in 400F, 1200F, 2200F,
4200F and 5000F).

Note: We recommend retaining the default list. If necessary, you can deselect the
SSL ciphers that you do not want to support.

TLSv1.3 ciphers are listed as following:
* TLS_AES_256_GCM_SHA384
* TLS_AES_128_GCM_SHA256
* TLS_CHACHA20_POLY1305_SHA256
* TLS_AES_128 CCM_SHA256
e TLS_AES_ 128 CCM_8 SHA256
Note: This option only available if the TLSv1.3 is checked.

You have the following options:
» SSLv3
e TLSv1.0
e TLSv1A1
e TLSv1.2
e TLSv1.3
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Client Certificate Verify

Client Certificate Verify Mode

SSL Session Cache Flag

Use TLS Tickets

Client Certificate Forward

Client Certificate Forward
Header

Forward Proxy

Client SNI Required

Local Certificate Group

Reject OCSP Stapling with
Missing Nextupdate
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Profile Configuration Guidelines

We recommend retaining the default list. If necessary, you can deselect SSL
versions you do not want to support.
Note:
« FortiADC does not support session reuse for SSLv2 at the client side.
Instead, a new SSL session is started. Please make sure that the
SSL versions are continuous. IF not, an error message should be returned.
e RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply
is enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an
error message will display.

Select the client certificate verify configuration object.

Note: For VS configurations that reference a ZTNA Profile, ensure the
corresponding EMS CA certificate is selected for the corresponding Client SSL
profile.

This option is available only when the Client Certificate Verify is selected.
Select one of the following:

¢ Required (default)

¢ Optional
Allows to the same SSL client attempts to reconnect to this SSL server and
requests a resumption of a previous SSL session.
Note: This feature doesn’t support TLSv1.3

Allows resuming TLS sessions by storing key material encrypted on the clients.
Note: This feature doesn’t support TLSv1.3

Disabled by default. When enabled, you must specify the client certificate forward
header. See below.

When Client Certificate Forward is enabled (see above), specify the client
certificate forward header.

By default, (SSL) Forward Proxy is disabled. When enabled, you'll have to
configure additional settings noted below.

Note: RFC 7919 Comply is not supported for Forward Proxy. If RFC 7919 Comply
is enabled and Forward Proxy is enabled, the RFC 7919 Comply feature will not
apply to Forward Proxy functionality.

Require clients to use the TLS server name indication (SNI) extension to include
the server hostname in the TLS client hello message. Then, the FortiADC system
can select the appropriate local server certificate to present to the client.

Select a local certificate group that includes the certificates this virtual server
presents to SSL/TLS clients. This should be the backend servers' certificate, NOT
the appliance's GUI web server certificate. See Manage certificates.

This flag is meaningful only when you have configured OCSP stapling in Local
Certificate Group.
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Renegotiation

Renegotiation Interval

SSL DH Parameter Size

SSL Renegotiate Period

SSL Renegotiate Size

Secure Renegotiation

RFC 7919 Comply
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By default, this option is disabled (unselected). In that case, FortiADC accepts all
OCSP responses, including those in which the next update field is not set. If
enabled, and the next update field is not set in an OCSP stapling response,
FortiADC will not load this OCSP stapling response or present it to clients during
the SSL/TLS handshake.

Enable or disable SSL renegotiation from the client side.
Note:

e The feature is disabled by default.

* When enabled, you must configure the options below.

Specify the minimum interval between two successive client-initiated
SSL renegotiation requests. The unit of measurement can be second, minute, or
hour, e.g., 100s, 20m, or 1h.
Note:
¢ The defaultis -1, which disables the function.
¢ 0 means ‘Indefinite’.
» FortiADC will terminate the connection once the threshold is exceeded.

Specify the pubkey length in Diffie Hellman. Default is 1024.

Note: The SSL DH Parameter Size option is not available when RFC 7919
Comply is enabled.

Specify the period in second (default), minute, or hour at which FortiADC will
initiate SSL renegotiation.

Note: The default is 0, which disables the function.

Specify the amount (MB) of application data that must have been transmitted over
the SSL connection whenFortiADC initiates SSL renegotiation.

Note: The default is 0, which disables the function.

Select one of the following:

* Request—FortiADC requests secure renegotiation of SSL connections.

¢ Require—(Default) Specifies thatFortiADC requires secure renegotiation of
SSL connections. In this mode, FortiADC permits initial SSL handshakes
from clients, but terminates renegotiation requests from clients that do not
support secure renegotiation.

¢ Require Strict—FortiADC requires strict secure renegotiation of SSL
connections. In this mode, FortiADC denies initial SSL handshakes from
clients that do not support secure renegotiation.

Enable/disable parameters to comply with RFC 7919.
Note:
¢ RFC 7919 Comply is not supported for Forward Proxy. If RFC 7919 Comply
is enabled and Forward Proxy is enabled, the RFC 7919 Comply feature will
not apply to Forward Proxy functionality.
e RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply
is enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an
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Supported Groups

Dynamic record sizing

error message will display.

e When RFC 7919 Comply is enabled the SSL DH Parameter Size option
becomes unavailable.

The Supported Groups option is available if RFC 7919 Comply is enabled.
Specify the supported group objects from the following:

e secp256r1

¢ secp384r1

e secp521r1

* x25519

e x448

o ffdhe2048

« ffdhe3072

o ffdhe4096

« ffdhe6144

o ffdhe8192
At least one item from the FFDHE group must be selected.
Note:
The RFC 7919 Comply feature requires certain cipher selections to correspond
with the Supported Group selection.

 Ifa FFDHE group is selected (for example, ffdhe2048), then at least one
cipher must be DHE-RSA (for example, DHE-RSA-AES256-SHA256).

« Ifthe Supported Group includes groups other than FFDHE (such as a SECP
group, secp256r1), then at least one cipher must be ECDHE (for example,
ECDHE-ECDSA-AES256-GCM-SHA384).

» Ifa ECDHE cipher is selected (for example, ECDHE-ECDSA-AES256-GCM-
SHA384), then the Supported Group must include at least one group that is
not FFDHE (such as a SECP group, secp256r1).

Allows ADC to dynamically adjust the size of TLS records based on the state of
the connection, in order to prevent bottlenecks caused by the buffering of TLS
record fragments.

Note: The feature is disabled by default.

Note: The following fields become available only when Forward Proxy is enabled.

Forward Proxy Certificate
Caching

Forward Proxy Local Signing CA

Forward Proxy Intermediate CA
Group

Backend SSL SNI Forward

FortiADC 7.2.0 Handbook
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Select a Forward Proxy Certificate Caching rule.

Select a Forward Proxy Local Signing CA.

Select a Forward Proxy Intermediate CA Group.

Disabled by default. Enable it to let FortiADC forward Server Name Indication
(SNI) from the client to the back end.
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Backend Customized SSL Enabled by default. In this case, you must specify the backend customized SS
Ciphers Flag ciphers. See below.

Backend Customized SSL Specify the customized SSL ciphers to be supported at the back end.

Ciphers

Backend SSL Cipher Suite List Select the cipher from the list to be supported at the back end.

Backend TLSv1.3 Cipher Suite TLSv1.3 ciphers are listed as following:
List TLS_AES_256_GCM_SHA384
TLS_AES_128 GCM_SHA256
TLS_CHACHA20_POLY1305_SHA256
TLS_AES_128 CCM_SHA256
TLS_AES_128_CCM_8 SHA256
Note: This option only available if the backendTLSv1.3 is checked.

Backend Allowed SSL Versions  We recommend retaining the default list. If necessary, you can deselect SSL
versions you do not want to support.

Note: FortiADC does not support session reuse for SSLv2 at the client side.
Instead, a new SSL session is started.

Backend SSL OCSP Stapling Disabled by default. Enable it to let FortiADC support OCSP stapling at the
Support backend.

Configuring HTTP2 profiles

You can now create application profiles that support HTTP2. To do so, you must first create an HTTP2 Profile, then use
that profile when creating a new application profile.

To configure HTTP2 profiles:

Go to Server Load Balance > Application Resources. Click the HTTP2 Profile tab.

Click Create New to display the configuration editor.

Complete the configuration as described in HTTP2 profile configuration guidelines on page 132.
Save the configuration.

Ao b=

HTTP2 profile configuration guidelines

Profile Configuration Guidelines

Name Specify a unique name for the HTTP2 profile.

Priority Mode Set to Best Effort. Not configurable.

Upgrade Mode Set to Upgradeable. Not configurable.

Max Concurrent Stream Specify the maximum number of concurrent streams available at one time. The

default number is 5.
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Max Receive Window Specify the maximum number of bytes that can be received without sending an
acknowledgment response. The default is 65535 bytes.

Max Frame Size Specify the max size of the data frames, in bytes that the HTTP2 protocol sends to
the client. Setting a large frame size improves network utilization, but it can also
affect concurrency. The default is 16384 bytes.

Header Table Size Specify the size of the header table, in KB. A larger table size allows for better
HTTP header compression, but it requires more memory. The default is 4096.

Header List Limitation Specify the size of the name value length , in bytes, that the HTTP2 protocol
sends in a single header frame. The default is 65536.

SSL Constraint Enable or disable SSL constraint. If enabled, the following conditions must be
met:

e The TLS implementation supports Server Name Indication.

e The TLS implementation disables compression.

e The TLS implementation disables renegotiation.

» Renegotiation takes place before the connection preface is sent.

e HTTP/2 uses cipher suites with ephemeral key exchange.

e Ephemeral key exchange has a size of at least 2048 bits (for DHE) or a
security level of at least 128 bits (for ECDHE).

 Clients accept DHE no smaller than 4096 bits.

» Stream or block ciphers are not used with HTTP.

Configuring load-balancing (LB) methods

The system includes predefined configuration objects for all supported load balancing methods, and there is no need to
create additional configuration objects. You may choose to do so, however, for various reasons, for example, to use a
naming convention that makes the purpose of the configuration clear to other administrators.

Predefined LB methods on page 133 describes the predefined methods.

Predefined LB methods

Predefined Description

LB_METHOD_ROUND_ROBIN Selects the next server in the series: server 1, then server 2, then server
3,and so on.

LB_METHOD_ LEAST _CONNECTION Selects the server with the least connections.
LB_METHOD_FASTEST_RESPONSE Selects the server with the fastest response to health check tests.

LB_METHOD_URI Selects the server based on a hash of the URI found in the HTTP header,
excluding hostname.

LB_METHOD_FULL_URI Selects the server based on a hash of the full URI string found in the
HTTP header. The full URI string includes the hostname and path.
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LB _METHOD HOST Selects the server based on a hash of the hostname in the HTTP Request
header Host field.

LB_METHOD_HOST_DOMAIN Selects the server based on a hash of the domain name in the HTTP
Request header Host field.

LB_METHOD DEST IP_HASH Selects the next hop based on a hash of the destination IP address. This
method can be used with the Layer 2 virtual server.

LB_METHOD_DYNAMIC_LOAD Selects the server with the highest weight assigned to it based on its
SNMP health check.

Note: Dynamic load-balancing is a load-balancing method in which
FortiADC (the load-balancer) actively polls server pool members, and
then assigns a weighted value to each member based on a set of default
or user-defined thresholds. The value ranges from 1 to 256, and
determines the amount of traffic FortiADC directs to a member. The
greater the value that FortiADC assigns to a member, the more client
requests it (the member) receives.

Dynamic load-balancing relies on the status of SNMP health check to
calculate the load on each real server. The health check covers a real
server's CPU, memory, and disk usage. When a real server has
exceeded its health check thresholds, it will be marked as "down". If that
happens, FortiADC will stop sending client requests to that server.

Before you begin:

» You must have Read-Write permission for Load Balance settings.

To configure a load-balancing method configuration object:

Go to Server Load Balance > Virtual Server > Application Resources.
Click the LB Method tab.

Click Create New to display the configuration editor.

Give configuration object a name and select the load-balancing type.
Save the configuration.

o o0N-=

Configuring persistence rules

Persistence rules identify traffic that should not be load balanced, but instead forwarded to the same backend server that
has seen requests from that source before. Typically, you configure persistence rules to support server transactions that
depend on an established client-server session, like e-commerce transactions or SIP voice calls.

The system maintains persistence session tables to map client traffic to backend servers based on the session attribute
specified by the persistence rule.

The persistence table is evaluated before load balancing rules. If the packets received by FortiADC match an entry in the
persistence session table, the packets are forwarded to the server that established the connection, and load balancing
rules are not applicable.
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Most persistence rule types have a timeout. When the time that has elapsed since the system last received a request
from the client IP address is greater than the timeout, the system does not use the mapping table to forward the request.
Instead, it again selects the server using the method specified in the virtual server configuration. Hash-based rule types
have a timeout built into the hash algorithm. For other types, you can specify the timeout.

Predefined persistence rules on page 135 describes the predefined persistence rules. You can get started with these
commonly used persistence methods or create custom objects.

Predefined persistence rules

Predefined Description
LB_PERSIS_SRC_ADDR Persistence based on source IP address or subnet.
LB_PERSIS_HASH_SRC_ADDR Persistence based on a hash of source IP address.

LB_PERSIS HASH_SRC_ Persistence based on a hash that includes source IP address and

ADDR_PORT port.

LB _PERSIS _HASH_COOKIE Persistence is based on a hash of a cookie provided by client
request.

LB_PERSIS_RDP_COOKIE Persistence based on RDP cookie sent by RDP clients in the initial
connection request.

LB_PERSIS _SSL_SESS ID Persistence based on the SSL session ID.

LB _PERSIS SIP_CALL ID Persistence based on the SIP call ID.

LB_PERSIS_PASSIVE_COOKIE Persistence based on a passive cookie generated by the server.
FortiADC does not generate or manage the cookie, but only
observes itin the HTTP stream, thus the name "passive cookie".
Also known as "server cookie".

Before you begin:

» You must have a good understanding and knowledge of the applications that require persistent sessions and the
methods that can be used to identify application sessions.

¢ You must have Read-Write permission for Load Balance settings.

After you have configured a persistence rule, you can select it in the virtual server configuration.

To configure a persistence rule:

Go to Server Load Balance > Application Resources.
Click the Persistence tab.
Click Create New to display the configuration editor.

Give the rule a name, select the type, and specify rule settings as described in Persistence rule guidelines on page
136.

5. Save the configuration.

Ao b=
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You can clone a predefined configuration object to help you get started with a user-
v defined configuration.
‘9'
- To clone a configuration object, click the clone icon i
column on the configuration summary page.

that appears in the tools

Persistence rule guidelines

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.
Type Select a persistence type.
Source Address
Source Address Persistence is based on source IP address.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

Subnet Mask Bits Number of bits in a subnet mask to specify a network segment that should follow the

(IPv4) persistence rule. For example, if IPv4 maskbits is set to 24, and the backend server A
responds to a client with the source IP 192.168.1.100, server A also responds to all clients
from subnet 192.168.1.0/24.

Subnet Mask Bits Number of bits in a subnet mask to specify a network segment that should follow the
(IPv6) persistence rule.

Match Across Virtual ~ OFF (disabled) by default. Click the button to enabile it.

Servers If enabled, clients will continue to access the same backend server through different virtual
servers for the duration of a session.

Note: The persistence rule with Match Across Virtual Servers enabled works only with L4
virtual servers or the L7 virtual server whose Profile is LB_ PROF_RADIUS.
Passive Cookie

Session Keyword Persistence is based on the cookie which generated from the server, including six options:

Type auto/PHPSESSID/JESSIONID/CFID+CFTOKEN/ASP.NET_Sessionld/custom. When type
is auto, PHPSESSID/JESSIONID/CFID+CFTOKEN/ASP.NET_Sessionld can be all
checked. When type is custom, user could define the cookie’s keyword at will.

Keyword Backend server cookie name.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

Match across servers  Enable so clients continue to access the same backend server through different virtual
servers for the duration of a session.
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For example, a client session with a vSphere 6.0 Platform Services Controller (PSC) has
connections on the following ports: 443, 389, 636, 2012, 2014, 2020. A FortiADC deployment
to load balance a cluster of vSphere PSCs includes Layer 4 virtual server configurations for
each of these ports. To ensure a client’'s connections for a session go to the same backend
real server:
1. Create a persistence object based on Source Address affinity and select the Match
Across Servers option.
2. Select this persistence object in each of the Layer 4 virtual servers configured to load
balance the vSphere PSC pool.
3. Select the same real server pool object in each of the Layer 4 virtual servers configured
to load balance the vSphere PSC pool.
When these options are enabled, FortiADC dispatches the intial connection to a real server
destination (for example, RS1) based on the virtual server’s load balancing method, and the
persistence object is noted in the connection table. Subsequent connection attempts with the
same source |IP address to any FortiADC virtual server that has this persistence object and
real server pool are dispatched to RS1, as long as the session is active.
Note: In the Layer 4 virtual server configuration, you specify a packet forwarding method.
You can use Source Address persistence with Match Across Servers with any combination of
Direct Routing, DNAT, and Full NAT packet forwarding methods. However, with NAT46 and
NAT64 packet forwarding methods, the source address type is different from the real server
address type. To use Match Across Servers with NAT46 or NAT64, all virtual servers for the
application must be configured with the same packet forwarding method: all NAT46 or all
NAT64.

Source Address Hash
Source Address Hash  Persistence is based on a hash of the IP address of the client making an initial request.
Source Address-Port Hash

Source Address-Port  Persistence is based on a hash of the IP address and port of an initial client request.
Hash

HTTP Header Hash

HTTP Header Hash Persistence is based on a hash of the specified header value found in an initial client request.
Keyword A value found in an HTTP header.

HTTP Request Hash

HTTP Request Hash  Persistence is based on a hash of the specified URL parameter in an initial client request.

Keyword A URL parameter.

Cookie Hash

Cookie Hash Persistence is based on a hash of the cookie provided by client request.
Keyword Specifies the cookie name.

FortiADC 7.2.0 Handbook
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If the specified cookie keyword is a valid cookie name from which the cookie value can be
extracted, it will be used to calculate the hash. Without the keyword, the hash will be
calculated using the whole cookie. Otherwise, the default round robin method will be used.

Persistent Cookie

Persistent Cookie Persistence is based on the cookie provided in the backend server response. It forwards
subsequent requests with this cookie to the original backend server.

Keyword Backend server cookie name.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

Insert Cookie

Insert Cookie Persistence is based on a cookie inserted by the FortiADC system.
The system inserts a cookie whose name is the value specified by Keyword and whose value
is the real server pool member Cookie value and expiration date (if the client does not already
have a cookie).
For example, if the value of Keyword is sessid and the real server pool member Cookie
valueis rs1, FortiADC sends the cookie sessid=rs1 | U61FN to the client, where U61FN is
the expiration date as a base64 encoded string.

Keyword Specifies the backend server cookie name.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

Domain Specifies the domain attribute of the cookie.

If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Httponly Enable/disable to add the "HTTPOnly" flag to cookies. The HttpOnly attribute limits the scope
of the cookie to HTTP requests. In particular, the attribute instructs the user agent to omit the
cookie when providing access to cookies via "non-HTTP" APIs (such as a web browser API
that exposes cookies to scripts).

If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Secure Enable/disable to add the Secure flag to cookies. The Secure attribute limits the scope of the
cookie to "secure" channels (where "secure" is defined by the user agent). When a cookie
has the Secure attribute, the user agent will include the cookie in an HTTP request only if the
request is transmitted over a secure channel (typically HTTP over Transport Layer Security
(TLS).

If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Samesite Add a SameSite attribute to prevent the browser from sending cookies along with cross-site
requests, to mitigate the risk of cross-origin information leakage. It provides Strict, Lax, and
None values for this attribute:
» Nothing — Do not add Samesite attribute to cookies.
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Custom Attribute

Custom Attribute
Value

Rewrite cookie

Rewrite Cookie

Keyword
Embedded Cookie
Embedded Cookie

FortiADC 7.2.0 Handbook
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The default value is Nothing.

¢ None — set the value as none if a cookie is required to be sent by cross origin.
Note: If Secure is enabled, then Samesite should be set to None.

¢ Lax—any request from the third parties will not carry such cookies except for GET
requests that navigate to the destination URL.

 Strict— any request from the third parties will not carry such cookies

If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Enable to specify custom attributes.

When Custom Attribute is enabled, the following options become unavailable: Domain,
Httponly, Secure, and Samesite.

The Custom Attribute Value option appears if Custom Attribute is enabled.

Specify the full cookie attributes, including any of the standard attributes and any of the
custom attributes.

If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Persistence is based on the cookie provided in the backend server response, but the system
rewrites the cookie.

The system checks the HTTP response fora Set-Cookie: value that matches the value
specified by Keyword. It replaces the keyword value with the real server pool member Cookie
value.

For example, the value of Keyword in the persistence configurationis sessid. The real
server pool member Cookie value is rs1. After an initial client request, the response from
the server contains Set-Cookie: sessid=666,which FortiADC changesto Set-
Cookie: sessid=rsl.FortiADC uses this rewritten value to forward subsequent requests
to the same backend server as the original request.

Specifies a Set-Cookie: value to match.

Persistence is based on the cookie provided in the backend server response.

Like Rewrite Cookie, the system checks the HTTP response fora Set-Cookie: value
that matches the value specified by Keyword in the persistence configuration. However, it
preserves the original value and adds the real server pool member Cookie value and a ~
(tilde) as a prefix.

For example, the value of Keyword is sessid. The real server pool member Cookie value is
rs1. After an initial client request, the response from the server contains Set-Cookie:
sessid=666, which the system changesto Set-Cookie: sessid=rsl1~666. Ituses this
rewritten value to forward subsequent requests to the same backend server as the original
request.
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Keyword Specifiesa Set-Cookie: valueto match.
RADIUS Attribute

Type Select RADIUS Attribute.

Timeout Specify the timeout for an inactive persistence session table entry. The default is 300
seconds, and valid values range from 1 to 86,400.

Match Across Virtual ~ OFF (disabled) by default. Click the button to enable it.

Servers If enabled, clients will continue to access the same backend server through different virtual
servers for the duration of a session.

Note: The persistence rule with Match Across Virtual Servers enabled works only with L4
virtual servers or the L7 virtual server whose Profile is LB_PROF_RADIUS.

Override Connection  OFF (disabled) by default, which means that when the connection limit is reached, new
Limit connections will still be persistently forwarded to the real server.

If enabled, new connections will be forwarded to another node (load-balancing) until all
nodes are full.

RADIUS Attribute RADIUS persistence rule supports multiple RADIUS settings, which can be either of the
Relation following relations:
¢ AND (Default) — The persistence condition is true if all RADIUS attributes are found.
¢« OR—The persistence condition is true if any of the attributes is found.

RADIUS Attribute After you have saved the RADIUS-type persistence configuration object, you can open the
Persistence configuration editor and add up to four (4) RADIUS attributes to it.

Note: If you choose to use the 26-Vendor-Specific attribute, you need to specify the Vendor

ID and Vendor Type.
RDP Cookie
RDP Cookie Persistence based on RDP cookie sent by RDP clients in the initial connection request.
SSL Session ID
SSL Session ID Persistence is based on SSL session ID.
Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid

range is 1-86,400.

SIP Call ID

SIP Call ID Persistence is based on SIP Call ID. For SIP services, you can establish persistence using
Source Address, Source Address Hash, or SIP caller ID.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid

range is 1-86,400.
1ISO8583 Bitmap
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Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

1ISO8583 Bitmap Relation among the bitmap type, be AND/OR. Default is OR.
Relation

Keyvalue Relation Relation of keyvalue, be AND/OR. Default is AND.

Type Persistence is based on bitmap. Support 30 bitmap type.

Configuring error pages

When backend real servers are unavailable or another status code for other module (ex: WAF/DoS/Auth), FortiADC can
respond to clients attempting HTTP/HTTPS connections with a customized HTML error page. From the Application
Resources > Error Page, you can create a customized error page by uploading an HTML error page file. You can then
edit and preview the HTML file from the GUI. Once the HTML error page has been created, you can select it in virtual
server configurations.

To aid you in customizing your HTML error page, FortiADC provides all default error page files that can be downloaded
from the predefined profile LB_ERROR_PAGE_DEFAULT. You may use any of these default error page files as a
template for customization.

The current error page file package only requests index.html to replace 503 error message when there are no servers in
the pool. We also extend the support to these files listed below:

File Name MUST Guidelines

Index.html Yes This page will replace 503 error message page.
200.html No This page will replace 200 error message page.
202.html No This page will replace 202 error message page.
205.html No This page will replace 205 error message page.
400.html No This page will replace 400 error message page.
401.html No This page will replace 401 error message page.
403.html No This page will replace 403 error message page.
404 .html No This page will replace 404 error message page.
405.html No This page will replace 405 error message page.
406.html No This page will replace 406 error message page.
408.html No This page will replace 408 error message page.
410.html No This page will replace 410 error message page.
413.html No This page will replace 413 error message page.
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500.html No This page will replace 500 error message page.

501.html No This page will replace 501 error message page.

502.html No This page will replace 502 error message page.

504.html No This page will replace 504 error message page.

waf_deny.html No This page will replace all response to a WAF deny action. The error

page will show the Message ID, Signature ID, and Client IP of the
attack in the message as recorded in the attack log.

The error page file does not include the related response-code.html.

default.html No This page will replace all other error page doesn’t include in the
package (excluding 503).

Alternatively, you do not have to create an HTML error page if you want to simply send a basic text error message when
backend servers are unavailable. Instead, you can enter an error message in a text box from within the virtual server
configuration. See Error Message on page 57.

Before you begin:

« You must have Read-Write permission for Server Load Balance settings.

« Copy the error message file to a location you can reach from your browser; the error page file must be named
index.html and contained in a tar, tar.gz, or zip file. The maximum file size is 1 MB.

To upload an error message file:

Go to Server Load Balance > Application Resources.
Click the Error Page tab.
Click Create New to display the configuration editor.

o b=

Enter the name of the error page. You will use this name to select the error page in virtual server configurations. No
spaces.

Click Choose File and browse and select the error message tar, tar.gz, or zip file. The maximum file size is 1MB.

Enter the Virtual Path of the error page. This virtual path will conflict with the custom authentication form base
page's virtual path and also with SAML's server URL configuration and Captcha path.

7. Click Save.

The newly created error page will be listed in the Error Page tab.

o a

To modify an error page:

1. Goto Server Load Balance > Application Resources.
2. Click the Error Page tab.
3. Double-click the error page or select the #" (edit) icon in the row of the error page that you want to modify.

The Error Page configuration editor displays.
4. From the configuration editor, you can make the following modifications:
« Upload a new error message file.

« Ifthe uploaded file is a zip file, edit the file directly through the text editor. The GUI text editor supports HTML,
CSS, and JS file types.
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5. Optionally, click Preview to test and view your HTML error page.
Note: The preview function only supports HTML files and cannot execute any JavaScript contained in the HTML.

6. Click Save.

Note: While it is possible to modify the error message file, once an error page is created, you cannot modify its name.

Configuring decompression rules

If the HTTP/HTTPS request body is compressed, FortiADC cannot pass it to the other functional modules which perform
inspection or modification.

To allow FortiADC to pass compressed HTTP/HTTPS client requests to other modules for inspection or modification
before forwarding it to the back-end server, you must create a FortiADC decompression policy.

You can configure FortiADC to temporarily decompress the body of a request based on its file type, which can be
specified by the HTTP/HTTPS Content-Type: header. The appliance can then inspect or modify the traffic. If no
inspection or modification is needed, it will allow the compressed version of the request to pass to the back-end server.

FortiADC supports HTTP/HTTPS request decompression in either gzip or deflate format. Upon receiving a compressed
HTTP/HTTPS request body, FortiADC first extracts the HTTP/HTTPS request body to a temporary buffer and then
sends the buffer to the other modules.

Note that, for the current release, decompression only works for Web Application Firewall (WAF) and Scripting functions.
FortiADC supports decompression of the following content-type files:

» application/javascript
« application/soap+xml
« application/x-javascript
 application/xml

» text/css

o text/html

« text/javascript

o text/plain

o text/xml

e custom

Before you begin:

» You must have a good understanding of HTTP decompression and knowledge of the content types served from the
backend real servers.
» You must have Read-Write permission for Load Balance settings.

Decompression is not enabled by default. After you have configured a decompression rule, you can select it in the profile
configuration. To enable decompression, select the profile when you configure the virtual server.

To configure a decompression rule:

1. Click Server Load Balance > Application Resources.
2. Click the Decompression tab.
3. Click Create New to display the configuration editor.
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4. Complete the configuration as described in Decompression configuration on page 144.
5. Save the configuration.

Decompression configuration

Settings Guidelines

Specify a unique name for the decompression rule. Configuration name. Valid characters are
A-7,a-z,0-9, ,and -.No spaces. You reference this name in the profile configuration.

Name

URI List Type

URI List

Content Types

FortiADC 7.2.0 Handbook
Fortinet Inc.

Note: After you initially save the configuration, you cannot edit the name.

Include— Select this option to create a decompression inclusion rule. HTPP/HTTPS
responses that match the URIs and content types specified in this rule will be
decompressed by FortiADC before being passed to the client.

Exclude—Select this option to create a decompression exclusion rule.

HTPP/HTTPS responses that match the URIs and content types specified in this rule will
not be decompressed by FortiADC before being passed to the client.

Click Add and specify URIs to build the list.

Click Add and select from the following content types to build the list:

application/javascript
application/soap+xml
application/x-javascript
application/xml
text/css

text/html
text/javascript
text/plain

text/xml

custom

Note: The "custom" option allows you to specify almost any content/media type, including
image files in .JPG, .PNG, and .BMP formats. The default is */*, which means any
content/media type.
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You can use the CLI to configure decompression rules:
config load-balance decompression
edit <name>

set cpu-limit {enable | disable}
set max-cpu-usage [1-100]

set uri-list-type {include | exclude}
config uri list

edit <ID>

set uri <refex pattern>

next

end

config content-types

edit <ID>

set content-type <types>

{

application/javascript
application/soap+xml
application/x-javascript
application/xml

custom <plain-string>

text/css

text/html

text/javascript

text/plain

text/xml

}

next

end

You can use the CLI to select a decompression rule in a server load balance profile
(HTTP):

config load-balance profile

edit <name>

set decompression <decompression name>

next
end

Using decompression with script data body manipulation

Script data body manipulation can work in tandem with compression or decompression rules in a rather transparent way.

When a decompression rule is configured and used with scripting, FortiADC will decompress HTTP data first, then apply
script data body manipulation, and then re-compress the data before sending it to clients.

So, if HTTP data is compressed before being sent out from the real server, you must create a decompression rule if you
want to access the original data and use it in a script. This can be done either via the GUI or the Console. The following
paragraphs show you the basic steps for configuring decompression rules to work with script data body manipulation.
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From the GUI

Step 1: Creating a decompression rule

1. Click Server Load Balance > Application Resources > Decompression.
2. Click Create New to open the Decompression configuration dialog.
3. For Name, specify a unique name for the decompression rule.
4. For URI Rule Type, select Include or Exclude.
5. Click Save. The dialog closes and the decompression rule appears in the Decompression table.
6. Double-click the decompression rule (or click the corresponding Edit button) to open it.
7. Inthe URI Rule section, make the desired configuration. (Optional)
8. Inthe Content Types sections, make the desired configuration. (Optional)
9. Click Save.
10. Repeat the above steps to create as many decompression rules as needed.

Step 2: Configuring a load balance profile

Click Server Load Balance > Application Resources > Application Profile.

Click Create New to open the Application Profile configuration dialog.

For Type, click the down arrow and select HTTP or HTTPS from the list menu.

For Decompression, click the down arrow and select a decompression rule from the list menu.
Complete all the other fields required for load-balancing profile configuration.

Click Save.

ok wDd-=

Step 3: Enabling scripting in virtual server configuration

Click Server Load Balance > Virtual Server > Virtual Server.
Click Add > Advanced Mode.
For Type (under the Basic section), be sure to select Layer 7.

For Profile (under the General section), be sure to select an HTTP or HTTPS profile associated with the
decompression rules that you have configured.

P owbd-=

For Scripting, be sure to turn it on (enable it), and then select the desired script or scripts.
Complete all the other fields required for virtual server configuration.
7. Click Save.

o a

From the Console

Use the following example commands as a reference when configuring decompression and script data body
manipulation from the Console.

Step 1: Creating a decompression rule

config load-balance decompression
edit "decompress"

set uri-list-type include

config uri list

edit 1

set uri /
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next

end

config content types

edit 1

set content-type text/html
next

end

next

end

Step 2: Configuring a load balance profile

config load-balance profile
edit "http"

set type http

set decompression decompress
next

end

Step 3: Enabling scripting in virtual server configuration

config load-balance virtual-server
edit "wvs"

set load-balance-profile http

set scripting-flag enable

set scripting-list data

next

end

Configuring Captcha

FortiADC allows administrators to validate incoming users with CAPTCHAs to determine whether a client is a regular
user or an attacker. FortiADC can configure the WAF/DoS Policy to issue CAPTCHASs only to clients who meet the attack
rules.

Select a FortiADC default captcha profile from within the virtual server configuration or upload a customized captcha
page if you want to use your own captcha verification page for when an WAF/DoS attack detected.

Before you begin:

» You must have Read-Write permission for Server Load Balance settings.
« Copy the captcha file to a location you can reach from your browser; the captcha file must be named

« index.html it must include a tag called “%%FORTIADC_CAPTCHA_IFRAME%%” and be compressed as tar, tar.gz,
or zip file. The maximum file size is 1 MB.

To upload a Captcha page file:

Go to Server Load Balance > Application Resources.
Click the Captcha tab.
Click Create New to display the configuration editor.

Enter the name of the captcha. You will use this name to select the captcha profile in virtual server
configurations. No spaces.

P obh-=
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5. Toggle the Customized Captcha Page and then click Choose File and browse and select the captcha page tar,
tar.gz, or zip file. The maximum file size is 1MB.

6. Save the configuration.

Captcha Configuration
Parameter Description

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and-.No
spaces are allowed. Maximum length 63. Note: After you initially save the
configuration, you cannot edit the name.

Virtual Path Virtual path of captcha function. This path is running on VS, so it will conflict with
other configurations like errorpage’s vpath and custom auth page. String type, not
empty, maximum length 63, the default value is “/fortiadc_captcha/”

Max Attempts Maximum attempts for Captcha verification. Integer type, range 1-100, default 5.
The client will be blocked upon exceeding max attempts.

Max Picture Changes The maximum number of times you can change another picture. Integer type,
range 1- 100, default 5. Exceed change times change picture action won’t
success.

Picture Difficulty There are two difficulty level here can be selected, hard and easy. hard level

picture may fight Al picture recognition, but may cause difficulty in human
identification. Default value is hard.

Max Block Period Once client is blocked, how long it will be blocked. Integer type, range 10-
2592000, default 86400. Exceed this time client will be reset to untracked state.

Max Verify Period The longest verification time from captcha verify action start. Unit second, range
20- 86400, default 1200. Exceed this time the client will be blocked.

Customized Captcha Page Switch for customize captcha page, default disable. If disable, the custom captcha
package file option won't valid.

File File package for customize captcha page. Click ‘Choose File’ to upload.

The file package must include index.html file, and in the index page, it must
include a tag called “%%FORTIADC_CAPTCHA_IFRAME%%”, that we will insert
the verify page box on it.

Note: This option is only available when the ‘Customized Captcha Page’ is
enabled.

Creating a PageSpeed configuration

A PageSpeed configuration sets the rule(s) that FortiADC follows when rendering web pages. Creating a PageSpeed
configuration object involves the following:

» Specify the inode/file cache limits

o Choose a PageSpeed profile (Must be configured in advance)

» Set page control

« Setresource control
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To create a PageSpeed configuration object:

1. Click Server Load alance > Application Optimization.
2. Select the Page Speed tab.
3. Make the entries or selections as described in PageSpeed configuration on page 149.

4. Click Save when done.

PageSpeed configuration

Parameter Description

PageSpeed
Name

File Cache Inode Limit

File Cache
Size Limit

PageSpeed Profile

Page Control

Type

FortiADC 7.2.0 Handbook
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Enter a name for the PageSpeed configuration object that you are creating.

Specify the maximum number of inodes that can be cached on FortiADC for this virtual
server. The defaultis 10,000. Valid values range from 1 to 100,000.
Note: An inode is a data structure with information about files or directories on a
filesystem on Linux or other Unix-type operating systems. It's generated when a
filesystem is created. Within a filesystem, every file and directory has a corresponding
inode identified by an inode number. Each inode contains the attributes and disk block
location(s) of the file's or directory's data, which may include metadata (e.g., access
mode, times of last change, modification) and user, ownership, and permission data.
A filesystem has a set number of inodes, which indicates the maximum number of files
or directories it can hold. A FortiADC appliance can support up to 100,000 inodes.
Every time you open a file, the kernel of the server reads the file's inode. The more files
and directories you have, the more inodes the server uses. And the more inodes the
server uses, the more system resources it consumes. So it is always a good practice to
try to limit the number of inodes a host has on a shared server. This will prevent it from
using all system resources.
To ensure efficient use of its resources, FortiADC cleans its cache every 10 minutes. It
cleans the cache only when either of the following conditions is met:

e The virtual server has reached its set inode cache limit.

¢ The virtual server has reached its file size cache limit.
When performing cache clean-up, FortiADC will use the "first-in first-out" (FIFO)
principle to remove the oldest cached inodes or files until the cached data is reduced to
less than 75% of its set inode- or file-cache limit(s).

Specify the maximum file size that can be cached on FortiADC for this virtual server. The
defaultis 128. Value values range from 1 to 512 (MB).

Select a PageSpeed profile from the list menu.

Note: You must have PageSpeed profiles created before you start to create a
PageSpeed rule. For instructions on how to create a PageSpeed profile, refer to
Creating PageSpeed profiles on page 150

Select either of the following page control types:
¢ Include — If selected, FortiADC will process Web pages associated with the
URI specified below.
¢ Exclude — If selected, FortiADC will skip Web pages associated with the
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Parameter Description

URI Pattern

Resource Control

Origin Domain Patten

Rewrite Domain

Fetch Domain

URI specified below.

Specify the full URI in regular expression. For example,

(http(s) ://) *example.com/*/htmls/*.html

Note: In the HTTP response body, HTML sometimes is linked to a certain resource URL.
If the resource contains a domain name, then FortiADC will do the fetch according to the
fetch-domain setting or the rewrite-domain setting.

Wildcards include * (asterisk) which matches any 0 (zero) or more characters, and ?
(question mark) which matches exactly one character. Unlike Unix shells, the / directory
separator is not special, and can be matched by either * or ?. The resources are always
expanded into their absolute form before expanding.

A wildcard will be matched against the full URL, including any query parameters. For
example, youcanuse "*.jsp*" tomatch
http://example.com/index.jsp?test=xyz.

Specify the original domain pattern in regular expression in alphanumeric characters.
Forexample, (http(s)://)*.example.com

Note: Valid characters are 0— 9, a—z, A—Z, . (period), : (colon), hyphen (-) and / (forward
slash). The FortiADC 4.8.0 release only supports HTTP or HTTPS.

To improve web page performance, PageSpeed will examine and modify the content of
the resources referenced on web pages. It does that by fetching those resources using
HTTP, according to the URL reference specified on an HTML page.

Specify the fetch domain string. For example, http: //www.example.com

Valid characters are 0— 9, a—z, A—Z, . (period), : (colon), hyphen (-) and / (forward slash).
The FortiADC 4.8.0 release only supports HTTP or HTTPS.

Specify the rewrite domain string. For example, http://www.example.com

Valid characters are 0— 9, a—z, A—Z, . (period), : (colon), hyphen (-) and / (forward slash).
The FortiADC 4.8.0 release only supports HTTP or HTTPS.

Creating PageSpeed profiles

PageSpeed provides a technology solution to speed up web application response and optimize web pages and

resources in real time.

As a module on FortiADC device, PageSpeed is simple to deploy and does not require any integration into Web
application servers or any client installation on end-user devices. With the PageSpeed feature, you can select the
approach(es) to make your web site faster and more user-friendly.

A PageSpeed profile specifies the option(s) for optimizing the delivery of web applications. To take full advantage of the
benefits that PageSpeed offers, you must first create your own PageSpeed profiles and then select the application
optimization option(s) to add to them. Once you have your own PageSpeed profiles created, you can simply select them
toinclude in any PageSpeed configurations you create.

FortiADC offers options for optimizing the delivery of the following web content:
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« HTML
« CSS
» Image

For more information and instructions on how to use these options, see Table 1.
To create a PageSpeed profile:

1. Click Server Load balance > Application Optimization.

2. Select the Page Speed Profile tab.

3. Make the entries or selections as described in Application optimization parameters on page 151.
4. Click Save when done.

Application optimization parameters

Parameter Description

HTML Disable (default) or enable HTML optimization. If enabled, you must also select a
specific option(s) below.
Note: FortiADC supports optimization of compressed HTML files.

Move CSS to Head If selected, FortiADC will move CSS elements above script tags.

Note: This ensures that the CSS styes are parsed in the head of the HTML page
before any body elements are introduced,. In so doing, it can effectively reduce the
number of times web browsers have to re-flow HTML documents.

CSS Disable (default)/enable CSS optimization.
Note: If enabled, you must also select the specific option(s) below.

Combine CSS If selected, FortiADC will combine multiple CSS elements into one.
Note: This option replaces multiple CSS files with a combined CSS file that contains
the contents of all individual CSS files. As a result, it can reduce the number of
HTTP/HTTPS requests web browsers make during page refresh. This is particularly
beneficial to older browsers that can handle only up to two connections per domain.
Not only can this reduce the overhead for HTTP/HTTPS headers and
communications warm-up, but also work well with TCP/IP slow-start because it
increases the effective payload bit rate through a browser's network connection.

Maxi Combine CSS Byte Specify the maximum number of CSS bytes that can be combined. The default is
4,096.

Note: Valid values range from 1 to 10,240.

Image Disable (default)/enable image optimization.
Note: If enabled, you must also select the specific option(s) below.

Resize Image Disabled by default. If enabled, this will reduce the dimension of an image to the

"width=" and "height=" attributes defined in the <img> tag or in the inline
"style=attibute".
Note:

¢ The option will remove color profile and metadata.

¢ The re-sized image may also be re-compressed or converted to a new format and

quality based on user configuration.
¢ This option applies to .jpg, .png, and .webp images only.
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Parameter Description

JPEG Sampling Disabled by default.When enabled, it will apply 4:2:0 chroma subsampling to .jpg
images, in which hue and saturation have only 25% as many samples as brightness.
Because the human eye is less sensitive to hue and saturation than to brightness, this
subsampling technique can greatly reduce image size with no noticeable effect on

perception

PageSpeed support and restrictions

Implementation of PageSpeed is subject to the following conditions or restrictions.

Supported

PageSpeed is supported in the following use scenarios:

o Layer-7 serverload balancing HTTP
» Layer-7 server load balancing HTTPS

Restrictions

Support for Layer-7 sever load balancing HTTP/HTTPS is subject to the following conditions:

» Content-type must be text or html
» Data without compression

Not Supported

The following are not supported:
« Too many virtual servers using PageSpeed at the same time

o« HTTP/2
« File cache sync for high availability (HA)

Note: Although it is possible to create more than 16 virtual machines with PageSpeed, you must do it with careful
consideration. This is because virtual machines with PageSpeed consume more system memory, and your FortiADC

appliance could quickly run out of memory as a result.

Configuring compression rules

To offload compression from your back-end servers, you can configure FortiADC to perform HTTP/HTTPS compression
on behalf of the server.

The following content types can be compressed:
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application/javascript
application/soap+xml
application/x-javascript
application/xml
text/css

text/html

text/javascript
text/plain

text/xml

custom

Not all HTTP.HTTPS responses should be compressed. Compression offers the greatest performance improvements

when applied to URIs whose media types include repetitive text such as tagged HTML and JavaScript. Files that already
contain efficient compression such as GIF images usually should not be compressed, as the CPU usage and time spent

compressing them will result in an increased delay rather than network throughput improvement. Plain text files where
no words are repeated, such as configurations with unique URLSs or IPs, also may not be appropriate for compression.

FortiADC supports HTTP/HTTPS response compression in either gzip or deflate format.

Before you begin:

You must have a good understanding of HTTP/HTTPS compression and knowledge of the content types served
from the back-end real servers.

You must have Read-Write permission for Load Balance settings.

Compression is not enabled by default. After you have configured a compression inclusion rule, you can select it in the
profile configuration. To enable compression, select the profile when you configure the virtual server.

To configure a compression rule:

o o0N-=

Click Server Load Balance > Application Optimization.

Click the Compression tab.

Click Add to display the configuration editor.

Complete the configuration as described in Compression configuration on page 153.
Save the configuration.

Compression configuration

Settings Guidelines

Name Configuration name. Valid characters are -7, a-z, 0-9, , and -. No spaces. You reference

this name in the profile configuration.
Note: After you initially save the configuration, you cannot edit the name.

URI List Type ¢ Include— Select this option to create a compression inclusion rule. HTPP/HTTPS

responses that match the URIs and content types specified in this rule will be
compressed by FortiADC before being passed to the client.

¢ Exclude—Select this option to create a compression exclusion rule. HTPP/
HTTPS responses that match the URIs and content types specified in this rule will not be
compressed by FortiADC before being passed to the client.
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Settings Guidelines

URI Rule Click Add and specify the URI to create the rule. Note: You must use a regular expression,
e.g., https://example.com/tmp/test.txt.

Content Types Click Add and select from the following content types to build the list:

¢ application/javascript

e application/soap+xmi

e application/x-javascript

¢ application/xml

o text/css

o text/html

¢ text/javascript

e text/plain

o text/xml

e custom
Note: The "custom" option allows you to specify almost any content/media type, including
image files in .JPG, .PNG, and .BMP formats. The default is */*, which means any
content/media type.

You can use the CLI to configure advanced options:

config load-balance compression

edit 1

set cpu-limit {enable | disable}

set max-cpu-usage <percent> -- max cpu usage for compression
set min-content-length <bytes> -- min bytes for compression

end

Compression and decompression

FortiADC supports HTTP/HTTPS response compression and request decompression with either gzip or deflate format.

You can offload HTTP/HTTPS response compression to FortiADC to save resources on your back-end servers, and let
FortiADC to decompress compressed HTTP/HTTPS client requests for WAF inspection before passing them to your
back-end servers.

Using caching features

The system RAM cache can store HTTP content and serve subsequent HTTP requests for that content without
forwarding the requests to the backend servers, thereby reducing the load on the backend servers.

You can configure basic static caching or dynamic caching rules.
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Static caching

Static caching feature on page 155 illustrates the static caching feature.

Static caching feature

Internet
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Chent B
Servers
Before content is cached After content has been cached
1. FortiADC receives the request from Client A and 1. FortiADC receives the request from Client B and
checks to see if it has a cached copy of the content. checks to see if it has a cached copy of the content.
2. Ifitdoes not, it forwards the request to a backend 2. Itdoes, so it responds by sending the content to the
server. client. The backend server is not contacted.

3. The server sends content in response, and FortiADC
caches the content.
4. FortiADC sends it to the client.

In general, the RAM cache conforms with the cache requirements described in sections 13 and 14 in RFC 2616.

If caching is enabled for the profile that is applied to traffic processing, the system evaluates HTTP responses to
determine whether or not to cache the content. HTTP responses with status codes 200, 203, 300, 301, 400 can be
cached.

The following content is not cached:

» Aresponse for a request that uses any method other than GET.
« Aresponse for a request of which URI is contained in URI Exclude List or Dynamic Request URI Invalid list.

» Aresponse for a request that contains any of the following headers: If-Match, If-Unmodified-Since, Authorization,
Proxy-Authorization.

« Aresponse that contains any of the following headers: Pragma, Vary, Set-Cookie, and Set-Cookie2.
» Aresponse that does not include the Content-Length header. The Content-Length header must be 0.
« Aresponse that does not contain the following headers: Cache-Control, Expires.

« Aresponse with a Cache-Control header that does not have any of the following values: public, max-age, s-
maxage.

» Aresponse with a Cache-Control header that has one of the following values: no-cache, no-store, private.
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In addition, content is not cached if the user-configured RAM cache thresholds described below are exceeded.

Dynamic caching

Dynamic caching is subject to rules you configure. In the Dynamic Caching Rules List, content that matches "caching
invalid" URlIs is never cached; otherwise, content that matches the Dynamic Cache Rule List of URlIs is cached for the
period you specify.

Dynamic caching is useful for dynamic web app experiences, such as online stores. For example, suppose a site uses a
shopping cart. The URL to list items in the shopping cart is as follows:

http://customshop.com/cart/list

The URLs to add or delete items in the cart is as follows:
http://customshop.com/cart/add
http://customshop.com/cart/delete

In this case, you never want to cache the added or deleted pages because the old content will be "invalidated" by the
changes you make. You may want, however, to cache the list page, but only for the period of time that you specify. The
dynamic "invalid" rules makes it possible for you to never cache added and deleted pages, whereas the Dynamic Cache
Rule List allows you to cache the list page for a specified period of time.

Another case where dynamic caching is useful is when content on a page is dynamic. For example, suppose an online
ticket vendor has the following URL that shows how many tickets remain available for an
event: http://customshop.com/tickets/get_remains. The number of tickets available is updated by a backend database.
In this case, you might want to invalidate caching the URL or give it a small age out time.

Configuring caching rules

Before you begin:
» You must have a good understanding of caching and knowledge about the size of content objects clients access on
the backend servers.
« You must have deep and detailed knowledge of your website URIs if you want to create dynamic caching rules.
» You must have Read-Write permission for Load Balance settings.

Caching is not enabled by default. After you have configured caching, you can select it in the profile configuration. To
enable caching, select the profile when you configure the virtual server.

To configure caching:

Click Server Load Balance > Application Optimization.

Click the Caching tab.

Click Create New to display the Caching configuration editor.

Complete the configuration as described in Caching configuration on page 157.
Save the configuration.

o oN-=
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Caching configuration

Settings Guidelines

Name Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces. You reference
this name in the profile configuration.

Note: After you initially save the configuration, you cannot edit the name.

Maximum Object The defaultis 1 MB. The valid range is 1 byte to 10 MB.

Size

Maximum Cache The defaultis 100 MB. The valid range is 1 byte to 500 MB.
Size

Maximum Entries The defaultis 10,000. The valid range is 1 to 262,144.
Maximum Age The default is 43,200 seconds. The valid range is 60 to 86,400.

The backend real server response header also includes a maximum age value. The FortiADC
system enforces whichever value is smaller.

URI Exclude List

URI Specify URIs to build the list. You can use regular expressions.
This list has precedence over the Dynamic Cache Rule List. In other words, if a URI matches
this list, it is ineligible for caching, even if it also matches the Dynamic Cache Rule list.
Dynamic Cache Rule List

ID Enter a unique ID. Valid values range from 1 to 1023.

Age Timeout for the dynamic cache entry. The default is 60 seconds. The valid range is 1-86,400.
This age applies instead of any age value in the backend server response header.

URI Pattern to match the URIs that have content you want cached and served by FortiADC.
Be careful with matching patterns and the order rules in the list. Rules are consulted from
lowest rule ID to highest. The first rule that matches is applied.

Invalid URI Pattern to match URIs that trigger cache invalidation.

Be careful with matching patterns and the order rules in the list. Rules are consulted from
lowest rule ID to highest. The first rule that matches is applied.

This list has precence over the Dynamic Cache URI list. In other words, if a URI matches this
list, it is ineligible for caching, even if it also matches the Dynamic Cache URI list.

Using real server pools

This section includes the following topics:

» Configuring real server pools
o Example: Using port ranges and the port 0 configuration
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Configuring real server pools

Server pools are groups of real servers that host the applications that you load balance.
To configure a server pool:

1. Create a server pool object.
2. Add members.

Before you begin:

» You must have a good understanding and knowledge of the backend server boot behavior, for example, how many
seconds it takes to “warm up” after a restart before it can process traffic.

» You must know the IP address and port of the applications.

« If you want to select user-defined health checks, you must create them before creating the pool configuration. See
Configuring health checks.

« If you want to select user-defined real server SSL profiles, you must create them before creating the pool
configuration. See Configuring real server SSL profiles.

» You must have Read-Write permission for Load Balance settings.

After you have configured a real server pool, you can select it in the virtual server configuration.

To configure a real server pool:

1. Goto Server Load Balance > Real Server Pool.
The configuration page displays the Real Server tab.
2. Click Create New to display the configuration editor.
3. Configure the following settings for the Real Server Pool:

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You
reference this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Address Type e IPv4
e IPv6

Type Static
Dynamic

» Select "SDN Connector" which is created on "Global external connectors"
» Select "Service"

IP Address Type Select whether the SDN connector should get the private address or public address of the
instances.

Available only when Type is Dynamic and FortiADC is deployed on public cloud platforms.

Health Check Enable health checking for the pool. You can override this for individual servers in the
pool.
Health Check « AND—AII of the selected health checks must pass for the server to the considered
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Settings Guidelines
Relationship available.
¢« OR—One of the selected health checks must pass for the server to be considered
available.
Health Check List Select one or more health check configuration objects.

Real Server SSL
Profile

Select areal server SSL profile. Real server profiles determine settings for communication
between FortiADC and the backend real servers. The defaultis NONE, which is
applicable for non-SSL traffic.

4. Click Save to save the real server pool parent configuration.
The Member section becomes available to add real server pool member configurations.

5. Under the Member section, click Create to display the configuration editor.
6. Configure the following settings for the real server pool Member:

Settings Guidelines

Status

Real Server

Port

Weight

FortiADC 7.2.0 Handbook
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e Enable—The server can receive new sessions.

e Disable—The server does not receive new sessions and closes any current sessions
as soon as possible.

¢ Maintain—The server does not receive new sessions but maintains any current
connections.

Click the down arrow and select a real server configuration object from the list menu.
Note: The name of the selected real server pool member will appear in logs and reports.

Enter the backend server's listening port (number), as described below:

e HTTP—80,

e HTTPS —443

e FTP—21

e SMTP—25

» DNS—53

 POP3—110

o IMAP4—143

* RADIUS—1812

 SNMP—161
Tip: The system uses Port 0 as a “wildcard” port. When configured to use Port 0, the
system uses the destination port from the client request. For example, if you specify 0, and
the destination port in the client request is 50000, the traffic will be forwarded to Port
50000.

Assigns relative preference among members—higher values are more preferred and are
assigned connections more frequently. The defaultis 1. The valid range is 1 to 256.
All load balancing methods consider weight. Servers are dispatched requests proportional
to their weight, relative to the sum of all weights.
The following example shows the effect of weight on Round Robin:

e Sever A, Weight 2; Server B, Weight 1: Requests are sent AABAAB.

» Sever A, Weight 3; Server B, Weight 2: Requests are sent AABAB.
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Recover

Warm Up

Warm Rate
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For other methods, weight functions as a tie-breaker. For example, with the Least
Connection algorithm, requests are sent to the server with the least connections. If the
number of connections is equal, the request is sent to the server with the greater weight.
For example:

Server A, Weight 1, 1 connection
Server B, Weight 2, 1 connection
The next request is sent to Server B.

Seconds to postpone forwarding traffic after downtime, when a health check indicates that
this server has become available again. The default is O (disabled). The valid range is 1 to
86,400 seconds. After the recovery period elapses, the FortiADC assigns connections at
the warm rate.

Examples of when the server experiences a recovery and warm-up period:

A server is coming back online after the health check monitor detected it was down.
A network service is brought up before other daemons have finished initializing and
therefore the server is using more CPU and memory resources than when startup is
complete.

To avoid connection problems, specify the separate warm-up rate, recovery rate, or both.
Tip: During scheduled maintenance, you can also manually apply these limits by setting
Status to Maintenance instead of Enable.

Note: Not applicable for SIP servers.

If the server cannot initially handle full connection load when it begins to respond to health
checks (for example, if it begins to respond when startup is not fully complete), indicate
how long to forward traffic at a lesser rate. The defaultis O (disabled). The valid range is 1
to 86,400 seconds.

Note: Not applicable for SIP servers.

Maximum connection rate while the server is starting up. The default is 10 connections per
second. The valid range is 1 to 86,400 connections per second.

The warm up calibration is useful with servers that have the network service brought up
before other daemons have finished initializing. As the servers are brought online, CPU
and memory are more utilized than they are during normal operation. For these servers,
you define separate rates based on warm-up and recovery behavior. For example, if
Warm Up is 5 and Warm Rate is 2, the number of allowed new connections increases at
the following rate:

1st second—Total of 2 new connections allowed (0+2).
2nd second—2 new connections added for a total of 4 new connections allowed

(2+2).
3rd second—2 new connections added for a total of 6 new connections allowed
(4+2).
4th second—2 new connections added for a total of 8 new connections allowed
(6+2).

5th second—2 new connections added for a total of 10 new connections allowed
(8+2).

Note: Not applicable for SIP servers.
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Connection Limit Maximum number of concurrent connections to the backend server. The default is 0
(disabled). The valid range is 1 to 1,048,576 concurrent connections.

Note: Connection Limit is not supported for FTP or SIP servers.

Connection Rate Limit the number of new connections per second to this server. The default is 0 (disabled).
Limit The valid range is 1 to 86,400 connections per second.

In Layer 4 deployments, you can apply a connection rate limit per real server and per
virtual server. Both limits are enforced.

Note: The connection rate limit applies only when the real servers belong to a Layer 4
virtual server. If you add a real server pool with this setting configured to a Layer 7 virtual
server, for example, the setting is ignored.

Note: Connection Rate Limit is not supported for FTP or SIP servers.

Cookie Specify the cookie name to be used when cookie-based Layer 7 session persistence is
enabled. The cookie is used to create a FortiADC session ID, which enables the system to
forward subsequent related requests to the same backend server.

If you do not specify a cookie name, it is set to the pool member server name string.
Note: This option is NOT applicable for SIP servers.

MySQL Group ID Specify the MySQL group ID.
MySQL Read Only Disabled by default. Select the button to enable it.

Backup Designate this as a backup server to which FortiADC will direct traffic when the other
servers in the pool are down. The backup server receives connections when all the other
pool members fail the health check or you have manually disabled them.

Note: Not applicable for SIP servers.

Health Check Inherit When enabled, FortiADC will use the pool's health check settings. If disabled, you must
select a health check to use with this individual backend server. See below.

Health Check Select this option to specify a health check configuration object for this server.
Note: This option becomes available only when

Health Check « AND—AII of the selected health checks must pass for the server to the considered
Relationship available.
¢« OR—One of the selected health checks must pass for the server to be considered
available.
Health Check List Select one or more health check configuration objects. Shift-click to select multiple objects

at the same time.

RS Profile Inherit Enable to inherit the real server SSL profile from the pool configuration. Disable to specify
the real server profile in this member configuration. See below.

RS Profile If RS Profile Inherit (above) is disabled, you must specify a real server SSL profile. A real
server SSL profile determines the settings for communication between FortiADC and
backend real server.
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Note: This option becomes available only when RS Profile Inherit is disabled.

Proxy Protocol This is a protocol of application layer, which is located upper layer of HTTP and SSL, and
it contains a head to description the real IP address of client. There two major version of
this protocol v1 and v2.

Support none, v1, v2. None will disable this function and it's the default value, v1 and v2 is
different version of this protocol, the v1 version is human readable.

You need co-deployment with FortiWeb, and because X-Forword-For option isn’t valid for
them they demand use proxy protocol to deliver the real client’s IP address to them.

Only support : HTTP/HTTPS/TCPS/RDP, Either L7 and L2 VS of these type can support
it.

Modify Host Enable to allow FortiADC to modify the HTTP header according to the "host" field of the
real server. This is disabled by default.

Host The Host option is available if Modify Host is enabled.
Specify the host as a string. This field cannot be left empty. The input validation regex is
([0-9A-Za-z+/2%S#&\=.: —-1I\[|])+$, maximum of 255 characters. The default

value is host.

7. Click Save.
The newly created real server pool member is listed under the Member section.

Example: Using port ranges and the port 0 configuration

In some deployments, it is advantageous to support listening port ranges for client requests. For example, data centers
or web hosting companies sometimes use port numbers to identify their customers. Client A sends requests to port
50000, client B to port 50001, client C to port 50002, and so on.

To support this scenario:

1. Onthe real servers, configure the listening ports and port ranges according to your requirements.

2. Onthe FortiADC, when you configure the real server pool member, specify port O for the port. The system handles
port 0 as a “wildcard” port. When configured to use port 0, the system uses the destination port from the client
request. For example, if you specify 0, and the destination port in the client request is 50000, the traffic is forwarded
to port 50000.

3. When you configure the virtual server, specify a listening port and port range. The port range is like an offset. If the
specified port is 50000 and the port range is 10, the virtual server listens on ports 50000-50009.

Key FortiADC configuration elements
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= \irtual Server

Basic General Monitoring

Configuration

Address
10.125.2.16

Example: 192.0.2.1

Interface

port2

Resources

Profile

DNS

Real Server Pool

dns

Method

LB_METHOD_ROUND_ROBIN -

Cancel

FortiADC 7.2.0 Handbook
Fortinet Inc.

163



Chapter 4: Server Load Balancing

Virtual Server

m Security Monitoring

Configuration

10.125.2.16
Address
Example: 192.0.2.1
53
Port Default: 80 Range: 0 or 1-65535. You can specify up to eight ports or port ranges separated by space,
e.g., 80-90 100. Valid values are from 0 to 45535, with O for Layer-4 virtual servers only.
Interface port2 hd
Resources
Profile DNS hd
Method LBE_METHOD _ROUND_ROBIN -
Real Server Pool dns hd
FortiGSLE
Public IP Type IPv4
Public IPv4 i
Example: 192.0.2.1
One Click G5LB Server »

Note: Ports shown on the Dashboard > Virtual Server > Real Server page are for the configured port, so in this case, port
0. The ports shown in traffic logs are the actual destination port, so in this case, port 50000.

Note: The real-server port must be 0 or the same as the virtual server port for Layer-4 virtual servers in tunnel mode.

Configuring real servers

Real servers are physical servers that are used to form real server pools. These dedicated servers provide clients with
services such as HTTP or XML content, streaming audio or video, TFTP/FTP uploads and downloads, etc. You can start
configuring a real server by giving it a unique configuration name, setting its status, and specifying its IP address.

After you have created your real server configuration objects, you can select them as members to form real server pools.
At that stage, further configurations are needed as discussed in Configuring real server pools on page 1.

To configure a real server configuration object:

1. Goto Server Load Balance > Real Server Pool > Real Server.
2. Click Create New to display the configuration editor.
3. Complete the configuration and add members as described in Real Server configuration on page 165.
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4. Click Save.
5. Repeat the same steps to add as many real server configuration objects as needed.

Real Server configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You
reference this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Server Type Static
Dynamic
¢ Select "SDN Connector" which is created on "Global external connectors". See
External connectors for more information.
» Select "Service".

Status Select one of the options:
* Enable—The server can receive new sessions.
e Disable—The server does not receive new sessions and closes any current
sessions as soon as possible.
* Maintain—The server does not receive new sessions but maintains any current
connections.

Address For IPv4 real server, enter the real server's IP address in IPv4 address format.
Address6 For IPv6 real server, enter the real server's IP address in IPv6 address format.
FQDN A fully qualified domain name, such as "www.example.com"

Note: The instructions above only covers the basic configuration of real servers. More configuration tasks are needed
when you use them to form real server pools.

Configuring real server SSL profiles

A real server SSL profile determines settings used in network communication on the FortiADC-server segment, in
contrast to a virtual server profile, which determines the settings used in network communication on the client-FortiADC
segment.

SSL profiles on page 165 illustrates the basic idea of client-side and server-side profiles.

SSL profiles
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Predefined real server profiles on page 167 provides a summary of the predefined profiles. You can select predefined
profiles in the real server pool configuration, or you can create user-defined profiles.
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Predefined real server profiles

Profile Defaults

LB_RS_SSL_PROF_DEFAULT

LB_RS_SSL_PROF_ECDSA

LB_RS_SSL_PROF_ECDSA
SSLV3

LB_RS_SSL_PROF_ECDSA _
TLS12

LB_RS_SSL_PROF_ENULL

LB_RS_SSL_PROF_HIGH

LB_RS_SSL_PROF_LOW_
SSLV3

LB_RS_SSL_PROF_MEDIUM

FortiADC 7.2.0 Handbook
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Allow version: SSLv3, TLSv1.0, TLSv1.1, TLSv1.2, TLSv1.3
Cipher suite list: custom

Allow version: SSLv3, TLSv1.0, TLSv1.1, and TLSv1.2

Cipher suite list: ECDHE-ECDSA-AES256-GCM-SHA384,
ECDHE-ECDSA-AES256-SHA384, ECDHE-ECDSA-AES256-
SHA, ECDHE-ECDSA-AES128-GCM-SHA256,ECDHE-
ECDSA-AES128-SHA256,ECDHE-ECDSA-AES128-
SHA,ECDHE-ECDSA-RC4-SHA ECDHE-ECDSA-DES-
CBC3-SHA,

Allow version: SSLv3

Cipher suite list: ECDHE-ECDSA-AES256-SHA, ECDHE-
ECDSA-AES128-SHA ECDHE-ECDSA-RC4-SHA ,ECDHE-
ECDSA-DES-CBC3-SHA,

Allow version: TLSv1.2

Cipher suite list: ECDHE-ECDSA-AES256-GCM-SHA384,
ECDHE-ECDSA-AES256-SHA384, ECDHE-ECDSA-AES128-
GCM-SHA256,ECDHE-ECDSA-AES128-SHA256,

Allow version: SSLv3, TLSv1.0, TLSv1.1, and TLSv1.2
Cipher suite list: eNull

Recommended for Microsoft Direct Access servers where the
application data is already encrypted and no more encryption is
needed.

Allow version TLSv1.2

Cipher suite list: ECDHE-RSA-AES256-GCM-SHA384
ECDHE-RSA-AES256-SHA384 ECDHE-RSA-AES256-SHA
DHE-RSA-AES256-GCM-SHA384 DHE-RSA-AES256-
SHA256 AES256-GCM-SHA384 AES256-SHA256,

Allow version SSLv3

Cipher suite list: DHE-RSA-AES128-GCM-SHA256 DHE-
RSA-AES128-SHA256 DHE-RSA-AES128-SHA AES128-
GCM-SHA256 AES128-SHA256 AES128-SHA ECDHE-RSA-
RC4-SHA RC4-MD5 ECDHE-RSA-DES-CBC3-SHA EDH-
RSA-DES-CBC3-SHA DES-CBC3-SHA EDH-RSA-DES-CBC-
SHA DES-CBC-SHA

Allow version: TLSv1.0, TLSv1.1, and TLSv1.2

Cipher suite list: ECDHE-RSA-AES128-GCM-SHA256
ECDHE-RSA-AES128-SHA256 ECDHE-RSA-AES128-SHA
DHE-RSA-AES128-GCM-SHA256 DHE-RSA-AES128-
SHA256 DHE-RSA-AES128-SHA AES128-GCM-SHA256
AES128-SHA256 AES128-SHA RC4-SHA EDH-RSA-DES-
CBC3-SHA DES-CBC3-SHA
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Profile Defaults

NONE * SSLis disabled.

Before you begin:

¢ You must have Read-Write permission for Load Balance settings.

To configure custom real server profiles:

Go to Server Load Balance > Real Server Pool.

Click the Server SSL tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Real Server SSL Profile configuration guidelines on page 168.
Save the configuration.

o obd-=

Ny You can clone a predefined configuration object to help you get started with a user-defined

- » configuration.
9 &2

To clone a configuration object, click the clone icon
the configuration summary page.

that appears in the tools column on

Real Server SSL Profile configuration guidelines

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You
reference this name in the real server pool configuration.
Note: After you initially save the configuration, you cannot edit the name.
SSL Enable/disable SSL for the connection between the FortiADC and the real server.
Note: The following fields become available only when SSL is enabled. See above.

Customized SSL Ciphers Enable/disable use of user-specified cipher suites. When enabled, you must select a

Flag Customized SSL Cipher. See below.
Customized SSL Ciphers If the customize cipher flag is enabled, specify a colon-separated, ordered list of cipher
suites.

An empty string is allowed. If empty, the default cipher suite list is used.

The names you enter are validated against the form of the cipher suite short names
published on the OpenSSL website:

https://www.openssl.org/docs/manprimary/apps/ciphers.html
SSL Cipher Suite List Ciphers are listed from strongest to weakest:

» ECDHE-ECDSA-AES256-GCM-SHA384
» ECDHE-ECDSA-AES256-SHA384
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o ECDHE-ECDSA-CAMELLIA256-SHA384
* *ECDHE-ECDSA-AES256-SHA
 ECDHE-ECDSA-AES128-GCM-SHA256
» *ECDHE-ECDSA-AES128-SHA256

» ECDHE-ECDSA-CAMELLIA128-SHA256
e *ECDHE-ECDSA-AES128-SHA

» ECDHE-ECDSA-DES-CBC3-SHA

» ECDHE-ECDSA-RC4-SHA
 ECDHE-RSA-AES256-GCM-SHA384
 ECDHE-RSA-AES256-SHA384

» ECDHE-RSA-CAMELLIA256-SHA384
e *ECDHE-RSA-AES256-SHA

e DHE-RSA-AES256-GCM-SHA384

» *DHE-RSA-AES256-SHA256

» DHE-RSA-CAMELLIA256-SHA256

e *DHE-RSA-AES256-SHA

» DHE-RSA-CAMELLIA256-SHA

* AES256-GCM-SHA384

* *AES256-SHA256

» *AES256-SHA

» ECDHE-RSA-AES128-GCM-SHA256

* *ECDHE-RSA-AES128-SHA256
 ECDHE-RSA-CAMELLIA128-SHA256

» *ECDHE-RSA-AES128-SHA

e DHE-RSA-AES128-GCM-SHA256

e *DHE-RSA-AES128-SHA256

» DHE-RSA-CAMELLIA128-SHA256

e *DHE-RSA-AES128-SHA

* AES128-GCM-SHA256

» *AES128-SHA256

» *AES128-SHA
 ECDHE-RSA-RC4-SHA

¢ RC4-SHA

* RC4-MD5

» ECDHE-RSA-DES-CBC3-SHA

« EDH-RSA-DES-CBC3-SHA

» DES-CBC3-SHA

» EDH-RSA-DES-CBC-SHA

» DES-CBC-SHA

* eNULL

*These ciphers are fully supported by hardware SSL (in 400F, 1200F, 2200F, 4200F
and 5000F).

Note: We recommend retaining the default list. If necessary, you can deselect the SSL
ciphers that you do not want to support.
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TLSv1.3 Cipher Suite List TLSv1.3 ciphers are listed as following:
» TLS_AES 256_GCM_SHA384
e« TLS AES_128 GCM_SHA256
e TLS CHACHA20 POLY1305 SHA256
 TLS_AES 128 _CCM_SHA256
 TLS_AES 128 CCM_8_SHA256
Note: This option only available if the TLSv1.3 is checked.

Allowed SSL Versions You have the following options:

e SSLv3

e TLSv1.0

e TLSv1A1

e TLSV1.2

e TLSv1.3

Note:

« Please make sure that the SSL version is continuous. If not, an error message
should be returned.

¢ RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply is
enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an error
message will display.

Certificate Verify Specify a Certificate Verify configuration object to validate server certificates. This
Certificate Verify object must include a CA group and may include OCSP and CRL
checks.

SNI Forward Flag Enable/disable forwarding the client SNI value to the server. The SNI value will be

forwarded to the real server only when the client-side ClientHello message contains a
valid SNI value; otherwise, nothing is forwarded.

Session Reuse Flag Enable/disable SSL session reuse.

Session Reuse Limit The defaultis 0 (disabled). The valid range is 0-1048576.

TLS Ticket Flag Enable/disable TLS ticket-based session reuse.

Renegotiation This option controls how FortiADC responds to mid-stream SSL reconnection requests
either initiated by real servers or forced by FortiADC.
Note:

e This option is enabled by default.
e When disabled, you must select an option for Renegotiation-Deny-Action.

Renegotiation Period Specify the interval from the initial connect time that FortiADC renegotiates an SSL
session. The unit of measurement can be second (default), minute, or hour, e.g., 100s,
20m, or 1h.

Note:
* The defaultis 0, which disables the function.
 [facustom value is set, FortiADC will renegotiate the SSL session accordingly. For
example, if you set the renegotiate period to 3600s (or 3600, 60m, or 1h), FortiADC
will renegotiate the SSL session at least once an hour.
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Renegotiate Size Specify the amount (in MB) of application data that must have been transmitted over the
secure connection before FortiADC initiates the renegotiation of an SSL session.

Note: The default is 0, which disables the function.

Secure Renegotiation Select one of the following options:

¢ Request—FortiADC requests secure renegotiation of SSL connections.

e Require—FortiADC requires secure renegotiation of SSL connections. In this
mode, FortiADC allows initial SSL handshakes from real servers, but terminates
renegotiation from real servers that do not support secure renegotiation.

¢ Require Strict—FortiADC requires strict secure renegotiation of SSL connections.
In this mode, FortiADC denies initial SSL handshakes from real servers that do not
support secure renegotiation.

Renegotiation-Deny-Action  This option becomes available when Renegotiation is disabled on the server side. In
that case, you must select an action that FortiADC will take when denying an SSL
renegotiation request:

* Ignore (default)—Ignores SSL renegotiation requests.
* Terminate— Terminates SSL connections.

RFC 7919 Comply Enable/disable parameters to comply with RFC 7919.

Note: RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply is
enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an error
message will display.

Supported Groups The Supported Groups option is available if RFC 7919 Comply is enabled.
Specify the supported group objects from the following:
e secp256r1
e secp384r1
e secp521r1
e x25519
o x448
« ffdhe2048
» ffdhe3072
» ffdhe4096
» ffdhe6144
o ffdhe8192
At least one item from the FFDHE group must be selected.
Note:
The RFC 7919 Comply feature requires certain cipher selections to correspond with the
Supported Group selection.

« Ifa FFDHE group is selected (for example, ffdhe2048), then at least one cipher
must be DHE-RSA (for example, DHE-RSA-AES256-SHA256).

« If the Supported Group includes groups other than FFDHE (such as a SECP group,
secp256r1), then at least one cipher must be ECDHE (for example, ECDHE-
ECDSA-AES256-GCM-SHA384).
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« |fa ECDHE cipher is selected (for example, ECDHE-ECDSA-AES256-GCM-
SHA384), then the Supported Group must include at least one group that is not
FFDHE (such as a SECP group, secp256r1).

Using HTTP scripting

Enable scripting for Layer 2 and Layer 7 HTTP/HTTPS virtual servers to perform actions that are not supported by the
current built-in feature set. You can import HTTP scripts from the GUI, Server Load Balance > Scripting > HTTP tab.
To get you started, FortiADC provides system predefined HTTP scripts that can be cloned for customization. The HTTP
scripts are event-triggered, allowing you to manipulate HTTP requests and responses, redirection, and dynamically
change backend routing. This functionality can be combined with other HTTP related functions such as WAF, SSL, and
Authentication.

FortiADC HTTP scripts are based on Lua 5.3.

]
\-\ ’.- FortiADC does not support all Lua functions. For the full list of supported functions, see
9 Appendix C: Scripts on page 748. The Appendix C: Scripts page also provides the supported
- list of events and predefined commands.

This section includes the following:

» Create a script object on page 172

e Import a script on page 173

o Export a script on page 173

o Delete a scripton page 173

o Predefined HTTP scripts on page 173
o Multi-script support on page 179

Create a script object

To create a script configuration object:

Go to Server Load Balance > Scripting.

Click the HTTP tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Script configuration on page 172.
Save the configuration.

o wDb =

Script configuration

Settings Guidelines

Name Unique group name. Valid characters are A-Z, a-z, 0-9, , and -. No spaces.
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After you initially save the configuration, you cannot edit the name.

Input Type or paste the script.

Note: If you want the script to be part of a big multiple script and have it executed in a certain
order, be sure to set its priority. For more information, see Support for multiple scripts.

Import a script

To import a script:

1. Click Import
2. Click Choose File to browse for the script file.
3. Click Save.

Export a script

To export a script:

1. Select the script of interest.
2. Click Export.

Delete a script

To delete a script:

1. Select the script of interest.
2. Click Delete.

Predefined HTTP scripts

You can view and use predefined HTTP scripts by going to Server Load Balance > Scripting > HTTP.

Scripts and predefined commands on page 173 highlights the functions of these scripts and commands and shows how
to use them.

Scripts and predefined commands
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RULE INIT IP_COMMAMNDS and
- MAMNAGEMENT_COPMANDS are available in
all events except for RULE_INIT.
L 4

Use TCE: reject to close the connection.
TCP_ACCEPTED See TCP_EVENTS_n_COMMANDS. TCP_CLOSED

3

| CLIEMTS5L_RENEGOTIATE | ‘ SERVERSSL_RENEGOTIATE |

h

Fetch 55L-related information, such as D
CLIENTSSL_HAMDSHAKE — HTTP_RESPONSE_DATA
o

<“— client’s certificate info, session 1D, SMI,
etc. See 551 EVENTS n COMMRNDS.

¥

# Use HTTP:collect command to :

HTTP_REQUEST trigger HTTP data collection. HTTP_RESPONSE
* Use cookie commands to manipulate

cookies. See COOEIE COMMRNDS. b

Use HITE:pavload command to
manipulate HTTP data.

-
[ HTTP_REQUEST_DATA SERVERSSL_HANDSHAKE }

L

Note:

e UTILITY_FUNCTIONS_DEMO and CLASS_SEARCH_n_MATCH provide various utility commands.

e MULTIPLE_SCRIPT_CONTROL_DEMO_1 and MULTIPLE_SCRIPT_CONTROL_DEMO_2 show how to use
multiple-script support.

o« HTTP_DATA_FIND_REMOVE_REPLACE_DEMO and HTTP_DATA_FETCH_SET_DEMO show how to
manipulate HTTP data.

o« SPECIAL_CHARACTERS_HANDLING_DEMO shows how to handle certain special characters.
o INSERT_RANDOM_MESSAGE_ID_DEMO shows how to generate random message IDs.

e OPTIONAL_CLIENT_AUTHENTICATION shows how to perform optional client authentication based on a request
URL.

« COMPARE_IP_ADDR_2_ADDR_GROUP_DEMO shows how to perform IP address match.

o« USE_REQUEST_HEADERS_in_OTHER_EVENTS shows how to share information across events.

« Many more predefined scripts are provided for load balance content routing, HTTP redirection, and HTTP content
rewriting.

The following table lists the FortiADC predefined scripts available for users to apply and customize.
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Predefined script Usage

AES_DIGEST_SIGN_2F COMMANDS Demonstrate how to use AES to encryption/decryption data
and some tools to generate the digest.

AUTH_COOKIE_BAKE Allows you to retrieve the baked cookie and edit the cookie
content.

AUTH_EVENTS_n_COMMANDS Used to get the information from authentication process.

CLASS _SEARCH _n_MATCH Demonstrates how to use the class match andclass
search utility function.

COMPARE_IP_ADDR_2_ADDR_ Compares an IP address to an address group to determine if

GROUP_DEMO the IP address is included in the specified IP group. For

example ,192.168.1.2 is included in 192.168.1.0/24.

Note: Do NOT use this script "as is". Instead, copy it and
customize the IP address and the IP address group.

CONTENT_ROUTING_by URI Routes to a pool member based on URI string matches. You
should not use this script as is. Instead, copy it and customize
the URI string matches and pool member names.

CONTENT_ROUTING_by X Routes to a pool member based on IP address in the X-

FORWARDED_FOR Forwarded-For header. You should not use this script as is.
Instead, copy it and customize the X-Fowarded-For header
values and pool member names.

COOKIE_COMMANDS Demonstrate the cookie command to get the whole cookie in a
table and how to remove/insert/set the cookie attribute.

COOKIE_COMMANDS USAGE Demonstrate the sub-function to handle the cookie attribute
"SameSite" and others.

COOKIE_CRYPTO_COMMANDS Used to perform cookie encryption/decryption on behalf of the
real server.

CUSTOMIZE_AUTH_KEY Demonstrate how to customize the crypto key for
authentication cookie.

GENERAL_REDIRECT_DEMO Redirects requests to a URL with user-defined code and
cookie.

Note: Do NOT use this script "as is". Instead, copy and
customize the code, URL, and cookie.

GEOIP_UTILITY Used to fetch the GEO information country and possible
province name of an IP address.
HTTP_2 HTTPS_REDIRECTION Redirects requests to the HTTPS site. You can use this script
without changes.
HTTP_2 HTTPS_REDIRECTION _ Redirects requests to the specified HTTPS URL.
FULL_URL Note: This script can be used directly, without making any
change.
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Predefined script Usage

HTTP_DATA FETCH_SET DEMO Collects data in HTTP request body or HTTP response body.
In HITP_REQUEST or HTTP_RESPONSE, you could collect
specified size data with “size” in collect () .In HTTP_
DATA REQUEST orHTTP_DATA RESPONSE. You could print
the datause “content”, calculate data length with
“size”, and rewrite the data with “set”.

Note: Do NOT use this script "as is". Instead, copy it and
manipulate the collected data.

HTTP_DATA_FIND_REMOVE_ Finds a specified string, removes a specified string, or
REPLACE_DEMO replaces a specified string to new content in HTTP data.

Note: Do NOT use this script "as is". Instead, copy it and
manipulate the collected data.

INSERT_RANDOM_MESSAGE_ID_ Inserts a 32-bit hex string into the HTTP header with a
DEMO parameter “Message-ID”.
Note: You can use the script directly, without making any
change.
IP_COMMANDS Used to get various types IP Address and port number
between client and server side.
MANAGEMENT_COMMANDS Allow you to disable/enable rest of the events from executing.
MULTIPLE_SCRIPT_CONTROL_ Uses demo 1 and demo_2 script to show how multiple scripts
DEMO_1 work. Demo_1 with priority 12 has a higher priority.

Note: You could enable or disable other events. Do NOT use
this script "as is". Instead, copy it and customize the operation.

MULTIPLE_SCRIPT_CONTROL_ Uses demo 1 and demo_2 script to show how multiple

DEMO_2 scripts work. Demo_ 2 with priority 24 has a lower priority.
Note: You could enable or disable other events. Do NOT use
this script "as is". Instead, copy it and customize the operation.

OPTIONAL_CLIENT _ Performs optional client authentication.
AUTHENTICATION Note: Before using this script, you must have the following four
parameters configured in the client-ssl-profile:
« client-certificate-verify—Set to the verify you'd like to use
to verify the client certificate.
« client-certificate-verify-option—Set to optional
* ssl-session-cache-flag—Disable.
 use-tls-tickets—Disable.

PERSIST_COMMANDS Demonstrates how to use persist commands and event. Event
PERSISTENCE is triggered when FADC receive the HTTP
REQ and ready to dispatch to real server.

You can set the entry in PERSISTENCE, then look up it in
POST_PERSIST.
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Predefined script Usage

FADC will dispatch to dedicate server according to your entry
set in PERSISTENCE if this session haven't assign real server
before.

RAM_CACHING_COMMANDS Demonstrate how to use script to do RAM caching.
FADC script allows user to control RAM caching behaviors
and check the caching status.
Note: make sure RAM caching configuration is selected in
HTTP or HTTPS profile.

RAM_CACHING_DYNAMIC Demonstrate how to use script to do dynamic RAM caching.

Note: Dynamic caching is identified by a configured ID. Make
sure RAM caching configuration is selected in HTTP or
HTTPS profile.

RAM_CACHING_GROUPING Demonstrate how to create multiple variations based on client
IP address. The sort of grouping applies to both regular
caching and dynamic caching.

Note: make sure RAM caching configuration is selected in
HTTP or HTTPS profile.

REDIRECTION_by STATUS_CODE Redirects requests based on the status code of server HTTP
response (for example, a redirect to the mobile version of a
site). Do NOT use this script "as is". Instead, copy it and
customize the condition in the server HTTP response status
code and the URL values.

REDIRECTION_by USER_AGENT Redirects requests based on User Agent (for example, a
redirect to the mobile version of a site). You should not use this
script as is. Instead, copy it and customize the User Agent and
URL values.

REWRITE_HOST_n_PATH Rewrites the host and path in the HTTP request, for example,
if the site is reorganized. You should not use this script as is.
Instead, copy it and customize the "old" and "new" hostnames

and paths.
REWRITE_HTTP_2 HTTPS in_ Rewrites HTTP location to HTTPS, for example, rewrite
LOCATION “Location:http://www.example.com” to

“Location:https://www.example.com” .

Note: You can use the script directly, without making any

change.
REWRITE_HTTP_2 HTTPS in_ Rewrites HTTP referer to HTTPS, for example, rewrite
REFERER “Referer: http://www.example.com” to

“Referer: https://www.example.com”.

Note: You can use the script directly, without making any
change.
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Predefined script Usage
REWRITE_HTTPS 2 HTTP_in_ Rewrites HTTPS location to HTTP, for example, rewrite
LOCATION “Location:https://www.example.com” to

“Location:http://www.example.com”.

Note: You can use the script directly, without making any

change.
REWRITE_HTTPS_2 HTTP_in_ Rewrites HTTPS referer to HTTP, for example, rewrite
REFERER “Referer: https://www.example.com” to

“Referer: http://www.example.com”.

Note: You can use the script directly, without making any
change.

SNAT_COMMANDS Allows you to overwrite client source address to a specific IP
for certain clients, also support IPv4tolPv6 or IPv6tolPv4 type.
Note: Make sure the flag SOURCE ADDRESS is selected in
the HTTP or HTTPS type of profile.

SOCKOPT_COMMAND_USAGE Allows user to customize the TCP_send bufferand TCP_
receive buffer size.

SPECIAL_CHARACTERS _ Shows how to use those "magic characters" which have

HANDLING_DEMO special meanings when used in a certain pattern. The magic
charactersare (). % +-*?[]"$

SSL_EVENTS_n_COMMANDS Demonstrate how to fetch the SSL certificate information and
some of the SSL connection parameters between server and
client side.

TCP_EVENTS_n_COMMANDS Demonstrate how to reject a TCP connection from a client in

TCP_ACCEPTED event.

TWO_STEP_VERIFICATION Demonstrate how to perform 2-Step Verification using
FortiToken. One needs have authentication policy configured
and selected in a virtual-server.

TWO_STEP_VERIFICATION_2_ NEW Demonstrate how to perform 2-Step Verification using
FortiToken for the second authentication group.

TWO_STEP_VERIFICATION_2_SAME Demonstrate how to perform 2-Step Verification for the
second authentication group using the same token group.

TWO_STEP_VERIFICATION_ Demonstrate how to change the AES key and its size for

CHANGE_KEY stored token group.

URL_UTILITY_COMMANDS Demonstrate how to use those url tools to
encode/decode/parser/compare.

USE_REQUEST_HEADERS in_ Stores a request header value in an event and uses it in other

OTHER_EVENTS events. For example, you can store a URL in a request event,

and use it in a response event.
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Predefined script Usage

Note: Do NOT use this script "as is". Instead, copy it and
customize the content you want to store, use collect () in
HTTP_REQUEST to trigger HITP_DATA REQUEST,Or use
collect () in HTTP_ RESPONSE to trigger H-TTP DATA
RESPONSE.

UTILITY_FUNCTIONS_DEMO Demonstrates how to use the basic string operations and
random number/alphabet, time, MD5, SHA1, SHA2, BASE64,
BASE32, table to string conversion, network to host
conversion utility function

Commands

AUTH_EVENTS_n_COMMANDS Lists the auth event and commands

COOKIE_COMMANDS Lists the two cookie commands and shows how to use them.

IP_COMMANDS Lists the IP commands and shows how to use them.

MANAGEMENT_COMMANDS Lists the management commands and shows how to use
them.

PERSIST_COMMANDS Lists the persist event and commands

RAM_CACHING_COMMANDS Lists the RAM caching event and commands

SSL_EVENTS_n_COMMANDS Lists the SSL events and commands.

TCP_EVENTS_n_COMMANDS Lists the TCP events and commands.

Multi-script support

Linking multiple scripts to the same virtual server

FortiADC supports the use of a single script file containing multiple scripts and applies them to a single virtual serverin
one execution. Different scripts can contain the same event. You can specify the priority for each event in each script file
to control the sequence in which multiple scripts are executed or let the system to execute the individual scripts in the
order they are presented in the multi-script file.

For the current release, you can add up to 16 individual scripts to create a big multi-script file.

If you'd like to, you can disable the processing of the rest of the scripts (e.g., you can disable the processing of the
remaining scripts in the list in a script), and even totally disable the processing of a certain event (e.g., you can disable
processing the HTTP RESPONSE eventin a HTTP REQUEST script). FortiADC also supports multiple calls of
HTTP:redirect(), HTTP:redirect_with_cookie(), LB:routing(), and HTTP:close() functions such that the final one prevails.

In practice, rather than building one big complicated script containing all the required logic, it might be more useful to
break it down into smaller functional pieces in the form of individual scripts. This is because executing multiple scripts at
the same time is more efficient than running them separately, one at a time. Also, breaking down a giant script into
multiple small individual scripts makes it more flexible to apply scripts to different virtual servers because some virtual
servers may use some of the scripts while others may use them all. With the small individual scripts at hand, you can
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simply pick and choose only the scripts you need to assemble a big multi-script file with a set priority for each script and
apply them all at once to a virtual server.

Apply multiple scripts on page 180 shows how to link multiple scripts to a single virtual server from the GUI.

Apply multiple scripts
Scripting List Selected [temn Available ltem
HTTP_Z_HTTF>_REDIRECTION SPECIAL_CHARACTERS_HANDLING_DEM
HTTP_2_HTTPS_REDIRECTICOM_FULL_URL $ o
REWRITE_HTTP_2_HTTPS in LOCATION REDIRECTIOMN by USER_AGENT
REWRITE_HTTF_2_HTTPS_in_REFERER > REWRITE_HTTPS_2_HTTP_in_REFERER
-
Double-click to deselect. Drag to rearder. Daouble-click to select.

Setting script priority

Priority in a multi-script is optional, but is highly recommended. When executing a big multiple-script file, care must be
taken to avoid conflicting commands among the scripts. You can set the priority for each script using the script editor on
FortiADC's GUI. Valid values range from 1 to 1,000, with 500 being the default. The smaller the value, the higher the
priority. Below is an example script with a set priority:

when HTTP_ REQUEST priority 100 {

LB:routing (“crl”)

}

To display the priority info in the GUI, you can define one and only one event in each
script file, as shown below:

Script 1:

when HTTP REQUEST priority 500 {

LB:routing (“crl”)

}

Script 2:

when HTTP RESPONSE priority 500 {

HTTP:close ()

}

Script 3:

when HTTP REQUEST priority 400 {

LB:routing (“cr2”)

}

Script 4:

when HTTP RESPONSE priority 600 {

HTTP:close ()

}

Individual script files are loaded separately into the Lua stack. A numeric value (starting from 1) is appended to each
event (e.g., for HTTP_REQUEST event, there are functions HTTP_REQUST1, HTTP_REQUEST2, and so on so forth).

To support multiple scripts, FortiADC:

» Supports multiple calls of redirect/routing/close function, making them re-entrant so that the final one prevails. For
that purpose, the system checks the behavior of multiple calls across redirect (), close(), and routing
().lfredirect () comesfirst, followed by close (), then close () prevails. If close () comes first, followed
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by redirect (), then redirect () prevails. If you wantto close (), you must disable the event after close ().

« Allows enabling or disabling events. There are times when you may want to disable the processing of the remaining
scripts while a multi-script file is being executed, or want to disable processing the response completely. The
mechanism serves that purpose.

« Allows enabling or disabling automatic event-enabling behavior. In the HTTP keep-alive mode, the system by
default re-enables HTTP REQUEST and HTTP RESPONSE processing for the next transaction (even if they are
disabled in the current transaction using the above enable or disable event mechanism). Now you can disable or
enable this automatic enabling behavior.

Script priority on page 181 shows a sample multi-script with priority information.

Script priority
Name MULTIPLE_SCRIPT_CONTROL DEMO 1
1 when RULE_IMIT priority 14 {
2 --This is one of the script to demo the control of multiple scripts
3 --please change the priority of each event according to your need
4 debug("IMIT in script 1'n");
5 ¥
o]
7 when HTTP_REQUEST priority 12 {
8 debug("HTTP_REQUEST in script 1'\n");
9 --add your own manipulation here
10
11 --you can disable rest of the HTTP_REQUEST events from executing
12 --by disabling this event
13 ={}
14 t["event”]="req"; — can be "req", "res", "data_req", and "data_res
15 t"operation"]="disable"; -- can be "enable”, and "disable’
16 HTTP:set_event(t);
17 debug("disable rest of the HTTP_REQUEST events in script 1\n");
18 --you can also disable other events, say HTTP_RESPONSE, data events
19
2 --in the case of keep-alive, all events will be re-enabled automatically
2 --even though they are disabled in previous TRANSACTION using the
22 —-HTTP:ser_svent(t) command. To disable this automatic re-enabling
23 --behavior, you can call HTTP:set_auto(t) as below
24 =0 i
25 t["event’]="req"; — can be "req", "res", "data_req", and "data_res P

Compiling principles

« Allindividual scripts should be pre-compiled when they are linked to a virtual server, where they can be combined
into one big multi-script.

» For the same event, combine the commands in different scripts according to their priorities and orders.

» For commands of different priorities, FortiADC processes the high-priority commands first, and then the low-priority
ones; for commands of the same priority, it processes them in the order they appear in the combined script.

« And if you are using multiple scripts with overlapping events for bidirectional traffic, you must ensure that the
response traffic traverses the overlapping events in the expected order. By default, the scripts applied to the same
virtual server will run in the order in which they are applied, regardless of the direction of traffic flow.
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» For a specified event, you must make sure to avoid the conflict commands in different scripts. For example, if you
have multiple scripts applied to the same virtual server and the scripts contain both request and response logic, the
default execution order is like this:

Rule #1 HTTP_REQUEST HTTP_RESPONSE

Rule #2 HTTP_REQUEST HTTP_RESPONSE

but NOT like this:

Rule #1 HTTP_REQUEST HTTP_RESPONSE

Rule #2 HTTP REQUEST HTTP_RESPONSE

As shown above, FortiADC cannot control the order in which events in the scripts are executed. The only way to enforce
the execution order for response traffic is to use the event priority command, as we have discussed above. When setting
the priorities, pay special attention to both request and response flows.

Special notes

When using the multi-script feature, keep the following in mind:

e The multi-script feature is supported on all FortiADC hardware platforms.

Currently, the feature can be applied to layer-2 and Layer-7 virtual servers on HTTP/HTTPS protocol only.
 Scripts are VDOM-specific, and cannot be shared among different VDOMSs.

« Session tables set up using scripts must be synced through high-availability (HA) configuration.

« Each multi-script script can contain up to 256 individual scripts, each being no more than 32 kilobytes.

Configuring an L2 exception list

In some jurisdictions, SSL interception and decryption is disfavored for some types of websites or disallowed entirely.
You use the L2 Exception List configuration to define such destinations. You can leverage FortiGuard web filter
categories, and you can configure a list of additional destinations.

Before you begin:

» You must have created a Web Filter Profile configuration that includes the web categories to exclude from SSL
decryption.

« You must have hostname or IP address details on additional destinations you want to exclude from SSL decryption.

» You must have Read-Write permission for Load Balance settings.
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After you have created an L2 exception list configuration object, you can select it in a Layer 2 virtual server configuration.

To configure an exception list:

Go to Server Load Balance > SSL-FP Resources.

Click the L2 Exception List tab.

Click Create New to display the configuration editor.

Complete the configuration as described in L2 exception list configuration on page 183.
Save the configuration.

o o0bd-=

L2 exception list configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the profile configuration.

Note: After you initially save the configuration, you cannot edit the name.

Description A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Web Filter Profile Select a Web Filter Profile configuration.
Member
Type How you want to define the exception:
¢ Host
e IP
Host Pattern Specify a wildcard pattern, such as * .example. com.
IP/Netmask Specify the IP address and CIDR-formatted subnet mask, separated by a forward slash, such
as 192.0.2.0/24.
Note:

¢ Dotted quad formatted subnet masks are not accepted.
¢ |Pv6 addresses are not supported.

Creating a Web Filter Profile configuration

You use the web filter profile configuration to create groups of FortiGuard categories that you want to include in the SSL
forward proxy "L2 Exception List" configuration. The web filter profile should include categories that should not be
processed by the outbound L2 SSL forward proxy feature. To address privacy concerns, you can include categories
such as "Personal Privacy", "Finance and Banking", "Health and Wellness", and Medicine.

Before you begin:

« Learn about FortiGuard web filter categories. Go to http://fortiguard.com/webfilter.
» You must have Read-Write permission for Load Balance settings.

After you have created a web filter profile configuration object, you can select it in a L2 exception list configuration.
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To create a web filter profile configuration:

Go to Server Load Balance > SSL-FP Resources.

Click the Web Filter Profile tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Web Filter Profile configuration on page 184.
Save the configuration.

o wDbd =

Web Filter Profile configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the profile configuration.

Note: After you initially save the configuration, you cannot edit the name.

Description A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Category-Members

Category Select a category or subcategory from the predefined list.

Using the Web Category tab

The Web Category tab displays the web filter categories imported from FortiGuard. You specify web categories when
you create web filter groups.

For information on FortiGuard web categories, go to the FortiGuard website:
http://fortiguard.com/webfilter
Before you begin:

» You must have read permission for load balancing settings.

To display web categories:

1. Goto Server Load Balance > SSL-FP Resources.
2. Click the Web Category tab.

To manage how long the URL lists from FortiGuard are cached:

1. Go to System > FortiGuard.
2. Under Web Filter Configure, adjust caching settings as desired.
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Configuring certificate caching

Certificate caching allows the system to cache the certificates presented to it for later use. Once cached, the certificates
can be readily retrievable from the cache so that the system does not have to reload them when clients requesting
service. In so doing, system performance can be greatly improved.

Configuring a certificate caching object

Click Server Load Balance > SSL-FP Resources.

Click the Certificate Caching tab.

Click Create New to open the certificate caching editor.

Make the desired entries as described in Certificate caching configuration guidelines on page 185.
Click Save.

o wDbd =

Certificate caching configuration guidelines

Settings Guidelines

Name Enter a unique name for the certificate caching rule.

Maximum Certificate ~ Specify the maximum size of the certificate caching object. The defaultis 100 M.
Cache Size

Maximum entries Specify the maximum number of real servers whose certificates (RSA + ECDSA) are to be
cached. The default is 100,000.

TCP multiplexing

The TCP multiplexing option enables Layer 7 load balancing virtual servers to “reuse” existing TCP connections
between FortiADC and backend real servers. Using this connection pool can reduce TCP overhead and improve web
server and application performance. See Client requests handled using connections from the connection pool on page
185.

Client requests handled using connections from the connection pool
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Servers

FortiADC g

7
Dt

LN

Note: The feature is not supported for profiles with the Source Address option enabled.

You can enable and configure this option using the CLI only.

To configure a connection pool and assign it to a virtual server:

Use the following command to configure the connection pool:
config load-balance connection-pool

edit <name>

set age <integer>

set reuse <integer>
set size <integer>
set timeout <integer>

next
end
age Maximum duration of a connection in seconds. The recommended valueis 3000.
reuse Maximum number of times that the virtual server can reuse the connection. The recommended value is
2000.
size Maximum number of connections in the connection pool. The recommended value is 0, which specifies
that there is no limit on the connection size.
timeout Maximum number of seconds a connection can be idle before the system deletes it. The recommended

valueis 30.

To assign the connection pool configuration to a virtual server, enter the following command:

config load-balance virtual-server
edit <virtual-server name>

set type l1l7-load-balance

set connection-pool <pool name>
end

where:

<pool name> isthe name of the connection pool.
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Chapter 5: Link Load Balancing

This chapter includes the following topics:

 Linkload balancing basics on page 187

« Link load balancing configuration overview on page 190
« Configuring gateway links on page 195

« Configuring persistence rules on page 197

» Configuring proximity route settings on page 198

» Configuring a link group on page 193

« Configuring a virtual tunnel group on page 200

» Configuring link policies on page 192

Link load balancing basics

The link load balancing (LLB) features are designed to manage traffic over multiple internet service provider (ISP) or
wide area network (WAN) links. This enables you to subscribe to or provision multiple links, resulting in reduced risk of
outages, additional bandwidth for peak events, and potential cost savings if your ISP uses billing tiers based on
bandwidth rate or peak/off-peak hours.

In most cases, you configure link load balancing for outgoing traffic. Outbound traffic might be user or server traffic that is
routed from your local network through your ISP transit links, leased lines, or other WAN links to destinations on the
Internet or WAN. You configure link policies that select the gateway for outbound traffic.

When the FortiADC system receives outbound traffic that matches a source/destination/service tuple that you configure,
it forwards it to an outbound gateway link according to system logic and policy rules that you specify.

The LLB feature supports load balancing among link groups or among virtual tunnel groups.

Using link groups

The link group option is useful for ISP links. It enables you to configure multiple ISP links that are possible routes for the
traffic. The LLB picks the best route based on health checks, LLB algorithms, bandwidth rate thresholds, and other
factors you specify, including a schedule.

LLB link groups on page 187 shows an example topology when FortiADC is deployed to support link groups.
LLB link groups
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Clients
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Using virtual tunnels

A virtual tunnel is a good choice when you want to load balance traffic from applications that embed the source address
in the packet payload, like VPN and VolP traffic. Such traffic can be difficult to load balance using traditional LLB
methods. Virtual tunnels enable reliable, site-to-site connectivity using Generic Routing Encapsulation (GRE). The local
FortiADC appliance encapsulates traffic so that it can be routed according to your link policy rules. The link policy rules
use LLB techniques to identify the best available route among a group of links. If one of the links breaks down, the traffic
can be rerouted through another link in the tunnel group. When traffic egresses the remote FortiADC appliance, itis
decapsulated and the original source and destination IP addresses are restored.

WAN connectivity over single leased lines on page 189 shows an example of a deployment that does not use LLB. It
uses dedicated leased lines for its WAN links, which are reliable, but expensive.

WAN connectivity over single leased lines

wm)i%@

G Ay Branch ‘9\52/\'

LLB virtual tunnels on page 189 shows the same network deployed with FortiADC appliances. The LLB link policy load
balances traffic among more affordable ADSL links.

LLB virtual tunnels

FortiADC 7.2.0 Handbook 189
Fortinet Inc.



Chapter 5: Link Load Balancing

Depending on your business, you might use the link group option, the virtual tunnel option, or both.

The FortiADC system evaluates traffic to determine the routing rules to apply. With

regard to link load balancing, the system evaluates rules in the following order and
applies the first match:

1. LLB link policy

2. Policy route

3. Static/Dynamic route
4. LLB defaultlink group

Link load balancing configuration overview

The system has a configuration framework that enables granular link load balancing rules.

LLB configuration summary on page 190 shows the configuration objects used in the LLB configuration and the order in
which you create them. A link policy specifies the source/destination/service matches to which the policy applies. You
apply a link policy to a link group or a virtual tunnel.

LLB configuration summary
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Recommended
o Address Optional
Required

Persistence

Proximity Route

© ©0 0

The granular configuration of the gateway configuration includes health checks and bandwidth thresholds. The granular
configuration of link groups includes load balancing methods, persistence rules, and proximity routes.

The granular configuration of virtual tunnels includes load balancing methods. In the virtual tunnel configuration, you can
enable health check tests, but you do not use health check configuration objects.

Basic steps

1. Add address, address group, service, service group, and schedule group configuration objects that can be used to

match traffic to link policy rules. This step is recommended. If your policy does not use match criteria, it will not have
granularity.

2. Configure optional features. If you want to use health check rules, configure them before you configure the gateway
links. If you want to use persistence rules or proximity routes, configure them before you configure a link group.
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3. Configure gateway links.
4. Configure link groups or virtual tunnels.

5. Configure the link policy. When you configure a link policy, you set the source/destination/service matching tuple for
your link groups or virtual tunnels.

Configuring link policies

A link policy matches traffic to rules that select a link group or virtual tunnel.

The policy uses a matching tuple: source, destination, service, and schedule. The policy match is a Boolean AND—AII
must match for the rule to be applied.

The elements of the tuple support specification by group objects. This is a Boolean OR—If source IP address belongs to
member 1 OR member 2, then source matches.

The logical combinations enable you to subscribe multiple address spaces or services to a group of links, and create
load balancing rules on that group basis.

The policy table is consulted from top to bottom. The first rule to match is applied.

The FortiADC system evaluates traffic to determine the routing rules to apply. With
regard to link load balancing, the system evaluates rules in the following order and
applies the first match:

1. LLB link policy

2. Policy route

3. Static/Dynamic route

4. LLB default link group

Before you begin:
« You must have configured any address, service, and schedule objects that you want to use as match criteria for
your policy.
« You must have configured a link group or virtual tunnel group.
» You must have Read-Write permission for Link Load Balance settings.

To configure a link policy:

Go to Link Load Balance > Link Policy.

Click Create New to display the configuration editor.

Complete the configuration as described in Link policy configuration on page 192.
Save the configuration.

Reorder rules, as necessary.

o wDb =

Link policy configuration

Option Guidelines

Default Link Group Select a link group configuration object that is used as the default when traffic does not
match policy rules.
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Option Guidelines

Name

Ingress Interface

Source Type

Source, Source ISP, or

Source Group

Destination Type

Destination, Destination
ISP, or Destination Group

Service Type

Service or Service Group

Schedule

Group Type

Link Group

Reordering

+4

Hit Counts

Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Select the network interface to which the policy applies.
Whether to use address, address group, or ISP address objects for this rule.

Select an address object to match source addresses. If you do not specify a source
address, the rule matches any source address. See Configuring IPv4 address groups.

Whether to use address, address group, or ISP address objects for this rule.

Select an address object to match destination addresses. If you do not specify a
destination address, the rule matches any destination. See Configuring IPv4 address
groups.

Whether to use service or service group objects for this rule.

Select a service object to match destination services. If you do not specify a service, the

rule matches any service. See Creating service groups.

Select the schedule object that determines the times the system uses the logic of this
configuration. The link policy is active when the current time falls in a time period
specified by one or more schedules in the schedule group. If you do not specify a
schedule, the rule applies at all times. See Creating schedule groups.

» Link Group—Policy applies to a link group. Select the option, then the link group.
See Configuring a link group.

 Virtual Tunnel—Policy applies to a virtual tunnel. Select the option, then the virtual
tunnel. See Configuring a virtual tunnel group.

Select a link group.

After you have saved a rule, reorder rules as necessary. The rules table is consulted
from top to bottom. The first rule that matches is applied and subsequent rules are not
evaluated.

Hit Counts: For monitor only. The value indicates the link policy hit times.

Configuring a link group

Link groups include ISP gateways your company uses for outbound traffic. Grouping links reduces the risk of outages
and provisions additional bandwidth to relieve potential traffic congestion. See Using link groups.

The link group configuration specifies the load balancing algorithm and the gateway routers in the load balancing pool.

You can enable LLB options, such as persistence rules and proximity routes.
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Before you begin:

« You must have configured gateway links and persistence rules and before you can select them in the link group
configuration.

« You must have Read-Write permission for Link Load Balance settings.

After you have configured a link group configuration object, you can select it in the link policy configuration.

To configure a link group:

1. Goto Link Load Balance > Link Group.
The configuration page displays the Link Group tab.
2. Click Create New to display the configuration editor.
3. Complete the configuration and add members as described in Link group configuration on page 194.
4. Save the configuration.

Link group configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the LLB policy configuration.

Note: After you initially save the configuration, you cannot edit the name.

Address Type IPv4
Note: IPv4 is selected by default, and cannot be changed.

Route Method ¢ Weighted Round Robin—Dispatches new connections to link members using a weighted

round-robin method.

¢ Least Connections—Dispatches new connections to the link member with the lowest
number of connections.

¢ |east New Connections per Second—Dispatches new connections to the link member
that has the lowest rate of new connections per second.

¢ Least Throughput Outbound—Dispatches new connections to the link member with the
least outbound traffic.

¢ Least Throughput Inbound—Dispatches new connections to the link member with the
least inbound traffic.

¢ Least Throughput Total—Dispatches new connections to the link member with the least
total traffic (that is, inbound plus outbound).

¢ Spillover Throughput Outbound—Dispatches new connections according to the spillover
list based on outbound traffic.

¢ Spillover Throughput Inbound—Spillover list based on inbound traffic.

¢ Spillover Throughput Total—Spillover list based on total traffic (that is, inbound plus
outbound).

¢ Source Address Hash—Selects the gateway link based on a hash of the source IP
address.

Persistence Select a persistence configuration. Optional.

Proximity Route ¢ Enable—The system uses the proximity route logic and configuration when determining
routes.
¢ Disable—The system does not use the proximity route configuration.
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Add member

Name Configuration name. Valid characters are A-Z7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Gateway Select a gateway configuration object. See Configuring gateway links.

Weight Assigns relative preference among members—higher values are more preferred and are
assigned connections more frequently. The defaultis 1. The valid range is 1 to 255.

All load balancing methods consider weight, except spillover, which uses its own priority
configuration. Servers are dispatched requests proportional to their weight, relative to the sum
of all weights.
The following example shows the effect of weight on WRR:

e Sever A, Weight 2; Server B, Weight 1: Requests are sent AABAAB.

e Sever A, Weight 3; Server B, Weight 2: Requests are sent AABAB.
For other methods, weight functions as a tie-breaker. For example, with the Least Connection
algorithm, requests are sent to the server with the least connections. If the number of
connections is equal, the request is sent to the server with the greater weight. For example:

e Server A, Weight 1, 1 connection

¢ Server B, Weight 2, 1 connection
The next request is sent to Server B.

Spillover Priority Assigns a priority to the link when using a spillover load balancing method. Higher values
have greater priority. When a spillover method is enabled, the system dispatches new
connections to the link that has the greatest spillover priority until its threshold is exceeded;
then it dispatches new connections to the link with the next greatest priority until its threshold
is exceeded, and so on.

If multiple links in a link group have the same spillover priority, the system dispatches new
connections among those links according to round robin.
The defaultis 0. The valid range is 0-9.
Status ¢ Enable—The member is considered available for new traffic.
¢ Disable—The member is considered unavailable for new traffic.
Backup Enable to designate the link as a backup member of the group. All backup members are

inactive until all main members are down.

Configuring gateway links

The gateway link configuration enables you to specify health checks, bandwidth rate thresholds, and spillover threshold
behavior for the gateway links you add to link groups.

Before you begin:

» You must know the IP addresses of the ISP gateway links used in the network segment where the FortiADC
appliance is deployed.

« You must have added health check configuration objects that you want to use to check the gateway links.

« You must have Read-Write permission for Link Load Balance settings.
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After you have configured a gateway link configuration object, you can select it in the link group configuration.

To configure a gateway link:

Go to Link Load Balance > Link Group.

Click the Gateway tab.

Click Create New to display the configuration editor.

Complete the configuration as described in LLB gateway configuration on page 196.
Save the configuration.

o o0bd-=

LLB gateway configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the link group configuration.

Note: After you initially save the configuration, you cannot edit the name.

Address IP address of the gateway link.

Health Check Enable health checks.

Health Check ¢ AND—AII of the selected health checks must pass for the link to the considered available.
Relationship * OR—One of the selected health checks must pass for the link to be considered available.
Health Check List Select one or more health check configuration objects.

Inbound Bandwidth Maximum bandwidth rate for inbound traffic through this gateway link.

Outbound Bandwidth  Maximum bandwidth rate for outbound traffic to this gateway link. If traffic exceeds this
threshold, the FortiADC system considers the gateway to be full and does not dispatch new
connections to it.

The default is 2,000,000 Kbps. The valid range is 1 t0 2,147,483,647.

We recommend you tune bandwidth thresholds strategically, using the bandwidth rate and
price structure agreement you have with your ISP to your advantage.

Inbound Spillover Maximum inbound bandwidth rate for a link in a spillover load balancing pool.
Threshold

Outbound Spillover Maximum outbound bandwidth rate for a link in a spillover load balancing pool.

Threshold If you enable spillover load balancing in the link group configuration, the system maintains a
spillover list. It dispatches new connections to the link with the greatest priority until its
spillover threshold is exceeded; then dispatches new connections to the link with the next
greatest priority until its threshold is exceeded, and so on.

The default is 2,000,000 Kbps. The valid range is 1 t0 2,147,483,647.

Total Spillover Maximum total bandwidth rate (inbound plus outbound) for a link in a spillover load balancing
Threshold pool.
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Configuring persistence rules

Persistence rules identify traffic that should be ignored by load balancing rules and instead be forwarded to the same
gateway each time the traffic traverses the FortiADC appliance.

You should use persistence rules with applications that use a secure connection. Such applications drop connections
when the server detects a change in a client’s source IP address.

Persistence rules used in link load balancing on page 197 describes the types of persistence rules you can configure.

Persistence rules used in link load balancing

Persistence Description

Source-Destination Pair Packets with the same source IP address and destination IP address take same
outgoing gateway.

Source-Destination Address Packets with a source IP address and destination IP address that belong to the
same subnet take the same outgoing gateway.

Source Address Packets with a source IP address that belongs to the same subnet take the same
outgoing gateway.
Source address based persistence consumes a significant amount of memory, as
calculated using the following formula per VS:
(max persistence entry size) x (size per entry of the table) x (content routing or
pool count)
For example:
If the max persistence entry size is 262144 (default), the per entry of the table is
44 bytes, and there is no content routing.
262144 x 44 = 11534336 bytes (which is =11MB)

Destination Address Packets with a destination IP address that belongs to the same subnet take same
outgoing gateway.

Before you begin:

¢ You must have an awareness of the types of outbound traffic from your network. Persistence rules are useful for
traffic that requires an established session, such as secure connections (HTTPS and SSH, for example).

« You must have knowledge of the source and/or destination subnets to which the persistence rules should apply.
« You must have Read-Write permission for Link Load Balance settings.

You can use persistence rules in link groups but not virtual tunnels.

To configure a persistence rule:

1. Goto Link Load Balance > Link Group.
2. Click the Persistence tab.
3. Click Create New to display the configuration editor.
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4. Complete the configuration as described in Persistence rule configuration on page 198.

5. Save the configuration.

Persistence rule configuration

Type Guidelines

Name

Type
Source-Destination Pair

Timeout

Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You
reference this name in the link group configuration.

Note: After you initially save the configuration, you cannot edit the name.

Select one of the persistence types, as described below.

The default is 300 seconds.

Source-Destination Address

Timeout

Source IPv4 Netmask Bits

Destination IPv4 Netmask
Bits

Source Address
Timeout

Source IPv4 Netmask Bits

Destination Address
Timeout

Destination IPv4 Netmask
Bits

The proximity route feature enables you to associate link groups with efficient routes. Proximity routes can improve user

The default is 300 seconds.

Number of bits in a subnet mask to specify a network segment that should following the
persistence rule.

Number of bits in a subnet mask to specify a network segment that should following the
persistence rule.

For example, if you set this to 24, and the system chooses a particular gateway router
for destination IP 192.168.1.100, the system will select that same gateway for traffic to
all destination IPs in subnet 192.168.1.0/24.

The default is 300 seconds.

Number of bits in a subnet mask to specify a network segment that should following the
persistence rule. The default is 32, but you can set it to any value between 1 and 32.
For example, if you set this to 24, and the system chooses a particular gateway router
for client IP 192.168.1.100, the system will select that same gateway for subsequent
client requests when the subsequent client belongs to subnet 192.168.1.0/24.

The default is 300 seconds.

Number of bits in a subnet mask to specify a network segment that should following the
persistence rule.

Configuring proximity route settings

experience over the WAN because traffic is routed over fast routes.

You can use either or both of these methods:
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« Static Table—You specify the gateways to use for traffic on destination networks.
« Dynamic Detection—The system polls the network for efficient routes. The algorithm selects a gateway based on
latency.

If you configure both, the system checks the static table first for a matching route and, if any, uses it. If there is no
matching static route, the system uses dynamic detection.

Before you begin:

» You must have knowledge of IP addresses used in outbound network routes to configure a static route.
« You must have Read-Write permission for Link Load Balance settings.

To configure a proximity route:

Go to Link Load Balance > Link Group.

Click the Proximity Route tab.

Complete the configuration as described in Proximity route rule configuration on page 199.
Save the configuration.

o bN-=

Proximity route rule configuration

Type Guidelines

Mode o Static Table First—Consult the static table first. If no match, use dynamic detection.
¢ Static Table Only—Use the static table; do not use dynamic detection.
¢ Dynamic Detect Only—Use dynamic detection; do not use the static table.
¢ Disable—Do not use the proximity route configuration.

Static Table
Type ¢ ISP—Use an ISP address object.
¢ Subnet—Specify an IP netmask manually.
Routes that are specified manually have priority over ISP address object entries.
ISP Name If you use the ISP configuration type, select an ISP address book configuration object.
If an address exists in multiple ISP address books, the route entries have priority as follows:
1. User-defined entries.
2. Entries from an address book that has been imported.
3. Entries from the predefined address book (default for the firmware image).
IP Subnet If you use the Subnet configuration type, specify a destination IP address and netmask.
Gateway Select a gateway configuration object. The gateway must be able to route packets to the

destination IP address that you have specified.
Dynamic Detect

Protocol ¢ ICMP—Use ICMP to detect routes. Calculate proximity by the smaller RTT.
¢ ICMP and TCP—Some hosts do not respond to ICMP requests. Specify this option to
use both ICMP and TCP to detect routes and RTT. For TCP detection, port 7 (TCP echo)
is used. A connection refused or connection reset by the destination is treated as
successful detection.

Aging Period The default is 86,400 seconds (24 hours).
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Type Guidelines

Retry Number The defaultis 3.

Retry Interval The defaultis 3.

Configuring a virtual tunnel group

Virtual tunnels enable reliable, site-to-site connectivity using Generic Routing Encapsulation (GRE) to tunnel traffic
between pairs of FortiADC appliances. See Using virtual tunnels.

The virtual tunnel group configuration sets the list of tunnel members, as well as load balancing options like algorithm
and weight.

When you add members to a virtual tunnel configuration, you specify a local and remote IP address. These addresses
are IP addresses assigned to a network interface on the local and remote FortiADC appliance.

Before you begin:
» You must have Read-Write permission for Link Load Balance settings.

After you have configured a virtual tunnel configuration object, you can select it in the link policy configuration.

To configure a virtual tunnel:

Go to Link Load Balance > Virtual Tunnel.

Click Create New to display the configuration editor.

Complete the configuration and add members as described in Virtual tunnel configuration on page 200.
Save the configuration.

Ao bdhd-=

Virtual tunnel configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the LLB policy configuration.

Note: After you initially save the configuration, you cannot edit the name.

Method ¢ Weighted Round Robin—Dispatches packets to VT members using a weighted round-
robin method.
* Source-Destination Hash—Dispatches packets by source-destination IP address tuple.

Add member
Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.
Tunnel Local IP address for the network interface this system uses to form a VPN tunnel with the remote
Address system.
Tunnel Remote IP address that the remote FortiADC system uses to form a VPN tunnel with this system.
Address
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Settings Guidelines

Health Check

Weight

Status

Backup

FortiADC 7.2.0 Handbook
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¢ Enable—Send probes to test whether the link is available.
¢ Disable—Do not send probes to test the health of the link.

Assigns relative preference among members—higher values are more preferred and are
assigned connections more frequently.

¢ Enable—The member is considered available for new traffic.
¢ Disable—The member is considered unavailable for new traffic.

Enable to designate the tunnel as a backup member of the group. All backup members are
inactive until all main members are down.
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Chapter 6: Global Load Balancing

This chapter includes the following topics:

Global load balancing basics on page 202

Global load balancing configuration overview on page 204
Configuring servers on page 206

Configuring link on page 209

Configuring data centers on page 210

Configuring hosts on page 211

Configuring wizard on page 212

Configuring virtual server pools on page 214

Configuring location lists on page 216

Logical Topology on page 216

Configuring an address group on page 239

Configuring remote DNS servers on page 240
Configuring the DSSET list on page 238

Configuring DNS zones on page 218

Configuring DNS64 on page 237

Configuring the response rate limit on page 240
Configuring a Global DNS policy on page 217

Configuring general settings on page 222

Configuring DNS over HTTPS and DNS over TLS on page 224
Configuring the trust anchor key on page 236

Global load balancing basics

The global load balancing (GLB) feature is a DNS-based solution that enables you to deploy redundant resources
around the globe that you can leverage to keep your business online when a local area deployment experiences

unexpected spikes or downtime. The FortiADC system implements a hardened BIND 9 DNS server that can be deployed

as the authoritative name server for the DNS zones that you configure. Zone resource records are generated
dynamically based on the global load balancing framework. The DNS response to a client request is an ordered lists of

answers that includes all available virtual servers. A client that receives DNS response with a list of answers tries the first

and only proceeds to the next answers if the first answer is unreachable. The response list is based on the following

priorities:

1.

Virtual server health—Auvailability is determined by real-time connectivity checking. When the DNS server receives
a client request, it checks connectivity for all possible matches and excludes unavailable servers from the response

list.

Persistence—You can enable persistence for applications that have transactions across multiple hosts. A match to

the persistence table has priority over proximity algorithms.

Geographic proximity—Proximity is determined by matching the source IP address to either the FortiGuard Geo IP

database or the FortiADC predefined ISP address book.
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4. Dynamic proximity—Proximity is determined by application response time (RTT probes), least connections, or byte-
per-second.

5. Weighted round robin—If proximity algorithms are not configured or not applicable, available virtual servers are
listed in order based on a simple load balancing algorithm.

Global load balancing deployment on page 203 shows an example global load balancing deployment with redundant
resources at data centers in China and the United States.

Global load balancing deployment

- .com IN NS ns. com. example. com. IN NS ns. example. com.
7 ns.com. IN A 203.0.113.1 ns, example, com. IN A 192.0.2.1
2 A 192,0.2.2
; DNS root > DNS com
-~ - server & nName server
Local DNS resolver ]
f Q. www.example.com ?
/ Jpe——
f v

: ( ‘ D

__A__,,—-./'\

Client in China
/ Q. www.cxamplc_com ?
f A wwiwv.cramole.com. 86400 IN AAAS 2001 dbg:100
Global SLB y WWW.EXample.com. 6400 IN & 1920.2.700 G'oba| SLB

DNS server IP address 192.0.2.2 DNS server IP address 192.0.2.1

FortiADC-1 Local SLB
mgmt |P address 2001:db&::10
vs1 IP address 2001:db8::100

FortiADC-2 Local SLB
mgmt IP address 192.0.2.10
vs1 IP address 192.0.2.100

2 sd §
sg b B3P | o &
A B C » 3 ) =] =

g 8 '
D E F
. 202 v 202
Data Center - China 192.02.101 192.0.2.102 192.0.2.103

Data Center - United States

2001:db8::101 2001:db&102 2001:db8::103

FortiADC-1 is the local SLB for the data center in China. FortiADC-2 is the local SLB for the data center in the United
States. FortiADC-1 and FortiADC-2 are also the GSLB. They host the DNS servers that are authoritative for
www.example.com. When a client clicks a link to www.example.com, the local host DNS resolver commences a DNS
query that is ultimately resolved by the authoritative DNS server on them. The set of possible answers includes the
virtual servers on FortiADC-1 or FortiADC-2. The global load balancing framework uses health status and proximity
algorithms to determine the set of answers that are returned, and the order of the answer list. For example, you can use
the global SLB framework geoproximity feature to direct clients located in China to the virtual server in China, or if the
virtual server in China is unavailable, then to the redundant resources in the United States.

You configure the global load balancing framework and DNS settings only on the global FortiADC (in the example above,
both FortiADC-1 and FortiADC-2 are GSLBs). The virtual server IP addresses and ports can be discovered by the
FortiADC global SLB from the FortiADC local SLBs. The GLB DNS server uses the discovered IP addresses in the DNS
response. The framework also supports third-party IP addresses and health checks for them.

The DNS server supports the following security features:

o DNSSEC—Domain Name System Security Extensions. DNSSEC provides authentication by associating
cryptographically generated digital signatures with DNS resource record (RR) sets. The FortiADC system makes it
easy to manage the keys that must be provided to DNS parent domains and the keys that must be imported from
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DNS child domains.

» Response rate limit—Helps mitigate DNS denial-of-service attacks by reducing the rate at which the authoritative
name servers respond to high volumes of malicious queries.

» DNS forwarding—In a typical enterprise local area network, the client configuration has the IP address of an internal
authoritative DNS server so that requests for internal resources can be answered directly from its zone data.
Requests for remote resources are sent to another DNS server known as a forwarder. The internal server caches
the results it learns from the forwarder, which optimizes subsequent lookups. Using forwarders reduces the number
of DNS servers that must be able to communicate with Internet DNS servers.

vy Further reading:
- s BIND 9 reference manuals: http://www.bind9.net/manuals
RFC 1035 (DNS): http://tools.ietf.org/html/rfc1035

RFC 4033 (DNSSEC): http://tools.ietf.org/html/rfc4033

Global load balancing configuration overview

In a global load balancing deployment, you configure DNS server and global load balancing details only on the global
FortiADC instance. The configuration framework enables granular administration and fine tuning of both the DNS server
and the global load balancing framework.

Global load balancing configuration summary on page 204 shows the basic configuration elements for global load
balancing and the recommended order for creating the configuration objects. The order is important for initial
configurations because complex configuration elements like policies often include references to simple configuration
objects like the remote DNS servers (forwarders) or DNS64 rules, but the simple elements must be created first.

Global load balancing configuration summary
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DNS Server and Policy Settings Global Load Balancing
Servers and Locations Settings

Address Group o Data Center

Virtual Server Pool
DSSET List
Dynamic Proximity

Persistence

Response Rate Limit

2
©

Global DNS Policy

General Settings

Required
Required with predefined (any or none)
Optional with defaults

Trust Anchor Key Optional
Zone is generated
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Basic steps (DNS server)

1. Configure address groups to use in your DNS policy matching rules. The system includes the predefined address
groups any and none.

2. Configure remote DNS servers (forwarders) and the DSSET list that you might reference in the zone configuration.

3. Complete the zone configuration. The global load balancing framework generates the zone configuration for zones
that include the FortiADC virtual servers.

4. Configure DNS64 or response rate limit configurations that you might reference in the DNS policy.

5. Configure the DNS policy that matches a source/destination tuple to a zone. You can also enable and configure
DNSSEC in the DNS policy.

6. Configure general DNS settings to be applied when DNS requests do not match the DNS policy.

Basic steps (Global load balancing)

1. Create the data center, servers, virtual server pool, and host configurations that are the framework for associating
locations with virtual servers and generating the DNS zone configuration and resource records. You can adjust the
dynamic proximity and persistence settings at any time.

2. Review the generated DNS zone configuration.
3. Create a policy that matches traffic to the generated zone configuration.

Configuring servers

In the context of the global server load balance configuration, servers are the local SLB (FortiADC instances or third-
party servers) to be load balanced. For FortiADC instances, the GLB checks status and synchronizes configuration from
the local SLB so that it can learn the set of virtual servers that can be included in the GLB virtual server pool.

Virtual server discovery on page 206 illustrates configuration discovery. Placement in this list does not include them in
the pool. You also must name them explicitly in the virtual server pool configuration.

Virtual server discovery
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Global FortiADC

discovery virtual server
Global Load Balance \
, virtual server

rver [P addn

M virtual server

Local FortiADC - China

virtual server

virtual server

virtual server

Local FortiADC - US

Before you begin:

You must have created the data center configuration objects that are associated with the local SLB.

You must have created virtual server configurations on the local FortiADC SLB. In this procedure, the global SLB
discovers them.

You must have created gateway configuration objects on the local FortiADC SLB if you want to configure a gateway
health check. In this procedure, the global SLB discovers them.

You must have Read-Write permission for Global Load Balance settings.

After you have created a server configuration object, you can specify it the global load balancing virtual server pool
configuration.

To configure servers:

a b obd-=

7.

Go to Global Load Balance > Global Object.

Click the Server tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Server configuration on page 207.

Use the Discover utility to populate the Member list configuration with virtual server configuration details from the
local FortiADC SLB.

Optional. Edit the populated list to select a discovered gateway configuration object if you want the GSLB to perform
gateway health checks.

Save the configuration.

Server configuration

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, , and -. No spaces. You reference this

name in the virtual server pool configuration.
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Settings Guidelines

Type

Auth Type

Password

Address Type
IP Address

Port

Data Center

Auto-sync

Health Check
Control

Health Check
Relationship

Health Check
List

Member

Discover

Note: After you initially save the configuration, you cannot edit the name.

¢ FortiADC SLB: A FortiADC instance.
¢ Generic Host: A third party ADC or server.

¢ None—No password.

e« TCP MD5SIG—With password, but can not be used if NAT is in between the client and server.
This is because, when using the TCP MD5SIG authentication in a network with NAT in
between, the IP layer is encrypted. So is every packet. Because the IP address will be changed,
the encryption check will always fail.

¢ Auth Verify—The authentication key is sent to the server after a three-way handshake. The key
is encrypted and NAT in between will not affect the authentication.

Enter the password to authenticate key.

Note: This field appears only when TCP MD5SIG or Auth Verify is selected as the authentication
type. The password your enter here must match the password configured on the FortiADC appliance
in a global sever load-balancing configuration.

IPv4 or IPv6.

Specify the IP address for the FortiADC management interface. This IP address is used for
synchronization and also status checks. If the management interface is unreachable, the virtual
servers for that FortiADC are excluded from DNS answers.

5858 by default.

Select a data center configuration object. The data center configuration object properties are used to
establish the proximity of the servers and the client requests.

Enable/disable auto-sync from the server. Global load balancing will auto-sync the server member
when enabled.

Note: When disabling auto-sync, the server member will be cleared and re-synced.

If type is Generic Host, enable/disable health checks for the virtual server list. The health check
settings at this configuration level are the parent configuration. When you configure the list, you can
specify whether to inherit or override the parent configuration.

Note:This option is available only when Generic Host is selected. See Type above. Health checking
is built-in, and you can optionally configure a gateway health check.

* AND—AII of the specified health checks must pass for the server to be considered available.
¢ OR—One of the specified health checks must pass for the server to be considered available.

Select one or more health check configuration objects.

Populate the member list with virtual servers from the local FortiADC configuration. After the list had
been populated, you can edit the configuration to add a gateway health check.

FortiADC 7.2.0 Handbook
Fortinet Inc.

208



Chapter 6: Global Load Balancing

Settings Guidelines

Override Select this option if you want to update the discovered virtual server configuration with the latest
configuration information whenever you use the Discover utility (for example, additions or changes
to previously discovered configurations).

Unselect this option if you want to preserve the previously discovered configuration and not have it
overwritten by the Discover operation.

Name Must match the virtual server configuration name on the local FortiADC.

Address Type  IPv4 or IPv6.

IP Address Virtual server IP address.

Gateway Enable an additional health check: is the gateway beyond the FortiADC reachable?
The list of gateway configuration objects is populated by discovery, but you must select the
appropriate one from the list.

Health Check  If type is Generic Host, enable to inherit the health check settings from the parent configuration.

Inherit Disable to specify health check settings in this member configuration.

Health Check  Enable health checking for the virtual server.

Control Note: This option is available only when Health Check Inherit is disabled. In that case, you can
enable this option and configure the Health Check Relationship and Health Check List fields below.

Health Check * AND—AIl of the specified health checks must pass for the server to be considered available.
Relationship ¢ OR—One of the specified health checks must pass for the server to be considered available.

Health Check  Specify one or more health check configuration objects.
List

Configuring link

To configure a global load balance link:

Go to Global Load Balance > Global Object.

Click the Link tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Global load balance link configuration on page 209.
Save the configuration.

o o0N-=

Global load balance link configuration

Settings Guidelines

Name Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces. You reference
this name in the global load balance servers configuration.

Note: After you initially save the configuration, you cannot edit the name.

Data Center Select a data center from the list.
Note: You must the data center(s) configured ahead of time.
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ISP Select an ISP from the list.

Gateway

Server Select a server.

Gateway Name Specify the name of a gateway.

or Select Here Click the down arrow to select a gateway from the drop-down list.

Note: Use this option only when you already have a list of gateways configured on the server.

Configuring data centers

The data center configuration sets key properties: Location and/or ISP and ISP province. These properties are used in
the global load balancing algorithm that selects the FortiADC in closest proximity to the client.

Before you begin:
« If you want to select a user-defined ISP address book, you must create it before creating the data center
configuration.
« You must have Read-Write permission for Global Load Balance settings.

After you have created a data center configuration object, you can specify it in the global load balance servers
configuration.

To configure a data center:

Go to Global Load Balance > Global Object.

Click the Data Center tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Data center configuration on page 210.
Save the configuration.

o obd-=

Data center configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the global load balance servers configuration.

Note: After you initially save the configuration, you cannot edit the name.
Location Select a location from the drop-down list menu. See the note below.

Description Optional description to help administrators know the purpose or usage of the configuration.

Note: Stating from FortiADC 5.x.x, the GUI shows the full country or region names listed in alphabetical order for location

list and data center configuration. The Console uses country or region name abbreviations instead. The abbreviations
are done in accordance with the ISO standards. So if you configure a location list or data center from the Console, be
sure to consult ISO-3166-1 and/or ISO 3166-2:CN for the correct abbreviations to use. See the following example
commands:
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config global-load-balance topology

edit "tpl"
set member ZZ US CN65
next
end

Where ZZ stands for Reserved, US for United States, and CN65 for China, Xingjiang

Configuring hosts

Host settings are used to form the zone configuration and resource records in the generated DNS zone used for global
load balancing.

Host configuration and the generated DNS zone on page 211 shows how the host settings are mapped to zone settings
and resource records. Domain and hostname are used in both the configuration and the generated configuration name.
The IP address and weight are derived from the virtual server pool.

Host configuration and the generated DNS zone

Mame: fgdn_generate _host_www_example com

Zone
Domain: example.com.

A/AAAA Records )
Domain name example.com.
Host: www Host name WWw
IP address: Virtual server pool  vs-1
Weight:
Generated Zone Configuration Host Configuration

Before you begin:

« You must have created the global virtual server pools you want to use.
» You must have Read-Write permission for Global Load Balance settings.

After you have created a host configuration object, it can be used to form the zone and resource records in the generated
DNS zone configuration.

To configure a host:

Go to Global Load Balance > FQDN Settings.

Click the Host tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Host configuration on page 212.
Save the configuration.

ok oN=
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Host configuration
Settings Guidelines
Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
Note: After you initially save the configuration, you cannot edit the name.
Host Name The hostname part of the FQDN, such as www.
Note: You can specify the @ symbol to denote the zone root. The value substituted for @
is the preceding $ORIGIN directive.
Domain Name The domain name must end with a period. For example: example . com.
DNS Policy Select the DNS policy you want the host to use.
Respond Single Record Enable/disable an option to send a single record in response to a query. Disabled by
default. By default, the response is an ordered list of records.
Persistence Enable/disable the persistence table. Disabled by default.
If you enable persistence, the client source address is recorded in the persistence table,
and subsequent requests from the same network or the same host or domain are sent an
answer with the virtual servers listed in the same order (unless a server becomes
unavailable and is therefore omitted from the answer).
Virtual Server Pool * Weight—If selected, virtual server pool will be responded by weight.
Selection Method » DNS Query Origin—If selected, virtual server pool with the same topology
information as the local DNS address will be responded.
¢ Global Availability—If selected, virtual servers will be responded by their global
availability: the first virtual server in queue will always be responded if it is globally
available, and the next virtual server in queue will be responded if the preceding
virtual server is unavailable.
Default Feedback IPv4 Specify an IP address to return in the DNS answer if no virtual servers are available.
Default Feedback IPv6 Specify an IPv6 address to return in the DNS answer if no virtual servers are available.

Virtual Server Pool

Name Enter the mkey.

Virtual Server Pool Select a virtual server pool from the list, or create a new one.
Weight Assign a weight. Valid values range from 1 to 255.

Topology Select a topology from the list, or create a new one.

ISP Select an ISP from the list or create a new one.

Configuring wizard

The GLB wizard is a step-by-step tool to help you configure a GLB object in GUI.
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To use the GLB Wizard:

Go to Global Load Balance > GLB Wizard

= .= FortiADC FortiADC-VM

@ Dashboard > Global Load Balance Wizard
& FortiView ¥
Server
& System >
8 Grarad Resalinees g Name | Required. Specify the server name.
3 Natwork . Kiitiress \ Required. Specify the IP address.
W
Example: 192.0.2.1 2001:0db8::1
Server Load Balance >
Data Center Location
% Link Load Balance 5
Data Center Location R d >
@ Global Load Balance v esenve ‘
G"B piErs FortiGSLB Cloud
FQDN © FortiGSLB Cloud provides a multi-site DNS load balancing as a service. For
— additional information, please visit FortiGSLB Cloud:www.fortiadccloud.com
one Tools

Global Object

7 Web Application Firewall >

U Network Security > Next > Cancl
& DoS Protection >
& User Authentication ¥
lml | og & Report >

To configure a GLB wizard:

1. In Server, configure the Name, Address, and Data Center Location.

2. InVirtual Server Pool, configure the Name, Preferred and Alternate. Discover the server members that were
previously configured in Server, and select from the given list.

3. ltis required to specify the Name, Host Name, and Domain Name. You can also, if you want, specify the Default
Feedback IPv4 or Default Feedback IPv6.

4. After clicking Finished, the Global DNS Configuration will be complete. The Global DNS Configuration radio
button in GLB > Zone Tools > General Settings will be enabled automatically.

In Zone Tools, three things will happen:

1. Under Zone, your new zone will appear.

2. Under Global DNS Policy, select the first policy. If more than one policy exists, choose the first one.

ortiADC  FortiADC-VM HA:Standalone  V600Buildoo3s~ Q >~ ©@ @ L
@ Dashboard > Global DNS Policy  [lea0S General Settings ~ Trust Anchor Key DNS64 DSSETList  Address Group Remote DNS Server Response Rate Limit
% it i
S Security Fabric > B Delete O Add Filter
& FortiView >
Name Source Destination Zone List DNS64 List o

& System
o Shsore Rcsances , | DEFAULT_DNS_POLICY any any fqdn_generate_example.com. PR R 3
b Network > | Showing1toloflentries  Show 23] entries Previous | 1
Server Load Balance >
% Link Load Balance >
@ Global Load Balance v

GLB Wizard

FQDN

Global Object
2 Web Application Firewall >
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3. A dialogue opens. Under Zone List, you will see that your zone has moved automatically from Available Items to
Selected Items.

e S HA:Standalone  V600Buili0038~ Q >~ © ® L & admin-
@ Dashboard Global DNS Policy

S& Security Fabric Name DEFAULT_DNS_POLIC)

18 FortiView Source any -

& System Destination

+ Network
Zone List
Server Load Balance

>
>
>
>
3 Shared Resources >
>
>
% Link Load Bslance >

‘ @ Global Load Balance
GLB Wizard

DNS64 List
FQDN

E
. Double-click to deselect. Dragto reorde D ck tosel
lobsl Object Recursion ©
B Web Application Firewall i -
O NetworkSecurity DNSSECValidation (B

LR ] Forwarders Click toselect -

>
>

o i

& Do Protection > Forward W
>
&

bl &
Wi Log&Report Response RateLimit | Click toselect -

Configuring virtual server pools

The virtual server pool configuration defines the set of virtual servers that can be matched in DNS resource records, so it
should include, for example, all the virtual servers that can be answers for DNS requests to resolve www.example.com.

You also specify the key parameters of the global load balancing algorithm, including proximity options, status checking
options, load balancing method, and weight.

The DNS response is an ordered list of answers. Virtual servers that are unavailable are excluded. Available virtual
servers are ordered based on the following priorities:

1. Geographic proximity
2. Dynamic proximity
3. Weighted round robin

A client that receives DNS response with a list of answers tries the first and only proceeds to the next answers if the first
answer is unreachable.

Before you begin:

» You must have created GLB Servers configuration objects.

« You must have Read-Write permission for Global Load Balance settings.
After you have created a virtual server pool configuration object, you can specify it in the global load balancing host
configuration.

To configure a virtual server pool:

1. Goto Global Load Balance > FQDN Settings.
2. Click the Virtual Server Pool tab.
3. Click Create New to display the configuration editor.
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4. Complete the configuration as described in Virtual server pool configuration on page 215.
5. Save the configuration.

Virtual server pool configuration

Settings Guidelines

Name Specify a unique name for the virtual server pool configuration. Valid characters are 2-z, a-z, 0-9,
and -. No spaces. You reference this name in the host configuration.

Note: After you initially save the configuration, you cannot edit the name.

Preferred * None—No preference.

¢ Geo—If selected, virtual servers with the same GEO information as the local DNS address will
respond.

* Geo-ISP—If selected, virtual servers with the same ISP information as the local DNS address will
respond first, and virtual servers with the same GEO information as the local DNS address will
respond second.

e RTT—Virtual servers with the shortest latency link or closest to the data center will respond.

¢ Least-Connnections—Virtual servers with the least connections will respond.

¢ Connection-Limit—Virtual servers will be responded by their connection limit determined by virtual
servers' weight: the greater the weight of a virtual server, the more responses it will get.

* Bytes-Per-Second—Virtual servers with the lowest traffic will respond.

¢ Server-Performance—Virtual servers with better server-performancec in the CPU or Memory
(whichever one you give more weight to) will respond.

Alternate Same as above.

Load Weighted Round Robin

Balance

Method

Check Enable/disable polling of the local FortiADC SLB. If the server is unresponsive, its virtual servers are
Server not selected for DNS answers.

Status

Check Enable/disable checks on whether the status of the virtual servers in the virtual server list is known.
Virtual Virtual servers with unknown status are not selected for DNS answers.

Server

Existence

Member

Server Select a GLB Servers configuration object.

Server Select the name of the virtual server that is in the servers virtual server list configuration.

Member

Weight Assigns relative preference among members—higher values are more preferred and are assigned

connections more frequently.
The defaultis 1. The valid range is 1-255.

Backup Enable to designate the member as a backup. Backup members are inactive until all main members
are down.
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Configuring location lists

A location list configuration consists of a list of locations you select.

To configure a location list:

Go to Global Load Balance > FQDN Settings.

Click the Location List tab.

Complete the configuration as described in Location List settings on page 216.
Click Save.

P obh-=

Location List settings

Settings Guidelines

Name Specify a unique name for the location list.

GEO IP List Create a GEO IP list:
1. Click inside the box.
2. Select an option from the drop-down list menu.
3. Repeat Steps 1 and 2 to add more locations to the list.
Note: To remove an entry off your list, click the corresponding x sign.

Note: Stating from FortiADC 5.x.x, the GUI shows the full country or region names listed in alphabetical order for location
list and data center configuration. The Console uses country or region name abbreviations instead. The abbreviations
are done in accordance with the ISO standards. So if you configure a location list or data center from the Console, be
sure to consult ISO-3166-1 and/or ISO 3166-2:CN for the correct abbreviations to use. See the following example
commands:

config global-load-balance topology

edit "tpl"
set member ZZ US CN65
next
end

Where ZZ stands for Reserved, US for United States, and CN65 for China, Xingjiang

Logical Topology

The FortiView>Global Load Balance>Logical Topology page shows the logical topology of your global load balance
configurations.

Adding hosts

To add a host:

1. Click Add Host.
2. Make desired entries or selections as described in Configuring hosts on page 211
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3. Click Save when done.

Note: While in Editor View, you click any component in the logical topology to edit or delete it.

Filtering hosts

The Add Filters button on top of the page allows you to customize the logical topology by:
o Availability
» Host
o Domain Name
e VS Pool
o Server
o Server Member
o Data Center

To add afilter:
1. Click the Add Filters button.

2. Select the desired filter from the drop-down list menu.

Note: You can use the same steps to apply multiple filters. Applied filters appear in front of the Add Filters button in the
order they are added. You can remove a filter by clicking the x sign on it.

Configuring a Global DNS policy

The Global DNS policy is a rule base that matches traffic to DNS zones. Traffic that matches both the source and the

destination criteria is served by the policy. Traffic that does not match any policy is served by the DNS “general settings”
configuration.

Before you begin, you must have:

« A good understanding of DNS and knowledge of the DNS deployment in your network.

» Configured address objects, remote servers, DNS zones, and optional configuration objects you want to specify in
your policy.

« Read-Write permission for Global Load Balance settings.

To configure the global DNS policy rule base:

Go to Global Load Balance > Zone Tools.

Click the Global DNS Policy tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Global DNS policy configuration on page 218.
Save the configuration.

2B

Reorder rules, as necessary.
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Global DNS policy configuration

Settings Guidelines

Name Configuration name. Valid characters are 2A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Source Select an address object to specify the source match criteria. See Configuring an address
group.

Destination Select an address object to specify the destination match criteria. See Configuring an address
group.

Zone List Select one or more zone configurations to serve DNS requests from matching traffic. See

Configuring DNS zones.

DNS64 List Select one or more DNS64 configurations to use when resolving IPv6 requests. See
Configuring DNS64.
Recursion Enables/disables recursion. If enabled, the DNS server attempts to do all the work required to

answer the query. If not enabled, the server returns a referral response when it does not
already know the answer.

DNSSEC Validation Enables/disables DNSSEC validation.

Forward ¢ First—The DNS server queries the forwarders list before doing its own DNS lookup.
¢ Only—Only queries the forwarders list. Does not perform its own DNS lookups.
Note: The internal server caches the results it learns from the forwarders, which optimizes
subsequent lookups.

Forwarders If the DNS server zone has been configured as a forwarder, select the remote DNS server to
which it forwards requests. See Configuring remote DNS servers.

Response Rate Limit ~ Select a rate limit configuration object. See Configuring the response rate limit.
Reordering

" After you have saved a rule, reorder rules as necessary. The rules table is consulted from top
+ to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Configuring DNS zones

The DNS zone configuration is the key to the global load balancing solution. This configuration contains the key DNS
server settings, including:
« Domain name and name server details.
o Type—Whether the server is the primary or a forwarder.
o DNSSEC—Whether to use DNSSEC.
« DNS RR records—The zone configuration contains resource records (RR) used to resolve DNS queries delegated
to the domain by the parent zone.

You can specify different DNS server settings for each zone you create. For example, the DNS server can be a primary
for one zone and a forwarder for another zone.
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Before you begin:

» You must have a good understanding of DNS and knowledge of the DNS deployment in your network.
« You must have authority to create authoritative DNS zone records for your network.
« You must have Read-Write permission for Global Load Balance settings.

After you have configured a DNS zone, you can select it in the DNS policy configuration.

To configure the DNS zone:

Go to Global Load Balance > Zone Tools.

Click the Zone tab.

Click Create New to display the configuration editor.

Complete the configuration as described in DNS zone configuration on page 219.

P obh-=

DNS zone configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
the name in the global DNS policy configuration.
Note:
¢ FortiADC supports third-party domain names.
» After you initially save the configuration, you cannot edit the name.

Type ¢ Primary—The configuration contains the “primary” copy of data for the zone and is the
authoritative server for it.
¢ Forward—The configuration allows you to apply DNS forwarding on a per-domain basis,
overriding the forwarding settings in the “general” configuration.
* FQDN Generate—The zone and its resource record is generated from the global load
balancing framework.

Domain Name The domain name must end with a period. For example: example.com.
DNS policy Select the DNS policy you want the zone to use.
Forward Options

Forward ¢ First—The DNS server queries the forwarder before doing its own DNS lookup.
¢ Only—Only query the forwarder. Do not perform a DNS lookup.
* Note: The internal server caches the results it learns from the forwarders, which
optimizes subsequent lookups.

Forwarders Select a remote server configuration object.
Primary Options
TTL The $TTL directive at the top of the zone file (before the SOA) gives a default TTL for every

RR without a specific TTL set.
The default is 86,400. The valid range is 0 to 2,147,483,647.
Negative TTL The last field in the SOA—the negative caching TTL. This informs other servers how long to

cache no-such-domain (NXDOMAIN) responses from you. The default is 3600 seconds. The
valid range is 0 t0 2,147,483,647.
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Settings Guidelines

Responsible Mail Username of the person responsible for this zone, such as hostprimary.example.com..
Note: Formatis mailbox-name.domain.com. (remember the trailing dot). The format
uses a dot, not the @ sign used in email addresses because @ has other uses in the zone file.
Email, however, is sent to hostprimary@example.com.

Primary Server Sets the server name in the SOA record.
Name

Primary Server The IP address of the primary server.
Address

DNSSEC Enable/Disable DNSSEC

Only when a DNS policy has been set, and DNESSC is enabled, will the Back Up
DSSET Key, Regenerate DNNSEC Key, and Restore DNSSEC Key appear.
Back Up DSSET Key includes the following types of keys:
¢ KSK. Type characters for a string key. To regenerate the KSK, disable and re-enable
DNSSEC.
e ZSK. Type characters for a string key. To regenerate the ZSK, disable and re-enable
DNSSEC.
* DSSET. Itis generated by the system if DNSSEC is enabled for the zone.
Restore DNSSEC Key should be a tar type file.

DSSET List Select a DSSET configuration object. See Configuring the DSSET list.

Serial Set the serial number of the zone. Default 10004. Range 1-4294967295.

Notify Status Enable/Disable notify status. The IP in "also notify IP list" will be notified only when Notify
Status is enabled.

Also Notify IP List Set a list of IP addresses that will be notified if Notify Status is enabled.

Allow Transfer Defines a list of IP addresses that are allowed to transfer the DNS zone information.

By default there will be "Any" and "None."
FQDN Record

FQDN Record table Displays a summary of all DNS RR for the zone, including generated and manually configured

RR.
A/AAAA Record
Hostname The hostname part of the FQDN, such as www.
Note: You can specify the @ symbol to denote the zone root. The value substituted for @ is
the preceding $ORIGIN directive.
Type o |Pv4
e |Pv6
Address Specify the IP address of the virtual server.
Method Weighted Round Robin is the only method supported.
CNAME Record
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Settings Guidelines

Alias An alias name to another true or canonical domain name (the target). For instance,
www.example . comis an alias for example.com.

Target The true or canonical domain name. For instance, example . com.
NS Record
Domain Name The domain for which the name server has authoritative answers, such as example. com.

Note: FortiADC supports third-party domain names.

Hostname The hostname part of the FQDN, such as ns.
Type o |Pv4
e |IPv6
Address Specify the IP address of the name server.
MX Record
Hostname The hostname part of the FQDN for a mail exchange server, such asmail.
Priority Preference given to this RR among others at the same owner. Lower values have greater
priority.
Type e |Pv4
e |IPv6
Address Specify the IP address.
TXT Record
Name Hostname.

TXT records are name-value pairs that contain human readable information about a host. The
most common use for TXT records is to store SPF records.

Text Comma-separated list of name=value pairs.
An example SPF record has the following form:
v=spfl +mx a:colo.example.com/28 -all

If you complete the entry from the the Web Ul, do not put the string in quotes. (If you complete
the entry from the CLlI, you do put the string in quotes.)

SRV Record
Host Name The host name part of the FQDN, e.g., www.
Priority A priority assigned to the target host: the lower the value, the higher the priority.
Weight A relative weight assigned to a record among records of the same priority: the greater the
value, the more weight it carries.
Port The TCP or UDP port on which the service is provided.
Target Name The canonical name of the machine providing the service.
PTR Record
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PTR address A PTR address, such as 10.168.192.in-addr.arpa. or 1
FQDN A fully qualified domain name, such as "www.example.com".
CAA Record

Hostname The hostname of CAA record

Value Specify the value

Flag Range 0-255. Default is 0.

Tag Issue/lssuewild/lodef

Configuring general settings

The general settings configuration specifies the interfaces that listen for DNS requests. By default, the system listens on
the IPv4 and IPv6 addresses of all configured interfaces for DNS requests.

The other settings in the general settings configuration are applied when traffic does not match a Global DNS policy.

From general settings, you can also enable DNS over HTTP/HTTPS (DoH) and DNS over TLS (DoT) to encrypt the DNS
query.

Before you begin:

« You must have a good understanding of DNS and knowledge of the DNS deployment in your network.
« You must have Read-Write permission for Global Load Balance settings.

 Ifenabling DNS over HTTPS/TLS, you must have prepared a dedicated DNS server domain and a certificate pair
for your DNS over HTTPS/TLS service. For details, see Configuring DNS over HTTPS and DNS over TLS on page
224,

To configure general settings:

1. Goto Global Load Balance > Zone Tools.

2. Click the General Settings tab.

3. Complete the configuration as described in General configuration on page 222.
4. Save the configuration.

General configuration

Settings Guidelines

Global DNS Enables/disables this configuration.

Configuration

Recursion Enables/disables recursion. If enabled, the DNS server attempts to do all the work required to

answer the query. If not enabled, the server returns a referral response when it does not
already know the answer.
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Settings Guidelines

DNSSEC Validation Enables/disables DNSSEC validation.

Listen on IPv6 Enables/disables listening for DNS requests on the interface IPv6 address.
Listen on IPv4 Enables/disables listening for DNS requests on the interface IPv4 address.
Traffic Log Enables/disables traffic log.

Listen on All Enables listening on all interfaces.

Interface

Interface List The Interface List option is available if Listen on All Interface is disabled.

If not listening to all interfaces, select one or more ports to listen on.
DNS over HTTPS Enables/disables DNS over HTTPS to encrypt DNS queries using the HTTPS protocol.
DNS over HTTPS The DNS over HTTPS Port option is available if DNS over HTTPS is enabled.

Port Specify the port to listen on DNS over HTTPS. Default: 443 Range: 1-65535.

DNS over HTTPS The DNS over HTTPS Interface List option is available if DNS over HTTPS is enabled.
Interface List Select the interface(s) to listen on for DNS over HTTPS.

DNS over HTTP Enables/disables DNS over HTTP to encrypt DNS queries using the HTTP protocol.

DNS over HTTP Port The DNS over HTTP Port option is available if DNS over HTTP is enabled.
Specify the port to listen on DNS over HTTP. Default: 80 Range: 1-65535.

DNS over HTTP The DNS over HTTP Interface List option is available if DNS over HTTP is enabled.
Interface List Select the interface(s) to listen on for DNS over HTTP.
DNS over TLS Enables/disables DNS over TLS to encrypt DNS queries using the TLS protocol.

DNS over TLS Port The DNS over TLS Port option is available if DNS over TLS is enabled.
Specify the port to listen on DNS over TLS. Default: 853 Range: 1-65535.

DNS over TLS The DNS over TLS Interface List option is available if DNS over TLS is enabled.
Interface List Select the interface(s) to listen on for DNS queries for DNS over TLS.
Certificate The Certificate option is available if DNS over HTTPS or DNS over TLS is enabled.

Select the certificate object to apply for DNS over HTTPS or DNS over TLS. This certificate
must refer to the DNS server domain or IP address. For details, see Configuring DNS over
HTTPS and DNS over TLS on page 224.

Forward ¢ First—The DNS server queries the forwarder before doing its own DNS lookup.
¢ Only—Only queries the forwarder. Does not perform its own DNS lookups.
Note: The internal server caches the results it learns from forwarders, which optimizes
subsequent lookups.

Use System DNS Forwards DNS requests to the system DNS server instead of the forwarders list.
Server

Response Rate Limit  Selects a rate limit configuration object. See Configuring the response rate limit.
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Configuring DNS over HTTPS and DNS over TLS

DNS over HTTPS (DoH) and DNS over TLS (DoT) are protocols used to encrypt communications with DNS resolvers.
DoH encrypts the DNS traffic by passing DNS queries through an HTTPS encrypted session. Whereas DoT adds TLS
encryption on top of the UDP that is used for DNS queries.

The primary difference between the DoH and DoT standards is what port they use. DoT only uses port 853, whereas
DoH uses port 443 (which is the port that all other HTTPS traffic uses as well).

To configure DNS over HTTPS or DNS over TLS on FortiADC, follow the basic steps below:

Step 1: Prepare a full domain name or an IP address for your DoH/DoT service on page 224
Step 2: Prepare a certificate pair for the DoH/DoT service on page 224
Step 3: Enable DoH/DoT service on FortiADC on page 225

Step 4: Enable DoH/DoT service on your browser or local application on page 226

Step 1: Prepare a full domain name or an IP address for your DoH/DoT service

Before you can configure DoH/DoT on FortiADC, you must first prepare a full domain name or an IP address for the
DoH/DoT service. This will then be used for your custom DoH/DoT server URL and to sign the certificate.

You can prepare the full domain using either of the following methods:

« If your organization manages its own public domain, you can add a new record to the domain.
a. Login to you DNS service provider and go to your DNS Domain management page.

b. Add anew record to the existing public domain as dns. yourdomain.com. The IP address is the DNS-over-
HTTPS or DNS-over-TLS service public IP.

« If you want to test your own domain, you can add the full domain name resolution to the local hosts file.
For example: The Ubuntu local hosts file would be located at /etc/hosts, and in Windows it would be at
c:\Windows\System32\Drivers\etc\hosts.

Step 2: Prepare a certificate pair for the DoH/DoT service

Use the full domain name or IP address for the DoH/DoT service previously prepared to create a certificate pair.
You can prepare the certificate pair for your DoH/DoT service using either of the following methods:

» Apply for a public certificate from a public CA with your full domain name or IP address.

» Generate a self-signed certificate. Note: A self-signed certificate cannot be generated through FortiADC.
For example: Generating a self-signed certificate in Ubuntu with OpenSSL

a. Prepare the prerequisites:

mkdir demoCA

mkdir demoCA/newcerts
echo 01 > demoCA/serial
touch demoCA/index.txt

b. Add the following lines to the file /usr/lib/ssl/openssl.cnf underthe [v3_ req] section.

subjectAltName = Qalt names
[alt names]
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DNS.l=dns.yourdomain.com
IP.l=yourdomain IP

c. Generate the root CA key.
openssl genrsa -out rootca.key 2048
d. Generate the root CA cert.

openssl req -new -x509 -days 3650 -key rootca.key -out rootca.crt -subj
"/C=Country/ST=State/L=Location/O=Company/OU=Department/CN=yourdomain.com/emailAddre
ss=admin@yourdomain.com"

e. Generate the DNS server private key.
openssl genrsa -out dns-doh.key 2048
f. Generate the DNS server cert (enter y if prompted).

openssl req -new -key dns-doh.key -out dns-doh.csr -subj
"/C=Country/ST=State/L=Location/O=Company/OU=Department/CN=yourdomain.com/emailAddre
ss=admin@yourdomain.com"

openssl ca -in dns-doh.csr -out dns-doh.crt -cert rootca.crt -keyfile rootca.key -
days 365 -extensions v3 reqg

g. Verify the certificate.

openssl verify -CAfile rootca.crt dns-doh.crt

Step 3: Enable DoH/DoT service on FortiADC

After preparing the certificate pair for the DoH/DoT service, you can import the certificate and then enable the DoH/DoT
function in FortiADC.

1. Goto System > Manage Certificates.

2. Click the Local Certificate tab.
3. Click Import to upload the prepared certificate in FortiADC.
4. Goto Global Load Balance > Zone Tools.
5. Click the General Settings tab.
6. Configure the following relevant settings to enable DNS over HTTPS service and save the configuration:
Setting Guidelines
Global DNS Configuration Enable Global DNS Configuration.
DNS over HTTPS Enable DNS over HTTPS service.
DNS over HTTPS port Default port is 443. Change the HTTPS service port number if it is not the

default HTTPS service port or if there is an IP/port conflict.
DNS over HTTPS Interface List  Select the interfaces that allow the DNS over HTTPS service.

Certificate Select the matching certificate.

a. Testyour DNS over HTTPS configuration.
For example, you can use a DNS lookup tool such as Dig from a remote system.
dig @yourdomain.com example.com +https
If the DNS over HTTPS is successfully configured, you should get the IP address of example.com:
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93.184.216.34.

From Dig's output, you should also see the following:

;; SERVER: 18.217.127.135#443 (dns.yourdomain.com) (HTTPS)

This confirms that the query/response operation was performed successfully over HTTPS (TCP port 443)
rather than the traditional UDP port 53.

7. Configure the following relevant settings to enable DNS over TLS service and save the configuration:

Global DNS Configuration Enable Global DNS Configuration.

DNS over TLS Enable DNS over TLS service.

DNS over TLS port Default port is 853.

DNS over TLS Interface List Select the interfaces that allow the DNS over TLS service.
Certificate Select the matching certificate.

a. Testyour DNS over TLS configuration.
For example, you can use a DNS lookup tool such as Dig from a remote system.
dig @yourdomain.com example.com +tls
If the DNS over HTTPS is successfully configured, you should get the IP address of example.com:
93.184.216.34.
From Dig's output, you should also see the following:
;7 SERVER: 18.217.127.135#853(dns.yourdomain.com) (TLS)
This confirms that the query/response operation was performed successfully over TLS (TCP port 853) rather
than the traditional UDP port 53.

Step 4: Enable DoH/DoT service on your browser or local application

After you have configured DoH/DoT on FortiADC, enable DoH/DoT service on your browser or local application.
However, if you have used a self-signed certificate pair, you need to firstimport that certificate into the local system
before enabling DoH/DoT on the browser or local application.
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Importing the self-signed certificate pair to the local system for DoH/DoT

Example 1: Importing the self-signed certificate to Windows

1. Launch MMC (mmc.exe). Go to File > Add/Remove Snap-ins.

i Consolel - [Console Root]
File Action View Favorites Window Help
@ New Ctri+N

Open... Ctrd+0
Save Ctrl+S
Save As...

There are no items to show in this view. Console Root

More Actions
Add/Remove Snap-in... Ctrl+M
Options...

Recent File

Exit

Enables you to add snap-ins to or remove them from the snap-in console.

2. Select Certificates, then click Add.
The Certificates snap-in dialog displays.
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3. Inthe Certificates snap-in dialog, select My user account. Click Finish, then click OK.

Add or Bemove Snan-ins

o

You can select snap-ns for this console from those available on your computer and configure the selected set of snap-ins. For

extensible snap-ins, you can configure which

extensions are enabled.

Avaiable snap-ins: Selected snap-ins: h:m(
Snap-in Vendor A [ Console Root Edit Extensions, .. k Actions
= ActiveX Control Microsoft Cor... L
huthorizalion Manager Microsoft Cor... Certificates snap-in
5 Certificates Microsoft Cor...

. Component Services  Microsoft Cor...

A Computer Managem... Microsoft Cor... This snap-n will always manage cerfficates for:
% Device Manager Microsoft Cor... (®) My user account
by Disk Management Microsoft and. .. @
{3 Event Viewer Micrasoft Cor...

~| Folder Microsoft Cor... O Computer account

.=/ Group Policy Object ... Microsoft Cor...

3, 1p Security Monitor  Microsoft Cor...

& 1p Seawrity Policy M...  Mirosoft Cor...

; Link to Web Address ~ Microsoft Cor...

Description:

The Certificates snap-in allows you to browse the contents of the ¢

| .|

Cancel

<o
P ——————————

4. Select Certificates - Current User, right-click on Trusted Root Certification Authorities. Then select All Tasks

> Import.
% Consolel - [Console Root\Certificates - Current User] - O X
@ File Action View Favorites Window Help -8 x
e nmolc=H
‘_ ‘:_0"‘50'9 Root Logical Store Name Actions
» L Certificates - Current User B perconal 3 - TE—
| | Trusted Root Certification Authoritig -
- . Find Certificates... Miare Aictions g
| Enterprise Trust
_ Intermediate Certification Authoritie Al Tasks » e e Certification A... &
| Active Directory User Object ) e Actions 4
T Trusted Publishers New Window from Here Import...
| Untrusted Certificates Refresh
" Third-Party Root Certification Authc
I Trusted People Help

“| Client Authentication Issuers
I Local NonRemovable Certificates
" Certificate Enrollment Requests
" Smart Card Trusted Roots

Contains actions that can be performed on the item.

The Certificate Import Wizard dialog displays.
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5. Inthe Certificate Import Wizard dialog, click Browse to select the rootca.crt file and click Open.

E o x —

@& File Action View Favorites =
——— € £* Cerificate Import Wizard I

e a@ala:=l

y

| Console Root | Actions
L4l Certificates - Current User i i e e
1 Specify the file you want to import. More Actions
Trusted Root Certification A...
File name: =
More Actions
C:\Wsers\Administrator\Desktop\rootca.art | | Browse... |
R L
y O
Personal | @ Upen
Cryptogri 4 B > ThisPC > Desktop v (¥] Search Desktop
Microsoft
Organize « MNew folder =z + TR
“ Videos ~ MName . Date modified
& OneDrive =l rootca 8/2/2022 459 PM
[ This PC
wa LocalDisk (D) w <
File name: [rootca w | X509 Certificate (".cer;".crt)

Trusted Root Certification Authorities Sture cunmams o cermma)

Type

Security]

X

R

~

6. Select Place all certificates in the following store and set Trusted Root Certification Authorities as the
Certificate store. Click Next and Next again, then click Finish.

7. Click Yes and Finish for the prompt windows.

Example 2: Importing the self-signed certificate to Ubuntu

1. Install or update ca-certificates.
$ sudo apt-get install -y ca-certificates

2. Copy your certificate in PEM format (the format that has ----BEGIN CERTIFICATE----init)into
/usr/local/share/ca-certificates and name it with a .crtfile extension.

$ sudo cp rootca.crt /usr/local/share/ca-certificates
3. Update your ca chain list.

$ sudo update-ca-certificates
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Enabling DNS over HTTPS on the browser

Example 1: Enable DoH in Chrome (version 105.0.5195.102)

1. Import self-signed certificate to Chrome. You may skip this step if you use a public certificate.
a. Open chrome://settings/privacy and select Security.
« > C (\‘,-‘; Chrome | chrome://settings/privacy < ﬁ) @ 2 & 0O

% FortiADCTea... % GitLab B¢ Translate 2! FortiGSLB-local = FortiGSLB-AWS < DecimaltoIP... # Binary/Decim...

@ Settings Q, search settings
= You and Google
- g Safety check
B Autofil
. . Q Chrome can help keep you safe from data breaches, bad extensions, and more m
@ Privacy and security
@  Appearance
Privacy and security
Q,  Search engine
—  Clearbi ing dat
BN Default browser ear _mwsmg ata »
Clear history, cookies, cache, and more
() On startup
Privacy Guide R
Review key privacy and security controls
@@ Languages
& Cookies and other site data R
¥ Downloads Third-party cookies are blocked in Incognito mode
T  Accessibility e Security X
Safe Browsing (protection from dangerous sites) and other security settings
9,  System
£)  Reset settings - Site Settings N
“F  Controls what information sites can use and show (location, camera, pop-ups, and maore)
W Extensions [ i Privacy Sandbox 0
Trial features are on
®  About Chrome
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b. Scroll down and select Manage Certificates > Authorities, then click Import.
& > C & chrome | chrome://settings/certificates < E% n & 0O

©: FortiADCTea... % GitLab B¢ Translate 2 FortiGSLB-local E FortiGSLB-AWS < DecimaltoIP... # Binary/Decim...

@ Se‘[‘tings Q, search settings
= Youand Google < Manage certificates
B Autofil
Your certificates Servers Authorities Others
@  Privacy and security
@  Appearance ) o § i
You have certificates on file that identify these certificate authorities Import
Q,  Search engine
BD  Default browser org-AC Camerfirma S.A. v
()  Onstartup
org-AC Camerfirma SA CIF A82743287 ~
@ Languages org ACCY o
5 Naumlands
c. Select the file rootca.crt and open. Check all the boxes and click OK.
& > C & chrome | chrome;/settings/certificates < Eﬁﬂl % 0O

% FortiADCTea... Y GitLab B+ Translate 22 FortiGSLB-local % FortiGSLB-AWS <> DecimaltoIP... # Binary/Decim...

Certificate authority
The certificate "fortiadc-dev” represents a Certification Authority

Trust settings

Trust this certificate for identifying websites

Trust this certificate for identifying email users

Trust this certificate for identifying software makers

2. Enable custom DNS over HTTPS settings.
a. Goto Settings > Privacy and security > Security.
b. Enable Use secure DNS, select With, then select Custom from the drop-down list.
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c. Inputthe URL that matches your FortiADC DNS server domain and your certificate as
https://yourdomain/dns-queryoOrhttps://yourIP:port/dns-query.

@ Settings
= Youand Google
B Autofil
@ Privacy and security
&  Appearance
Q,  Search engine
BN Default browser
() On startup
@ Languages
¥  Downloads
T Accessibility
9,  System
40  Reset settings

3. Debugging.
Try the following URL and see if there is a file downloading.
https://yourdomain/dns-query?dns=q80BAAABAAAAAAAAA3d3dwdleGFtcGx1A2NVDQAAAQAR
If downloaded, then all configurations are correct.

Otherwise, the most common erroris ERR_CERT COMMON NAME INVALID, which means your server cert CN is
invalid or does not match your FortiADC server.

Q, Search settings

Advanced

Always use secure connections
Upgrade navigations to HTTPS and warn you before loading sites that don't support it

Use secure DNS
Determines how to connect to websites over a secure connection

O  with your current service provider
Secure DNS may not be available all the time

@® Wwith Custom -

https://dns.fortiadc-dev.com/dns-query

Manage security keys
Reset security keys and create PINs

Manage certificates
Manage HTTPS/SSL certificates and settings

SocgendesdProtesonPosEm z

Example 2: Enable DoH in Firefox (version 104.0.2)

1. Import self-signed certificate to Firefox. You may skip this step if you use a public certificate.
a. Goto Settings > Privacy & Security, under the Certificates section, click View Certificates.

(_

&) @ Firefox

E§3 General
@ Home
Q_ search

& Privacy & Security

Q Sync
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about:preferences#privacy w 4,

Find in Settings

Warn you about unwanted and uncommon software

Certificates

0 Query OCSP responder servers to confirm the current validity ~ View Certificates...
~ of certificates

Security Devices...
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b. Select Authorities, click Import and select your root CA file. Check all the boxes and click OK to save.
« — O @ Firefox about:preferences#privacy g ® & O =

Certificate Manager

Your Certificates Authentication Decisions People Servers Authorities

Downloading Certificate

You have certificates on file that identify these ce

| certificate Name | s You have been asked to trust a new Certificate Authority (CA).

~ AC Camerfirma S.A. Do you want to trust “fortiadc-dev” For the Following purposes?
chambers of Commerce Root - 2008 By ¥ Trust this CA to identify websites.
Global chambersign Root - 2008 BL Trust this CA to identify email users.

~ AC Camerfirma SA CIF AB2743287 Before trusting this CA for any purpose, you should examine its

Camerfirma Chambers of Commerce R... B certificate and its policy and procedures (if available).

Camerfirma Global Chambersign Root  Bu View Examine CA certificate

Cancel

View... Edit Trust... Import...

2. Enable custom DNS over HTTPS settings.
a. Goto Settings > General, under the Network Settings section, click Settings.

< > C & Firefox about:preferences o7 ® v 0

" O Find in Settings ‘

@3 General

Search for text when you start typing

@ Home Enable picture-in-picture video controls Learn more
Q Search Control media via keyboard, headset, or virtual interface Learn more
e) Privacy & Security Recommend extensions as you browse Learn more

Recommend features as you browse Learn more

(D Sync
E More from Mozilla
Network Settings

&7 Extensions & Themes Configure how Firefox connects to the internet. Learn more Settings...

® Firefox Support

b. Select Enable DNS over HTTPS. In the Use Provider field, select Custom from the drop-down list.
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c. Inputthe URL that matches your FortiADC DNS server domain and your certificate as
https://yourdomain/dns-queryoOrhttps://yourIP:port/dns-query. Click OK to save.

&) & Firefox about:preferences bk @ & 0

Connection Settings X

No proxy for

Example: .mozilla.org, .net.nz, 192.168.1.0/24

Connections to localhost, 127.0.0.1/8, and ::1 are never proxied.

[] Do not prompt for authentication if password is saved
[] Proxy DNS when using SOCKS v5

Enable DNS over HTTPS

Use Provider  Custom v

Custom| https://dns.Fortiadc-dev.com/dns-query|

Help Cancel ﬂ

/‘

3. Debugging.
Try the following URL and see if there is a file downloading.
https://yourdomain/dns-query?dns=gq80BAAABAAAAAAAAA3d3dwdleGFtcGx1A2NVbQAAAQAR
If downloaded, then all configurations are correct.
Otherwise, the most common erroris ERR_CERT COMMON NAME INVALID, which means your server cert CN is
invalid or does not match your FortiADC server.

Enabling DNS over TLS on your local application

Example 1: Enable DoT in Ubuntu with systemd

1. Check the systemd version.
systemd start to support strict DNS over TLS mode from version 243. Use the following command to check your
version and update it if the version is too old.

$ systemd --v
systemd 249 (249.11-0Oubuntu3.6)

2. Setup the systemd configuration.
Modify /etc/systemd/resolved. conf so thatitis similar to what is shown below. Be sure to enable DNS over
TLS and to configure the IP addresses of the DNS servers you want to use.

$ cat /etc/systemd/resolved.conf
DNS=10.106.210.81
FallbackDNS=8.8.8.8

#Domains=

#DNSSEC=no

DNSOverTLS=yes

FortiADC 7.2.0 Handbook 234
Fortinet Inc.



Chapter 6: Global Load Balancing

#LLMNR=yes
#MulticastDNS=yes
#Cache=yes
#DNSStubListener=yes
#ReadEtcHosts=yes

Restart services.
To make the settings configured in the previous steps take effect, restart systemd-resolved.

$ sudo systemctl restart systemd-resolved
Check that everything is running correctly.

$ resolvectl status
Global
Protocols: -LLMNR -mDNS +DNSOverTLS -DNSSEC
resolv.conf mode: foreign
Current DNS Server: 10.106.210.81
DNS Servers: 10.106.210.81
Fallback DNS Servers: 8.8.8.8

Verify the configuration.
Use the following command to perform a DNS query.

$ sudo resolvectl flush-caches

$ resolvectl query google.com

google.com: 142.250.72.206 -- link: ensl160
2607:£8p0:4005:801::200e -- link: ensl160

-- Information acquired via protocol DNS in 23.8ms.

-- Data is authenticated: no; Data was acquired via local or encrypted transport:

-- Data from: network

Use tcpdump to capture the traffic in another terminal. You will find that the traffic goes to DNS server
10.106.210.81 port 853 instead of the regular DNS service port 53.

Example 2: Enable DoT in Ubuntu with Unbound

1.

Install Unbound.

# sudo apt install -y unbound
# sudo systemctl enable unbound

Edit the configuration file.

# cat /etc/unbound/unbound.conf.d/pihole.conf
server:
port: 53
tls-upstream: yes
tls-cert-bundle: "/etc/ssl/certs/ca-certificates.crt"

forward-zone:
" "

name:
forward-addr: 10.106.210.81@853

# unbound-checkconf
unbound-checkconf: no errors in /etc/unbound/unbound.conf

FortiADC 7.2.0 Handbook
Fortinet Inc.

yes

235



Chapter 6: Global Load Balancing

3. Restart services.
# sudo systemctl restart unbound

4. Verify the configuration.
Perform a simple Dig test and use tcpdump to capture the traffic in another terminal. You will find that all the DNS
traffic goes to Server 10.106.210.81 port 853 instead the regular DNS service port 53.

Example 3: Enable DoT in Windows with YogaDNS

1. Go to https://dns.sb/guide/dot/windows/
2. Setthe IP address and optional port to match your FortiADC configuration.
3. Under DNS over TLS options, set the Hosthame to match your certificate or you may leave it blank. Click OK.

DMS Server >
User friendly name: |dns-fartiadn:-deu |
Type: DMNS over TLS £

IP address and optional port: | 10, 108,210,581 |

[ ] DMSSEC Supported edns://

DMS over TLS options

Hostname: | | |

S

Hashes: | |

[ Chedk Cancel

Configuring the trust anchor key

DNSSEC validation requires that a DNS name server know the trust anchor key for the root DNS domain in order to
validate already signed responses. In general, trust anchor keys do not change often, but they do change occasionally,
and might change unexpectedly in the event the keys are compromised.

The FortiADC DNS server is preconfigured with a trust anchor key for the root DNS domain. If you are informed that you
must update this key, you can use the configuration editor to paste the new content into the DNS server configuration.

Further reading:
http://data.iana.org/root-anchors/draft-icann-dnssec-trust-anchor.html

Before you begin:
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e You must have a good understanding of DNSSEC and knowledge of the DNS deployment in your network.
« You must have already obtained the key so that you can copy and paste it into the DNS server configuration.
» You must have Read-Write permission for Global Load Balance settings.

To configure the trust anchor key:

Go to Global Load Balance > Zone Tools.
Click the Trust Anchor Key tab.
Click Create New to display the configuration editor.

Complete the configuration as described in Trust anchor key configuration on page 237.
Save the configuration.

oD =

Trust anchor key configuration

Settings Guidelines

Name Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Value The key value. The key format is a string with the following format:
\"<domainname>\" <numl> <num2> <num3> \"<content>\"
The following is an example:
\".\" 256 3 5
\"AwWEAAbLDrWmiIReotvZ6FObgKygZwUxSUJWIz5p ] iOMLHOJBGX00HrR1 6
pdKhI9mNkM8bLUMtwYfgeUOYXIvifagee8rk=\"

Description Description for the key.

Configuring DNS64

The DNS64 configuration maps IPv4 addresses to AAAA queries when there are no AAAA records. This feature is

optional. It can be used in network segments that use NAT64 to support IPv6 client communication with IPv4 backend
servers.

Before you begin:

» You must have a good understanding of DNS and knowledge of the DNS deployment in your network.

» You must have configured address objects that specify the network segments for which the DNS64 map applies.
See Configuring an address group.

» You must have Read-Write permission for Global Load Balance settings.

After you have created a DNS64 configuration, you can select it a DNS policy configuration.

To configure DNS64:

Go to Global Load Balance > Zone Tools.

Click the DNS64 tab.

Click Create New to display the configuration editor.

Complete the configuration as described in DNS64 configuration on page 238.

Ao bdh-=
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DNS64 configuration

Settings Guidelines

Name Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces. You reference
the name in the global DNS policy configuration.
After you initially save the configuration, you cannot edit the name.

IPv6 Prefix IP address and netmask that specify the DNS64 prefix. Compatible IPv6 prefixes have
lengths of 32, 40, 48, 56, 64 and 96 as per RFC 6052.
Each DNS64 configuration has one prefix. Multiple configurations can be defined.

Source Address Select an address object. Only clients that match the source IP use the DNS64 lookup table.

Mapped Address Select an address object that specifies the IPv4 addresses that are to be mapped in the
corresponding A RR set.

Exclude Select an address object. Allows specification of a list of IPv6 addresses that can be ignored.

Typically, you exclude addresses that do have AAAA records.

Configuring the DSSET list

If you enable DNSSEC, secure communication between the FortiADC DNS server and any child DNS servers is based
on keys contained in delegation signer files (DSSET files). In DNSSEC deployments, DSSET files are generated
automatically when the zone is signed by DNSSEC.

You use the DSSET list configuration to paste in the content of the DSSET files provided by child domain servers or stub
domains.

Note: You use the Global DNS zone configuration to generate the DSSET file for this server. The file generated by the
zone configuration editor is the one you give to any parent zone or the registrar of your domain.

Before you begin:

» You must have a good understanding of DNSSEC and knowledge of the DNS deployment in your network.

» You must have used DNSSEC to sign the child domain servers and have downloaded the DSset files to a location
you can reach from your management computer.

« You must have Read-Write permission for Global Load Balance settings.

After you have configured a DSSET list, you can select it in DNS zone configuration.

To configure the DSSET list:

Go to Global Load Balance > Zone Tools.

Click the DSSET List tab.

Click Create New to display the configuration editor.

Complete the configuration as described in DSset list configuration on page 239.

o bN-=
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DSset list configuration

Settings Guidelines

Name Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces. You reference
the name in the zone configuration (if you enable DNSSEC).

After you initially save the configuration, you cannot edit the name.
Filename Type the filename. The convention is dsset-<domain>, for example, dsset-example.com.

Content Paste the DSset file content. The content of DSset files is similar to the following:

dns.example.com. IN DS 13447 5 1
AS5AD9EFB6840F58CF817F3CC7C24A7ED2DD5559C

Configuring an address group

An address group is a configuration object that specifies the source and destination IP addresses that are the matching
criteria for DNS policies.

Before you begin:
« You must have Read-Write permission for Global Load Balance settings.

After you have configured an address group, you can select it in the DNS policy configuration.

To configure address groups:

Go to Global Load Balance > Zone Tools.
Click the Address Group tab.
Click Create New to display the configuration editor.

Ao bd-=

Complete the configuration and add members as described in Address group configuration on page 239

Address group configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the global DNS policy configuration.

Note: After you initially save the configuration, you cannot edit the name.

Member
Address Type e IPv4
e |IPv6
IP/Netmask Address/mask notation to match the IP address in the packet header.
Create objects to match source IP address and different objects to match destination IP
address.
Action ¢ Include—The rule logic creates an address object that includes addresses matching the
specified address block.
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Settings Guidelines

¢ Exclude—The rule logic creates an address object that excludes addresses matching the
specified address block.

Configuring remote DNS servers

The remote server configuration is used to create a list of DNS forwarders. DNS forwarders are commonly used when
you do not want the local DNS server to connect to Internet DNS servers. For example, if the local DNS server is behind
a firewall and you do not want to allow DNS through that firewall, you implement DNS forwarding to a remote server that
is deployed in a DMZ or similar network region that can contact Internet DNS servers.

Before you begin:

« You must have a good understanding of DNS and knowledge of the remote DNS servers that can be used to
communicate with Internet domain servers.

» You must have Read-Write permission for Global Load Balance settings.

After you have configured remote DNS servers, you can select them in DNS zone and DNS policy configurations.

To configure a remote server:

Go to Global Load Balance > Zone Tools.

Click the Remote DNS Server tab.

Click Create New to display the configuration editor.

Complete the configuration and add members as described in Remote DNS server configuration on page 240.

A owbdhd-=

Remote DNS server configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the zone configuration (if you use forwarders).

Note: After you initially save the configuration, you cannot edit the name.

Member
Address Type o |IPv4
* IPv6
Address IP address of the remote DNS server.
Port Port number the remote server uses for DNS. The default is 53.

Configuring the response rate limit

The response rate limit keeps the FortiADC authoritative DNS server from being used in amplifying reflection denial of
service (DoS) attacks.
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Before you begin:

» You must have a good understanding of DNS.
« You must have Read-Write permission for Global Load Balance settings.

After you have created a response rate limit configuration, you can select it in the DNS policy and DNS general settings
configurations.

To configure the response rate limit:

Go to Global Load Balance > Zone Tools.

Click the Response Rate Limit tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Response rate limit configuration on page 241.

oD

Response rate limit configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
the name in the global DNS policy configuration.

After you initially save the configuration, you cannot edit the name.

Responses per Maximum number of responses per second. The valid range is 1-2040. The default is 1000.
Second

FortiADC 7.2.0 Handbook 241
Fortinet Inc.



Chapter 7: Network Security
Chapter 7: Network Security

This chapter includes the following topics:

o Security features basics on page 242

« Managing IP Reputation policy settings on page 243

» Configure IP reputation exception on page 244

« Configure IP reputation block list

» Using the Geo IP block list on page 245

o Using the Geo IP allowlist

o Special Geo codes on page 248

» Enabling denial of service protection on page 248

« Configuring an IPv4 firewall policy on page 249

o Configuring an IPv6 firewall policy on page 251

« Configuring an IPv4 connection limit policy on page 253
« Configuring an IPv6 connection limit policy on page 254
o Anti-virus on page 256

» Configuring IPS on page 261

o Zero Trust Network Access (ZTNA) on page 266

Security features basics

In most deployment scenarios, we recommend you deploy FortiGate to secure your network. Fortinet includes security
functionality in the FortiADC system to support those cases when deploying FortiGate is impractical. FortiADC includes
the following security features:

« Firewall—Drop traffic that matches a source/destination/service tuple you specify.

» Security connection limit—Drop an abnormally high volume of traffic from a source/destination/service match.

« IP Reputation service—Drop or redirect traffic from source IPs that are on the FortiGuard IP Reputation list.

e Geo IP—Drop or redirect traffic from source IPs that correspond with countries in the FortiGuard Geo IP database.

» Web application firewall—Drop or alert when traffic matches web application firewall attack signatures and
heuristics.

 AntiVirus—Drop traffic that matches in FortiSandbox's Malware Signature Database.
« Denial of service protection—Drop half-open connections to protect the system from a SYN flood attack.
o IPS—Protect the system based on a robust FortiGuard pattern / signature-based engine.
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Managing IP Reputation policy settings

The FortiGuard IP Reputation service provides a database of known compromised or malicious client IP addresses. The
database is updated periodically.

The IP Reputation configuration allows you to specify the action the system takes when an SLB virtual server receives
traffic from a client with an IP address on the list. IP Reputation actions on page 243 lists limitations for IP Reputation
actions.

IP Reputation actions

Action Profile Limitations

Pass IPv4 only Not supported for RADIUS.
Deny IPv4 only Not supported for RADIUS.
Redirect IPv4 only Not supported for RADIUS, FTP, TCP, UDP.
Send 403 Forbidden IPv4 only Not supported for RADIUS, FTP, TCP, UDP.

Note: IP Reputation is also not supported for Layer 4 virtual servers when the Packet Forwarding Mode is Direct
Routing.

Basic Steps

1. Configure the connection to FortiGuard so the system can receive periodic IP Reputation Database updates. See
Configuring FortiGuard service settings.

2. Optionally, customize the actions you want to take when the system encounters a request from a source IP address
that matches the list; and add exceptions. If a source IP address appears on the exceptions list, the system does not
look it up on the IP Reputation list. See below.

3. Enable IP Reputation in the profiles you associate with virtual servers. See Configuring Application profiles.
Before you begin:

» You must have Read-Write permission for Firewall settings.

To customize IP Reputation policy rules:

Go to Network Security > IP Reputation.

Make sure to select the IP Reputation tab, which displays all IP reputation policy configuration in FortiADC.
Click a policy or the corresponding Edit icon to open the IP Reputation editor.

Make the desired changes as described in I[P Reputation policy configuration on page 243.

5. Click Save.

Ao b=

IP Reputation policy configuration

Settings Guidelines

Category Depending the configuration on FortiGuard IP Reputation service, the IP reputation policy can
be one of the following categories:
* Anonymous Proxy
¢ Others
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Settings Guidelines

* Block List
Status Enable or disable the category.
Action * Pass

* Deny

* Redirect

¢ Send 403 Forbidden

Note: Layer 4 and TCPS virtual servers do not support Redirect or Send 403 Forbidden. If you
apply an IP Reputation configuration that uses these options to a Layer 4 or TCPS virtual
server, FortiADC logs the action as Redirect or Send 403 Forbidden but in fact denies the
traffic.

Severity The severity to apply to the event. Severity is useful when you filter and sort logs:
e Low
* Medium
¢ High

Log Enable or disable logging.

Configure IP reputation exception

To create an IP Reputation exception:

1. Go to Network Security > IP Reputation.

2. Click the IP Reputation Exception tab to add exceptions as described in IP Reputation exception on page 244.
3. Click Save.

IP Reputation exception

Settings Guidelines
Status Enable or disable the exception. You might have occasion to toggle the exception off and on.
Type ¢ IP/netmask: Select this option to allow a specified IP address to pass through.
¢ |IP Range: Select this option to allow a specified range of IP addresses to pass through.
IP/Netmask If IP/netmask is selected in the Type field above, specify a subnet using the address/mask
notation.
StartIP/End IP Is IP Range is selected in the Type field above, specify the starting address and ending

address of the IP range.
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Configure IP reputation block list

Upload the source IP's or CIDRs that you want the ADC to block in the IP reputation block list. When these source IP's try
to access the VS, the connection will fail. You can create IP/Netmask or IP Range type block list, back up or restore files.

The content of IP reputation block list file should be coded in ASCII and every line can be a IP netmask or IP address
range. There can be 256 IP netmasks or IP address ranges in the file. It looks like this:

192.168.1.1-192.168.1.10
172.16.1.1-172.16.2.100
10.1.1.0/24

20.1.1.0/24

You use the Restore utility to import the file and the Back Up utility to export it. This operation will back up the current
restored IP reputation block list, however, it does not back up user-configured entries.

You use the Clean utility to erase entries that were imported from the text file. This operation will erase the current
restored IP reputation block list, however, it does not affect user-configured entries.

To create an IP Reputation block list:

1. Go to Network Security > IP Reputation

2. Click the IP Reputation Block List tab to Create New block lists as described in IP Reputation block list on page
245,

3. Click Save.

IP Reputation block list

Settings Guidelines

Status Enable or disable the exception. You might have occasion to toggle the exception off and on.

Type ¢ IP/netmask: Select this option to allow a specified IP address to pass through.
¢ IP Range: Select this option to allow a specified range of IP addresses to pass through.

IP/Netmask If IP/netmask is selected in the Type field above, specify a subnet using the address/mask
notation.
StartIP/End IP If IP Range is selected in the Type field above, specify the starting address and ending

address of the IP range.

Using the Geo IP block list

The FortiGuard Geo IP service provides a database that maps IP addresses to countries, satellite providers, and
anonymous proxies. The database is updated periodically.

The Geo IP block list is a policy that takes the action you specify when the virtual server receives requests from IP
addresses in the blocked country’s IP address space.
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For Layer 4 virtual servers, FortiADC blocks access when the first TCP SYN packet arrives. For Layer 7 virtual servers,
FortiADC blocks access after the handshake, allowing it to redirect the traffic if you have configured it to do so.

Geo IP block list actions on page 246 lists limitations for Geo IP block list actions.

Geo IP block list actions

Action Profile Limitations

Pass IPv4 only Not supported for HTTP Turbo, RADIUS.
Deny IPv4 only Not supported for HTTP Turbo, RADIUS.
Redirect IPv4 only Not supported for HTTP Turbo, RADIUS, FTP, TCP, TCPS, UDP.
Send 403 Forbidden IPv4 only Not supported for HTTP Turbo, RADIUS, FTP, TCP, TCPS, UDP.
Basic Steps
1. Configure the connection to FortiGuard so the system can receive periodic Geo |IP Database updates. See

Configuring FortiGuard service settings.
Create rules to block traffic from locations.

Maintain a allowlist to allow traffic from specified subnets even if they belong to the address space blocked by the
Geo IP block list.

Select the Geo IP block list and allowlist in the profiles you associate with virtual servers. See Configuring
Application profiles.

Before you begin:

« You must have Read-Write permission for Security settings.

To configure a Geo IP block list:

No ook obdbh-=

Go to Network Security > Geo IP Protection.

Click the Geo IP Protection tab.

Click Create New to create a block list as described in Geo IP block list configuration on page 246.
Click Save.

Edit your new block list to add members as described in Geo IP block list configuration on page 246.
Click Save to save your member settings.

Click Save.

Geo IP block list configuration

Settings Guidelines

Name Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces.

After you initially save the configuration, you cannot edit the name.

Default Action * Pass—Allow the traffic.

¢ Deny—Drop the traffic.

¢ Redirect—Send a redirect. You specify the redirect URL on the profile configuration
page.

¢ Send 403 Forbidden—Send the HTTP Response code 403.
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Settings Guidelines

Note: Layer 4 and TCPS virtual servers do not support Redirect or Send 403 Forbidden. If you
apply an Geo IP configuration that uses these options to a Layer 4 or TCPS virtual server,
FortiADC logs the action as Redirect or Send 403 Forbidden, but in fact denies the traffic.

Status Enable or disable the Geo IP block list configuration.

Member

Log Enable/disable logging.

Severity The severity to apply to the event. Severity is useful when you filter and sort logs:
* Low
* Medium
¢ High

Action ¢ Pass—Allow the traffic.

Deny—Drop the traffic.

Redirect—Send a redirect. You specify the redirect URL on the profile configuration
page.

Send 403 Forbidden—Send the HTTP Response code 403.

Note: Layer 4 and TCPS virtual servers do not support Redirect or Send 403 Forbidden. If you
apply an Geo IP configuration that uses these options to a Layer 4 or TCPS virtual server,
FortiADC logs the action as Redirect or Send 403 Forbidden, but in fact denies the traffic.

Regions Select a geolocation object. The listincludes countries as well as selections for anonymous
proxies and satellite providers.

Using the Geo IP allowlist

To configure a Geo IP allowlist:

1. Go to Network Security >

Geo IP Protection.

2. Click the Allowlist tab to create a allowlist as described in Geo IP allowlist configuration on page 247.

3. Click Save.

Geo IP allowlist configuration

Settings Guidelines

Name Configuration name. The name can be up to 35 characters long. Valid characters are 2-7, a-

z, 0

-9, ,and -. No space is allowed.

After you initially save the configuration, you cannot edit the name.

Description A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Status Enable/disable the exception. You might have occasion to toggle the exception off and on.
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Settings Guidelines

Member

Type Select and configure either of the following:
IP Subnet—Specify the IP address and CIDR-formatted subnet mask, separated by a forward
slash ( /), such as 192.0.2.0/24. Dotted quad formatted subnet masks are not accepted. IPv6
addresses are not supported.
IP Range—Specify the Start IP and the End IP addresses of the IP range.

Description Enter a brief description of the IP subnet or IP range, depending on which Type you choose.

The description can be up to 1023 characters long. Valid characters are A-Z, a-z, 0-9, , -,.,
and :. No space is allowed.

Special Geo codes

Special GEO codes and their usage on page 248 below describes the usage of special GEO codes.

Special GEO codes and their usage

GEO code Usage

2z Reserved (IP addresses that are not assigned, e.g., 10.0.0.0/24)

A1 Anonymous Proxy (IP addresses that are defined as anonymous proxy in
MaxMind, e.g., 46.19.137.0/24)

A2 Satellite Provider (IP addresses that are defined as satellite provider in MaxMind,
e.g., 57.72.6.0/24)

o1 Other Country (Reserved for further use, and no IP address is assigned to this
region)

Enabling denial of service protection

You can enable basic denial of service (DoS) prevention to combat SYN floods. When enabled, FortiADC uses the SYN
cookie method to track half-open connections. The system maintains a DoS mitigation table for each configured IPv4
virtual server. It times out half-open connections so that they do not deplete system resources.

Note: The DoS feature is supported for traffic to virtual servers only. However, it is not supported for IPv6 traffic or for
Layer 4 virtual servers with the Direct Routing packet forwarding mode.

Before you begin:

» You must have Read-Write permission for Firewall settings.

To enable denial of service protection:

1. Go to Security > SYN Flood Prevention.
2. Enable the SYN Cookie feature.
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3. Specify a maximum number of half open sockets. The defaultis 1 (10 connections). The valid range is 1 to 80,000.
4. Save the configuration.

Configuring an IPv4 firewall policy

A firewall policy is a filter that allows or denies traffic based on a matching tuple: source address, destination address,
and service. By default, firewall policy rules are stateful: if client-to-server traffic is allowed, the session is maintained in a
state table, and the response traffic is allowed.

The FortiADC system evaluates firewall policies before other rules. It matches traffic against the firewall policy table,
beginning with the first rule. If a rule matches, the specified action is taken. If the session is denied by a firewall policy
rule, itis dropped. If the session is accepted, system processing continues.

By default, if firewall rules are not configured, the system does not perform firewall processing; all traffic is processed as
if the system were a router, and traffic is forwarded according to routing and other system rules.

Note: You do not need to create firewall rules for routine management traffic associated with the management port or HA
ports. The interface “allow access” option enables permitted protocols. The system automatically permits from-self
traffic, such as health check traffic, and expected responses.

Before you begin:

» You must have a good understanding and knowledge of firewalls.

« You must have created the address configuration objects and service configuration objects that define the matching
tuple in your firewall policy rules.

» You must have Read-Write permission for Firewall settings.

To configure a firewall:

Go to Network Security > Firewall.

Click the IPv4 Firewall Policy tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Firewall policy configuration on page 249.
Save the configuration.

Reorder rules, as necessary.

ok wbd-=

Firewall policy configuration

Settings Guidelines

Default Action Action when no rule matches or no rules are configured:
¢ Deny — Drop the traffic.
¢ Accept — Allow the traffic to pass the firewall.

Rule
Name Configuration name. Valid characters are -7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.
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Settings Guidelines
Ingress Interface Select the interface that receives traffic.
Egress Interface Select an outgoing interface from the drop-down list if your FortiADC is configured for link

load-balancing and/or traffic routing. In both cases, the system will use this interface to
forward traffic to its destination.

Note: You MUST leave this option blank (default) if your FortiADC is configured for server
load-balancing and/or global load-balancing. Otherwise, server load-balancing and/or global
load-balancing packets may not match the firewall policy rule.

Source Type Select the source type to use to form the matching tuple.
e Address
¢ Address Group
¢ External Resource

Source The Source option is available if the Source Type is Address.
Specify the Address object to use as the source.

Source Address The Source Address Group option is available if the Source Type is Address Group.
Group Specify the Address Group object to use as the source.

Source External The Source External Address Group option is available if the Source Type is External
Address Group Resource.

Specify the external IP address list imported through the IP Address connector to use as the
source. For details, see IP Address Connector on page 742.

Destination Type Select the destination type to use to form the matching tuple.
e Address
e Address Group
¢ External Resource

Destination The Destination option is available if the Destination Type is Address.
Specify the Address object to use as the destination.

Destination Address  The Destination Address Group option is available if the Destination Type is Address
Group Group.

Specify the Address Group object to use as the destination.

Destination External  The Destination External Address Group option is available if the Destination Type is
Address Group External Resource.
Specify the external IP address listimported through the IP Address connector to use as the
destination. For details, see IP Address Connector on page 742.

Service Select a service object to use to form the matching tuple.
Action * Deny — Drop the traffic.
¢ Accept — Allow the traffic to pass the firewall.
Status Enabled by default.
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Settings Guidelines

Note: This button simplifies the implementation of firewall policy/NAT rules, allowing you to
turn a policy rule ON or OFF with a click of the button. When a firewall policy rule is disabled, it
will be removed from the relevant IP tables, and will be added to the IP table when the rule is

enabled.
Deny Log The Deny Log option is available is the Action is Deny.
Enable/disable logging for denied action.
Reordering
Reorder After you have saved a rule, reorder rules as necessary. The rules table is consulted from top

to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Configuring an IPv6 firewall policy

A firewall policy is a filter that allows or denies traffic based on a matching tuple: source address, destination address,
and service. By default, firewall policy rules are stateful: if client-to-server traffic is allowed, the session is maintained in a
state table, and the response traffic is allowed.

The FortiADC system evaluates firewall policies before other rules. It matches traffic against the firewall policy table,
beginning with the first rule. If a rule matches, the specified action is taken. If the session is denied by a firewall policy
rule, itis dropped. If the session is accepted, system processing continues.

By default, if firewall rules are not configured, the system does not perform firewall processing; all traffic is processed as
if the system were a router, and traffic is forwarded according to routing and other system rules.

Note: You do not need to create firewall rules for routine management traffic associated with the management port or HA
ports. The interface “allow access” option enables permitted protocols. The system automatically permits from-self
traffic, such as health check traffic, and expected responses.

Before you begin:

« You must have a good understanding and knowledge of firewalls.

« You must have created the address configuration objects and service configuration objects that define the matching
tuple in your firewall policy rules.

* You must have Read-Write permission for Firewall settings.

To configure a firewall:

Go to Network Security > Firewall.

Click the IPv6 Firewall Policy tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Firewall policy configuration on page 252.
Save the configuration.

Reorder rules, as necessary.
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Firewall policy configuration

Settings Guidelines

Default Action

Rule

Name

Ingress Interface

Egress Interface

Source Type

Source
Source Address

Group

Source External
Address Group

Destination Type

Destination

Destination Address
Group

Destination External
Address Group
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Action when no rule matches or no rules are configured:
¢ Deny — Drop the traffic.
¢ Accept — Allow the traffic to pass the firewall.

Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Select the interface that receives traffic.

Select an outgoing interface from the drop-down list if your FortiADC is configured for link
load-balancing and/or traffic routing. In both cases, the system will use this interface to
forward traffic to its destination.

Note: You MUST leave this option blank (default) if your FortiADC is configured for server
load-balancing and/or global load-balancing. Otherwise, server load-balancing and/or global
load-balancing packets may not match the firewall policy rule.

Select the source type to use to form the matching tuple.
¢ Address
¢ Address Group
» External Resource

The Source option is available if the Source Type is Address.
Specify the Address object to use as the source.

The Source Address Group option is available if the Source Type is Address Group.
Specify the Address Group object to use as the source.

The Source External Address Group option is available if the Source Type is External
Resource.

Specify the external IP address listimported through the IP Address connector to use as the
source. For details, see IP Address Connector on page 742.

Select the destination type to use to form the matching tuple.
e Address
¢ Address Group
* External Resource

The Destination option is available if the Destination Type is Address.
Specify the Address object to use as the destination.

The Destination Address Group option is available if the Destination Type is Address
Group.
Specify the Address Group object to use as the destination.

The Destination External Address Group option is available if the Destination Type is
External Resource.
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Settings Guidelines

Specify the external IP address listimported through the IP Address connector to use as the
destination. For details, see IP Address Connector on page 742.

Service Select a service object to use to form the matching tuple.

Action e Deny — Drop the traffic.
¢ Accept — Allow the traffic to pass the firewall.

Status Enabled by default.

Note: This button simplifies the implementation of firewall policy/NAT rules, allowing you to
turn a policy rule ON or OFF with a click of the button. When a firewall policy rule is disabled, it
will be removed from the relevant IP tables, and will be added to the IP table when the rule is

enabled.
Deny Log The Deny Log option is available is the Action is Deny.
Enable/disable logging for denied action.
Reordering
Reorder After you have saved a rule, reorder rules as necessary. The rules table is consulted from top

to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Configuring an IPv4 connection limit policy

The firewall connection limit policy allows or denies traffic based on a matching tuple: source address, destination
address, and service; and connection count. The purpose is to detect anomalous connection requests.

The limit you specify can be based on the following counts:

« Count of concurrent sessions that match the tuple.
» Count of concurrent sessions from a single host that match the tuple.

The FortiADC system evaluates firewall connection limit policy rules before other rules. It matches traffic against the
connection limit table, beginning with the first rule. If no rule matches, the connection is forwarded for further processing.
If a rule matches, and the limit has not been reached, the connection is forwarded for further processing. If a rule
matches and the limit has been reached, the connection is dropped.

By default, if firewall connection limit rules are not configured, the system does not perform connection limit policy
processing. The firewall connection limit can be configured for non-SLB traffic and for Layer 7 SLB traffic, but not Layer 4
SLB traffic.

Note: The purpose of the firewall connection limit is distinct from the virtual server connection limit. The firewall
connection limit setting is a security setting; the virtual server connection limit is a capacity setting.

Before you begin:

« You must have a good understanding and knowledge of the capacity of your backend servers.

« You must have created the address configuration objects and service configuration objects that define the matching
tuple in your connection limit rules.

* You must have Read-Write permission for Firewall settings.
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To configure a firewall connection limit:

Click Network Security > Firewall > IPv4 Connection Limit Policy.

Click Create New to display the configuration editor.

Complete the configuration as described in Connection limit configuration on page 254.
Save the configuration.

Reorder rules, as necessary.

o oN-=

Connection limit configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select the interface that forwards traffic.

Source Select a source address object to use to form the matching tuple.

Destination Select a destination address object to use to form the matching tuple.

Service Select a service object to use to form the matching tuple.

Type Specify whether the limit is per rule or per host.

Side When the connection limit is per host, specify whether the connection counter gets

incremented when the host IP address appears in:
¢ Source—Only increment the counter if the host is the source address.
¢ Destination—Only increment the counter if the host is the destination address.
¢ Both—Increment the counter if the host is the source or destination address.

Limit Maximum concurrent sessions. The default is 1,048,576.
Reordering

After you have saved a rule, reorder rules as necessary. The rules table is consulted from top
to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

*~d

Configuring an IPv6 connection limit policy

The firewall connection limit policy allows or denies traffic based on a matching tuple: source address, destination
address, and service; and connection count. The purpose is to detect anomalous connection requests.

The limit you specify can be based on the following counts:

» Count of concurrent sessions that match the tuple.
» Count of concurrent sessions from a single host that match the tuple.

The FortiADC system evaluates firewall connection limit policy rules before other rules. It matches traffic against the
connection limit table, beginning with the first rule. If no rule matches, the connection is forwarded for further processing.
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If a rule matches, and the limit has not been reached, the connection is forwarded for further processing. If a rule
matches and the limit has been reached, the connection is dropped.

By default, if firewall connection limit rules are not configured, the system does not perform connection limit policy
processing. The firewall connection limit can be configured for non-SLB traffic and for Layer 7 SLB traffic, but not Layer 4
SLB traffic.

Note: The purpose of the firewall connection limit is distinct from the virtual server connection limit. The firewall
connection limit setting is a security setting; the virtual server connection limit is a capacity setting.

Before you begin:

« You must have a good understanding and knowledge of the capacity of your backend servers.

« You must have created the address configuration objects and service configuration objects that define the matching
tuple in your connection limit rules.

* You must have Read-Write permission for Firewall settings.

To configure a firewall connection limit:

Click Network Security > Firewall > IPv6 Connection Limit Policy.

Click Create New to display the configuration editor.

Complete the configuration as described in Connection limit configuration on page 255.
Save the configuration.

Reorder rules, as necessary.

o oON-=

Connection limit configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select the interface that forwards traffic.

Source Select a source address object to use to form the matching tuple.

Destination Select a destination address object to use to form the matching tuple.

Service Select a service object to use to form the matching tuple.

Type Specify whether the limit is per rule or per host.

Side When the connection limit is per host, specify whether the connection counter gets

incremented when the host IP address appears in:
¢ Source—Only increment the counter if the host is the source address.
¢ Destination—Only increment the counter if the host is the destination address.
¢ Both—Increment the counter if the host is the source or destination address.

Limit Maximum concurrent sessions. The default is 1,048,576.
Reordering
Reorder After you have saved a rule, reorder rules as necessary. The rules table is consulted from top

to bottom. The first rule that matches is applied and subsequent rules are not evaluated.
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Anti-virus

Malware and Advanced Persistent Threats (APT) can cause significant damage to the business of any organization.
Malicious codes are commonly used to steal valuable data, gain unauthorized access to networks, or cause products to
degrade.

Using a suite of integrated security technologies, Anti-virus (AV) solutions provide protection against a variety of threats,
including both known and unknown malicious codes (Malware) and Advanced Targeted Attacks (ATA).

Integrated with the FortiOS AV engine, FortiADC provides an industry-class malware and APT detection and mitigation
solution to our customers.

AV module topology on page 256 illustrates how FortiADC's AV module works:

1. Automatically updates the latest attack signatures from FortiGuard to ensure real-time protection.

2. Submits all files, including suspicious files, to an on-premise appliance (FortiSandbox) or cloud-based service
(FortiCloud Sandbox) for further analysis after performing the basic AV processing of its own.

3. Malicious files will be dropped or quarantined, and healthy ones will be forwarded to the backend servers.

_ _ FortiCloud Sandbox  FortiGuard

AV module topology

Hard Disk FortiSandbox l
i A
Suspicious - ECTI"I:IErr'E;,gr.,-
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E'ch"la”'"""'i““““"'"-{ AV module e E;;;:E
——Traffic—————
-
—Traffig———l —}o—} T Traffic -
)
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FortiADC

To use the AV module, you must

o Creating an AV profile on page 257
o Setting AV quarantine policies
» Setting AV service level

Important Notes

e The AV feature does not support HA.
« IfFortiADC is in HA mode, you must use the default source-ip for FortiSandbox.
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o Try to limit the number of VDOMs when the AV feature is enabled. Otherwise, the capacity of quarantine may
become limited.

« Allfile types are supported by AV feature.

Creating an AV profile

You must configure AV profiles to use the anti-virus service module, which can be done either from the GUI or the
Console. Once created, you can include your AV profiles when creating advanced virtual server profiles that use the
HTTP, HTTPS, or SMTP protocol. For more information, refer to Configuring virtual servers.

Configure AV profiles from the GUI

To configure an AV profile from the GUI:

Click Network Security > Anti Virus.

Select the Profile tab.

Click the Create New button.

Make the entries or selections as described in AV profile configuration on page 257.
Click Save when done.

o obd-=

AV profile configuration

Settings Description

Name A unique name for the AV profile.
An AV profile name can contain up to 63 alphanumeric characters.

Comments A brief description of the profile.
A description can be up to 1024 alphanumeric characters long.

Uncomp Size Limit The maximum size in MB of the memory buffer used to temporarily
decompress files.
The default is 2 MB. Valid values range from 1 to 2000 MB.

Uncomp Nest Limit The maximum number of levels of nesting (compression) allowed for the

system to decompress.
The default is 2. Valid values range from 2 to 100.

Scan Bzip2 Scan archives using the bzip2 algorithm.
This is disabled by default.

Streaming Content Bypass Enable or disable bypass streaming content (rather than buffering it).
This is enabled by default.

Oversize Limit The maximum in-memory file size in KB to be scanned.
The default is 1024 KB. Valid values range from 1 to 12000000 KB.
Note: For AV files larger than 1000 KB, the device memory must be larger
than 32 GB to support the scan.

Oversize Select one of the options for the system to handle over-sized files:
¢ Bypass — Ignore oversized files.
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Settings Description

¢ Log — Log and block oversized files.
» Block — Block oversized files.
The default option is Bypass.

Options Select an option for the system to handle infected files:
¢ AV Monitor — Block and log infected files.
¢ Quarantine — Quarantine and log infected files.
The default is AV Monitor.

Emulator Enable or disable the Win32 Emulator.
This is disabled by default to improve throughput.

FSA Analytics Select an option to submit files to to FortiSandbox.
¢ Disable—No file is submitted.
¢ Suspicious—Only suspicious files are submitted.
¢ All—All files are submitted.
The default is Disable.

Analytics Max Upload The maximum file size in KB allowed to upload to FortiSandbox.
The default is 1024 KB. Valid values range from 1 to 2048 KB.

Analytics DB Enable or disable supplementing the AV signature databases with the
FortiSandbox signature database.

This is disabled by default.

AV Virus Log Enable or disable logging for anti-virus scanning.
This is enabled by default.

Note that FortiADC currently imposes no restriction on the types of files that can be uploaded for AV analysis or
evaluation. When scanning files for viruses, it makes no distinction between viruses and Trojans, and submits all
suspicious files to FortiSandbox for evaluation. A log is generated whenever a file is uploaded to FortiSandbox.

Configure AV profiles from the Console

To configure an AV profile from the Console, execute the following commands:

config security antivirus profile

edit <name str>

set comment <var-string>

set uncomp-size-limit <limit int>

set uncomp-nest-limit <limit int>

set scan-bzip2 {enable | disable}

set streaming-content-bypass {enable | disable}
set oversize-limit <size int>

set oversize {bypass | log | block}

set options {avmonitor | quarantine}

set emulator {enable | disable}

set fsa-analytics {disable | suspicious | everything}
set analytics-max-upload <integer>

set analytics-db {disable | enable}

set av-virus-log {enable | disable}

end
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Setting AV quarantine policies

The “quarantined” daemon manages the infected or suspicious files. The quarantine destination can be either the local
hard disk.

It's a multi-process daemon, which receives quarantine requests from the AV daemon and then processes the requests
in child processes. It can work in tandem with remote devices to compliment the AV service, such as sending suspicious
files to FortiSandbox for deeper inspection or uploading the archive package onto FortiCloud.

In addition, it also manages the use of the storage space, listing the quarantined files, deleting expired files, overriding
old files, or dropping new files when there is no enough storage space available.

Note: For the 5.0.0 release, the AV module only supports quarantine on the hard disk and the integration with
FortiSandbox, as illustrated in AV quarantine process flow on page 259.

AV quarantine process flow

= IPC event handler | CMDE/gquarantinerequesthandle - — — — — — — — — — — — — — +
|
¥
’ S ; Send/receive files to/from remote - -
Timer handler — Pack files into archive L A l-_

| FortiSandbox
|
¥

Maonitor and adjust child processes

You can configure AV quarantine policies from the GUI or the Console.

Configuring AV quarantine policies from the GUI

To configure AV quarantine policies from the GUI:
Click Network Security>Anti Virus.
Click the Quarantine tab.

Make the entries or selections as described in AV quarantine policy configuration on page 259.
Click Save when done.

o bN-=

AV quarantine policy configuration

Settings Description

Destination The destination for quarantined files, which could be either of the following:
¢ NULL—Disable quarantine.
¢ Disk—Send quarantined files to the hard disk.

Age Limit The number of hours that quarantined files are kept on the hard disk. The default
is 1 hour. Valid values range form 0 to 336 hours.
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Settings Description

Note: If the age limit is set to 0 (zero), it means that there is no age limit and
quarantined files will remain on the hard disk forever.

Max File Size The maximum size (in KB) of a single file that can be quarantined. The default is
1024 (KB). Valid values range from 1 to 2048 KB.
Note: Files larger than the set Max File Size will not be quarantined. In reality, this
value is subject the available quarantine quota that remains on the hard disk. For
example, when there is less than 1024 KB of quarantine quota (disk space
reserved for quarantined files) remaining, a file of 1024 KB in size still will not be
quarantined even though you've set Max File Size to 1024.

Quarantine Quota The amount of disk space reserved for quarantining files. The defaultis 512 MB.
Valid values range from 0 to 1024 MB. If the value is set to 0, no files are
quarantined.

Drop Infected Select either or both of the following:
e HTTP
e HTTPS
 SMTP
Note: By default neither option is selected, which means that both types of files
are quarantined. If selected, files involving the specified protocol or protocols will
be dropped (not quarantined).

Lowspace Specify the way in which new files are handled when the system disk space is
running low, which could be either of the following:
¢ Override Old—Override old quarantine files with new ones.
¢ Drop New—Drop new quarantine files to retain old ones.

Configuring AV quarantine policies from the Console

To configure an AV quarantine policy from the Console, execute the following commands:

config security antivirus quarantine
set destination {NULL | disk}

set agelimit <integer>

set maxfilesize <integer>

set quarantine-quota <integer>

set drop-infected { http | https | smtp}
set lowspace {drop-new | ovrw-old}

end

Setting AV service level

FortiADC's AV service relies on the system's AV engine and signature databases. The AV engine is upgraded whenever
new functions are added. The Updated daemon is responsible for updating the AV engine and the signature databases.

The system offers three types of AV signature databases, namely, Normal, Extended, and Extreme. They represent
different levels of AV services. In order for FortiADC to provide you with the level of AV service that you desire, you must
choose the right signature database.
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Configure AV service level from the GUI

To choose a signature database from the GUI,

1. From the navigation bar, click Network Security > Anti Virus.
2. Click the Settings tab.
3. Select a Default DB setting:

Settings Description

Normal The regular virus database, which includes “In the Wild” viruses and most
commonly seen viruses on the network. It provides regular protection.

Extended The extended virus database, which includes both “In the Wild” viruses and a
large collection of zoo viruses that are no longer seen in recent virus studies. It
provides enhanced security protection.

Extreme The extreme virus database, which includes both “In the Wild” viruses and all
known zoo viruses that are no longer seen in recent virus studies. It provides
the highest level of security protection.

4. Specify the Ramdisk size in GB. The defaultis 0 GB. Valid values range from 0 to 12 GB. Please ensure to enlarge
the RAM disk size to scan large files.
Note: When the changes to the RAM disk configuration is committed, you will be prompted to restart the device for
the configuration to take effect.

5. Click Save.

Configure AV service level from the Console

To set the default signature database from Console, execute the following command:
config security antivirus settings

set default-db {normal | extended | extreme}

set ramdisk-size <integer>

end

Configuring IPS

The FortiADC Intrusion Prevention System (IPS) combines signature detection and prevention with low latency and
excellent reliability. With intrusion protection, you can create multiple IPS profiles, each containing a complete
configuration based on signatures. Then, you can apply any IPS profile to any L4 VS.

Intrusion Prevention System (IPS) technology protects your network from cybercriminal attacks by actively seeking and
blocking external threats before they can reach potentially vulnerable network devices.

This section describes how to configure the FortiADC Intrusion Prevention settings.
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Predefined Profiles

Every individual IPS Signature takes effect for a particular type of attack, for an effective detection and protection, a well-
considered combination of different IPS signatures plays a key role for the whole IPS system. FortiADC has 8 predefined
Profiles in respect to: action, application, severity, target, etc. are ready for customers for a fast security-set-up

Predefined Profile Comment

all_default signatures with default setting

all_default_pass signatures with PASS action

default Prevent critical attacks

high_security Blocks all Critical/High/Medium and some Low severity vulnerabilities
protect_client Protect against client-side vulnerabilities

protect_email_server Protect against email server-side vulnerabilities

protect_http_server Protect against HTTP server-side vulnerabilities

sniffer-profile Monitor IPS attacks

Signature-based defense

Signature-based defense is used against known attacks or vulnerability exploits. These often involve an attacker
attempting to gain access to your network. The attacker must communicate with the host in an attempt to gain access
and this communication will include particular commands or sequences of commands and variables. The IPS signatures
include these command sequences, allowing the FortiADC unit to detect and stop the attack.

Signatures

IPS signatures are the basis of signature-based intrusion prevention. Every attack can be reduced to a particular string
of commands or a sequence of commands and variables. Signatures include this information so your FortiADC unit
knows what to look for in network traffic.

Signatures also include characteristics about the attack they describe. These characteristics include the network
protocol in which the attack will appear, the vulnerable operating system, and the vulnerable application.

The FortiGuard Intrusion Prevention Service (IPS) provides customers with the latest defenses against stealthy network-
level threats through a constantly updated database of known threats and behavior-based signatures.

This update service is backed by a team of threat experts and a close relationship with major application vendors. The
best-in-class team also uncovers significant zero-day vulnerabilities continuously, providing FortiADC units with
advanced protection ahead of vendor patches.

The IPS Signatures Database is able to be updated automatically or manually by System > Settings > FortiGuard
page.

Protocol decoders

Before examining network traffic for attacks, the IPS engine uses protocol decoders to identify each protocol appearing
in the traffic. Attacks are protocol-specific, so your FortiADC unit conserves resources by looking for attacks only in the
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protocols used to transmit them. For example, the FortiADC unit will only examine HTTP traffic for the presence of a
signature describing an HTTP attack.

IPS engine

Once the protocol decoders separate the network traffic by protocol, the IPS engine examines the network traffic for
attack signatures. The engine count is configurable by CLI as well. (The recommendation is configuring the engine count
as the same count of CPU of the FortiADC has, an ips-engine per CPU)

IPS profiles

The IPS engine does not examine network traffic for all signatures. You must first create an IPS profile and specify which
signatures are included. Add signatures to profile individually using signature entries, or in groups using IPS filters.

To view the IPS profiles, go to Security Profiles > Intrusion Prevention.

You can group signatures into IPS profiles for easy selection when applying to L4 VS Security. You can define
signatures for specific types of traffic in separate IPS profiles, and then select those profiles in profiles designed to
handle that type of traffic. For example, you can specify all of the web-server related signatures in an IPS profile, and that
the profile can then be applied to a L4 VS Security that controls all of the traffic to and from a web server protected by the
unit.

The FortiGuard Service periodically updates the signatures, with signatures added to counter new threats. Since the
signatures included in filters are defined by specifying signature attributes, new signatures matching existing filter
specifications will automatically be included in those filters. For example, if you have a filter that includes all signatures
for the Windows operating system, your filter will automatically incorporate new Windows signatures as they are added.

Each filter consists of a number of signatures attributes. All of the signatures with those attributes, and only those
attributes, are checked against traffic when the filter is run. If multiple filters are defined in an IPS profile, they are
checked against the traffic one at a time, from top to bottom. If a match is found, the unit takes the appropriate action and
stops further checking.

The signatures included in the filter are only those matching every attribute specified. When created, a new filter has
every attribute set to all which causes every signature to be included in the filter. If the severity is changed to high, and
the target is changed to server, the filter includes only signatures checking for high priority attacks targeted at servers.

IPS filters

IPS profiles contain one or more IPS filters. A filter is a collection of signature attributes that you specify. The signatures
that have all of the attributes specified in a filter are included in the IPS filter.

For example, if your FortiADC unit protects a Linux server running the Apache web server software, you could create a
new filter to protect it. By setting OS to Linux, and Application to Apache, the filter will include only the signatures that
apply to both Linux and Apache. If you wanted to scan for all the Linux signatures and all the Apache signatures, you
would create two filters, one for each.

To view the filters in an IPS profile, go to Security Profiles > Intrusion Prevention, select the IPS profile containing the
filters you want to view, and select Edit.

Custom/predefined signature entries

Signature entries allow you to add an individual custom or predefined IPS signature. If you need only one signature,
adding a signature entry to an IPS profile is the easiest way. Signature entries are also the only way to include custom
signatures in an IPS profile.
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Another use for signature entries is to change the settings of individual signatures that are already included in a filter
within the same IPS profile. Add a signature entry with the required settings above the filter, and the signature entry will
take priority.

Security - L4 VS

To use an IPS profile, you must select it in a L4 VS security options. An IPS profile that it not selected in a policy options
will have no effect on network traffic.

L}
S L4
? IPS does not support NAT46

Session timers for IPS sessions

A session time-to-live (TTL) timer for IPS sessions is available to reduce synchronization problems between the
FortiADC Kernel and IPS, and to reduce IPS memory usage.

Creating an IPS Profile

You need to create an IPS profile before specific signatures or filters can be chosen. The signatures can be added to a
new profile before it is saved. However, it is good practice to keep in mind that the profile and its included filters are
separate things, and that they are created separately. (Predefined Profiles)

To create a new IPS Profile

Go to Security Profiles > Intrusion Prevention.

Select the Create New icon in the top of the Edit IPS Profile window.

Enter the name of the new IPS Profile.

Optionally, enter a comment. The comment will appear in the IPS Profile list.
Select OK.

A newly created Profile is empty and contains no filters or signatures. You need to add one or more filters or
signatures before the Profile will be of any use.

IS

Adding IPS signatures to a Profile

Go to Security > Intrusion Prevention.

Select the IPS Profile to which you want to add the signature and click the pencil icon.
Under IPS Signatures, select Add Signature.

Select one or more signatures from the list and click Apply to add them to the sensor.

After the selected signature has been added to the IPS Signatures, the drop-down list of Action, which is on the right
side of the signature, has Default, Pass and Block, is changeable.

6. Click Apply on the bottom of the IPS Profile page

o obd-=

Adding an IPS filter to a Profile

While individual signatures can be added to a Profile, a filter allows you to add multiple signatures to a Profile by
specifying the characteristics of the signatures to be added.

To create a new pattern based signature and filter
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Go to Security Profiles > Intrusion Prevention.
Select the IPS Profile to which you want to add the signature and click the pencil icon.
Under IPS Filters, select Add Filter.

Configure the filter that you require. Signatures matching all of the characteristics you specify in the filter will be
included in the filter. Once finished, select Apply.

A owbdhd-=

Application refers to the application affected by the attack and filter options include over 25 applications.

OS refers to the Operating System affected by the attack. The options include BSD, Linux, MacOS, Other,
Solaris, and Windows.

Protocol refers to the protocol that is the vector for the attack; filter options include over 35 protocols, including
"other."

Severity refers to the level of threat posed by the attack. The options include Critical, High, Medium, Low, and
Info.

Target refers to the type of device targeted by the attack. The options include client and server.

Action Description

Pass Select Pass to allow traffic to continue to its destination.

Note: to see what the default for a signature is, go to the IPS Signatures page
and enable the column Action, then find the row with the signature name in it.

Block Select Block to drop traffic matching any signatures included in the filter.

Default Select Default to use the default action of the signature.

5. After the selected signature has been added to the IPS Signatures, the drop-down list of Action, which is on the right
side of the Filter, has Default, Pass and Block, is changeable

6. Click Apply on the bottom of the IPS Profile page

Adding rate based signatures

These are a subset of the signatures that are found in the database. This group of signatures is for vulnerabilities that are
normally only considered a serious threat when the targeted connections come in multiples, a little like DoS attacks.

Adding a rate based signature is straight forward. Select the enable button in the Rate Based Signature table that
corresponds with the desired signature.

Predefined IPS Profile

FortiADC has 8 predefined IPS Profiles for the convenience and fast-set-up of users to enable the IPS by an easier way,
each predefined profile is created under the attributes of each signature and thoughtful consideration. For users
demanding a widely protection but yet ready to create a particular customized one, predefined IPS profiles are highly
recommended. They will be kept updated resulted from a periodically database update of the FortiGuard Service. These
Profiles are available by directly selecting from Security -> IPS in L4 VS options as well as be considered as a Quick-
Enabling-IPS.

Enabling IPS
Currently, the IPS Scanning only supports for the L4VS traffic

o The IPS Profile contains filters, signature entries, or both. These specify which signatures are included in the IPS
Profile.

FortiADC 7.2.0 Handbook 265
Fortinet Inc.



Chapter 7: Network Security

When an IPS Profile is selected in a security option, and all network traffic matching the policy will be checked for the
signatures in the IPS Profile.

Configuring Engine Count

For the consideration of varying demands and the performance of different platforms, the Engine-Count of IPS in
FortiADC is configurable. The more Engine-Count that a FortiADC has, the better the IPS performs. Every coin has two
sides, however, consequently, the more CPU and memory usage will be taken from the whole system.

The default value of the Engine-count is 1, for a better performance accordingly, the configuration could be setting the
Engine-Count depends on CPU-Count of the platform has.

Eg: 4-Engine for a 4-Core device. (Refer to the hardware platform reference at the end of this article)

CLI Syntax

config global

config system ips

set engine-count {1-256}
next

end

Zero Trust Network Access (ZTNA)

Protect your virtual server resources with the FortiADC Zero Trust Network Access (ZTNA) access control method that
uses client device identification and Zero Trust tags to provide role-based application access. It provides administrators
the flexibility to manage network access for On-net local users and Off-net remote users. Access to applications is
granted only after verifying the device and user identity, and then performing context-based posture checks using Zero
Trust tags.
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ZTNA telemetry, tags, and policy enforcement
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When On-net and Off-net FortiClient endpoints register to FortiClient EMS, device information, logged on user
information, and security posture are all shared over ZTNA telemetry with the EMS server. Clients also make a certificate
signing request to obtain a client certificate from the EMS that is acting as the ZTNA Certificate Authority (CA).

Based on the client information, EMS applies matching Zero Trust tagging rules to tag the clients. These tags, and the
FortiClient endpoint information (including the device information, logged on user information, and security posture) are
synchronized with the FortiADC in real-time. This allows the FortiADC to verify the client's identity using the client
certificate, and grant access based on the ZTNA tags applied in the ZTNA security rule.

For more information, see How device identity and trust context is established with FortiClient EMS on page 270.

ZTNA in FortiADC server load balancing

The FortiADC ZTNA is a network security feature that allows users to securely access Layer 7 HTTPS and TCPS virtual
server resources for server load balancing. Once the ZTNA security rule has been configured it can be referenced by
Layer 7 HTTPS and TCPS virtual servers to implement role-based zero trust access by using the client certificate and
ZTNA tags for identification and security posture check.

The chart below illustrates the FortiADC ZTNA logic flow.
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SSL Handshake
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Prerequisites

Before you begin to configure ZTNA on the FortiADC unit, you must have the following:
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 FortiClient EMS running version 7.0.3 or later
» FortiClient running 7.0.1 or later
* FortiADC hardware, VM, or cloud platform that support FortiClient EMS.
Supported hardware models:
» FAD-120F
» FAD-220F
» FAD-300F
» FAD-400F
» FAD-1200F
» FAD-2200F
» FAD-4200F
» FAD-5000F
Supported cloud platforms with BYOL (PAYG FortiADC does not support FortiClient EMS):
* AWS (Amazon Web Services)
* Microsoft Azure
» GCP (Google Cloud Platform)
e OCI (Oracle Cloud Infrastructure)
 Alibaba Cloud
Supported VM environments:
» VMware — ESXi 3.5,4.x,5.0,5.1,5.5,6.0,6.5,6.7,7.0
* Microsoft Hyper-V — Windows Server 2012 R2, 2016 and 2019
¢ KVM — Linux version 3.19.0 gemu-img v2.0.0, gemu-img v2.2
 Citrix Xen — XenServer 6.5.0
» Xen Project Hypervisor —4.4.2,4.5

Note: The most recent certificate embedded license is required. If your license was issued prior to April 2021,
please obtain a new certificate embedded license for your VM through Fortinet Customer Service & Support.

» Read-Write access permission for FortiADC Systems settings

Basic ZTNA configuration

To deploy FortiADC ZTNA, follow the basic workflow below:

1. Configure a FortiClient EMS connector to register your FortiADC device as a Fabric Device in the FortiClient EMS.
For details, see Configuring FortiClient EMS Connector for ZTNA on page 271.

2. Verify the information synchronized to FortiADC from FortiClient EMS. For details, see Verifying EMS CA certificate,
ZTNA tag, and FortiClient endpoint synchronized from FortiClient EMS on page 275.

3. Configure a ZTNA profile to define the ZTNA rules. For details, see Configuring a ZTNA Profile on page 276

4. Apply the Security ZTNA profile to a Layer 7 HTTPS or TCPS virtual server to activate ZTNA for server load
balancing. Ensure the corresponding Client SSL profile is enabled for client certificate verification. For details, see
Configuring virtual servers on page 48 and Configuring client SSL profiles on page 126.

5. Enable security logging for ZTNA. This is optional.
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How device identity and trust context is established with FortiClient EMS

Integral to Zero Trust Network Access (ZTNA) is how device identity and trust context is established between FortiClient,
FortiClient EMS, and the FortiADC.

Device roles

The following illustrates how the FortiClient, FortiClient EMS, and FortiADC each function and participate in the ZTNA
workflow.

FortiClient
I EMS -

A (s

) [P

S ZTNA Telemetry

ZTNA Telemetry- 4 Sync
v ZTHNA tags

B ceriificates

| Internet F} FortiADC

LT
L

Enforce ZTMA policy |_ J Enforce ZTMNA policy
On-net clients
[—— ]
Off-net clients ! ! ! !!

Protected servers & resources

FortiClient

FortiClient endpoints provide the following information to FortiClient EMS when they register to the EMS:

» Device information (network details, operating system, model, and others)
« Logged on user information
» Security posture (On-net/Off-net, antivirus software, vulnerability status, and others)

FortiClient requests and obtains a client device certificate from the EMS ZTNA Certificate Authority (CA) when it
registers to FortiClient EMS. The client uses this certificate to identify itself to the FortiADC.

FortiClient EMS

FortiClient EMS issues and signs the client certificate with the FortiClient UID, certificate serial number, and EMS serial
number. EMS shares its EMS CA certificate with the FortiADC, so that the FortiADC can use it to verify the clients.

FortiClient EMS uses Zero Trust tagging rules to tag endpoints based on the information that it has on each endpoint.
The tags are also shared with the FortiADC.
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FortiADC

The FortiADC maintains a continuous connection to the EMS server to synchronize endpoint device information,
including primarily:

« FortiClient UID

« Client certificate SN

« EMS SN

» Device credentials (user/domain)

» Network details (IP and MAC address and routing to the FortiADC)

o« ZTNAtags

When a device's information changes, such as when a client moves from on-net to off-net, or their security posture
changes, EMS is updated with the new device information and then updates the FortiADC. The FortiADC's virtual
servers can use this information when processing ZTNA traffic. If an endpoint's security posture change causes it to no
longer match the ZTNA rule criteria then it will be denied in a new session.

Configuring FortiClient EMS Connector for ZTNA

The FortiClient Endpoint Management Server (EMS) connector enables you to establish device identity through client
certificates and device trust context between FortiClient, FortiClient EMS and the FortiADC as part of Zero Trust Network
Access (ZTNA).

You can register your FortiADC device as a Fabric Device through the FortiClient EMS connector. When you create a
FortiClient EMS connector, FortiADC sends a request to the FortiClient EMS server to obtain a EMS CA certificate to
register your FortiADC device. From the FortiClient EMS, you can then authorize the FortiADC as a Fabric Device. Once
authorized, the FortiClient EMS connector will display the status as Connected, indicating the device is registered. After
the FortiADC connects to the FortiClient EMS, it automatically synchronizes ZTNA tags, the EMS CA certificate, and
FortiClient endpoint information.

ZTNA tags are then generated from tagging rules configured on the FortiClient EMS. These tagging rules are based on
various posture checks that can be applied on the endpoints.

name. ZTNA tags that contain these special characters in their name may trigger

f In FortiClient EMS, do not use special characters suchas ", ', and \ in the ZTNA tag
unexpected behavior when referenced in the ZTNA Profile or in the security logs.

You can create a maximum of three FortiClient EMS connectors.

Requirements:

 FortiClient EMS running version 7.0.3 or later
» FortiClient running 7.0.1 or later
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« FortiADC hardware, VM, or cloud platform that support FortiClient EMS.

FortiClient EMS is supported in most FortiADC platforms but not all of them. The
following lists the hardware models, cloud platforms, and VM environments that
support FortiClient EMS.

Hardware models:

» FAD-120F, FAD-220F, FAD-300F, FAD-400F, FAD-1200F, FAD-2200F,
FAD-4200F, FAD-5000F

e - Cloud platforms with BYOL (PAYG FortiADC does not support FortiClient EMS):
9 ¢ AWS (Amazon Web Services), Microsoft Azure, GCP (Google Cloud
- Platform), OCI (Oracle Cloud Infrastructure), Alibaba Cloud
VM environments:
¢ VMware, Microsoft Hyper-V, KVM, Citrix Xen, Xen Project Hypervisor

Note: The most recent certificate embedded license is required. If your
license was issued prior to April 2021, please obtain a new certificate
embedded license for your VM through Fortinet Customer Service &
Support.

» Read-Write access permission for FortiADC Systems settings

To create and configure a FortiClient EMS connector:

1. Goto Security Fabric > Fabric Connectors.
2. Click Create New.
3. Under Core Network Security, click FortiClient EMS to display the configuration editor.
4. Configure the following FortiClient EMS Settings:
Setting Description
Name Specify the FortiClient Enterprise Management Server (EMS) name. Valid
characters are A-Z, a-z, 0-9, _, and -. No spaces.
IP/Domain name Specify the server IPv4 address or the domain name of the FortiClient EMS
FQDN. For example: 192.0.2.1
HTTPS Port Specify the FortiClient EMS HTTPS access port number. Range: 1-65535,
default: 443
5. Click Save.

The Verify EMS server certificate dialog displays the following message:
In order for the FortiClient EMS and FortiADC to communicate, the following certificate provided by the FortiClient
EMS must be reviewed for correctness, and accepted if deemed valid.
Do you wish to Accept the certificate as detailed below?

6. After you have verified the EMS server certificate information displayed, click OK to accept the EMS server
certificate.
The Verify completed dialog displays the following message:
This FortiADC is not authorized on FortiClient EMS yet. Please let FortiClient EMS to authorize it.
Note: This message will only appear if the FortiADC device has not yet been authorized as a Fabric Device through
FortiClient EMS.

7. Click OK.
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The newly created FortiClient EMS connector is added to the Security Fabric > Fabric Connectors page, under the
Core Network Security section. The FortiClient EMS connector will not be connected until the FortiADC has been
authorized as a Fabric Device in FortiClient EMS.

To authorize the FortiADC as a Fabric Device in FortiClient EMS:

1. Login to FortiClient EMS.

2. From the FortiClient EMS landing page, the Fabric Device Authorization Requests pop-up displays the Serial
Number and IP information of the FortiADC device. Click Authorize.

3. Alternatively, you can go to Administration > Fabric Devices and select the Fabric device you want to authorize.

To check and troubleshoot the FortiClient EMS connector connection:

1. Go to Security Fabric > Fabric Connectors.
2. Underthe Core Network Security section, locate the FortiClient EMS connector configurations.

Core Network Security

FortiClient EMS FortiClient EMS

ems-_226 ems223-dom

3. The 0 and O icons indicate whether FortiClient EMS has successfully authorized the FortiADC Fabric Device
for the corresponding FortiClient EMS connector. Hover over the FortiClient EMS connector to see the status
details. The table below lists the possible connection statuses for the FortiClient EMS connector.

Icon EMS Status Description

0 Connected The FortiADC has been successfully authorized as a Fabric
Device through FortiClient EMS.

0 Cert unauthorized FortiADC does not verify the EMS server's CA certificate. You can
edit the FortiClient EMS connector configuration and restart the
verification to accept the EMS CA certificate.

o Auth failed The EMS server does not authorize the FortiADC, indicating the
request is either denied or pending authorization. If pending
authorization, the status will change to Connected once
authorization is successful on the EMS server.

Not reachable The EMS server was not reachable. Ensure the EMS server IP and
system router is properly configured.

EMS server connection failed The EMS server connection failed with unknown issue. For
example, an incorrect EMS server port may cause this issue.

No compatible The EMS server connection failed because the server is not
compatible with FortiADC.

G 6 6 O

Not sent The EMS domain name cannot resolve. Ensure proper
configuration for the DNS server setting, domain name, and
system router.
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If the status is not Connected, edit the FortiClient EMS connector accordingly to troubleshoot the connection issue.

4. Locate the newly created FortiClient EMS connector, click the FortiClient EMS connector configuration then click
Edit, or double click the configuration object to display the configuration editor.

Edit Fabric Connector

Core Network Security

((®-

FortiClient EMS
FortiClient EMS Settings

Test
Mame
FortiClient Enterprise Management Server (EM5) name.
192.0.2.1
|E/Domain name
Example: 192.0.2.1
443
HTTPS Port
Range: 1-65535
. Mot authorized
Certificate :
Authorize

5. Edit the configuration to troubleshoot the connection issue then click Authorize to restart the verification to accept
the EMS CA certificate.
A request is resent to the FortiClient EMS to authorize the FortiADC as a Fabric Device in FortiClient EMS. The
FortiClient EMS connector will not be connected until the FortiADC has been authorized as a Fabric Device in
FortiClient EMS.

FortiClient EMS in virtual domain configurations

Virtual domains (VDOMs) are full FortiADC instances configured within a FortiADC device. Once the FortiADC device is
registered to the FortiClient EMS, the configuration settings are applied globally. Using the same ZTNA tag, each VDOM
can then configure ZTNA security rules that apply individually at the VDOM level.

FortiClient EMS for High Availability configurations

In a High Availability group, both the FortiADC units must be registered to the FortiClient EMS as individual Fabric
devices. However, you only need to configure the FortiClient EMS connector on one of the FortiADC units. Once the
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FortiClient EMS connector configuration has been completed in one of the FortiADC units in the HA group, the
configuration will be synchronized to the second FortiADC unit. The Fabric Device authorization request for both
FortiADC units are sent to FortiClient EMS to complete the device registration.

Verifying EMS CA certificate, ZTNA tag, and FortiClient endpoint synchronized from
FortiClient EMS

After the FortiADC device connects to the FortiClient EMS, it automatically synchronizes ZTNA tags, the EMS CA

certificate and the FortiClient endpoint information from the FortiClient EMS. Verify all the information have successfully
synchronized from FortiClient EMS to FortiADC in the following:

o Systems > Verify > CA tab to view the EMS CA certificate
o Network Security > ZTNA > ZTNA Tags tab to view the ZTNA tags
» FortiView > ZTNA to view the FortiClient endpoint information and status

Systems > Verify > CA tab

The EMS CA certificate is synchronized to Systems > Verify > CA tab. When a ZTNA profile is referenced in a VS
configuration, the corresponding Client SSL profile must enable verification of the client device certificate.

Verify CRL CA Group CA

=+ Import © Add Filter

Name “ | Subject Type | &

FCTEM JCN=FCTEM /O=Fortinet/ST=California/L=Sunnyvale/C=CA RSA @& & @

FCTEM 3 SCN=FCTEM /O=Fortinet/ST=California/L=Sunnyvale/C=CA RSA @& &

download

FCTEM JCN=FCTEM /O=Fortinet/ST=California/L=Sunnyvale/C=CA RSA @& & @

Fortinet_CA fC=U5/5T=California/L=Sunnyvale/O=Fortinet/OU=Certificate Authority/CN=fortinet- RSA @& &
ca2/emailAddress=support@fortinet.com

Showing 1to 4 of 4 entries 0 rows selected Show 25| entries Previous 1 Mext

Click the @ (View icon) to see the EMS CA certificate details.

Network Security > ZTNA > ZTNA Tags tab

ZTNA tags are synchronized to the Network Security > ZTNA > ZTNA Tags tab. After the FortiClient EMS connector
has successfully connected, check the ZTNA Tags page to ensure the corresponding ZTNA tag has been synchronized.
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ZTNA Profile ZTNA Tags

© Add Filter
Name “ | Provided By Ref.
ems-_226 0
ems-_226 1
ems-_226 0
ems-_226 1
ems-_226 0
ems-_226 0

The Ref. column indicates the number of ZTNA Profile rules that have referenced the ZTNA tag.

FortiView > ZTNA

The FortiClient endpoint information and status are synchronized to the FortiView > ZTNA. From here, you can monitor
the real-time status of the endpoints registered to FortiClient EMS.

Status
@ Online
Offline
< | | ©AddFilter x
Device
Hostname 2 rtiClient Version
Status @ online
Forticlient: 4 MAC Address 0.1
IP Address
forticlient 0.1
Domain

Showing 1to 2 of 2 entries Show [25] entries Previous Next

You can hover over the Hostname column to view the device details synchronized from the FortiClient EMS.

Configuring a ZTNA Profile

The ZTNA Profile is the ZTNA policy used to enforce access control to Layer 7 HTTPS and TCPS virtual servers. ZTNA
profiles consist of one or more ZTNA rule that determine the Source IP and ZTNA tags that are allowed access, and the
resulting action to take.
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After you have created a ZTNA profile, you can reference the ZTNA profile in Layer 7 HTTPS and TCPS virtual server
Security configurations.

Before you begin:

« You must have registered the FortiADC device through the FortiClient EMS connector. For more information, see
Zero Trust Network Access (ZTNA) on page 266 and Configuring FortiClient EMS Connector for ZTNA on page
271.

* You must have Read-Write permission for System settings.

To create and configure a ZTNA Profile:

1. Goto Network Security > ZTNA.

2. Click the ZTNA Profile tab.

3. Click Create New to display the configuration editor.
4. Configure the following:

Name Specify the ZTNA Profile name. Valid characters are A-Z, a-z, 0-9, _, and -. No
spaces.
Log Status Enable/disable logging.
Comments Optionally, enter comments about the ZTNA Profile.
5. Click Save.

6. Under Rule List, click Create New to display the configuration editor.
7. Configure the following:

Parameter Description
Source IP Select the source IPs.
ZTNA Tags Select the ZTNA tags.
Action Select either of the following actions:
e Pass
¢ Deny
Deny is the default action.
Comments Optionally, enter comments about the ZTNA rule.
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Rule List
Selected Items Available Items
< Any
Source [P 20.20subnet
> tit
-
el e A DL £ TAOOA AT £ TMOOAN DAL £ IAOA AT AL £ TANOAAD AL
Double-click to deselect. Drag to reorder. Double-click to select.
ZTNA Tags +

Action Pass

Comments Specify the comments.

8. Click Save.

Apply the Security ZTNA profile to a Layer 7 HTTPS or TCPS virtual server to activate ZTNA for server load balancing.
Ensure the corresponding Client SSL profile is enabled for client certificate verification. For details, see Configuring
virtual servers on page 48 and Configuring client SSL profiles on page 126.

ZTNA troubleshooting and debugging

The following CLI commands can be used to troubleshoot ZTNA issues:

Command Description

# execute fct'eff}s test- Verify the FortiADC to FortiClient EMS connectivity. This provides the connection
R et A status of your FortiClient EMS connector configuration. If the connection is not
successful, further detail is provided for the status condition.

# execute fctems is- Check if the configured EMS server has a verified certificate.
verified <EMS>

# diagnose debug module View information about your FortiClient NAC daemon (fcnacd), which handles
eIl FortiADC to FortiClient EMS connectivity.

# diagnose endpoint- List the FortiClient endpoints synchronized to FortiADC from FortiClient EMS.
control client list

# diagnose endpoint- List the ZTNA tags synchronized to FortiADC from FortiClient EMS.
control tag list

# diagnose debug module View information about your Layer 7 HTTPS virtual server that has referenced a
httproxy ztna ZTNA Profile.

For details of the above commands, see the FortiADC CLI| Reference document.
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Chapter 8: DoS Protection

You use web application firewall policies to scan HTTP requests and responses against known attack signatures and
methods and filter matching traffic. This section includes the following topics:

» Configuring DoS Protection Profile on page 279

o Configuring HTTP access limit policy on page 280

o Configuring HTTP connection flood policy on page 281

» Configuring an HTTP request flood policy on page 282

« Configuring an IP fragmentation policy on page 283

o Configuring a TCP SYN flood protection policy on page 284

» Configuring a TCP slow data flood protection policy on page 284

Configuring DoS Protection Profile

A DoS Protection profile references the DoS policies that are to be enforced.
Before you begin:
* You must have Read-Write permission for Security settings.

After you have configured DoS Protection profile, you can select them in Server Load Balance > Virtual Server >
Security > DoS Protection Profile.

To configure a DoS Protection Profile:

1. Goto DoS Protection > DoS Protection Profile.
2. Click Create New to display the configuration editor.
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3. Complete the configuration.

Name

HTTP Access
Limit
HTTP

Connection
Flood

HTTP
Request
Flood

TCP Slow
Data Flood
Protection

Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

HTTP Access Limit policy. Limit the request number per second from an IP.

HTTP Connection Flood policy. Limit the number of connections from a client, which is marked
by a cookie.

HTTP Request Flood policy. Limit the request number per second from a client, which is marked
by a cookie.

After the TCP connection is established (the three-way handshake is completed), if FortiADC
sends data to the client but the client returns a zero window (a zero window appears when, for
example, the client does not take the data out of the TCP receive queue of the client OS when
the data sent by the FADC fills up the queue), FortiADC will stop sending data. In this case,
FortiADC can actively abort TCP connections and release related resources to avoid occupying
its resources for a long time.

4. Save the configuration.

Configuring HTTP access limit policy

HTTP Access Limit policy can limit the speed of HTTP request from a source IP.

Before you begin:

» You must have Read-Write permission for Security settings.

After you have configured HTTP Access Limit policies, you can select them in DoS Protection Profile.

To configure a HTTP Access Limit policy:

1. Goto DoS Protection > Application > HTTP Access Limit.
2. Click Create New to display the configuration editor.
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3. Complete the configuration.

Name
Status

HTTP Request
Limit

Action

Period Block
Log

Severity

Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
Enable | Disable. If Enable, this policy will be activated, otherwise it is inactive.

0-65535. Limits the amount of HTTP requests per second from a certain IP. 0 means no limit
for HTTP request.

Pass—Allow the traffic.

Deny— Drop the traffic, send a 400 Bad request to the client.

Period Block—Deny all the HTTP request from a source IP within a period which specified by
Period Block.

Captcha—Requires the client to successfully fulfill the CAPTCHA request
1-3600 seconds; Default: 60
Enable | Disable; If Enable the Action will be log

High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.

The default value is High.

4. Save the configuration.

Configuring HTTP connection flood policy

HTTP Connection Flood policy can limit connections from a client which are marked by a cookie.

Before you begin:

» You must have Read-Write permission for Security settings.

After you have configured HTTP Connection Flood policies, you can select them in DoS Protection Profile.

To configure a HTTP Connection Flood policy:

1. Goto DoS Protection > Application > HTTP Connection Flood.
2. Click Create New to display the configuration editor.
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3. Complete the configuration.

Name
Status

HTTP Connection
Number Limit

Action

Period Block
Log

Severity

4. Save the configuration.

Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
Enable | Disable. If Enable, this policy will be activated, otherwise is in-active.

1-1024. Limits the number of TCP connections with the same session cookie.

Pass—Allow the traffic.
Deny— Drop the traffic, send a 400 Bad request to the client.

Period Block—Deny all the HTTP request from a source IP within a period which
specified by Period Block.

Captcha—Requires the client to successfully fulfill the CAPTCHA request
1-3600 seconds; Default: 60
Enable | Disable; If Enable the Action will be log

High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.

The default value is High.

Configuring an HTTP request flood policy

HTTP Request Flood policy can limit the speed of HTTP requests from a client which is marked by a cookie.

Before you begin:

« You must have Read-Write permission for Security settings.

After you have configured HTTP Request Flood policies, you can select them in DoS Protection Profile.

To configure a HTTP Request Flood policy:

1. Goto DoS Protection > Application > HTTP Request Flood.
2. Click Create New to display the configuration editor.
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3. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
Status Enable | Disable. If enabled, this policy will be activated, otherwise it is inactive.

HTTP Request 0-65535. Limits the number of HTTP requests per second with the same session cookie. 0
Limit means no limit for HTTP request.

Action Pass—Allow the traffic.
Deny— Drop the traffic, send a 400 Bad request to the client.

Period Block—Deny all the HTTP requests from a source IP within a period specified by Period
Block.

Captcha—Requires the client to successfully fulfill the CAPTCHA request
Period Block 1-3600 seconds; Default: 60
Log Enable | Disable; If Enable the Action will be log

Severity High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.
The default value is High.

4. Save the configuration.

Configuring an IP fragmentation policy

IP Packet fragmentation assures that IP data grams can flow through any other type of network. It allows data grams
created as a single packet to be splitinto many smaller packets for transmission and reassembled at a receiving host. A
DDoS attack can deny services to the network by creating a fragmented data gram of a large enough size to overrun the
buffers in your router.

The attack purpose is to consume the system memory and network bandwidth in the shortest possible time. We can limit
the maximum usage of memory in each socket, the maximum distance counters between fragmentation packages from
the same source IP, and the receiving timeout for an entire package.

Before you begin:
¢ You must have Read-Write permission for Security settings.
To configure an IP fragmentation policy:

1. Goto DoS Protection > Networking> IP Fragmentation Protection.
2. Click Edit to display the configuration editor.
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3. Complete the configuration.
Max Memory Maximum memory size of the IP fragmentation packet for the vdom. If the limit is reached,

Size Limit FortiADC will stop doing IP fragmentation reassemble.

Min Memory When total IP fragmentation memory size drops to this limit, FortiADC will start to do
Size Limit fragmentation reassemble again.

Timeout Max life time for each fragmentation queue. All the fragmentation packets in the queue will be
dropped if the queue exceed this timeout.

4. Save the configuration.

Configuring a TCP SYN flood protection policy

TCP SYN flood protection is a global setting to protect all virtual server traffic from SYN flood attack. After the

SYN Cookie option is enabled, each virtual server will monitor SYN rate. If the average SYN rate in 10 seconds exceeds
Maximum Half-Open Sockets, it will perform SYN Cookie on all subsequent new connections (SYN packets) of this
virtual server until the rate drops to below Maximum Half-Open Sockets.

Before you begin:
« You must have Read-Write permission for Security settings.
To configure a TCP SYN Flood Protection policy:

1. Goto DoS Protection > Networking> TCP SYN Flood Protection.
2. Click Edit to display the configuration editor.
3. Complete the configuration.

SYN Cookie Enable/disable syn flood protection.

Maximum If the average half-open connection rate in 10 seconds for each VS exceeds this setting, it will
Half-Open enable SYN Cookie for all new following TCP connections for this virtual server. If the average
Sockets rate drops to below this, it will disable SYN Cookie for this virtual server.

4. Save the configuration.

Configuring a TCP slow data flood protection policy

A Slow Data attack sends legitimate application layer requests but reads responses very slowly. With that, it may attempt
to exhaust the target’s connection pool. Slow reading advertises a very small number for the TCP Receive Window size
and at the same time empties the client’s TCP receive buffers slowly. This ensures a very low data flow rate.
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The attack purpose is to consume the system resources (memory, CPU time) slowly. We can disable the connection
when sending many probe packages fails in the zero-window timer.

Before you begin:

» You must have Read-Write permission for Security settings.
After you have configured HTTP Request Flood policies, you can select them in DoS Protection Profile.
To configure a HTTP Request Flood policy:

1. Goto DoS Protection > Networking> HTTP Request Flood.
2. Click Create New to display the configuration editor.
3. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.

Status Enable | Disable. If Enable, this policy will be activated, otherwise is inactive.

Probe Set probe interval time for the TCP zero window timer. After receiving a zero window packet,
Interval FortiADC will probe the peer side periodically until it returns with >0 window, or when probe count

exceeds the max probe-count.

Probe Max consecutive zero window probe count.
Count
Action Action after exceed max probe count.

Pass—if the probe count exceeds probe-count, stop the probe and pass all the packets in both
directions.

Deny—deny the connection with RST.
Block-period—deny the connection, and block any new connection from the peer side for a period of
time.
Severity High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.
The default value is High.

Log Enable or disable log

4. Save the configuration.
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Chapter 9: Web Application Firewall

You use web application firewall policies to scan HTTP requests and responses against known attack signatures and
methods and filter matching traffic. This section includes the following topics:

« Web application firewall basics on page 287

» Web application firewall configuration overview on page 289
» Configuring an OWASP TOP10 profile on page 291

» Configuring a WAF Profile on page 293

» Configuring WAF Action objects on page 295

» Configuring WAF Exception objects on page 297

« Configuring a Web Attack Signature policy on page 304

o Using the Signature Creation Wizard on page 309

« Configuring a URL Protection policy on page 312

» Configuring an Advanced Protection policy on page 313

» Configuring an HTTP Protocol Constraint policy on page 315
o Configuring CSRF protection on page 318

» Configuring brute force attack detection on page 320

« Configuring an SQL/XSS Injection Detection policy on page 321
» Configuring a Bot Detection policy on page 323

» Configuring a Threshold Based Detection policy on page 325
« Configuring a Biometrics Based Detection policy on page 330
» Configuring a Cookie Security policy on page 333

» Configuring sensitive data protection on page 335

» Configuring Cross-Origin Resource Sharing (CORS) protection on page 338

» Configuring XML Detection on page 343
» Configuring JSON detection on page 346
« Importing XML schema on page 348
o Uploading WSDL files on page 349
« Configuring Input Validation on page 354
» Web Vulnerability Scanner on page 358
» WVS Profile on page 361
e WVS Login on page 362
« WVS Exceptions on page 362
« Scan History on page 363
« Scan Integration on page 364
o Web Anti-Defacement on page 368
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Web application firewall basics

A web application firewall (WAF) is a security policy enforcement point positioned between a client endpoint and a web
application. The primary purpose is to prevent attacks against the web servers. A WAF is deployed separately from the
web application so that the process overhead required to perform security scanning can be offloaded from the web
server, and policies can be administered from one platform to many servers.

A WAF uses methods that complement perimeter security systems, such as the FortiGate next-generation firewall. The

FortiADC WAF module applies a set of policies to HTTP scanpoints, which are parsed contexts of an HTTP transaction.

HTTP scanpoints on page 288 illustrates the scanpoints. In the WAF policy configurations, you have options to enable

rules to detect attacks at the request line, query string, filename, URI, request headers, request body, response code, or
response body.

Web Attack Signature policy —The signature database includes signatures that can detect known attacks and
exploits that can be found in 29 scanpoints. In your policy configuration, you choose classes of scanpoints to
process: HTTP Headers, HTTP Request Body, and HTTP Response Body.

URL Protection policy — This policy enables you to create rules that detect patterns in the URI or the file extension.
HTTP Protocol Constraint policy — This policy enables you to create rules that restrict URI, header, and body
length; HTTP method, or HTTP response code.

SQL/XSS Injection Detection policy —This policy includes rules to detect SQL/XSS injection in the HTTP Request
URI, HTTP Referer Header, HTTP Cookie Header, or HTTP Request Body.

Cookie Security policy — This policy enables you to create rules that prevent cookie-based attacks and apply them
in a protection profile.

Data Leak Prevention policy — This policy enables you to create rules that prevent information leaks, damages and
loss.

HTTP Header Security policy — This policy enables you to create rules to prevent or mitigate known XSS,
clickjacking, and MIME sniffing security vulnerabilities. These response headers define security policies to client
browsers so that the browsers avoid exposure to known vulnerabilities when handling requests.

Input Validation Policy — This policy enables you to create rules to prevent suspicious HTTP requests by verifying
the user input from scan points like URL parameter, HTML form, hidden fields, and upload file.

Brute Force Attack Detection policy — This policy enables you to create rules to prevent too many login tests.
Credential Stuffing Defense policy — This policy enables you to create rules to identify login attempts using
username and password that have been compromised using an always up-to-date feed of stolen credentials.
JSON Detection policy — This policy enables you to create rules that enforce security checks that examine client
HTTP requests for anomalies in JSON data in HTTP POST operations.

XML Detection policy — This policy enables you to create rules that examine client requests for anomalies in XML
code.

OpenAPI Detection policy — This policy enables you to create rules through defining a standard, language-agnostic
interface to RESTful APIs, which allows both humans and computers to discover and understand the capabilities of
the service without access to source code, documentation, or through network traffic inspection.

API Gateway policy — This policy includes an APl management tool that sits between a client and a collection of
backend services. It acts as a reverse proxy to accept all API calls and return the appropriate result.

Bot Detection — This policy includes rules to detect Bots. A Bot is an application that runs automated tasks over the
Internet. The WAF supports two methods for detecting bad Bots: signature detection and behavior detection. You
can also use allowlists to exclude known trusted sources (good Bots) from detection.

Threshold Based Detection — This policy enables you to create rules to detect bad bots, such as web crawlers,
content scraping, and attack bots.

Biometrics Based Detection — This policy enables you to create rules that detect bots using behavioral biometrics
such as mouse movement, keyboard, screen touch, and scroll.
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« Advanced Protection policy — This policy enables you to create rules that detect web crawlers and content
scraping.
« CSREF Protection policy — This policy enables you to create rules that protect backend servers from CSRF attacks.

Policy rules are enforced (action taken) when scanning is completed at four checkpoints:

o« HTTP Request Header

o HTTP Request Body

« HTTP Response Header
o HTTP Response Body

If the HTTP Request Header violates a rule, and the action is Deny, the attempted session is dropped and scanning for
the transaction stops. If the action is Alert, the event is logged and rules processing continues.

HTTP scanpoints

REQUEST_LINE
A

s A WSP REQUEST LINE = 1,
URI WSP QUERY STRING,
¢ o WSP REQ FILENAME,
. GETfpath1fpathfoilename.ext?egrg1=argl_vaIue&arg2=arg2_va|ue)H1‘l’P,fl.1 WSP LRI,
HOST: www.hostname.com ; s WSP FULL URI,
Content-Length: 123 QUERY_STRING W5P URI NORMALIZE,
REQUEST < Cookie: req_cookiel=req_cookie_valuel; req_cookie2=req_cookie_value WSP FULL URI NORMALIZE,
Agent: Chrome WSP_REQ HEADER,
REQ_Header_Name: REQ_Header WSP_REQ HEADER NAME,
- WsP RES HEADER,
<REQ_Body>Request Body Content</REQ_Body> WsP RES HEADER NAME,
. WsP REQ COOKIE,
(" HTTP/1.1 200 OK WSP REQ COOKIE NAME,
Cookie: res_cookiel=res_cookie_valuel; res_cookie2=res_cookie_value WSP RES COOKIE,
Content-Length: 123 WSP RES COOKIE NAME,
RESPONSE < Server:lls WSP REQUEST,
RES Header Name: RES Header WSP REQUEST BODY,
WSP ARGS,
.. <RES_Body=Response Body Content</RES_Body= WSP ARGS NAME,
WSP RESPONSE,

WSP RESPONSE BODY,
WSP METHOD,

Number Attack Solution

1 SQL Injection FortiADC Supports it in two ways to prevent the SQL injection attack:
e Signatures

* SQL/XSS Injection Detection (Under WAF > Common Attacks Detection)

Enable FortiADC's exclusive SQL/XSS Injection Detection function for XSS
attacks prevention .

2 Cross Site Scripting FortiADC Supports it in two ways to prevent the XSS injection attack.
¢ Signatures

¢ SQL/XSS Injection Detection (Under WAF > Common Attacks Detection)
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Number

Attack Solution

Enable FortiADC's exclusive SQL/XSS Injection Detection function for XSS
attacks prevention .

Parameter/HTTP FortiADC Supports it with "request-body-detection" signature profile.
Tampering « If the signature profile was created by being cloned from "High-Level-
Security" profile, the "request-body-detection” is enabled already.

« If the signature profile was created by "Create New", the "request-body-

detection" is disabled.

You can enable it through CLI, for example:

config security waf web-attack-signature
edit "Poc Test"

set request-body-detection enable

next

end

Sensitive information It can be protected by configuring the Sensitive Data Type in Data Leak
Prevention (DLP) policy.

Cross Site Request It can be prevented by configuring “.*” in Parameter Value.
Forging (CSRF)

Session Hijacking It can be prevented by enabling Cookie Security and configuring Authentication

policy.
Blind SQL Injection FortiADC supports it in two ways to prevent the SQL injection attack.
¢ Signatures
¢ SQL/XSS Injection Detection (Under WAF > Common Attacks Detection)

It's recommended to enable the Exclusive SQL/XSS Injection Detection
function for SQL attack prevention.

Request Smuggling FortiADC strictly follows RFC 7230, section 3.3.3. If both Content-Length and
Transfer-Encoding HTTP Header exist in the request, Content-Length will be
removed. This ensures that the HTTP Request Smuggling attack can be
blocked by FortiADC without any additional settings.

Web Scraping FortiADC provides three ways to prevent the Web Scraping attacks.
¢ WAF Signatures
¢ Content Detection (Under WAF > Threshold Based Detection)

¢ Content Scraping (Under WAF > Common Attacks Detection > Advance
Protection)

Web application firewall configuration overview

WAF configuration overview on page 290 shows the relationship between WAF configuration elements. A WAF profile
comprises a Web Attack Signature policy, URL Protection policy, HTTP Protocol Constraint policy, SQL/XSS Injection
Detection, Bot Detection policy, and more. The profile is applied to a load balancing virtual server, so all traffic routed to
the virtual server is subject to the WAF rules. WAF profiles can be applied to HTTP and HTTPS virtual servers but not

HTTP Turbo virtual servers.
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WAF configuration overview

Virtual Server WAF Profile

| Name: HTTP | [Profile: HTTP | [Name: waf

I Interface: port1 | | Service port: 80 |

[Paddress: 1111 | [ WAFprofie:wafl | Exceptions | | Signature URL Protocol SQU/Xss Bot

Exceptions Attack Signature URL Protection HTTP Protocol Constraint SQL/XSS Injection Bot Detection

Name: waf-except | Name: High Mame: High | Mame:High Name:High Mame: myBot |
Host: www.examplecom ] [ Scan request: enable URL pattam: ] URL Length: | SOL Injection: anable Good Bat list: enable |
URL: /honey.html | I Scan response: disable | | File extension pattern: l Status Code: ] | XS5 Injection: enable | | Bad Botlist: enable ]

-] [-] [-] [-] -] -]

Predefined configuration elements

The FortiADC WAF includes many predefined configuration elements to help you get started: WAF profiles, Web Attack
Signature policies, HTTP Protocol Constraint policies, SQL/XSS Injection Detection policies, JSON Detection and XML
Detection.

Severity

The severity ratings for predefined Web Attack Signatures and the default severity rating for feature options like
SQL/XSS Injection Detection are based on the Open Web Application Security Project (OWASP) Risk Rating
Methodology. In order to harmonize the significance of severity levels in logs, we recommend you use this methodology
to assign severity for any custom elements you create.

Action
You can create an action which FortiADC takes when the conditions are fulfilled for WAF.

Basic Steps

1. Create configuration objects that define the action.
2. Select this action to a WAF rule configuration.

Exceptions

You can create exceptions so that traffic to specific hosts or URL patterns is not subject to processing by WAF rules.
Exception lists are processed before traffic is inspected. If an exception applies, the traffic bypasses the WAF module.
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Basic Steps

1. Create configuration objects that define the exception.
2. Add the exception to a WAF profile configuration or WAF rule configuration.

Configuring an OWASP TOP10 profile

Configure a WAF profile based on OWASP Top 10 attacks. In the configuration wizard, you can select one or more

OWASP Top 10 attacks, then FortiADC will aggregate all the WAF policies that can protect against the selected attacks.

After you complete the OWASP TOP10 wizard, it will be listed in the WAF Profile table.

‘\ ! f' From FortiADC 7.1.0, the OWASP Top 10 list has been updated to the latest 2021
version. The OWASP Top 10 Wizard is automatically updated to the 2021 list, and
9 the OWASP Top 10 2021 log data will be displayed through FortiView.
- Log data from OWASP Top 10 2017 can still be accessed through the Security log.

To create a OWASP TOP10 profile:

1. GotoWeb Application Firewall > OWASP TOP10 Wizard
To access this part of the web Ul, you must have Read-Write permission for Security settings.
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2. Selectthe top10 attacks that you want to prevent. Click Next.

OWASP TOP10 Wizard
© riros
OWASP Top10

A1:2021-Broken Access Control
A2:2021-Cryptographic Failures
A3:2021-Injection

A4:2021-Insecure Design

A5:2021-Security Misconfiguration
A6:2021-Vulnerable and Outdated Components

A7:2021-ldentification and Authentication Failures

AB8:2021-Software and Data Integrity Failures
A9:2021-Security Logging and Monitoring Failures

A10:2021-Server-Side Request Forgery

3. Select the Security Level, so that this OWASP Top10 profile will protect against the attacks with the corresponding
security level.

a. High: Only the attacks with high security level will be screened out.

b. Medium: Attacks with medium and high security levels will both be screened out.

c. Low: Attacks with low, medium, and high security levels will all be screened out.
OWASP TOP10 Wizard

Security Level

High
Medium

Low

< Back || Next = || Cancel
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4. Enter a name and brief description for the profile. Select an exception configuration object. Exceptions identify
specific hosts or URL patterns that are not subject to processing by this rule.

OWASP TOP10 Wizard
>0 rura |
Add Profile

Name Required config name. No spaces.

Description Optional description.

Exception Click to select v

< Back m Cancel

5. Save the configuration.

You can view this profile in Web Application Firewall > WAF Profile.

Configuring a WAF Profile

A WAF profile references the WAF policies that are to be enforced.

Predefined WAF profiles on page 293 describes the predefined profiles. In many cases, you can use predefined profiles
to get started.

Predefined WAF profiles

Predefined Pro- Description
files

High-Level-Security ¢ Web Attack Signature policy: High-Level-Security
e HTTP Protocol Constraints policy: High-Level-Security
¢ SQL/XSS Injection Detection policy: High-Level-Security

Medium-Level- ¢ Web Attack Signature policy: Medium-Level-Security
Security e HTTP Protocol Constraints policy: Medium-Level-Security
¢ SQL/XSS Injection Detection policy: Medium-Level-Security

Alert-Only ¢ Web Attack Signature policy: Alert-Only
e HTTP Protocol Constraints policy: Alert-Only
e SQL/XSS Injection Detection policy: Alert-Only

If desired, you can create user-defined profiles. The maximum number of profiles per VDOM is 255.

Before you begin:

« You can use predefined WAF profiles, create profiles based on predefined feature options, or create profiles based
on user-defined configuration objects. If you want to add user-defined configuration objects, you must create them
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before using this procedure to add them to a WAF profile.
» You must have Read-Write permission for Security settings.

After you have created a WAF profile, you can specify it in a virtual server configuration.

To configure a WAF Profile:

Go to Web Application Firewall > Web Profile.

Click the WAF Profile tab.

Click Create New to display the configuration editor.

Complete the configuration as described in WAF Profile configuration on page 294.
Save the configuration.

ok oN-=

WAF Profile configuration

Settings Guidelines

Standard Protection

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Exception Name Select a user-defined exception configuration object. Exceptions identify specific hosts or
URL patterns that are not subject to processing by this rule.

Description A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Web Attack Select a predefined or user-defined Web Attack Signature configuration object.
Signature

HTTP Protocol Select a predefined or user-defined HTTP Protocol Constraint configuration object.
Constraint

Sensitive Data Protection

Cookie Security Select a user-defined Cookie Security configuration object.

Data Leak Select a user-defined Data Leak Prevention configuration object.
Prevention

HTTP Header Select a user-defined HTTP Header Security configuration object.
Security

Input Protection

SQL/XSS Injection Select a predefined or user-defined SQL/XSS Injection Detection configuration object.

Detection

Input Validation Select a user-defined Input Validation Policy configuration object.
Policy

CORS Protection Select a user-defined CORS Protection configuration object.

Access Protection
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Brute Force Attack Select a user-defined Brute Force Attack Detection configuration object.
Detection

URL Protection Select a user-defined URL Protection configuration object.

Credential Stuffing Select a user-defined Credential Stuffing Defense configuration object.
Defense

API Protection
JSON Detection Select a predefined or user-defined JSON Detection configuration object.
XML Detection Select a predefined or user-defined XML Detection configuration object.

OpenAPI Detection Select a user-defined OpenAPI Detection configuration object.

API Gateway Select a user-defined AP| Gateway configuration object.

Bot Mitigation

Bot Detection Select a user-defined Bot Detection configuration object.

Threshold Based Select a predefined or user-defined Threshold Based Detection configuration object.
Detection

Biometrics Based Select a user-defined Biometrics Based Detection configuration object.

Detection

Advanced Protection
Advanced Protection  Select a user-defined Advanced Protection configuration object.

CSREF Protection Select a user-defined CSRF Protection configuration object.

Configuring WAF Action objects

Configure what action FortiADC should take when it meets the WAF conditions.
After you have created an action object, you can specify it in individual WAF feature rules.
Before you begin:

¢ You must have Read-Write permission for Security settings.

In many cases, you can use predefined profiles to get started.

Predefined actions Description

alert WAF policies will allow the traffic to pass and log the event.

block WAF policies will drop the current attack session by HTTP 403 message and
block the attacker (according the attacker’s IP address) for 1 hour, and log the
event.
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Predefined actions Description

captcha WAF policies will allow the traffic to pass if the client successfully fulfills the
CAPTCHA request, and log the event.

deny WAF policies will the drop current attack session by HTTP 403 message, and log
the event.
silent-deny WAF policies will drop the current attack session by HTTP 403 message, without

logging the event.

To configure a WAF Action object:

1. Go to Web Application Firewall > WAF Profile.

2. Click the Action tab.

3. Click Create New to display the configuration editor.
4. Complete the configuration of WAF Action objects.

5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Action Type Select which action FortiADC takes when the conditions are fulfilled for WAF:
¢ Pass — Allow the request.
* Deny — Block the request.

¢ Period Block — Deny all the HTTP requests from a source IP within a period
which specified by Period Block.

* Redirect — Send a redirect. You must specify the redirect URL.
e Captcha — Requires the client to successfully fulfill the CAPTCHA request.

Deny Code The Deny Code option is available if the Action Type is Deny or Period Block.
Select the HTTP response code, Default: 403.
200, 202, 204, 205, 400, 403, 404, 405, 406, 408, 410, 500, 501, 502, 503, 504

Period Block The Period Block option is available if the Action Type is Period Block.

Specify a time period when action blocks the client. Default: 60 seconds, Range:
1- 3600 seconds.

Redirect URL The Redirect URL option is available if the Action Type is Redirect.
Specify the URL that you want to redirect.
Log Status Enable/Disable log of events
Comment Enter comment or description of the action for your records.
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Configuring WAF Exception objects

WAF exceptions identify specific patterns that are not subject to processing by WAF rules. Use WAF exception rules to
reduce false-positives triggered by legitimate HTTP requests that match an attack signature rule. FortiADC supports
URL, hosts and source IP patterns matching in the WAF exception rules.

You can create and configure WAF Exception objects using either of the following methods:

« From the Web Application Firewall > WAF Profile > Exceptions tab, you can create/configure exception objects
to then apply to specific WAF profiles and individual WAF feature rules. For detailed steps, see Configuring WAF
exception rules from the WAF Profile > Exceptions tab on page 297.

o From the WAF security log (Log & Report > Security Log or FortiView > Security Logs), you can

create/configure exception objects to directly apply to the specific WAF log. For detailed steps, see Configuring
WAF exception rules from the WAF log on page 299.

Before you begin:

¢ You must have Read-Write permission for System settings.

‘\ ' !" For optimal functionality, we recommend keeping the number of WAF exception
rules configured to a minimum. If a large number of WAF exception rules are
9 configured, none may work effectively due to limitations of the shared memory
- (maximum total is 256.0 MBs in the VM platform).

Configuring WAF exception rules from the WAF Profile > Exceptions tab
You can create or configure exception objects to then apply to specific WAF profiles and individual WAF feature rules.

To configure a WAF exception rule from the WAF Profile > Exceptions tab:

1. Goto Web Application Firewall > WAF Profile.
2. Click the Exceptions tab.
3. Click Create New to display the configuration editor.
4. Configure the following:
Parameter Description
Name Enter a unique name for the WAF Exception. Maximum length is 130
characters.
Note: Once saved, the name of an Exception cannot be changed.
5. Click Save.

6. Under Exception Rule, click Create New to display the configuration editor.
7. Select the exception pattern Element Type from the drop-down menu.

« URL

» Source IP

» Source IPv6

o HTTP Method
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e HTTP Header
« Cookie
o Parameter

8. Configure the following parameters based on the exception pattern Element Type.

Parameter

URL
Exception Host Status

Host Pattern

URL Pattern

Source IP
IPv4/Netmask
Source IPv6

IPv6/Netmask

HTTP Method
HTTP Method

HTTP Header

Name Pattern

FortiADC 7.2.0 Handbook
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Description

Enable/disable the setting exceptions by host pattern.

The Host Pattern option appears if Exception Host Status is enabled.

Specify the matching string. Regular expressions are supported. Maximum
length is 128 characters.

For example, you can specify www.example.com, *.example.com, Or
www .example . * to match a literal host pattern or a wildcard host pattern.

Specify the matching string. Must begin with a URL path separator (/). Regular
expressions are supported. Maximum length is 128 characters.

For example, you can specify path names and files with expressions like
\/admin, .*\/data\/1.html,or\/data. *.

Specify the IPv4 address and netmask. For example: 192.0.2.5/24

Specify the IPv6 address and netmask. For example:
2001:0db8:85a3::8a2¢e:0370:7334/64

Select the HTTP method(s):
e GET

e POST

e« HEAD

« TRACE

¢ CONNECT
e DELETE
e PUT
 PATCH

¢ OPTIONS
¢ OTHERS

Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.

Forexample: . Content*
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Parameter Description

Check Value of Specified Enable/disable value checking for the specified element.

Element

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.

Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.

For example: . Content*

Cookie

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
Forexample: . Content*

Check Value of Specified Enable/disable value checking for the specified element.

Element

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Parameter

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
Forexample: . Content*

Check Value of Specified Enable/disable value checking for the specified element.

Element

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

9. Click Save.

Configuring WAF exception rules from the WAF log

You can create or configure exception objects to directly apply to the specific WAF log. You have the option to create
exception rules in basic mode or advanced mode. Using basic mode, you can apply the URL or Source IP/ Source IPv6
from the WAF log directly to the exception rule. The advanced mode enables you to create and configure exception rules
for all supported element patterns.
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To configure a WAF exception rule from the WAF log using basic mode:

1. GotoLog & Report > Security Log or FortiView > Security Logs.
2. Navigate to the WAF security log and expand the details for which you want to add an exception rule.
3. Inthelog details, click Add Exception to display the configuration editor.
4. Configure the following parameters.
Parameter Description
Profile Name Select the WAF Profile to apply the WAF exception rule.
Advanced Mode To configure the WAF exception rule using basic mode, ensure Advanced
Mode is disabled.
By default, Advanced Mode is disabled, which enables basic mode.
Element Type Select either of the following:
¢ URL — To apply the HTTP URL from this WAF log for this exception rule.
¢ Source IP — To apply the Source from this WAF log for this exception
rule. The Source IP option appears if the Source address is IPv4.
¢ Source IPv6 — To apply the Source IPv6 from this WAF log for this
exception rule. The Source IPv6 option appears if the Source address is
IPVv6.
5. Click Save.

To configure a WAF exception rule from the WAF log using advanced mode:

Goto Log & Report > Security Log or FortiView > Security Logs.

Navigate to the WAF security log and expand the details for which you want to add an exception rule.
In the log details, click Add Exception to display the configuration editor.

Configure the following:

Parameter Description

Profile Name Select the WAF Profile to apply the WAF exception rule.

o b=

Note: The profile name parameter will display according to the WAF
subcategory of the log. For example, if the WAF subcategory of the log is
"cookie security" then the parameter will display as "Cookie Security Profile
Name".

Advanced Mode Enable Advanced Mode to configure the WAF exception rule using advanced
mode.

Once Advanced Mode is enabled, the Element Type drop-down menu will
include all supported exception pattern.

5. Select the exception pattern Element Type from the drop-down menu.
« URL
» Source IP
» Source IPv6
e HTTP Method
o HTTP Header
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« Cookie
o Parameter

Parameter

6. Configure the following parameters based on the exception pattern Element Type.

Description

URL
Exception Host Status

Host Pattern

URL Pattern

Source IP
IPv4/Netmask
Source IPv6

IPv6/Netmask

HTTP Method
HTTP Method

HTTP Header

Name Pattern

Check Value of Specified
Element

FortiADC 7.2.0 Handbook
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Enable/disable the setting exceptions by host pattern.

The Host Pattern option appears if Exception Host Status is enabled.

Specify the matching string. Regular expressions are supported. Maximum
length is 128 characters.

For example, you can specify www.example.com, *.example.com, Or
www.example. * to match a literal host pattern or a wildcard host pattern.

Specify the matching string. Must begin with a URL path separator (/). Regular
expressions are supported. Maximum length is 128 characters.

For example, you can specify path names and files with expressions like
\/admin, .*\/data\/1.html,or\/data. *.

Specify the IPv4 address and netmask. For example: 192.0.2.5/24

Specify the IPv6 address and netmask. For example:
2001:0db8:85a3::8a2e:0370:7334/64

Select the HTTP method(s):
e GET

¢ POST

¢ HEAD

e TRACE

e CONNECT
e DELETE
e PUT

e« PATCH

¢ OPTIONS
¢ OTHERS

Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.

Forexample: . Content*

Enable/disable value checking for the specified element.
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Parameter Description
Value Pattern The Value Pattern option appears if Check Value of Specified Elementis
enabled.

Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.

Forexample: . Content*

Cookie

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
Forexample: . Content*

Check Value of Specified Enable/disable value checking for the specified element.

Element

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
Forexample: . Content*

Parameter

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
Forexample: . Content*

Check Value of Specified Enable/disable value checking for the specified element.

Element

Value Pattern The Value Pattern option appears if Check Value of Specified Elementis
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
Forexample: . Content*

7. Click Save.

Limitations: Escaped Characters

All Name Pattern and Value Pattern fields support regular expression. However, some characters must be escaped to
be a valid regular expression or be functional as an exception rule. If your expression contains characters that require
escaping, an error message may be triggered to reject the invalid expression. However, it is also possible that an error
may not be triggered by unescaped characters if it is considered syntactically correct — in which case these expressions
would not function as exception rules since they will not match any user traffic.

This section lists the most commonly used special characters that need to be escaped to make an input valid or
functional as an exception rule.
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Brackets: []

Brackets ([ 1) require other characters between the brackets to be a valid exception rule regular expression.
For example:

Invalid: []

Valid: [123] — Valid

[ ] is aninvalid exception rule regular expression because the input only contain brackets with no other characters in
between. Whereas [123] is valid because there are number characters between the brackets.

Parentheses: ()

Parentheses ( () ) require a backslash (\) before each parenthesis to be a valid exception rule regular expression — ()
=\ (\)

For example:
Invalid: http://x.x.x.x/login?link=mocha:alert ('attack%20success')
Valid: http://x.x.x.x/login?link=mocha:alert\ ('attack success'\)

Focusing on the parameter value, mocha:alert ('attack%20success"') isinvalid because there is no backslash
before each parenthesis. Whereas mocha:alert\ ('attack success'\) is valid with the backslash inserted before
each parenthesis.

Asterisk: *

Asterisks (*) require a backslash (\) before each asterisk to be a valid and functional exception rule — * — \ *
For example:

curl -vv -X POST --cookie "Cookiel23=abcd"

"http://x.x.x.x/index.php?nl23=v123&p namel=p valuel"

Where the cookie name is "cookie" and the cookie value is "a*"

Invalid: a*

Valid: a\ *"

In this case, both a* and a\ * are both correct in syntax. However, a* would not be functional as an exception rule
because it would not match any user traffic.

Space: %20

Spaces (%20) in URLs must be replaced with spaces to be a valid exception rule regular expression.
For example:
Invalid: http://x.x.x.x/login?link=mocha:alert ('attack%20success"')

Valid: http://x.x.x.x/login?link=mocha:alert (\'attack success'\)
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Focusing on the parameter value, the invalid expression becomes valid when the $20 is replaced with the space:
mocha:alert ('attack%$20success') —»mocha:alert (\'attack success'\)

Single Quotes: '’

When the Name Pattern or Value Pattern fields contain single quotes, it will be automatically escaped.
For example:
In the GUI or CLI, you may enter the parameter value pattern as: alert\ ('attack%20success'\)

In the CLI, the value pattern will appear as: alert\\ (\'attack success\'\\)

Configuring a Web Attack Signature policy

The FortiGuard Web Attack Signature service provides a database of attack signatures that is updated periodically to
protect against new kinds of attacks. Web Attack Signature categories and subcategories on page 307 summarizes the
categories of threats that are detected by the signatures. The categories are reported in logs.

In the Web Attack Signature policy configuration, you can enable/disable the class of scanpoints and the action when
traffic matches signatures.

There are three classes of scanpoints:
o HTTP Header—Scans traffic against HTTP header signatures. If you enable a policy at all, you are enabling HTTP
header scanning.

o HTTP Request Body—Scans traffic against HTTP request body signatures.
o HTTP Response Body—Scans traffic against HTTP response body signatures.

Header scanning is always a good practice, so enabling a policy always enables header scanning. Body scanning
impacts performance, so you have the option of disabling body scanning if system utilization or latency become an issue.

You can specify separate actions for three levels of event severity:

» High—We recommend you deny traffic for high severity events.
+ Medium—We recommend you deny or alert, according to your preference. To be strict, deny; otherwise, alert.
o Low—We recommend you allow the traffic and log an alert for low severity events.

Web Attack Signature predefined policies on page 304 describes the predefined policies. You can select the predefined
policies in your WAF profiles, or you can create policies that enable a different set of scan classes or a different action. In
this release, you cannot exclude individual signatures or create custom signatures. You can enable or disable the scan
classes.

Web Attack Signature predefined policies

Policy Status Action
High-Level-Security =~ Scan HTTP header—Enabled. High Severity Action—Deny.
Scan HTTP Request Body—Enabled. Medium Severity Action—Deny.
Scan HTTP Response Body—Disabled. Low Severity Action—Alert.
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Policy Status Action

Medium-Level- Scan HTTP header—Enabled. High Severity Action—Deny.

Security Scan HTTP Request Body—Enabled. Medium Severity Action—Alert.
Scan HTTP Response Body—Disabled. Low Severity Action—Alert.

Alert-Only Scan HTTP header—Enabled. High Severity Action—Alert.
Scan HTTP Request Body—Disabled. Medium Severity Action—Alert.
Scan HTTP Response Body—Disabled. Low Severity Action—Alert.

Basic Steps

1. Configure the connection to FortiGuard so that the system can receive periodic WAF Signature Database updates.
See Configuring FortiGuard service settings.

2. Optionally, if you do not want to use the predefined policies, configure Web Attack Signature policies. See below.

3. When configuring the WAF profile, select a policy that you associate with virtual servers . See Configuring a Web
Attack Signature policy.

Before you begin:

» You must have read-write permission for security settings.

To configure a Web Attack Signature policy:

Go to Web Application Firewall > Known Web Attacks.

Click the Web Attack Signature tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Web Attack Signature configuration on page 305.
Save the configuration.

ok~ oN-=

Web Attack Signature configuration

Settings Guidelines

Category This dialog provides tools for configuring a Web attack signature policy.

Name Specify a unique name for the Web attack signature policy and click Save. Valid characters
are A-z, a-z, 0-9, , and -. No space is allowed between characters.

Note: Once saved, the policy name cannot be changed.

Category This section lists the (main) categories of Web attack signatures within the system. Do the
following to include the desired categories of Web attack signature in the policy:
1. Inthe Name column, identify the categories of Web attack signatures of interest.
2. Inthe Status column, select (check mark) the categories you like to include in the
policy.
3. Inthe Action column, select the action you want to apply to the categories that you
select.

4. Double-click the name of a category to view its sub-categories. See Sub-category
below.
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Settings Guidelines

Sub-category This section lists the sub-categories of a (main) category of Web attack signature that you
have opened (double-clicked) from above. Do the following to enable any of the sub-
categories of interest:

1. In the Name column, identify the sub-categories of interest.
2. Inthe Status column, select (check mark) the sub-categories you like to include in the
policy.

Signature This dialog provides tools for searching through and filtering Web attack signatures
available within the system.

Search Use the following options to search for Web attack signatures to display:
» Description—Enter a descriptive text string and click Search.
¢ ID—Enter a Web attack signature ID and click Search.
¢ CVE Number—Enter a CVE number related to a Web attack signature and click
Search.
 Clear Search—Click this button to empty all search fields.
Note: Web attack signatures that match your search criterion show up in the Signature
section below the moment you click the corresponding Search button.

Filters Use any or a combination of the following filters to filter the Web attack signatures to be
displayed in the Signature section below:

» Category—Click the down arrow and select a (main) category of Web attack signatures
from the drop-down menu.

¢ Sub-category—Click the down arrow and select a sub-category of the category of Web
attack signatures that you have selected.

o Status —Click the down arrow and select either (Enable or Disable) from the drop-
down menu.

» Severity—Click the down arrow and select High, Medium, or Low from the drop-down
menu.

¢ Exception—Click the down arrow and select either (Yes or No) from the drop-down
menu.

« Clear All—Click this button to clear the existing filters. Note: You can also remove a
specific filter by clicking the corresponding x mark.

Signature This section displays all Web attack signatures that match your search and filter criteria,
showing the following information for each Web attack signature:
« ID
e Status
¢ Name
e Severity
e Target Application
» Exception Name

Signature Detall This section shows detailed information about the Web attack signature that you've
highlighted (clicked) in the Signature section above.

Detail This tab shows the following information about the selected signature:
« Signature ID
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Settings Guidelines

e Category

¢ Sub-category

e Severity

» Target Application

¢ Description

¢ CVE Number (if one exists)
» Reference (if one exists)

e FoundIn

Edit Signature This tab provides tools for editing a selected Web attack signature. It contains the following
fields:
e Signature ID—(Read only) Shows the ID of the selected signature.
» Status—Click to enable or disable the signature.
» Exception Name—Click the down arrow and select an exception from the drop-down
menu.

Web Attack Signature categories and subcategories on page 307 summarizes the categories of threats that are detected
by the signatures.

Web Attack Signature categories and subcategories

Cross Site Scripting (1) Generic XSS Attack (42)
SQL Injection (2) Generic SQL Injection (43)
Generic Attacks (3) OS Command Injection (1)

Coldfusion Injection (2)
LDAP Injection (3)
Command Injection (4)
Session Fixation (5)

File Injection (6)

PHP Injection (7)

SSl Injection (8)

UPDF XSS (9)

Email Injection (10)

HTTP Response Splitting (11)
RFI Injection (12)

Xpath Injection (49)

XML External Entities (57)
Insecure Deserialization (59)
HTTP Header Injection (60)
Buffer Overflow (62)

Denial Of Service (64)
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Category (ID) Subcategory (ID)

Trojans (4) Trojans (44)

Information Disclosure (5) Zope Information Leakage (13)
CF Information Leakage (14)
PHP Information Leakage (15)
ISA Server Existence Revealed (16)
Microsoft Office Document Properties Leakage (17)
CF Source Code Leakage (18)
II1S Information Leakage (19)
Weblogic information leakage (20)
Generic Filename and Directory leakage (21)
ASP/JSP Source Code Leakage (22)
PHP Source Code Leakage (23)
SQL Error leakage (24)
HTTP Header Leakage (25)
WordPress Leakage (26)
Generic Malicious Leakage (47)
Path Travel (58)

Known Exploits (6) Oracle 9i (27)
Coppermine Photo Gallery (28)
Netscape Enterprise Server (29)
Cisco IOS HTTP Service (30)
Microsoft SQL Server (31)
HP OpenView Network Node Manager (32)
Best Sofrware SalesLogix (33)
IBM Lotus Domino Web Server (34)
Microsoft IIS (35)
Microsoft Windows Media Services (36)
Dave Carrigan Auth_LDAP (37)
427BB (38)
RaXnet Cacti Graph (39)
CHETCPASSWD (40)
SAP (41)
Generic Exploit (48)
Lighttpd Server (53)
Caucho Resin Server (54)
JRun Web Server (55)
IBM Lotus Domino (56)
WordPress (61)
Struts 2 (63)
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Category (ID) Subcategory (ID)

Joomla! (65)
Credit Card Detection (7) Credit Card Detection (45)
Bad Robot (8) Bad Robot (46)
Cross Site Scripting (Extended) (9) Cross Site Scripting (Extended) (50)
SQL Injection (Extended) (10) SQL Injection (Extended) (51)
Generic Attacks (Extended) (11) Generic Attacks (Extended) (52)

Using the Signature Creation Wizard

The Signature Creation Wizard is a step-by-step tool available in the GUI that helps you configure a Web Attack
Signature policy based on the database, web server, or web application you want to protect. Using your selections, the
Signature Creation Wizard automatically compiles a list of the most applicable WAF Signatures for protecting your
database, web server, or web application. You can then apply those WAF Signatures in a Web Attack Signature policy.

Alternatively, you can custom configure a Web Attack Signature policy without using the Signature Creation Wizard. For
more information, see Configuring a Web Attack Signature policy on page 304.

To configure a Web Attack Signature using the Signature Creation Wizard:

1. GotoWeb Application Firewall > Known Web Attacks.
2. Click the Web Attack Signature tab.
3. Click Signature Wizard to display the configuration editor.
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4. From the Database tab, select the database(s) you want to protect. Click Next to navigate to the Web Server tab.
Signature Creation Wizard

Database
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MySQL
MSSQL
DB2
Sybase

PostgreSQL
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5. From the Web Server tab, select the web server(s) you want to protect. Click Next to navigate to the Web
Application tab, or click Back to navigate to the Database tab.

Signature Creation Wizard

Web Server
s

Apache

Apache Tomcat

Netscape Enterprise Server

IBM Lotus Domino
Nginx

IEM Websphere
Lighttpd

JBoss

Caucho Resin
JRun Web Server
WebLogic

SAP Server
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6. From the Web Application tab, select the web application(s) you want to protect. Click Next to navigate to the Add
Signature tab, or click Back to navigate to the Web Server tab.

Signature Creation Wizard

Web Application

WordPress
Drupal
Struts
SharePoint

SAP

< Back Mext = Cancel

7. From the Add Signature tab, enter a name for your Web Attack Signature policy and click Save.
The Category and Sub Category sections display the applicable WAF Signatures that you can apply to your policy.
8. Click Apply to save your Web Attack Signature policy.

9. Optionally, you can click Save and Edit Signature Details to apply WAF Exceptions where applicable.

Configuring a URL Protection policy

URL protection policies can filter HTTP requests that match specific character strings and file extensions.
Before you begin:
» You must have Read-Write permission for Security settings.

After you have configured URL protection policies, you can select them in WAF profiles.

To configure a URL Protection policy:

Go to Web Application Firewall > Access Protection.

Click the URL Protection tab.

Click Create New to display the configuration editor.

Complete the configuration as described in URL Protection configuration on page 313.
Save the configuration.

o oDbd =
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URL Protection configuration

Settings Guidelines

Name

URL Access Rule
Full URL Pattern

Action

Severity

Exception Name
File Extension Rule

File Extension
Pattern

Action

Severity

Exception Name

Configuration name. Valid characters are 2A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Matching string. Regular expressions are supported.

Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.

The default is alert.

¢ High—Log as high severity events.
¢ Medium—Log as a medium severity events.
* Low—Log as low severity events.

The default is low.

Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Matching string. Regular expressions are supported.

Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.

The default is alert.

¢ High—Log as high severity events.
¢ Medium—Log as a medium severity events.
* Low—Log as low severity events.

The default is low.

Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Configuring an Advanced Protection policy

The Advanced Protection policy includes the following rules:

» Content Scraping—Checks HTTP response header. If the traffic matches the occurrence limit and is over the
specified percentage match, it detects web scraping, then executes the relevant actions for the traffic.

+ HTTP Response Code—Checks HTTP response code. If the traffic matches the occurrence limit and is over the
specified percentage match, it detects web scraping, then executes the relevant actions for the traffic.
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To configure an Advanced Protection policy:

Go to Web Application Firewall>Common Attacks Detection.

Click the Advanced Protection tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Advanced Protection configuration on page 314.

o bd-=

Ay
‘9' If you want to drop a large number of packets when traffic match the rules, you should set

action to “block” instead of “deny."

5. Save the configuration.

Advanced Protection configuration

Settings Guidelines

Name Enter a unique Advanced Protection policy name. Valid characters are A-z, a-z, 0-9, ,and -.
No space is allowed.

Note: Once saved, the name of an Advanced Protection policy cannot be changed.
Content Scraping

Content Type Specify a Content Type for the Content Scraping rule:
o text/html
e text/plain
o text/xml
¢ application/xml
e application/soap+xml
e application/json

Occurrence Limit Sets the condition for the limit of the number of responses received from the specified type. If
the number of responses received within the time frame (set in Occurrence Within) from the
specified type is above this limit, this condition is fulfilled.

Occurrence Within Sets the time span during which to count how many times a response is received from the
specified type.
Percentage Match Sets the condition for what percentage of the traffic received is from the specified type, during

the given time frame. If the specified type, compared to all traffic, is received above this
Percentage Match, this condition is fulfilled.

Defaultis 0, indicating that this condition is disabled by default.

Action Select which action profile that you want to apply. See Configuring WAF Action objects on
page 295.
The default value is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log message contains a
Severity Level (severity_level) field. Select which severity level FortiADC uses when using
Advanced Protection:
* Low
¢ Medium

FortiADC 7.2.0 Handbook 314
Fortinet Inc.



Chapter 9: Web Application Firewall

Settings Guidelines

¢ High
The default value is Low.

HTTP Response Code
Response Code Specify a Response Code for the HTTP Response Code rule.

Occurrence Limit Sets the condition for the limit of the number of responses received from the specified type. If
the number of responses received within the time frame (set in Occurrence Within) from the
specified type is above this limit, this condition is fulfilled.

Occurrence Within Sets the time span during which to count how many times a response is received from the
specified type.
Percentage Match Sets the condition for what percentage of the traffic received is from the specified type, during

the given time frame. If the specified type, compared to all traffic, is received above this
Percentage Match, this condition is fulfilled.

Default is 0, indicating that this condition is disabled by default.

Action Select which action profile that you want to apply. See Configuring WAF Action objects on
page 295.

The default value is Alert.

Severity * High—Log as high severity events.
¢ Medium—Log as a medium severity events.
¢ Low—Log as low severity events.
The default is low.

Configuring an HTTP Protocol Constraint policy

The HTTP Protocol Constraint policy includes the following rules:

o HTTP request parameters—Limit the length of URIs, headers, and body to prevent several types of attacks, such as
buffer overflow and denial of service.

e HTTP request methods—Restrict HTTP methods allowed in HTTP requests. For example, do not allow the PUT
method in HTTP requests to prevent attackers from uploading malicious files.

o HTTP response codes—Drop response traffic containing HTTP response codes that might contain information
attackers can use to craft attacks. For example, some HTTP response codes include fingerprint data like web server
version, database version, OS, and so on.

Predefined HTTP protocol constraint policies on page 315 describes the predefined policies.

Predefined HTTP protocol constraint policies

Predefined Rules Description

High-Level-Security ~ Protocol constraints enabled with default values. Action is set to deny. Severity is set to high.
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Predefined Rules Description

Medium-Level- Protocol constraints enabled with default values. Action is set to alert. Severity is set to
Security medium.
Alert-Only Protocol constraints enabled with default values. Action is set to alert. Severity is set to low.

If desired, you can create user-defined rules to filter traffic with invalid HTTP request methods or drop packets with the
specified server response codes.

Before you begin:

« You should have a sense of legitimate URI lengths and HTTP request methods for the destination resources.
« You should know whether your servers include application fingerprint information in HTTP response codes.
» You must have Read-Write permission for Security settings.

To configure an HTTP Protocol Constraint policy:

Go to Web Application Firewall > Common Attacks Detection.

Click the HTTP Protocol Constraint tab.

Click Create New to display the configuration editor.

Complete the configuration as described in HTTP Protocol Constraint configuration on page 316.
Save the configuration.

o wDbd =

HTTP Protocol Constraint configuration

Settings Guidelines

Name Enter a unique HTTP protocol constraint policy name. Valid characters are A-z, a-z, 0-9, ,
and -. No space is allowed.

Note: Once saved, the name of an HTTP protocol constraint policy cannot be changed.

Request Parameters

Maximum Maximum characters in an HTTP request URI. The default is 2048. The valid range is 1-8192.
URI Length
lllegal Host Name Enable/disable hostname checks. A domain name must consist of only the ASCII alphabetic

and numeric characters, plus the hyphen. The hostname is checked against the set of
characters allowed by the RFC 2616. Disallowed characters, such as non-printable ASCII
characters or other special characters (for example, '<’, >', and the like), are a symptom of an
attack.

lllegal HTTP Version  Enable/disable the HTTP version check. Well-formed requests include the version of the
protocol used by the client, in the form of HTTP/v where v is replaced by the actual version
number (one of 0.9, 1.0, 1.1). Malformed requests are a sign of traffic that was not sent from a
normal browser and are a symptom of an attack.

llegal HTTP Enable/Disable the HTTP body multipart check. If the content-type is multipart media type, the

Multipart HTTP body must contain one or more body parts, each preceded by a boundary delimiter line
and the last one followed by a closing boundary delimiter line. After its boundary delimiter line,
each body part then consists of a header area, a blank line, and a body area. Malformed
HTTP requests are a sign of traffic that was not sent from a normal browser and are a
symptom of an attack.
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Settings Guidelines

Maximum Cookie Maximum number of cookie headers in an HTTP request. The default is 16. The valid range is
Number In Request 1-32.

Maximum Header Maximum number of headers in an HTTP request. The default is 50. Requests with more
Number In Request headers are a symptom of a buffer overflow attack or an attempt to evade detection
mechanisms. The valid configuration range is 1-100.

Maximum Request Maximum characters in an HTTP request header name. The default is 1024. The valid range
Header Name is 1-8192.
Length

Maximum Request Maximum characters in an HTTP request header value. The default is 4096. Longer headers
Header Value Length  might be a symptom of a buffer overflow attack. The valid configuration range is 1-8192.

Maximum URL Maximum characters in a URL parameter name. The defaultis 1024. The valid range is 1-
Parameter Name 2048.

Length

Maximum URL Maximum characters in a URL parameter value. The default is 4096. The valid range is 1-
Parameter Value 8192.

Length

Maximum Request Maximum length of the HTTP request header. The default is 8192. The valid range is 1-
Header Length 16384.

Maximum Request Maximum length of the HTTP body. The default is 67108864. The valid range is 1-67108864.
Body Length

Constraint Method Enable/Disable to scan request method and try to match it in request method rule in following
Override override headers:

¢ X-HTTP-Method

¢ X-Method-Override

¢ X-HTTP-Method-Override

Request Method Rule

Method Select one or more methods to match in the HTTP request line:

e CONNECT

e DELETE

e GET

« HEAD

e OPTIONS

¢ POST

e PUT

¢ TRACE

e Others
Note: The first 8 methods are described in RFC 2616. The group Others contains not
commonly used HTTP methods defined by Web Distributed Authoring and Version
(WebDAV) extensions.
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Settings Guidelines

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.

The default is alert.

Severity ¢ High—Log as high severity events.
¢ Medium—Log as a medium severity events.
e Low—Log as low severity events.
The default is low.

Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Response Code Rule

Minimum Status Start/end of a range of status codes to match. You can specify codes 400 to 599.
Code / Maximum

Status Code

Action ¢ Alert—Allow the traffic and log the event.

¢ Deny—Drop the traffic, send a 403 Forbidden to the client, and log the event.
The default is alert.

Severity * High—Log as high severity events.
¢ Medium—Log as a medium severity events.
¢ Low—Log as low severity events.
The default is low.

Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Configuring CSRF protection

A cross-site request forgery (CSRF) is an attack that exploits the trust that a site has in a user's browser to transmit
unauthorized commands.

Configuration overview
To protect back-end servers from CSRF attacks, you create two lists of items:

e URL list—The URL list contains all the URLs that you want to protect. FortiADC will verify the anti-csrf token when
you access the URL.

» Page List—When FortiADC receives a request for a web page in the page list, it inserts a javascript in the web page.
The script runs in the client's web browser and automatically appends an anti-csrf token.
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Parameter filters

. In some cases, a request for a web page and the requests generated by its links have the
Sl . same URL. FortiADC cannot distinguish between requests to add javascript to and requests to
9 check for the anti-CSRF parameter.

To avoid this issue, you create unique Page List and URL List items by adding a parameter
filter to them. The parameter filter allows you to add additional criteria to match in the URL or
HTTP body of a request.

Create your configuration carefully, making sure that all the URLs in the list have corresponding entries in the page list.
When FortiADC checks requests for the token but has not added the script to the corresponding web page, it blocks or
takes other action against the request.

To configure a CSRF Protection policy:

-—

-—
-—

12,
13.

SOV NGO AWM=

Go to Web Application Firewall.

Click the Common Attacks Detection tab.

Click the CSRF Protection tab

Click Create New to display the configuration editor.

Fillin the Name.

Enable the Status.

Modify the Action or Severity based on your requirements.
Click Save to save the configuration.

Click Edit to display the CSRF Protection.

Click Create New in CSRF Page to display the configuration editor and fill the Full URL Pattern and enable or
disable Parameter Filter based on your security requirements.

Click Create New in CSRF URL to display the configuration editor and fill the Full URL Pattern and enable or
disable Parameter Filter based on your security requirements.

Click Save to save the configuration.
Add the CSRF Protection policy to WAF profile.

CSREF Protection configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.

After you initially save the configuration, you cannot edit the name.

Action Select which action profile that you want to apply. See Configuring WAF Action objects on

page 295.
The default value is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log message contains a

Severity Level (severity_level) field. Select which severity level FortiADC uses when it logs a
CSREF attack:

* Low

¢ Medium

¢ High
The default value is Low.
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Full URL Pattern Supports regular expression.
Parameter Filter Enable/disable Parameter Filter.
Parameter Name Name of the parameter.
Parameter Value Supports regular expression.

Configuring brute force attack detection

Brute Force Attack Detection policies can prevent too many login tests. If an HTTP client tries to log into a server via
FortiADC and fails too many times, Brute Force Attack Detection policies can stop it.

Before you begin:

* You must have Read-Write permission for Security settings.
After you have configured Brute Force Attack Detection policies, you can select them in WAF profiles.
To configure a Brute Force Attack Detection policy:

1. GotoWeb Application Firewall > Access Protection.
2. Click the Brute Force Attack Detection tab.

3. Click Create New to display the configuration editor.

4. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Status On | OFF. If On, this policy will be activated, otherwise it is inactive.
Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.

The default is alert.

Severity High—Log as high severity events.
Medium—Log as medium severity events.
Low—Log as low severity events.
The defaultis low.

Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns that
are not subject to processing by this rule.

Comments A string to describe the purpose of the configuration.

Save the configuration.

Edit the new saved configuration.

Find “Match Condition” and click Create New.
Complete the configuration.

© No a
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Host
Status

Host
Pattern

URL
Pattern

Login
Failed
Code

IP
Access
Limit

On | OFF;
If On, Host Pattern will be shown and needed.
The defaultis OFF.

Matching string for host name. Regular expressions are supported.

Matching string. Regular expressions are supported. The input string must start with "/".

Matching failed code (HTTP response code). 0 means it does not match this code.
The defaultis 0.

1-65535. Specify the number of consecutive login failures.

Note: If a pair of HTTP request/response match all the settings above (Host Pattern if Host Status is
On, URL Pattern and Login Failed Code if it isn’t 0), this is a login failure.

9. Save the configuration.

A\,

S L4
q You can add multiple match condition rules by repeating steps 6-9.

10. Save the configuration.

Configuring an SQL/XSS Injection Detection policy

SQL/XSS Injection Detection policies detect SQL injection and cross-site scripting (XSS) attacks. Injection occurs when
user-supplied data is sent to an interpreter as part of a command or query. In an SQL injection attack, attackers craft
HTTP requests that cause SQL queries to be executed directly against the web application’s database. XSS injection
attacks cause a web browser to execute a client-side script.

In contrast to signature-based detection, the WAF SQL and XSS injection detector module detects SQL and XSS
injection through lexical analysis, which is a complementary method and is faster.

The policy enables/disables scanpoints, the action when traffic matches signatures, and the event severity.

You can enable detection in the following scanpoints:

SQL Injection
SQL Injection
SQL Injection
SQL Injection
XSS Injection

: URI—Analyzes content in the URI.

: Referer—Analyzes content in the HTTP Referer header.
: Cookie—Analyzes content in the HTTP Cookie header.
: Body—Analyzes content in the HTTP request body.

: URI—Analyzes content in the URI.

XSS Detection: Referer—Analyzes content in the HTTP Referer header.
XSS Detection: Cookie—Analyzes content in the HTTP Cookie header.
XSS Detection: Body—Analyzes content in the HTTP request body.
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Header scanning is recommended. Body scanning impacts performance, so you have the option of disabling body
scanning if system utilization or latency become an issue.

Predefined SQL injection and XSS detection policies on page 322 describes the predefined policies.

Predefined SQL injection and XSS detection policies

SQL Injection XSS
Predefined Rules Detection Severity Detection Severity
High-Level-Security  All except Body Deny High All except Body Deny High
SQL Injection XSS Injection
Detection Detection
Medium-Level- Only SQL URI Deny High None Alert Low
Security SQL Injection
Detection
Alert-Only Only SQL URI Alert High None Alert Low
SQL Injection
Detection

If desired, you can create user-defined policies.
Before you begin:
¢ You must have Read-Write permission for Security settings.

After you have created an SQL injection/XSS policy, you can specify it in a WAF profile configuration.

To configure an SQL/XSS Injection Detection policy:

Go to Web Application Firewall > Common Attacks Detection.

Click the SQL/XSS Injection Detection tab.

Click Create New to display the configuration editor.

Complete the configuration as described in SQL/XSS Injection Detection configuration on page 322.
Save the configuration.

o obd-=

SQL/XSS Injection Detection configuration

Settings Guidelines

Name Configuration name. Valid characters are A-Z7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

SaL
SQL Injection Enable/disable SQL injection detection.
Detection
URI Detection Enable/disable detection in the HTTP request.
Referer Detection Enable/disable detection in the Referer header.
Cookie Detection Enable/disable detection in the Cookie header.
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Settings Guidelines

Body Detection Enable/disable detection in the HTTP Body message.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.

The default is alert, but we recommend using Deny SQL Injection.

Severity ¢ High—Log as high severity events.
¢ Medium—Log as a medium severity events.
* Low—Log as low severity events.
The default is low, but we recommend you rate this high or medium.

SQL Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns

Name that are not subject to processing by this rule.

XSS

XSS Injection Enable/disable XSS injection detection.

Detection

URI Detection Enable/disable detection in the HTTP request.

Referer Detection Enable/disable detection in the Referer header.

Cookie Detection Enable/disable detection in the Cookie header.

Body Detection Enable/disable detection in the HTTP Body message.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.

The default is alert, but we recommend you deny XSS Injection.

Severity ¢ High—Log matches as high severity events.
¢ Medium—Log matches as a medium severity events.
* Low—Log matches as low severity events.
The default is low, but we recommend you rate this high or medium.

XSS Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns
Name that are not subject to processing by this rule.

Configuring a Bot Detection policy

Bot detection policies use signatures and source behavior tracking to detect client traffic likely to be generated by robots
instead of genuine clients. Some bots, such as search engine crawlers, are "good bots" that perform search indexing
tasks that can result in more legitimate users being directed to your site. You enable a allowlist to permit those. "Bad
bots" are known to send traffic that has an negative impact on site availability and integrity, such as DDoS attacks or
content scrapping. You want to block these.

To get started, you can use predefined allowlists (known good bots) and blocklists (known bad bots). You can also
specify a rate limit threshold of HTTP requests/second for sources not matched to either allowlist or blocklist. The rate
limit threshold can be useful in detecting "unknown bots".

In the event of false positives, you can use the user-specified allowlist table to fine-tune detection.
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Before you begin:

» You must configure the connection to FortiGuard so the system can receive periodic WAF Signature Database
updates, including "good bot" and "bad bot" signatures and lists. See Configuring FortiGuard service settings.

» You must have Read-Write permission for Security settings.

After you have configured Bot Detection policies, you can select them in WAF profiles.

To configure a Bot Detection policy:

Go to Web Application Firewall > Bot Detection.

In the Bot Detection tab, click Create New to display the configuration editor.
Complete the configuration as described in Bot Detection configuration on page 324.
Save the configuration.

o bd-=

Bot Detection configuration

Settings Guidelines

Name Configuration name. Valid characters are -7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Status Enable/disable Bot detection.

Search Engine Bypass Enable/disable the predefined search engine spider allowlist. The list is included in
WAF signature updates from FortiGuard.

Search Engine List Set list of search engines. Default value is all search engines.

Bad Robot Status Enable/disable the predefined bad robot blocklist. The list is included in WAF
signature updates from FortiGuard.

HTTP Request Rate Specify a threshold (HTTP requests/second/source) to trigger the action. Bots send
HTTP request traffic at extraordinarily high rates. The source is tracked by source IP
address and User-Agent.

The default is 0 (off). The valid range is 0-100,000,000 requests per second.

Action Select the action profile that you want to apply. See Configuring WAF Action objects
on page 295.

The default is alert.

Severity ¢ High—Log as high severity events.
¢ Medium—Log as a medium severity events.
* Low—Log as low severity events.
The default is low.

Allowlist

IPv4/Netmask Matching subnet (CIDR format).

URL Pattern Matching string. Regular expressions are supported.
URL Parameter Name Matching string. Regular expressions are supported.
Cookie Name Matching string. Regular expressions are supported.
User Agent Matching string. Regular expressions are supported.

FortiADC 7.2.0 Handbook
Fortinet Inc.

324



Chapter 9: Web Application Firewall

Configuring a Threshold Based Detection policy

Using Threshold Based Detection policies, FortiADC can determine whether requests are generated by robots instead of
a human by detecting suspicious behavior patterns that exceed the normal threshold defined in the policy. Threshold
Based Detection rules are defined by the number of times a type of behavior is allowed to occur within a specified
amount of time. Once the number of occurrence exceeds the defined threshold value, an action is triggered in response
to detecting the suspicious behavior.

FortiADC supports the following three types of Threshold Based Detection:

o Crawler Detection — Detects web crawlers that are usually used to map out your application structure by monitoring
the frequency of HTTP response codes. If the occurrence of a specified HTTP response code exceeds the
allowable threshold in the specified time frame, FortiADC will execute the relevant action for the traffic.

« Content Detection — Detects malicious tools that try to download large amounts of content such as text/HTML and
application/ XML from your website by monitoring the frequency of download activities. If the occurrence of the
download activity exceeds the allowable threshold within the specified time frame, FortiADC will execute the
relevant action for the traffic.

« Attack Detection — Detects suspicious attack behavior patterns indicative of a bot attack by monitoring the
frequency of attacks detected in specific WAF Attack modules. If the occurrence of specific attacks exceeds the
allowable threshold within the specified time frame, FortiADC will execute the relevant action for the traffic.

FortiADC offers Predefined Threshold Based Detection policy configurations on page 328 that can be applied as is or
used as a template for customization.

After you have configured Threshold Based Detection policies, you can select them in WAF profiles.

Before you begin:

¢ You must have Read-Write permission for Security settings.

To configure a Threshold Based Detection policy:

1. Goto Web Application Firewall > Threshold Based Detection.
2. Inthe Threshold Based Detection tab, click Create New to display the configuration editor.
3. Configure the following Biometrics Based Detection settings:

Setting Description

Name Specify a name for the Threshold Based
Detection rule. Valid characters are A-27, a-z,
0-9, ,and -. No spaces.

The configuration name cannot be edited once
it has been saved.

Comments Optionally, enter comments about the
Threshold Based Detection policy.

Crawler Detection

Crawler Status Enable/Disable Crawler Detection. This is
disabled by default.
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Setting Description

Response Code Specify the 3 digit HTTP response code(s) to
check. Enter as a single code (e.g. 403),
multiple codes (e.g. 403,404), or as a range
(e.g. 500-503). Range: 100-599.

Crawler Action Select the action profile to apply when a web
crawler bot is detected. See Configuring WAF
Action objects on page 295.

The default action is alert.

Crawler Severity Select the event severity to log when a web
crawler bot is detected:
¢ High — Log as high severity events.
¢ Medium — Log as a medium severity
events.
* Low — Log as low severity events.
The default is low.

Crawler Occurrence Limit Specify the maximum number of responses
that can be received from the specified
Response Code within the time frame (set in
Crawler Occurrence Within). If the limitis
exceeded, the specified Crawler Action will
be triggered. Default: 100, Range: 1-100000.

Crawler Occurrence Within Specify the time span during which to count
how many times a response is received from
the specified Response Code. Default: 60
seconds, Range: 1-600 seconds.

Content Detection

Content Scraping Status Enable/disable Content Detection. This is
disabled by default.
Content Type Select one or more content type to monitor for

content scraping:

e Text/HTML

e Text/Plain

e Text/XML

¢ Application/XML

¢ Application/Soap+XML
¢ Application/lJSON

Content Action Select the action profile to apply when a
content scraping bot is detected. See
Configuring WAF Action objects on page 295.

The default action is alert.

Content Severity Select the event severity to log when a content
scraping bot is detected:
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Setting Description

Content Occurrence Limit

Content Occurrence Within

Attack Detection
Attack Detection Status

Attack Modules

Attack Action

Attack Severity

FortiADC 7.2.0 Handbook
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¢ High — Log as high severity events.
¢ Medium — Log as a medium severity
events.
* Low — Log as low severity events.
The default is low.

Specify the maximum number of responses
that can be received from the specified
Content Type within the time frame (set in
Content Occurrence Within). If the limit is
exceeded, the specified Content Action will
be triggered. Default: 100, Range: 1-100000.

Specify the time span during which to count
how many times a response is received from
the specified Content Type. Default: 60
seconds, Range: 1-600 seconds.

Enable/disable Attack Detection. This is
disabled by default.

Select one or more attack modules to monitor
for bot attacks:
¢ Web Attack Signature
Input Validation
¢ Brute Force Attack Detection
URL Protection
HTTP Protocol Constraint
¢ Credential Stuffing Defense
Click Advanced to expand the selection list:
¢ Data Leak Prevention
¢ SQL/XSS Injection Detection
e Cookie Security
¢ CSRF Protection
¢ CORS Protection
e JSON Validation
¢ OpenAPI Validation
e XML Protection
¢ AP| Gateway

Select the action profile to apply when a bot
attack is detected. See Configuring WAF
Action objects on page 295.

The default action is alert.

Select the event severity to log when a bot
attack is detected:
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Setting Description

¢ High — Log as high severity events.
¢ Medium — Log as a medium severity
events.
* Low — Log as low severity events.
The default is Low.

Attack Occurrence Limit Specify the maximum number of responses
that can be received from the specified Attack
Module within the time frame (set in Attack
Occurrence Within). If the limit is exceeded,
the specified Attack Action will be triggered.
Default: 100, Range: 1-100000.

Attack Occurrence Within Specify the time span during which to count
how many times a response is received from
the specified Attack Module. Default: 60
seconds, Range: 1-600 seconds.

4. Click Save.
The newly configured Threshold Based Detection policy is added to the Threshold Based Detection page.

Predefined Threshold Based Detection policy configurations

You can apply any of the predefined Threshold Based Detection policies in WAF profiles or you can clone a predefined
configuration to use as a template to define your own policy.

Name Comments Predefined settings
Bot_Detect Detect suspicious bot with Crawler Status — Enabled
CAPTCHA action Response Code — 403,404

Crawler Action — captcha

Crawler Severity — Medium

Crawler Occurrence Limit— 100

Crawler Occurrence Within — 60 (seconds)
Content Scraping Status — Enabled

Content Type — Text/HTML, Text/Plain, Text/XML,
Application/XML, Application/Soap+XML,
Application/JSON

Content Action — captcha

Content Severity — Medium

Content Occurrence Limit— 100

Content Occurrence Within — 60 (seconds)
Attack Detection Status — Enabled

Attack Modules — Web Attack Signature, Input
Validation, Brute Force Attack Detection, URL Protection,
HTTP Protocol Constraint, Credential Stuffing Defense

Attack Action — captcha
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Name Comments

Content_Scraping_
Detect

Monitor the frequency of illegal
content scraping with ALERT
action

Crawler_Detect Monitor the frequency of 403 and
404 response codes with ALERT

action

High-Level-Security ~ Block all suspicious threshold

violations

FortiADC 7.2.0 Handbook
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Predefined settings

Attack Severity — Medium
Attack Occurrence Limit— 100
Attack Occurrence Within — 60 (seconds)

Crawler Status — Disabled
Content Scraping Status — Enabled

Content Type — Text/HTML, Text/Plain, Text/XML,
Application/XML, Application/Soap+XML,
Application/JSON

Content Action — alert

Content Severity — Low

Content Occurrence Limit— 100

Content Occurrence Within — 60 (seconds)
Attack Detection Status — Disabled

Crawler Status — Enabled

Response Code — 403,404

Crawler Action — alert

Crawler Severity — Low

Crawler Occurrence Limit— 100

Crawler Occurrence Within — 60 (seconds)
Content Scraping Status — Disabled
Attack Detection Status — Disabled

Crawler Status — Enabled

Response Code — 403,404

Crawler Action — deny

Crawler Severity — High

Crawler Occurrence Limit— 100

Crawler Occurrence Within — 60 (seconds)
Content Scraping Status — Enabled

Content Type — Text/HTML, Text/Plain, Text/XML,
Application/XML, Application/Soap+XML,
Application/JSON

Content Action — deny

Content Severity — High

Content Occurrence Limit— 100

Content Occurrence Within — 60 (seconds)
Attack Detection Status — Enabled

Attack Modules — Web Attack Signature, Input
Validation, Brute Force Attack Detection, URL Protection,
HTTP Protocol Constraint, Credential Stuffing Defense

* Advanced — Data Leak Prevention, SQL/XSS
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Name Comments

lllegal_User_Detect  Detectillegal user with

CAPTCHA action

Vulnerability_Scan Monitor the frequency of web
attack signature violations with

CAPTCHA action

Predefined settings

Injection Detection, Cookie Security, CSRF
Protection, CORS Protection, JSON Validation,
OpenAPI Validation, XML Protection, APl Gateway

Attack Action — deny

Attack Severity — High

Attack Occurrence Limit— 100

Attack Occurrence Within — 60 (seconds)

Crawler Status — Disabled
Content Scraping Status — Disabled
Attack Detection Status — Enabled

Attack Modules — Brute Force Attack Detection,
Credential Stuffing Defense

Attack Action — captcha

Attack Severity — Medium

Attack Occurrence Limit— 100

Attack Occurrence Within — 60 (seconds)

Crawler Status — Disabled

Content Scraping Status — Disabled
Attack Detection Status — Enabled
Attack Modules — Web Attack Signature
Attack Action — captcha

Attack Severity — Medium

Attack Occurrence Limit— 100

Attack Occurrence Within — 60 (seconds)

Configuring a Biometrics Based Detection policy

Using Biometrics Based Detection policies, FortiADC can determine whether requests are generated by robots instead

of a human by checking client events within a specified period. With JavaScript enabled on the client browser, FortiADC
can collect behavioral biometrics (such as mouse movement, keyboard, screen touch, and scroll) and monitor as client

events for a specified period. FortiADC can then determine whether the behavioral biometrics from the request is

indicative of a bot or a human.

After you have configured Biometrics Based Detection policies, you can select them in WAF profiles.

Before you begin:

» You must have Read-Write permission for Security settings.
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To configure a Biometrics Based Detection policy:

1. GotoWeb Application Firewall > Biometrics Based Detection.
2. Inthe Biometrics Based Detection tab, click Create New to display the configuration editor.
3. Configure the following Biometrics Based Detection settings:

Setting Description

Name Specify a name for the Biometrics Based Detection rule. Valid characters are
A-7,a-z, 0-9, ,and -.No spaces.
The configuration name cannot be edited once it has been saved.

Ignore JS Check Enable/disable to redirect to a warning page to enable JavaScript. This is
disabled by default.

¢ Disable — FortiADC will check if JavaScript is enabled on the client
browser. If JavaScript is not enabled, then FortiADC will redirect to a
warning page to let the user enable JavaScript. If the client does not
enable JavaScript within 10 seconds, the traffic may be recognized as a
bad bot.

¢ Enable — FortiADC will not check if JavaScript is enabled on the client
browser. If JavaScript is enabled on the client browser, events can be
collected normally and FortiADC can determine if it is a bot or not. But if
JavaScript is disabled on the client browser, the client will be recognized
as a bot after the Event Collection Time, since events cannot be collected
by FortiADC.

Monitor Client Events Select one or more client events to monitor:

¢ Mouse Movement

¢ Click

¢ Keyboard

e Screen Touch

e Scroll
By default, Mouse Movement, Click, and Keyboard are preselected. If the
configuration is saved with no Monitor Client Events selected, it will default to
the preselected client events.

Event Collection Time Specify for how long the events will be collected from the client. Default: 60
Range: 10-3600 seconds.

Bot Effective Time Specify the time interval before FortiADC tests and verifies a bot again, once a
bot has been detected. Default: 5 Range: 1-60 minute(s).

JS Request URL Specify the URL to use to insert JavaScript code to the client machine. Default:
/fadc_client/default index.Js.

Action Specify a WAF action object to apply when a bot is detected. See Configuring
WAF Action objects on page 295.

The default action is alert.

Severity Select the event severity to log when a bot is detected:
¢ High — Log as high severity events.
¢ Medium — Log as a medium severity events.
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Setting Description

¢ Low—Log as low severity events.
The default is Low.

Exception Name Select an exception configuration object. Exceptions identify specific hosts or
URL patterns that are not subject to processing by this rule.

4. Click Save.
Once the configuration is saved, the URL List becomes configurable. The Biometrics Based Detection policy will be
applied to the request URLs in the URL List.

5. Under the URL List section, click Create New to display the configuration editor.
6. Configure the following URL List settings:

Setting Description

Host Status If enabled, require authorization only for the specified host. If disabled, ignore
hostname in the HTTP request header and require authorization for requests
with any Host header. Disabled by default.

Host The Host option is available if Host Status is enabled.

Specify the HTTP Host header. If Host Status is enabled, the policy matches
only if the Host header matches this value. Complete, exact matching is
required. For example, www . example . com matches www.example . com but
not www.example.com.hk.

Request URL The literal URL, such as /index . php, or a regular expression, such as
~/* .php that the HTTP request must contain in order to match the rule.
Multiple URLSs are supported.
7. Click Save.

Once the URL List configuration is saved, you are returned to the Biometrics Based Detection configuration editor.
8. Click Save again to apply the newly created URL List configuration to the Biometrics Based Detection configuration.

Configuring a Credential Stuffing Defense Policy

Credential Stuffing Defense identifies login attempts using username and password that have been compromised using
an always up-to-date feed of stolen credentials. Administrators can configure their supported devices to take various
actions if a suspicious login is used including logging, alerts, and blocking.

To configure an Credential Stuffing Defense policy:

Go to Web Application Firewall > Access Protection.
Click the Credential Stuffing Defense tab.

Click Create New to display the configuration editor.
Complete the Credential Stuffing Defense configuration.
Save the configuration.

o o0N-=
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Predefined Rules Description

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

Status Enable or disable this profile. Default is disable.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 295.

The default is Alert.

Severity High—Log matches as high severity events.
Medium—Log matches as a medium severity events.
Low—Log matches as low severity events.
The default is Low, but we recommend you use High or Medium.

Note: FortiADC has no built-in Credential Stuffing Defense database. At least one FortiGuard update is required to install
the database, otherwise this feature is ineffective. For details, see Configuring FortiGuard service settings on page 465.

Configuring a Cookie Security policy

A cookie security policy allows you to configure FortiADC features that prevent cookie-based attacks and apply themin a
protection profile. For example, a policy can enable cookie poisoning detection, encrypt the cookies issued by a back-
end server, and add security attributes to cookies.

To configure an Cookie Security policy:

Go to Web Application Firewall>Sensitive Data Protection.

Click the Cookie Security tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Cookie Security configuration on page 333.

oo Dd =

Ay
‘9' If you want to drop a large number of packets when traffic match the rules, you should set
- Action to “block” instead of “deny."

5. Save the configuration.

Cookie Security configuration

Settings Guidelines

Name Enter a unique Cookie Security policy name. Valid characters are A-Z, a-z, 0-9, ,and -. No
space is allowed.

Note: Once saved, the name of an Cookie Security policy cannot be changed.

Security Mode No—Does not apply cookie tampering protection or encrypted cookie.
Signed—Prevents tampering by tracking the cookie by adding a signature.
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Settings Guidelines

Encrypted—FortiADC encrypts set-cookie values which have been sent from back-end web
server to clients. Clients can only see the encrypted cookies. FortiADC also decrypts cookies
which have been submitted by clients before sending them to the back-end server to
determine if a cookie attack has been placed.

Samesite Add SamesSite attribute to prevent the browser from sending cookies along with cross-site

requests, to mitigate the risk of cross-origin information leakage. It provides Strict, Lax, and
None values for this attribute:

e Strict: any request from the third parties will not carry such cookies;

¢ Lax: any request from the third parties will not carry such cookies except for GET

requests that navigate to the destination URL.

¢ None: set the value as none if a cookie is required to be sent by cross origin.

¢ Nothing: Do not add Samesite attribute to cookies.
The default value is Nothing.

Secure Enable to add the secure flag to cookies. The secure attribute limits the scope of the cookie to
"secure" channels (where "secure" is defined by the user agent). When a cookie has the
Secure attribute, the user agent will include the cookie in an HTTP request only if the request
is transmitted over a secure channel (typically HTTP over Transport Layer Security (TLS).

Note: cookie attribute.

Severity When FortiADC records violations of this rule in the attack log, each log message contains a
Severity Level (severity level) field. Select which severity level FortiADC uses when using
Cookie Security:
e Low
¢ Medium
¢ High
The default value is Low.

Remove Cookie Enable so FortiADC will accept the request, but will also remove the cookie before sending it
to backend web server.

Note: Only applies when Security Mode is set to encrypted or signed.

HTTP Only Enable to add "HTTPOnly" flag to cookies. The HttpOnly attribute limits the scope of the
cookie to HTTP requests. In particular, the attribute instructs the user agent to omit the cookie
when providing access to cookies via "non-HTTP" APIs (such as a web browser API that
exposes cookies to scripts).

Note: cookie attribute.

Encrypted Cookie All—will encrypt all cookies.
Type List—will encrypt the cookie that matches with the cookie-list.
Note: Only applies when Security Mode is set to encrypted.

Cookie Replay Disable or enable to allow FortiADC to use the IP address of a request to determine the owner
of the cookie.

If Cookie Replay is enabled, the client IP address will be appended to the set-cookie value
before encryption. Once the FortiADC receives the cookie, the cookie will be decrypted and
FortiADC will check if the IP matches with the client.
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Settings Guidelines

Since the public IP of a client is not static in many environments, we recommend that you do
not enable cookie-replay.

Note: Only applies when Security Mode is set to encrypted. Optional.

Allow Suspicious Never—Never allow suspicious cookies.

Cookies Always—Always allow suspicious cookies.
Custom—Don't Block suspicious cookies until the date specified by "Dont_block_until".
Select whether or not FortiADC will allow requests that contain unrecognizable cookies or if
there are missing cookies.
When cookie-replay is enabled, the suspicious cookie is a missing cookie that tracks the client
IP address.

In many cases, when you first introduce the cookie security features, the
cookies that client browsers have cached earlier will generate false

positives. To avoid this problem, either select Never, or select Custom
and enter an appropriate date on which to start taking the specified action
against suspicious cookies.

Note: Only applies when Security Mode is set to encrypted.
Don't Block Until Specify the date to begin blocking suspicious cookies. Applicable only when Allow Suspicious

Cookies is set to custom.
Note: Only applies when Security Mode is set to encrypted.

Max Age Note: cookie attribute.
Default value is 0 (do not add max age ), range 0- 2147483647.
Add the maximum age (in minutes) if the response from the backend server does not already
have a "Max-Age" attribute, or does not have an "Expires" attribute.

Exception See Configuring WAF Exception objects on page 297.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.
The default value is Alert.

Cookie List The list of cookies to be encrypted.

Note: Only when Security Mode is set to encrypted, and when encrpyted_cookie_type is set
to "list."

Configuring sensitive data protection

The Data leak prevention (DLP) feature allows Web Application Firewall (WAF) to prevent information leaks, damage
and loss. It provides desensitization and warning measures for sensitive information leaks on websites, such as SSN
numbers and credit card information, as well as the leakage of sensitive keywords.

» Detects and identifies private and sensitive data generated on the webpage, offering protective measures.
» Provides a built-in illegal and sensitive keyword library.
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Before you begin:

« Configure a virtual server with a WAF Profile.

To configure Data Leakage Prevention

1. Goto Web Application Firewall > Sensitive Data Protection > Sensitive Data Type.

2, Click Create New.
3. Complete the configuration.

4. Name

Description

Regex

5. Click Save.

Enter the name of the Sensitive Data Type. You will use the name to select the
Sensitive Data Type profile in Data Leak Prevention profiles. No spaces.

Comments about this profile. Describe what this profile is used for and what
kind of data this regex is used to match.

Specify the regex string used to match sensitive data. There are two pre-
defined regex strings named Credit_Card_Number and US_Social_Security
Number.

6. Go tothe Data Leak Prevention tab. Click Create New.

Data Leak Prevention
Name 1
Status [ @
Masking @
The threshold is ignored when the masking is enabled.

Action alert
Severity | High Low

Rule

@ Delete © Add Filter

D “ | URI Pattern
1 sa

2 /b

Showing 1to 2 of 2 entries Show 25 entries

Sensitive Data Type Threshold -3
Credit_Card_Number 1 PR vl

Crediit_Card_Nurmber 1 £ w

Previous 1 Next

Cancel

7. Complete the configuration and click Save.

Name

Status

Masking

Action

Severity
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Enter the name of the Data Leak Prevention. You will use the name to select
the Data Leak Prevention profile in WAF profiles. No spaces.

Enable or disable this profile. Default is disable.

Enable masking to replace sensitive data with asterisks(*). Default is disable.
Note: When masking is enabled, all target data will be replaced by an asterisk
(*) so the threshold value won’t take effect here. Masking only works when the
action is alert. The connection will be rejected when the action is set as "deny"
or "block," so no target data will be replaced.

Select the action profile that you want to apply. See Configuring WAF Action
objects on page 295. The default is Alert.

Set the severity level in the WAF logs for potential attacks detected by the
Data Leak Prevention profile.

336



Chapter 9: Web Application Firewall

e High
¢ Medium
e Low

8. Edit the newly created Data Leak Prevention. Under Rule, click Create New.
9. Complete the configuration and click Save.

Name Enter the name of the Sensitive Data Type. You will use the name to select the
Sensitive Data Type profile in Data Leak Prevention profiles. No spaces.

11. Click Save in the Data Leak Prevention profile. You have successfully created a Data Leak Prevention. The
maximum number of rules is 256 but detection will stop after matching as many as 8 rules.

Example

Create a sensitive-data-type

config security waf sensitive-data-type

edit "Credit Card Number"

set regex "3 (?:[47I\\A([ -12)\\d{4} (?:\\1\\d{4}) {2} |0[0-5]\\d{11}|[68]1\\d{12})$S|"4
(2 ANNANNANND) 2 ([ =12)\\A {4} (?:\\2\\d{4}) {2}$176011 ([ -]12)\\d{4} (2:\\3\\d{4}) {2}$|"5[1-
S5INNANNA ([ =12)\\d{4} (2:\\4\\d{4}) {2}$172014\\d{11}$]72149\\d{11}$]72131\\d
{11}$]171800\\d{11}$|~3\\d{15}$"

set description "For credit card numbers from MC, Visa, Amex, Diners/CarteBlanche,
Discover/Novus, Enroute, and JCB. Matches 341-1111-1111-1111 | 5431-1111-1111-1111 |
30569309025904 Non-Matches 30-5693-0902-5904 | 5631-1111-1111-1111 | 31169309025904."

next

End

Use it in data-leak-prevention

config security waf data-leak-prevention

edit "dlp"

set status enable -> default disable

set action alert -> default alert,means pass with a security log if hit target
config rule

edit 1

set request-uri-pattern / -> default none,means do not scan the content
set sensitive-data-type Credit Card Number -> use data-leak-prevention
next

end

next

end

Configure the waf profile

config security waf profile
edit "WAF"

set data-leak-prevention dlp
next

end
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Configuring Cross-Origin Resource Sharing (CORS) protection

Cross-Origin Resource Sharing (CORS) is a browser mechanism which enables controlled access to resources located
outside of a given domain The CORS standard works by adding new HTTP headers that allow servers to describe which
origins are permitted to read that information from a web browser. It extends and adds flexibility to the same-origin policy
so that websites would not be restricted to accessing resources from the same origin.

However, in the process of enabling information sharing between sites, the significance of CORS configuration may be
overlooked and allow for vulnerabilities. One such example is the Cross-Origin Request Site, an OWASP TOP10
Security Misconfiguration vulnerability.

To protect your applications against CORS vulnerabilities, use the CORS Protection feature to ensure that only
legitimate CORS requests from allowed web applications can reach your application.

Configuration overview

To enable the CORS protection functionality, you need to configure the following:

» Allowed Origin List — see the section on Configuring the Allowed Origin List on page 338.
» CORS Headers List (optional) — see the section on Configuring the CORS Headers List on page 340.
+ CORS Protection Rule List— see the section on Configuring the CORS Protection Rule List on page 341.

After you have configured your CORS Protection, you can add it to your WAF profile configuration under the Input
Protection section. For more information, see Configuring a WAF Profile on page 293.

Configuring the Allowed Origin List

The Allowed Origin List specifies the allowed domains using the HTTP response header. The header can contain either
a * to indicate that all domains are allowed OR a specified domain to indicate the specified allowed domain.

You can create and configure the Allowed Origin List from the Allowed Origin tab or as part of the CORS Protection
Rule List.

1
1-\6-' The CORS Protection configuration requires Allowed Origin to function correctly. If

the Allowed Origin List is not applied, the CORS Protection would not work as the
empty list would not match the condition.

To create and configure the Allowed Origin List from Allowed Origin tab:

1. GotoWeb Application Firewall > CORS Protection.
2. Click the Allowed Origin tab.

3. Click Create New to display the configuration editor.
Configure the following:

Parameter Description

Name Enter a unique Allowed Origin name. Valid characters should match regular
expression /~ [A-Za-z0-9.: -1*$/.No space is allowed.

Note: Once saved, the name of an Allowed Origin cannot be changed.
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4. Click Save.

5. Under Allowed Origin List, click Create New to display the configuration editor.
Configure the following:

Parameter Description

Protocol Select which type of protocols are allowed for the connections between foreign
applications and your application.
e HTTP

e« HTTPS
¢ ANY
The defaultis HTTP.

Origin Name Enter the foreign application's domain name or IP address.
Wildcards are supported. (Range: 1-128 characters).

Port Specify the TCP port number for the CORS connections. (Range: 0-65535;
default: 80).

Include Sub Domains Enable/disable to allow/disallow the Origin Value to match with the domains of
its sub level.

This is disabled by default.

6. Click Save.

To create and configure the Allowed Origin List as part of the CORS Protection Rule List:

1. Goto Web Application Firewall > CORS Protection.
2. Click the CORS Protection tab.

3. Click Create New to display the configuration editor.
Configure the following:

Parameter Description

Name Enter a unique CORS Protection name. Valid characters should match regular
expression /~ [A-Za-z0-9.: -1*$/.No space is allowed.

Note: Once saved, the name of an CORS Protection cannot be changed.

Status Enable/disable CORS protection. This is disabled by default.

Note: The CORS Protection Rule List cannot be configured until CORS
protection is enabled.

4. Click Save.
The newly created CORS Protection is listed under the CORS Protection tab.

5. Locate the newly created CORS Protection on the list and double-click the row or click the #* (Edit icon).
6. Under CORS Protection Rule List, click Create New to display the configuration editor.

7. Inthe Allow Origin field, select Create New from the drop-down.
The Allowed Origin configuration editor is displayed.
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8. Configure the following:

Parameter Description

Name Enter a unique Allowed Origin name. Valid characters should match regular
expression /~ [A-Za-z0-9.: -]1*$/.No space is allowed.

Note: Once saved, the name of an Allowed Origin cannot be changed.

9. Click Save.

10. Under Allowed Origin List, click Create New to display the configuration editor.
Configure the following:

Parameter Description

Protocol Select which type of protocols are allowed for the connections between foreign
applications and your application.
e HTTP

¢ HTTPS
« ANY
The defaultis HTTP.

Origin Name Enter the foreign application's domain name or IP address.
Wildcards are supported. (Range: 1-128 characters).

Port Specify the TCP port number for the CORS connections. (Range: 0-65535;
default: 80).

Include Sub Domains Enable/disable to allow/disallow the Origin Value to match with the domains of
its sub level.

This is disabled by default.

11. Click Save.

Configuring the CORS Headers List

The CORS Headers List specifies the HTTP headers that may be "allowed" or "exposed" in the CORS Protection Rule
List. If allowed, FortiADC will use the headers list to verify whether the headers used in the CORS requests are
legitimate. If exposed, FortiADC will expose the headers in the headers list in JavaScript and share with foreign
applications.

The CORS Headers List can be optional as it is only required if Allowed Headers or Exposed Headers is enabled in
the CORS Protection Rule List.

To create and configure the CORS Headers List:

1. GotoWeb Application Firewall > CORS Protection.
2. Click the CORS Headers tab.

3. Click Create New to display the configuration editor.
Configure the following:
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Parameter Description
Name Enter a unique CORS Headers name. Valid characters should match regular
expression /" [A-Za-z0-9.: -]1*$/.Nospace is allowed.

Note: Once saved, the name of a CORS Headers cannot be changed.

4. Click Save.
The newly created CORS Headers is listed under the CORS Headers tab.

5. Locate the newly created CORS Headers on the list and double-click the row or click the # (Edit icon).

6. Under CORS Headers List, click Create New to display the configuration editor.
Configure the following:

Parameter Description
Header Specify the HTTP header as a string. (Range: 1-63 characters).
7. Click Save.

Configuring the CORS Protection Rule List

The CORS Protection Rule List defines the actions FortiADC may take to protect the Cross-Origin Resource Sharing
using the Allowed Origin and optionally, the CORS Headers.

To create and configure the CORS Protection Rule List:

1. GotoWeb Application Firewall > CORS Protection.
2. Click the CORS Protection tab.

3. Click Create New to display the configuration editor.
Configure the following:

Parameter Description
Name Enter a unique CORS Protection name. Valid characters should match regular
expression /" [A-Za-z0-9.: -]1*$/.Nospace is allowed.

Note: Once saved, the name of an CORS Protection cannot be changed.

Status Enable/disable CORS protection. This is disabled by default.

Note: The CORS Protection Rule List cannot be configured until CORS
protection is enabled.

4. Click Save.
The newly created CORS Protection is listed under the CORS Protection tab.

5. Locate the newly created CORS Protection on the list and double-click the row or click the #* (Edit icon).

6. Under CORS Protection Rule List, click Create New to display the configuration editor.
Configure the following:

Parameter Description
Action Specify the WAF action:
o alert
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Parameter Description

e deny

¢ block

¢ silent-block

The default action is block.

Host Status Enable/disable to allow this rule to protect a specific domain name or IP
address. This is disabled by default.

Host Name This option appears if Host Status is enabled.
Specify the host name.

Request URL Specify the request URL as a regular expression. The maximum length is
8192 characters.

Allowed Origin Specify the name of the Allowed Origin.

From the drop-down, you may select previously configured Allowed Origin or
select Create New to create and configure an Allowed Origin directly. For
detailed steps, see Configuring the Allowed Origin List on page 338.

The allowed origin list ensures only the CORS traffic from the specified
applications are allowed.

Insert Allow Credentials Enable/disable to allow whether the CORS requests from foreign applications
can include user credentials. This is disabled by default.

Allowed Credentials This option appears if Insert Allow Credentials is enabled.
Select one of the following options:
e True

¢ False

If the selected Allowed Origin is set to *, then do not select True for Allowed
Credentials.

Insert Max Age Enable/disable to specify a maximum time period before the result of the
preflight request expires.

Allowed Maximum Age This option appears if Insert Max Age is enabled.
Specify the maximum time period in seconds. (Range: 0-86400, default: 0).

Allowed Methods Enable/disable to allow FortiADC to use the Methods specified to verify
whether the methods used in the CORS requests are legitimate. This is
disabled by default.

Methods This option appears if Allowed Methods is enabled.
Specify the method(s):
e GET
e POST
« HEAD
e TRACE
¢ CONNECT
e DELETE
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Parameter Description

« PUT
« PATCH

Allowed Headers Enable/disable to allow FortiADC to use the CORS Headers List to verify
whether the headers used in the CORS requests are legitimate. This is
disabled by default.

Allowed Headers List This option appears if Allowed Headers is enabled.
Specify the name of the CORS Headers List to allow.
From the drop-down, you may select previously configured CORS Headers.
For detailed steps, see Configuring the CORS Headers List on page 340.
FortiADC uses the allowed-headers-list to verify whether the headers used in
the CORS requests are legitimate.

Exposed Headers Enable/disable to allow FortiADC to expose the specified headers in the
CORS Headers List in JavaScript and share with foreign applications. This is
disabled by default.

Exposed Headers List This option appears if Exposed Headers is enabled.

Specify the name of the CORS Headers List to expose.

From the drop-down, you may select previously configured CORS Headers.
For detailed steps, see Configuring the CORS Headers List on page 340.

FortiADC will expose the headers in the exposed-headers-list in JavaScript
and share with foreign applications.

7. Click Save.

Configuring XML Detection

XML is commonly used for data exchange, and hackers sometimes try to exploit security holes in XML code to attack
web servers. You can use FortiADC's web application firewall (WAF) to examine client requests for anomalies in XML
code. The WAF can also attempt to validate the structure of XML code in client requests using a trusted XML schema
file. Configuring XML detection can help to ensure that the content of requests containing XML does not contain any
potential attacks.

XML Check Chain on page 343 illustrates how HTTP packets containing XML can be examined when XML detection is
configured.

XML Check Chain
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XML
Schema
Validation

50L XSS

Detection

Format

Injection

Check Detection

XML checks are composed of six parts, and each one carries out a single detection function:

« Format Check—Executes XML format detection.

¢ XML Schema Validation—Checks to determine whether XML content is well-formed. Must upload an XML schema
file.

o Limit Check—Executes XML limit detection sub-module.
» SQL Injection Detection—Executes XML SQL injection detection.
e XSS Feature Library—Executes XML cross-site scripting detection sub-module (XML-SIDM).

Before you begin, you must:

» Configure a virtual server with a WAF Profile. See Configuring virtual servers on page 48 and Configuring a WAF
Profile on page 293.

To configure XML Detection:

1. GotoWeb Application Firewall > API Protection and select the XML Detection tab.
2. Click Create New.
3. Complete the configuration as described in XML Detection on page 344.

4. Click Save.
XML Detection
Name Enter the name of the XML Detection profile. You will use the name to select the XML Detection

profile in WAF profiles. No spaces.

XML Format Check Enable to configure security checks for incoming HTTP requests to determine whether they are
well-formed. You can set FortiADC response actions to malformed HTTP requests below.

Soap Format Enable or disable Soap Format Check.
Check
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Settings Guidelines

Note: When enabled, FortiADC will examine the format of incoming SOAP requests and block
those that are ill-formed.

This option is disabled by default. If enabled, you can choose to enable or disable WSDL Checks
below.

FortiADC's Soap format check supports Soap versions 1.1 and 1.2.

WSDL Check Enable or disable WSDL Check.
Note: When enabled, FortiADC will examine the SOAP content in a request against the special
characters and OS commands.

This option becomes available only when Soap Format Check is enabled above. It is disabled by
default. If enabled, you must select a WSDL file below.

WSDL Select a WSDL file from the list menu, which shows all WSDL files that are shown (uploaded) on
the WSDL page.

Note: This option allows FortiADC to check the SOAP content in a request against the selected
WSDL file, and block the content if it fails the check.

XML Schema Before enabling XML Schema Checks, you must upload an XML schema file to check whether
Check XML content is well-formed. Enable to use XML schema to validate XML content. See Importing
XML schema on page 348

XML Schema Select the XML schema file that you want to use to check whether XML content is valid.

XML Limit Check Enable to enforce parsing limits to protect web servers from DOS attacks, including XML bombs
and transform injections. If enabled, you may change the configuration for the following
parameters:

e Limit Max Attr

¢ Limit Max Attr Name Len

¢ Limit Max Attr Value Len

¢ Limit Max Cdata Len

¢ Limit Max Elem Child

¢ Limit Max Elem Depth

¢ Limit Max Elem Name Len

¢ Limit Max Namespace

¢ Limit Max Namespace Url Len

Max Attribute Limits the maximum number of attributes each individual element is allowed to have. The default
value is 256. The valid range is 1-256. Available only when XML Limit Checks is enabled.

Max Attribute Limits the maximum length of each attribute name. The default value is 128. The valid range is
Name Length 1-2048. Available only when XML Limit Checks is enabled.
Max Attribute Limits the maximum length of each attribute value. The default value is 128. The valid range is
Value Length 1-2048. Available only when XML Limit Checks is enabled.

Max Cdata Length  Limits the length of the CDATA section for each element. The default value is 65535. The valid
range is 1-65535. Available only when XML Limit Checks is enabled.

Max Element Child Limits the maximum number of children each element is allowed, and includes other elements
and character information. The default value is 65535. The valid range is 1-65535. Available
only when XML Limit Checks is enabled.
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Settings Guidelines

Max Element Limits the maximum number of nested levels in each element. The default value is 256. The valid
Depth range is 1-65535. Available only when XML Limit Checks is enabled.

Max Element Limits the maximum length of the name of each element. The default value is 128. The valid
Name Length range is 1-65535. Available only when XML Limit Checks is enabled.

Max Namespace Limits the number of namespace declarations in the XML document. The default value is 16. The
valid range is 0—256. Available only when XML Limit Checks is enabled.

Max Namespace Limits the URL length for each namespace declaration. The default value is 256. The valid range
URL Length is 0—1024. Available only when XML Limit Checks is enabled.

XML XSS Check Enable to examine the bodies of incoming XML requests that might indicate possible cross-site
scripting attacks. If the request contains a positive match, FortiADC responds with the
corresponding action selected below.

XML SQL Injection Enable to examine bodies of incoming requests for inappropriate SQL characters and keywords
Check that might indicate an SQL injection attack. If the request contains a positive match, FortiADC
responds with the corresponding action selected below.

Severity Set the severity level in WAF logs of potential attacks detected by the XML Detection profile.
Select one of the following options:
¢ High
e Middle
* Low

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.
The default is Alert.

Exception Name Optional. Select the exception profile that you want to apply to the XML Detection profile. See
Configuring WAF Exception objects on page 297.

Configuring JSON detection

Hackers sometimes try to exploit vulnerabilities in JSON data in HTTP POST operations to attack web servers. You can
configure FortiADC's web application firewall (WAF) to enforce security checks that examine client HTTP requests for
anomalies in JSON data in HTTP POST operations. This ensures that JSON data reaching web servers is well-formed.
Some of the security protections include:

» Running format checks on requests containing JSON data in HTTP POST operations to protect potential security
holes.

» Imposing JSON parsing limits to protect against denial-of-service (DOS) attacks.
o Performing JSON cross-site scripting (XSS) checks and JSON SQL Injection checks.

JSON Check Chain on page 346 illustrates how HTTP packets containing JSON can be examined via sequence
detection when JSON detection is configured.

JSON Check Chain
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Limit Check SAL Injection X558

Detection Detection

JSON checks are composed of four parts, and each one carries out a single detection function:

o Format Check—Executes JSON format detection sub-module (JSON-FDM).

o Limit Check—Executes JSON limit detection sub-module (JSON-LDM).

« SQL Injection Detection—Executes JSON cross-site scripting detection sub-module (JSON-XSSDM).
o XSS Detection—Executes JSON cross-site scripting detection sub-module (JSON-SIDM).

Before you begin, you must:

» Configure a virtual server with a WAF Profile. See Configuring virtual servers on page 48 and Configuring a WAF
Profile on page 293.

To configure JSON Detection:

1. GotoWeb Application Firewall > API Protection and select the JSON Detection tab.
2. Click Create New.

3. Complete the configuration as described in JSON Detection on page 347.

4. Click Save.

JSON Detection

Settings Guidelines

Name Enter the name of the JSON Detection profile. You will use the name to select the JSON
Detection profile in WAF profiles. No spaces.

JSON Format Checks Enable to configure security checks for incoming HTTP requests to determine whether they
are well-formed. You can set FortiADC response actions to malformed HTTP requests below.

JSON Limit Checks Enable to enforce parsing limits to protect web servers from attacks such as DOS attacks. If
enabled, you may change the configuration for the following parameters:
e Limit Max Array Value
¢ Limit Max Depth
¢ Limit Max Object Member
¢ Limit Max String

Limit Max Array Value Limits the maximum number of values within a single array. The default value is 256. The
valid range is 0—4096. Available only when JSON Limit Checks is enabled.

Limit Max Depth Limits the maximum depth in a JSON value. The default value is 16. The valid range is 0—
4096. Available only when JSON Limit Checks is enabled.
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Settings Guidelines

Limit Max Object Limits the number of members in a JSON object. The default value is 64. The valid range is 0—
Member 4096. Available only when JSON Limit Checks is enabled.

Limit Max String Limits the length of a string in a JSON request for a name or a value. The default value is 64.

The valid range is 0—4096. Available only when JSON Limit Checks is enabled.

JSON Xss Checks Enable to examine the bodies of incoming JSON requests that might indicate possible cross-
site scripting attacks. If the request contains a positive match, FortiADC responds with the
corresponding action selected below.

JSON SAQL Injection Enable to examine the bodies of incoming requests for inappropriate SQL characters and
Checks keywords that might indicate an SQL injection attack. If the request contains a positive match,
FortiADC responds with the corresponding action selected below.

Severity Set the severity level in WAF logs of potential attacks detected by the JSON Detection profile.
Select from one of the following options:
e High
e Medium
e Low

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
295.
The default is Alert.

Exception Name Optional. Select the exception profile that you want to apply to the JSON Detection profile.
See Configuring WAF Exception objects on page 297.

Importing XML schema

XML schema files specify the acceptable structure of and elements in an XML document. When you use XML schema
files to check XML content in HTTP requests, it's easier to describe acceptable content and validate that the content is
well-formed.

You can configure FortiADC's web application firewall (WAF) to use trusted XML schema files to validate XML content in
HTTP requests that contain XML. Using XML schema files to validate XML content can ensure that client requests to
web servers are well-formed and do not contain any potential attacks.

Before you begin, you must:

« Download a trusted XML schema file that you can import to FortiADC. Acceptable file types are . tar, .tar.gz, or
.zip.

To import an XML schema file:

1. Goto Web Application Firewall > API Protection and select the XML Schema tab.
2. Click Create New.

3. Enter the name of the XML schema configuration. You will use the name to select the schema file in XML detection
profiles. No spaces.

4. Click Choose File and select the XML schema file that you want to import.
5. Click Save.
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Uploading WSDL files

WSDL stands for Web Services Description Language, which is an XML-based interface definition language used to
describe the function of Web services. The acronym can also refer to a WSDL file that contains a specific WSDL
description of a Web service, as itis in our case. WSDL provides a machine-readable description of how a web service
can be called, what parameters it expects, and what data structures it returns.

WSDL is often used in tandem with SOAP and an XML schema to provide Web services. By reading the WSDL file, a
client program connecting to a Web service can find out what operations are available on the server. The WSDL file

contains all special data types used in the form of XML Schema. The client uses SOAP to call the operations listed in the
WSDL file using XML over HTTP.

In FortiADC, WSDL check is an option under Soap Format Check which is part of XML validation. In order to configure
this option, you must upload your WSDL file or files to FortiADC.

To upload a WSDL file:

On the navigation bar, click Web Application Firewall> API Protection.
Click the WSDL tab. Click Create New. The WSDL dialog opens.

Specify a unique name for the WSDL configuration.

Click Choose File to browse for and upload the WSDL file.

Click Save.

o ODd-=

Importing JSON schema

JSON Schema describes the structure of a JSON document (for instance, required properties and length limitations).

Applications can use this information to validate instances (check that constraints are met), or inform interfaces to collect
user input such that the constraints are satisfied.

Software architecture

Format Check Limit Check Schema Check

(

Sqli Check H XS5 Check ]—‘
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The schema will validate when the user upload it through CLI/WEB GUI. Only the schema that passes the validation can
be saved in ADC.

You can configure FortiADC's web application firewall (WAF) to use trusted JSON schema files to validate JSON content
in HTTP requests that contain JSON. Using JSON schema files to validate JSON content can ensure that client requests
to web servers are well-formed and do not contain any potential attacks.

Before you begin, you must:

o Download a trusted JSON schema file that you can import to FortiADC. Acceptable file types are . tar, .tar.gz,
or.zip.

To import a JSON schema file:

1. GotoWeb Application Firewall > API Protection and select the JSON Schema tab.
2. Click Create New.

3. Enter the name of the JSON schema configuration. You will use the name to select the schema file in
JSON detection profiles. No spaces.

4. Click Choose File and select the JSON schema file that you want to import.
5. Click Save.

Configuring OpenAPI Detection

The OpenAPI Specification (OAS) defines a standard, language-agnostic interface to RESTful APls, which allows both
humans and computers to discover and understand the capabilities of the service without access to source code,
documentation, or through network traffic inspection. When properly defined, you can understand and interact with the
remote service with a minimal amount of implementation logic.

FortiADC can parse the OpenAPI description file and provide additional security to APIs by making sure that access is
based on the definitions described in the OpenAPI file.

Note: FortiADC supports OpenAPI 3.0.

To configure OpenAPI Detection:

Go to Web Application Firewall > OpenAPI Validation.

Click the OpenAPI Detection tab.

Click Create New to display the configuration editor and set up the configuration.
Save the configuration.

Ao b=

API Detection Configuration

Settings Guidelines

Name Configure the name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces not
allowed.

Note: Once saved, the name cannot be changed.

OpenAP| Schema Check Before enabling OpenAPI Schema Check, you must upload an OpenAPI schema
file to check whether OpenAPI content is permitted. Enable to use OpenAPI
schema to validate OpenAPI content. See Importing OpenAPI schema on page
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Settings Guidelines

351.

OpenAPI Schema Select the OpenAPI schema file that you want to use to check whether OpenAPI
content is valid.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 295.

The default is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log message
contains a Severity Level (severity_level) field. Select the severity level FortiADC
uses when using Input Validation:

e Low
¢ Medium
e High
The default is Low.

Exception Select an exception configuration object. Exceptions identify specific hosts or
URL patterns that are not subject to processing by this rule.

Importing OpenAPIl schema

An OpenAPI schema file defines or describes the API including information like the APl URL, parameter names in the
URL, type of data parameters should have (string, integer, etc), where parameters are submitted (URL, header, body,
etc.), and so on. For more information about OpenAPI files, see https://github.com/OAIl/OpenAPI-Specification.

Once you upload the valid OpenAPI schema file, FortiADC will parse the file and then block requests that do not match
the definitions in the file.

Before you begin, you must:
| Prepare a trusted OpenAPI schema file in YAML or JSON format that you can import to FortiADC. Acceptable file

types are .tar, .tar.gz, and .zip.

To import an OpenAPI schema file:

Go to Web Application Firewall > OpenAPI Validation.
Click the OpenAPI Schema tab.
Click Create New.

Enter the name of the OpenAPI schema configuration. You will use the name to select the schema file in OpenAPI
Detection profiles.

5. Click Choose File and select the OpenAPI schema file that you want to import.
6. Click Save.

Ao bdhd-=
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Configuring APl Gateway

An API gateway is an APl management tool that sits between a client and a collection of backend services. Itacts as a
reverse proxy to accept all API calls and return the appropriate result.

API gateway on FortiADC provides the following functions:

o APl user management

o API key verification

« APl access control

» Rate limit control

o Attach HTTP Header in API call

afarer chec ate limit check

Aftach Header

Creating API Gateway User:

1. Go to Web Application Firewall > APl Gateway.
2. Click the API Gateway User tab.
3. Click Create New to display the configuration editor and set up the configuration.

4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces are
not allowed. After you initially save the configuration, you cannot edit the name.

Comments (Optional) Enter a description or comments for the user.

uuID Non-editable. Automatically generated when the user is created.

API Key Non-editable. Automatically generated when the user is created.

Restricted Access IPs Restrict this API key so that it may only be used from the specified IP addresses.

Restrict HTTP Referers Restrict this API key so that it may only be used when the specified URLs are

present in the Referer HTTP header. This can be used to prevent an API key from
being reused on other client-side web applications that don’t match this URL.

Only full URLSs that begin with http:// or https:// are supported.

Configuring APl Gateway Rule:

Go to Web Application Firewall > APl Gateway.

Click the APl Gateway Rule tab.

Click Create New to display the configuration editor and set up the configuration.
Save the configuration.

o bN-=
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Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces are
not allowed. After you initially save the configuration, you cannot edit the name.

Host Status Enable/Disable for applying this rule only to HTTP requests for specific web hosts.

Host Select the name of a protected host that the Host: field of an HTTP request must
be in to match the API gateway rule.

This option is available only if Host Status is enabled.

Full URL Pattern Matching string. Regular expressions are supported.
Method Select one or more HTTP methods are allowed when access the API.
API Key Verification When a user makes an APl request, the API key will be included in the HTTP

header or parameter. FortiWeb obtains the API key from the request. When this
option is enabled, FortiWeb verifies the key to check whether the key belongs to
an valid APl user.

API| Key Carried In Indicate where to find the APl key in HTTP request:
e HTTP Parameter
e HTTP Header
Available only when API Key Verification is enabled.

HTTP Header Name Enter the header filed name of the API key.

HTTP Parameter Name Enter the parameter name of the API key.

Rate Limit Status Enable/Disable to do rate limit for API calls.

Rate Limit Requests Sets the condition for the limit of the number of API requests received. If the

number of requests received within the time frame (set in Rate Limit Period), this
condition is fulfilled.

Rate Limit Period Sets the time spent during which to count how many times a request is received.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 295.

The default is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log message
contains a Severity Level (severity_level) field. Select which severity level
FortiADC uses when using Input Validation:
* Low
e Medium
* High
The default value is Low.

Exception Name Select a user-defined exception configuration object. Exceptions identify specific
hosts or URL patterns that are not subject to processing by this rule.

User Specify one or more users created in API Gateway User to define which users
have the permission to access the API.
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Settings Guidelines

Attach HTTP Header Insert specific header lines into HTTP header. Need to specify the fieldname and
value is seach entry.

Configure APl Gateway Policy:

1. Go to Web Application Firewall > APl Gateway.
2. Click the API Gateway Policy tab.

3. Click Create New to display the configuration editor and set up the configuration.

4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces are
not allowed. After you initially save the configuration, you cannot edit the name.

Rule Name Specify one or more rules created in API Gateway Rule to be used in policy. The
rules will be checked one by one from top to bottom until URL in request is
matched to the Full URL Patternin a rule.

Configuring Input Validation

An Input Validation policy can prevent suspicious HTTP requests. This function will verify the user input from scan points
like URL parameter, HTML form, hidden fields, and upload file. If the format isn't correct or FortiADC detects other
attacks, the request will be blocked.

To configure an Input Validation policy:

1. Go to Web Application Firewall>Input Validation.
2, Click the Parameter Validation tab.
3. Click Create New to display the configuration editor. See Parameter Validation on page 357.

Name Enter a unique Input Validation policy name. Valid characters are A-Z, a-z, 0-9, ,and -.
No space is allowed.

Note: Once saved, the name of an Input Validation policy cannot be changed.

Host Status Enable to require that the Host: field of the HTTP request match a protected host name's
entry in order to match the URL access rule. Also configure Host.

Host Select which protected host name's entry (either a web host name or IP address) that the
Host: field of the HTTP request must be in to match the URL access rule.

Note: Optional. Only available when Host Status is enabled.
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Request URL

Action

Severity

4. Click Save.

The HTTP request URL must be start with /. eg./login. This item must be set when
configuring the rule. FortiADC will match the other item (rule) when matching the request
URL,; if the match fails, FortiADC will not attempt to match others.

Select the action profile that you want to apply. See Configuring WAF Action objects on
page 295.

The default value is Alert.

When FortiADC records violations of this rule in the attack log, each log message contains
a Severity Level (severity_level) field. Select which severity level FortiADC uses when
using Input Validation:

e Low

¢ Medium

« High
The default value is Low.

5. Edit the newly created Parameter Validation. Under Parameter Validation Rule Element, click Create New.

Name

Max Length

Use Type Check
Argument Type
Data Type

Regular Expression

6. Click Save.

Enter a unique Parameter Validation Rule Element name. It must match the value of the
name in the input type of the HTML request.

The maximum length of the Parameter Validation Rule Element name's value.
Enable/disable to check the data type.

Select to use predefined data type or customized regular expression.

Match the string by the predefined data type.

Match the string by regular expression.

7. Click the Hidden Field tab.
8. Click Create New to display the configuration editor. See Hidden Fields on page 358.

Name

Host Status

Host

Request URL

Action

FortiADC 7.2.0 Handbook
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Enter a unique Hidden Fields policy name. Valid characters are A-7, a-z, 0-9, ,and -.No
space is allowed.

Note: Once saved, the name of a Hidden Field policy cannot be changed.

Enable to require that the Host: field of the HTTP request match a protected host name's
entry in order to match the URL access rule. Also configure Host.

Select which protected host name's entry (either a web host name or IP address) that the
Host: field of the HTTP request must be in to match the URL access rule.

Note: Optional. Only available when Host Status is enabled.
The HTTP request URL must be start with /. eg./login. This item must be set when

configuring the rule. FortiADC will match the other item (rule) when matching the request
URL,; if the match fails, FortiADC will not attempt to match others.

Select the action profile that you want to apply. See Configuring WAF Action objects on
page 295.
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Severity

9. Click Save.

The default value is Alert.

When FortiADC records violations of this rule in the attack log, each log message contains

a Severity Level (severity_level) field. Select which severity level FortiADC uses when
using Input Validation:

e Low

* Medium

e High
The default value is Low.

10. Edit the newly created Hidden Field. Under Post URL, click Create New.

URL

11. Click Save.

The hidden fields function only works on the configured Post URL.

12. Edit the newly created Hidden Field. Under Hidden Fields, click Create New.

To apply this feature, you must enable Session Management in your protection profile.

Name

13. Click Save.

Enter a unique Parameter Validation Rule Element name. It must match the value of the
name in the input type of the HTML request.

14. Click the File Restriction tab.
15. Click Create New to display the configuration editor. See File Restriction on page 358.

Name

Host Status

Host

Request URL

Action
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Enter a unique File Restriction policy name. Valid characters are A-Z, a-z, 0-9, ,and -.
No space is allowed.

Note: Once saved, the name of a File Restriction policy cannot be changed.

Enable to require that the Host: field of the HTTP request match a protected host name's
entry in order to match the URL access rule. Also configure Host.

Select which protected host name's entry (either a web host name or IP address) that the
Host: field of the HTTP request must be in to match the URL access rule.

Note: Optional. Only available when Host Status is enabled.

The HTTP request URL must be start with /. eg./login. This item must be set when
configuring the rule. FortiADC will match the other item (rule) when matching the request
URL,; if the match fails, FortiADC will not attempt to match others.

Select the action profile that you want to apply. See Configuring WAF Action objects on
page 295.

The default value is Alert.
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16.
17.

18.
19.

20.

Severity When FortiADC records violations of this rule in the attack log, each log message contains
a Severity Level (severity_level) field. Select which severity level FortiADC uses when
using Input Validation:

e Low
¢ Medium
» High
The default value is Low.

Upload File Status Allow: Only allow the selected file type to upload.

Block: Block any upload of the selected file type.

Upload File Size The maximum size of the uploaded file.

Click Save.
Edit the newly created File Restriction. Under Upload File Type, click Create New.

File Type The supported file types for the uploaded file.

Click save.
Go to the Input Validation Policy tab. Click Create New.

Name Enter a unique Input Validation policy name. Valid characters are A-z, a-z, 0-9, ,and -.
No space is allowed.

Note: Once saved, the name of an Input Validation policy cannot be changed.

Parameter The Parameter Validation rule created previously.
Validation Rule

Hidden Field Rule The Hidden Field rule created previously.

File Restriction Rule  The File Restriction rule created previously.

Click Save. You have successfully created an Input Validation policy.

Parameter Validation

Inputs are typically the <input> tags in an HTML form. Input rules define whether or not parameters are required, and
their maximum allowed length. Input rules are for visible inputs only, such as buttons and text areas. This function will do
the following:

1.
2,
3.

Check HOST by simple string or regular expression matching.
Check URL by simple string or regular expression matching.

Check the parameter name of inputs filed by matching simple string or regular express. Will also restrict the length
of the name.

If the conditions are successfully matched, it will execute the specified action.
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Hidden Fields

The Hidden Fields rules are for hidden parameters only, from <input type="hidden"> HTML tags. It is often written into an

HTML page by the web server when it serves that page to the client, and isnot visible on the rendered web page. This
function will do the following:

1. Check HOST by simple string or regular expression matching .
2. Check URL by simple string or regular expression matching.
3. Match the configuration of the fetched URL.

If the conditions are successfully matched, it will execute the specified action.

File Restriction

The File Restriction rule is for restricting file uploads based on file type and size. This function will do the following:

1. Check HOST by simple string or regular expression matching.
2. Check URL by simple string or regular expression matching .
3. Check the uploaded file type and file size by simple string or regular expression matching.

If the conditions are successfully matched, it will execute the specified action.

Web Vulnerability Scanner

Web Application Vulnerability Scanner is a set of automated tools which perform black box test on web applications, to
look for security vulnerabilities such as Cross-site scripting, SQL injection, command injection, source code disclosure
and insecure server configuration.

Scanner
Scanner
w
MIME Messages Files Context Apps
signatures Signatures Signatures Signatures Signatures

The figure shows the plug-in of the scanner which is configurable in UI/CLI. The user can select which type of
vulnerabilities included in each scan. There are 5 types of signatures in our scanner:

1. The mime signatures warn about server responses that have an interesting mime. For example anything that is
presented as php-source will likely be interesting
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2. The files signatures will use the content to determine if a response is an interesting file. For example, a SVN file.

3. The messages signatures look for interesting server messages. Most are based on errors, such as caused by
incorrect SQL queries or PHP execution failures.

4. The apps signatures will help to find pages and applications who's functionality is a security risk by default. For
example, phpinfo() pages that leak information or CMS admin interfaces.

5. The context signatures are linked to injection tests. They look for strings that are relevant to the current injection
test and help to highlight potential vulnerabilities.

A report will be generated after a web vulnerability scan is completed. FortiADC will generate a WAF profile based on the
results of the scan report. For example, if the scan report detects an SQL injection vulnerability, a WAF profile containing
SQL/XSS Injection Detection settings will be generated and attached to the VIP to protect servers behind VS.

WVS Task

Configuring WVS Task

1. Go to Web Application Firewall > Web Vulnerability Scanner

2. By default you will end up on the WVS Task tab.

3. Click Create New on the top right. It will open a dialogue box. See the figure WVS Task dialogue below.
4. Complete the configuration as described the table below.

5. Save the configuration.

6. Choose the WVS Task to be scanned by clicking the diamond in the row. It will turn into a square as it scans, and the
Task Status will read "Scanning..." or "In Queue" or "Stopped." See the figure Run/Stop below.

7. A report will be generated and WVS Tool will summarize the results in HTML format, zip and store in HD. See Scan
History on page 363

Notes

« Only one task can run at the same time. If multiple tasks are started, others are added to task queue to wait to run.
See the figure Status below.

« Ifataskis already running it can't be trigger again.
o WVS-task only works for ipv4 pool. ipv6 is not supported.
« It will send a scan according to the pool member port.
« If pool member health-check fails, it will still try to send scan.
« ltwill not send a scan when:
« there's no pool member.
» pool member portis 0.
« pool member status is disable/maintain
o The tasks are limited to 50.
o Itdoes not support HTTP2
e InHA, only the primary can start the scanning; it will be triggered only if it is primary.

« Crawl limit. If, in one task, the refer pool contains multiple real servers, the crawl limits will be dispatched to all the
real servers. For example, if the crawl limit is 3000, with 3 servers, the ADC will send 1000 requests to each server.
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WVS Task configuration
Settings Guidelines
Name Configuration name. Valid characters are 2A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.
Scheduler Select a scheduler from the schedule group. To configure a scheduler, go to Shared
Resources > Schedule Group. See Creating schedule groups on page 424
Profile Select a profile. Profiles are configured under WVS Profile, the tab to the right of WVS task.

See WVS Profile on page 361

WVS Task Dialogue

WS Task
Name test
Scheduler htt_p -
Profile -test v
Cancel
WVS Task dashboard
Settings Guidelines
Name Name of the task
Task Action Square—Task Status "Scanning..." in process. This task is being scanned.

Blank—Task Status "In Queue," waiting to be scanned.
Diamond—Task Status "Stopped.”

Report Created Time  Time the task was created.

f P @ Edit

Delete
Clone
Run/Stop WVS-task
W Delete © AddFiller x
[ e ~ | Task Action Task Status Report Created Time -
1 > Stopped ra Nl
test [ 3 Stopped 2020-08-06 20:05:59 & A
Showing 1to 2 of Zentries Show 25 entries Previous T| Next
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WVS Profile

Creates a WVS Profile that can be selected in Web Vulnerability Scanner on page 358lt gives you the option to select

which types of scans you want.

Configuring WVS Profile

1. Go to Web Application Firewall > Web Vulnerability Scanner

2. Select the WVS Profile tab.

3. Click Create New on the top right. It will open a dialogue box.

4. Complete the configuration as described the table below.

5. Save the configuration.

6. The configured profile will appear as an option in the WVS Task dialogue box.

WVS Profile dialogue box

WVS Profile

Name Required. Specify the name.

Real Server Pool rl
HTTP Login Option test
Mime Scan
File Scan
Message Scan
Apps Scan

Context Scan

uennnn

HTTP Cookie

300000
Crawl Limit

Default: 300000 Range: 1-5000000

WVS Exceptions Click to select

WVS Profile configuration

Settings Guidelines

Name

Real Server Pool

HTTP Login Option

Mime Scan
File Scan
Message Scan
Apps Scan

FortiADC 7.2.0 Handbook
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Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Select areal sever from the real server pool. To configure a scheduler, you have two options.
You can create it from the WVS profile dialogue, or you can go to Server Load Balance

> Real Server Pool. See Using real server pools on page 157

Select an HTTP Login Option. Configure a login option in WVS Login on page 362

You have five scan options. See Web Vulnerability Scanner on page 358
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Context Scan

HTTP Cookie Enable HTTP Cookie in Web Vulnerability Scanner profile.

Crawl Limit Specify a crawl limit.

WVS Exceptions Specify a WVS Exception. See WVS Exceptions on page 362.
WVS Login

Configuring WVS Login

1. GotoWeb Application Firewall > Web Vulnerability Scanner > Scan Profile. Select the WVS Login tab.
2. Click Create New on the top right. It will open a dialogue box.
3. Save the configuration.

The Login option will now appear in WVS Profile's dialogue box, under HTTP Login Option.

WVS Login configuration

Settings Guidelines

Name Configuration name. Valid characters are 2A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Login Method
None Nothing to specify.

Basic Username—Specify a username for the login.
Password—Specify a password for the login.

Advanced Username—Specify a username for the login.
Password—Specify a password for the login.
Auth URL—The full URL in POST for authentication.
Auth Target URL—The URL used to POST the form.
Auth Verify URL—Used to verify if the username and password authentication failed.
Username Field—Field name of the username.
Password Field—Field name of the password.
Extend Parameter—Extend the parameter for login.

WVS Exceptions

Creates a WVS Exception that can be selected in Web Vulnerability Scanner on page 358

Configuring WVS Exception

1. Go to Web Application Firewall > Web Vulnerability Scanner > Scan Profile
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2. Select the WVS Exceptions tab.
3. Click Create New on the top right. It will open a dialogue box.
4. Complete the configuration as described the table below.

5. Save the configuration.

WVS Exceptions configuration

Settings Guidelines

Name Configuration name. Valid characters are A-7, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Full URL Pattern The REGEX pattern used for the exception.

Scan History

After the scan is completed, the report is displayed on Scan History page.

WVS Report

Settings Guidelines

Name Name of the task.

Created Time Time the report was created.

On the far right.
L @@ m J . . . .
¢ Download the report. It can be imported in Scan Integration. See Scan Integration on
page 364.

¢ Delete the report.
¢ Preview the report.
¢ Generate Policy. See Generating Automatic Policy.

Add Filter Add Filter—Sort by Name, Created Time

Generating Automatic Policy

By analyzing the scan results in the imported report, FortiADC automatically generates a WAF profile to prevent the
reported attacks. In the Automatic Policy, you will required to specify the name of the generated WAF profile and the
actions to be taken upon the attacks.

To edit the Automatic Policy:
1. In Web Application Firewall > Web Vulnerability Scanner > Scan History, find the desired report in the table,

click the Lo Icon to edit the Automatic Policy.
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2. Configure the following settings.

Generate Policies
Automatically

Merge the Report to Existing
Profile

Profile Name

Action - High

Action - Medium

Action - Low

3. Click Save.

If enabled, FortiADC will automatically generate an Automatic Policy and
update it every time it runs the web vulnerability scan.

If disabled, FortiADC generates a new WAF profile based on the scan results.

If enabled, the WAF settings based on the scan results will be merged to an
existing WAF profile. If there are conflict settings, the new ones will overwrite
the existing ones.

Enter a name for the newly generated WAF profile, and select an existing WAF
profile.

Select the action that FortiADC will take if High severity attacks are detected.

Select the action that FortiADC will take if Medium severity attacks are
detected.

Select the action that FortiADC will take if Low severity attacks are detected.

After the auto policy is saved, you can view it on Scan Integration. See Scan Integration.

Scan Integration

FortiADC generates a WAF profile based on the results of the scan report. For example, if the scan report detects an
SQL injection vulnerability, a WAF profile containing SQL/XSS Injection Detection settings will be generated and
attached to the VIP to protect servers behind VS.

The Automatic Policy contains the automatically generated WAF profile and specify the actions to be taken on the
attacks. It is displayed on Scan Integration page.

You can also manually generate an Automatic Policy by importing a scan report . FortiADC supports scan reports from

the following products:

» Acunetix

« IBM AppScan Standard
o WhiteHat

« HP Weblnspect

e Qualys

o Telefonica FAAST

e ImmuniWeb

Fortiweb

FortiADC

To import a scan report:

1. GotoWeb Application Firewall > Web Vulnerability Scanner > Scan Integration.

2. Click Scanner File Import.
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3. Configure the following settings.

Scanner Type

Upload File

Generate Policies
Automatically

Merge the Report to Existing
Profile

Profile Name

Action - High

Action - Medium

Action - Low

4. Click Save.

Select the type of scanner report you want to import.

¢ Acunetix

¢ |IBM AppScan Standard

¢ WhiteHat

¢ HP Weblnspect

¢ Qualys

e Telefonica FAAST

¢ ImmuniWeb

¢ FortiWeb Scanner

¢ FortiADC Scanner
Some types of reports have specific requirements. For details, see WhiteHat
Sentinel scanner report requirements, Telefénica FAAST scanner report
requirements, and HP Weblnspect scanner report requirements.

Upload the scanner report file.

This is by default enabled.

If disabled, FortiADC will not generate an Automatic Policy the next time it runs
Web Vulnerability Scan.

If disabled, FortiADC generates a new WAF profile based on the scan results.

If enabled, the WAF settings based on the scan results will be merged to an
existing WAF profile. If there are conflict settings, the new ones will overwrite
the existing ones.

Enter a name for the newly generated WAF profile, and select an existing WAF
profile.

Select the action that FortiADC will take if High severity attacks are detected.

Select the action that FortiADC will take if Medium severity attacks are
detected.

Select the action that FortiADC will take if Low severity attacks are detected.

WhiteHat Sentinel scanner report requirements

To allow [[[Undefined variable FortiWebVariables.FortiWeb]]] to generate rules using a WhiteHat Sentinel scanner
report, ensure that the parameters “display_vulnerabilities” and “display_description” are enabled when you run the

scan.

You can upload a WhiteHat Sentinel scanner report using either a report file you have downloaded manually or directly

import the file from the WhiteHat portal using the RESTful API. Importing a scanner file from the WhiteHat portal requires

the API key and application name that WhiteHat provides.

To retrieve the WhiteHat APl key and application name

1. Go to the following location and log in:
https://source.whitehatsec.com/summary.html#dashboard
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2. Inthe top right corner, click My Profile.
3. Click View My API Key and enter your password.
Your API key is displayed. For example:

API Key

The Sentinel Web Application Programming Interface (4P1) gives you direct and secure access to
your organization's vulnerability, site, and schedule data. You can send HTTP requests through
the 4P to modify, query, and filter your data.

Each account uses a unique 32-character AP key like a password to authenticate your API
requests. Your AP key is

acd2dcl8-e533-417c-baTc-bfddb63343d9

umentation has helpful information and examples on how to use the Web AF1 Key.

4. To view the application name, navigate to the Assets tab. The application name is the NAME value. For example:

——  Whitehlat

Assets Findings Schedules Reports Admin =

Asset Management

m Add Asset - Expsort C5V

HAME - SCAN SETUP SCAM STATUS ASSET STATUS
" 247121227 Incomplete Stopped Acthse
crackme.Cenaac.onm Incom plete - Inactee

Telefénica FAAST scanner report requirements

You can upload a Telefénica FAAST scanner report using either a report file you have downloaded manually or directly
import the file from the Telefénica FAAST portal using the RESTful API. Importing a scanner file from the Telefonica
FAAST portal requires the API key that Telefonica FAAST provides. One Telefonica FAAST scanner account can apply
foran APl key.

To apply for a Teleféonica FAAST API key

1. Go to the following location and log in:
https://cybersecurity.telefonica.com/vulnerabilities/es/api_docs
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2. Inthe session : Authentication page, please select POST > api/session for the method, and fill in the blanks for

username and password. Then click Try it out.
essions : Authentication

Parameters

Parameter Value Description
usernane (required) Username
password ( required) Password
locale Locale

Try it out!

Show/Hide

Pararmeter Iw,'p:'

form

farm

query

List Operations | Expand Operations

Raw

Login to get api_key

Data Type

string

string

string

3. The API key will be gave in the Response Body if the username and password are authorized.

sessions : Authentication

apifsession

Parameters
Parameter Value Description
usErnane d:-__ o SR umm
password For . Pasiword
lacale Locale
Try It out!
Request LIRL

https:/feybersecurity.telefonice. com: 443/ vulnerabilities/api/session

Response Body

“user®y {

“§d®: leaa,

“name”: “David Castillo”™,

“"emall": “"deastilloffortinet.com”,

“locale id*: "es”,
| “apd_key": “S4ldice’ " |
I

Response Code
281

Maremasmea (A
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ShowHide

Parameter Type

form

form

QueeTy

List 'JFIE"E[ oS Expand Operations

Raw

Login to get api_key

Diata Type

string

srring

string
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HP Weblnspect scanner report requirements

To generate rules from HP Weblnspect, when you export the report, for the Details option, select either Full or
Vulnerabilities.

Web Anti-Defacement

The Web Anti-Defacement feature examines a website’s files for changes at specified time intervals. If it detects a
change that could indicate a defacement attack, it will notify you and quickly react by automatically restoring the website
contents to the previous backup.

To configure a Web Anti-Defacement policy:

Go to Web Application Firewall> Web Anti-Defacement.

Click Create New to display the configuration editor.

Complete the configuration.

Click Test Connection to test the connection between the FortiADC and the web server.
Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

o kN -=

Description A string to describe the purpose of the configuration, to help you and other
administrators more easily identify its use.

Monitor Enable/Disable to monitor the website’s files for changes, and to download
backup revisions for reverting the website to its previous revision.

Host Name/IP Address Type the IP address or FQDN of the web server.
Connection Type Select which protocol to use when connecting to the website in order to monitor its
contents and download website backups.
 FTP
» SSH
Port Enter the TCP port number on which the website’s real server listens. The

standard port number for FTP is 21; the standard port number for SSH is 22. The
valid range is 1 to 65535.

Folder of Web Site Type the path to the website’s folder, such as public_html or wwwroot, on the real
server. The path is relative to the initial location when logging in with the user
name that you specify in Username.

Username Enter the user name that the FortiADC will use to log in to the website’s real
server.
Password Enter the password for the username you entered
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Settings Guidelines

Monitor Interval for Root Folder Enter the time interval in seconds between each monitoring connection from the
FortiADC to the web server. During this connection, the FortiADC examines
Folder of Web Site(but not its subfolders) to see if any files have changed by
comparing the files with the latest backup. If it detects any file changes, FortiADC
will download a new backup revision. If you have enabled Restore in Automatic
Action, FortiADC will revert the files to their previous version.

The valid range is 1 to 86400 seconds and default value is 600 seconds.

Moniter Interval for Other Folder  Enter the time interval in seconds between each monitoring connection from the
FortiADC to the web server. During this connection, the FortiADC examines
subfolders to see if any files have been changed by comparing the files with the
latest backup.

If it detects any file changes, the FortiADC will download a new backup revision. If
you have enabled Restore in Automatic Action, FortiADC will revert the files to
their previous version.

The valid range is 1 to 86400 seconds and default value is 600 seconds.

Skip Files Larger Than Type a file size limit in kilobytes (KB) to indicate which files will be included in the
website backup. Files exceeding this size will not be backed up. The valid range is
1to 102400 KB and the default file size limit is 10240 KB.

Note: Backing up large files can impact performance.

Skip Files with these Extensions  Type zero or more file extensions, such as iso, avi, to exclude from the website
backup. Separate each file extension with a comma.

Note: Backing up large files, such as video and audio, can impact performance.

Automatic Action Select to decide which action will be excuted when the FortiADC detects file
changes.

 Disable - Accept changes and record the change in “Total Changed” table
when FortiADC detects that the web site has been changed. You can
manually restore the web site to a previous revision.

« Acknowledge - Automatically accept changes to the web site when FortiADC
detects that the web site has been changed

¢ Restore - Enable to automatically restore the web site to the previous
revision number when FortiADC detects that the website has been changed.

Accepting or reverting changed files

The anti-defacement feature maintains a list of files that have changed for each website it monitors. You can use this list
to review, accept, and revert the changes.

To restore all the website files, use Automatic Action - Restore.

Alternatively, to automatically acknowledge all changes to files (for example, if you are updating the website), use
Automatic Action - Acknowledge.
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To accept or revert changed files:

1. GotoWeb Application Firewall > Web Anti-Defacement. For the appropriate website, click the value in the Total
Changed column.

2. Do one of the following:

a. Selectanitemin the list, and then click the Acknowledge icon to accept the individual change. FortiADC clears
the item from the list.

b. Select anitemin the list, and then click the Revert to icon. In the list of previous versions, click the Revert to this
version icon for the version to revert to. FortiADC adds this revert action as a new version in the list.
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Chapter 10: User Authentication

This chapter includes the following topics:

» Configuring AD FS Proxy on page 371

« Configuring authentication policies on page 374

» Configuring user groups on page 376

« Configuring customized authentication form on page 378
¢ Using the local authentication server on page 381

¢ Using an LDAP authentication server on page 382

¢ Using a RADIUS authentication server on page 393

¢ Using a TACACS+ authentication server on page 394

» Configuring an NTLM authentication server on page 396
« Configuring Duo authentication server support on page 397
¢ Using Kerberos Authentication Relay on page 398

« Two-factor authentication on page 402

¢ OAuth 2.0 authentication on page 406

¢ Using HTTP Basic SSO on page 408

¢ SAML and SSO on page 410

Configuring AD FS Proxy

Microsoft AD FS (Active Directory Federation Services) makes it possible for local users and federated users to use
claims-based single sign-on (SSO) to Web sites and services. You can use AD FS to enable your organization to
collaborate securely across Active Directory domains with other external organizations by using identity federation. This
reduces the need for duplicate accounts, management of multiple log-ons, and other credential management issues that
can occur when you establish cross-organizational trusts.

The AD FS Proxy is a service that brokers a connection between external users and your internal AD FS server. It acts
as areverse proxy and typically resides in your organization’s perimeter network (aka DMZ). As far as the user is
concerned, they do not know they are talking to an AD FS proxy server, as the federation services are accessed by the
same URLs.

FortiADC can act as a AD FS Proxy to facilitate the deployment of AD FS. If all the users and applications are internal,
there is no need to use FortiADC as AD FS Proxy. If there is a requirement to expose the federation service to the
Internet, use FortiADC to replace the AD FS Proxy is helpful.

Adding an AD FS Proxy

1. Click User Authentication > AD FS Proxy.
2. Select Proxy tab.
3. Click Create New to open the AD FS Proxy configuration editor.
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4. Make the desired entries or sections, as described in the following table .

5. Save the configuration.

AD FS Proxy

Parameter Description

Name Specify a unique name for the AD FS Proxy;Valid characters are A-Z, a-z, 0-9,_, and -. No
space is allowed.

Note: Once you have saved the configuration, you\ cannot edit the AD FS Proxy name.

Status Enable—The proxy can be used by AD FS Publish.
Disable—The proxy can’t be used anymore.
Note: If the proxy is used by at least one AD FS Publish, it can’t be disabled.

Method None: no load balance method will be used, proxy will select the first real server in the AD FS
Server Pool. LB METHOD ROUND ROBIN: proxy will select the real server according to
Round Robin algorithm.

AD FS Server Pool Select a real server pool configuration object, which is also an AD FS server farm. See Using
real server pools on page 157.

Note: this real server pool must use a SSL profile whose SSL is on, and must also select a
local certificate.

Federation Service The FQDN string appointed by the AD FS server.

Name
User Name A user name used to login to the AD FS server.
Password The password used to login to the AD FS server.

Server Configuration  1-8640000; The time interval of AD FS Proxy to get some configuration from AD FS server.

Update Interval Within the interval, the proxy can only use the cached configuration.

Register Timeout 1-3600; the time of AD FS Proxy waiting for the register response from AD FS server.

Connect Timeout 1-3600; the time of AD FS Proxy setup TCP connection with AD FS server

Response Timeout 1-3600; the time of AD FS Proxy waiting for all the response other than register from AD FS
server.

Keepalive Timeout 1-3600; TCP connection keepalive timeout.

Add an AD FS Publish

1. Click User Authentication > AD FS Proxy

2. Select Publish tab.

3. Click Create New to open the AD FS Publish configuration editor.

4. Make the desired entries or selections, as described in the table below.

5. Save the configuration
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AD FS Publish
Parameter Description
Name Specify a unique name for the AD FS Proxy;Valid characters are A-Z, a-z, 0-9, , and -. No
space is allowed.
Note: Once you have saved the configuration, you\ cannot edit the AD FS Proxy name.
Status Enable—The proxy can be used by AD FS Publish.
Disable—The proxy can’t be used anymore.
Note: If the proxy is used by at least one AD FS Publish, it can’t be disabled.
AD FS Proxy Select an AD FS Proxy to publish on it.
Preauthentication Pass Through: ADC will not change the message flow, basically it will only forward the
Method message.
AD FS: ADC will do the pre-authentication, if OK, it will forward the following messages.
Relying Party Relying party trust configuration is received by AD FS Proxy from the AD FS server. This
parameter can only be used in the AD FS mode.
External URL The URL that ADC provide to the external users to serve as the Microsoft Application server

such as Exchange server.
Example: https://certauth.0365.com/owa/

Backend Server URL The URL that used for AD FS Proxy to access the Microsoft Application server such as
Exchange server.

Example: https://certauth.0365.com/owa/

Attach AD FS to a Virtual Server
There are two methods to use the AD FS function for a virtual server.

Attach an AD FS Publish

1. Edit a virtual server.
2. Click General.
3. Select a published service for AD FS Published Service.

4. Save the configuration.

Use an AD FS script

1. Complete all the steps in “Attach an AD FS Publish."

2. Click Server Load Balance > Scripting.

3. Find the script whose name format is “ADFS_virtual server name_AD FS Publish name." Then clone it.
4. Detach the AD FS Published Service for the virtual server;

5. If the real server pool which was used by the virtual server is different from the AD FS Proxy on which the AD FS
Published Service was published, add content routing configuration for the both pools.
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6. Attach the content routing created in step 5 to virtual server.

7. Add the cloned script in step 3 into virtual server.

8. Save the configuration.

Configuring authentication policies

Auth policies set the conditions that mandate authentication and reference the user group that has authorization. For
example, you can define an auth policy that has the following logic: if the Host header matches example.com and the
URI matches /index.html, then the group example-group is authorized. FortiADC supports the Basic Authentication

Scheme described in RFC 2617.

Authorization and authentication on page 374 illustrates the client-server communication when authorization is required.

Authorization and authentication

«

| 3
oGETJ‘index.HtmI HTTPA 1
Host wanw example com

«— 0
GET findex html HTTP/1.1 200 0K
Host www.example.com
Authorization: Basic YWRiaW4ASMTIz

N =

with a dialog box to provide credentials.

The real server responds with an HTTP 200 OK.

©No gk
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401 Authorization required

Auth reguest
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-
o GET /index_html HTTPA.1
Host: www.example.com

< 200 OK o

Auth rezponse

(5

The client reply includes an Authorization header that gives the credentials.

FortiADC sends a request to the server (local, LDAP, or RADIUS) to authenticate the user.
The authentication server sends its response, which can be cached according to your user group configuration.

If authentication is successful, FortiADC continues processing the traffic and forwards the request to the real server.

FortiADC processes the traffic and forwards the server response to the client.

L

[
LA

Servers

The client sends an HTTP request for a URL belonging to a FortiADC virtual server that has an authorization policy.
FortiADC replies with an HTTP 401 to require authorization. On the client computer, the user might be prompted
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Before you begin:
« You must have created the user groups to be authorized with the policy. You also configure users and
authentication servers separately. See Configuring user groups.
« You must have read-write permission for Server Load Balance settings.

After you have configured an auth policy, you can select it in the virtual server configuration. Note the following
requirements:
« Virtual server type must be Layer 2 or Layer 7.

 Profile type must be HTTP or HTTPS.
« The profile option once-only must be disabled.

To configure an authentication policy:

1. Goto User Authentication > Authentication Policy.

2. Click Create New to display the configuration editor.

3. Complete the configuration as described in Authentication policy configuration on page 375.
4. Save the configuration.

Authentication policy configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces. You reference
this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Member

Host Status If enabled, require authorization only for the specified host. If disabled, ignore hostname in the
HTTP request header and require authorization for requests with any Host header. Disabled
by default.

Host Specify the HTTP Host header. If Host Status is enabled, the policy matches only if the Host
header matches this value. Complete, exact matching is required. For example,
www .example.commatches www.example.combut not www.example.com.hk.

Type Select either of the following:

e Standard
¢ SAML
¢ OAuth

User Realm Realm to which the Path URI belongs. The realm is included in the basic authentication
header in the HTTP 401 message sent to the client. If a request is authenticated and a realm
specified, the same credentials are deemed valid for other requests within this realm.
Available only if Standard is selected as the Type.

Path Require authorization only if the URI of the HTTP request matches this pathname. If none is
specified, requests to any URI require authorization. The value is parsed as a match string
prefix. For example, /abc matches http://www.example.com/abcd and
http://www.example.com/abc/11.html but not
http://www.example.com/labcd.
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Settings Guidelines

User Group Select the user group that is authorized to access the protected resource.
Available only if Standard is selected as the Type.

SAML SSO ID Select the SAML SSO ID that is authorized to access the protected resource.
Available only if SAML is selected as the Type.

OAuth Policy Select the OAuth policy that is authorized to access the protected resource.
Available only if OAuth is selected as the Type.

Configuring user groups

User groups are authorized by the virtual server authentication policy. The user group configuration references the
authentication servers that contain valid user credentials.

Suggested steps:

Configure LDAP, RADIUS, NTLM, and TACACS+ servers, if applicable.
Configure local users.

Configure user groups (reference servers and local users).

Configure an authentication policy (reference the user group).
Configure the virtual server (reference the authentication policy).

o 0N -=

Before you begin:

» You must have created configuration objects for any LDAP, RADIUS, NTLM, and/or TACACS+ servers you want to
use, and you must have created user accounts for local users.

» You must have read-write permission for System and User settings.

After you have created user groups, you can specify them in the server load balancing authentication policy
configuration.

To configure a user group:

1. Goto User Authentication > User Group.
2. Click Create New to display the configuration editor.
3. Configure the following User Group settings:

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

User Cache Enable to cache the credentials for the remote users (LDAP, RADIUS, TACACS+)
once they are authorized.
User Cache Timeout The User Cache Timeout option is available if User Cache is enabled.
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Settings Guidelines

Timeout for cached user credentials. The default is 300 seconds. The valid range is
1-86,400 seconds.

Authentication Timeout Timeout for query sent from FortiADC to a remote authentication server. The default
is 2,000 milliseconds. The valid range is 1-60,000 milliseconds.

Authentication Log Specify one of the following logging options for authentication events:
¢ None — No logging.
e Fail — Log failed attempts.
e Success — Log successful attempts.
* All— Log all (both failed and successful attempts).

Client Authentication e HTML Form
Method e« HTTP
e NTLM (only if you want to use NTLM server as a authentication server)
Use Default Form The Use Default Form option is available if Client Authentication Method is
HTML Form.

Enabled by default to use the default authentication form. Disable to use a
customized authentication form.

Customized The Customized Authentication Form option is available if Client
Authentication Form Authentication Method is HTML Form and Use Default Form is disabled.

Select a Customized Authentication Form object or create new.

Group Type e Normal — Default. No action is needed.
* SSO — Select to enable Single Sign-On (SSO).

Authentication Relay The Authentication Relay option is available if Group Type is SSO.
Select an authentication relay profile.
Authentication Session Specify the authentication session timeout. Valid values range from 1 to 180
Timeout minutes. The default is 3 (minutes).
SSO Cross Domain The SSO Cross Domain Support option is available if Group Type is SSO.
Support Disabled by default. When enabled, you must specify the SSO domain.
Note:

Authentication policies cannot be applied to multiple virtual servers. Due to security
reasons, such as protection against XSS attacks, there is no shared mechanism
between virtual servers to decrypt cookies. As a result, you cannot log into a second
virtual server while already logged into the first virtual server as the virtual servers
are independent from each other.

SSO Cross Domain Support allows you to have multiple domain names on the same
virtual server (the virtual host), where you can specify a first-level domain name to
enable the second-level domain names on the virtual server to decrypt cookies at
the same time.

SSO Domain The SSO Domain option is available if Group Type is SSO and SSO Cross
Domain Support is enabled.
Specify the SSO domain.
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Settings Guidelines

Log Off URL The Log-off URL option is available if Group Type is SSO.
Specify the log-off URL.

4. Click Save.
Once the User Group configuration is saved, the Member section becomes available for configuration.
5. Under the Member section, click Create New to display the configuration editor.
6. Configure the following Member settings and save the configuration:
a. Selectthe Type: Local, LDAP, RADIUS, NTLM, or TACACS+.
b. Select the corresponding configuration based on the selected Type.
7. Click Save again to save the Member added to the User Group configuration.

Configuring customized authentication form

FortiADC allows you to customize your login page with your company brand images and modify the layout/text.

Similar to the GUI of the error page, we allow the user to upload a zip/tar/tar.gz file. The file must include a login.html file
and you must use onsubmit="return Fsb(event)" in your form. It must include the tag % %auth_script%%.

To configure a Customized Authentication Form:

1. Go to User Authentication > Customized Authentication Form.
2. Click Create New to display the configuration editor.
3. Complete the configuration for the customized authentication form.

PoODbd =

4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

File File package for customize Authentication form page. Click ‘Choose File’ to
upload.

Username Field Name The username field name in customize form

Password Field Name The password field name in customize form

Virtual Path Virtual path of customized authentication form function. This path is running on

VS, so it will conflict with other configure like error page’s vpath and Captcha.

The following is an example of a login.html file:

<html>

<head>

<style type="text/css">html, body, div, hl, p, form, section, {fontsize:

100%; font:inherit;vertical-align:baseline;} section {display:block;} body
{lineheight:1; font:13px/20px 'Lucida Grande', Tahoma,Verdana,sansserif;
color:#404040;background:#fff;} .cter {margin:80px auto;width:640px;} .lgin
{position:relative;margin:0 auto;padding:20px 20px
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20px;width:270px;background: #£f2£f2f2;border-radius:3px;} .lgin hl {margin:-20px -20px
21lpx;line-height:40px; font-size:15px; font-
weight:bold;color:white;textalign:center;background:#555555;border-bottom:1px solid
#cfcfcf;border-radius:3px 3px 0 0;} .lgin p {margin:20px 0 0;} .lgin p.submit {text-
align:center;} input|[type=text], input[type=password] {margin:5px;padding:0
10px;width:160px;height:25px;color:#404040;background:white;border:1px
solid;bordercolor:#cd4cd4cd #d1dldl #d4d4d4;outline:3px solid #eff4f7;} input
[type=text]:focus, input [type=password]:focus {border-color:#7dc9e2;outline-
color:#dceefc;outline-offset:0;} input[type=submit] {padding:0 18px;height:29px; font-
size:12px; fontweight:bold;color:#527881;background: #cdebef;border:1px solid;border-
color:#bdccce #b3c0c8 #9eb9c2;border-radius:8px;outline:0;} input[type=submit]:active
{background: #dfe7f2;border-color:#9eb9c2 #b3c0c8 #bdccce; }</style>

</head>

%$%auth_scripts%

<body >

<section class="cter">

<div class="lgin">

<hl>Web Authentication</hl>

<form method="post" action="/" onsubmit="return Fsb (event) ">

<p>UserName: <input type="text" id="customize-username" required></p>

<p>Password : <input type="password" id="pwd" required></p>

<p class="submit"><input type="submit" value="Login"></p>

</form>

</div>

</section>

</body>

</html>

Using the information from the example login.html file, the following is the corresponding Customized Authentication
Form configuration in the GUI.
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=-% FortiADC gdm-3-221

Customized Authentication Form

root v
@ Dashboard > Name customized-auth-form-example
¥X Security Fabric > Uploaded File customized-auth-form-example.zip
s FortiView 5 File Choose File | No file chosen
L System > Username Field Name i__customTzed—username |
¢ Shared Resources > Password Field Name | Ewdcustomizedjp_asswnrd |
& Network > | Virtual Path | adevirtualpath-forAuthForm?2 |
B Server Load Balance >
% Link Load Balance >
@ Global Load Balance >

&% Web Application Firewall >

U Network Security >
& DoS Protection >
I & User Authentication v

Authentication Policy

The corresponding CLI configuration:

config user cust_auth form
edit "customized-auth-form-example"
set auth form-file customized-auth-form-example.zip
set username field customized-username
set password field pwdcustomized-password
set virtual path adcvirtualpath-forAuthForm2
next
end

Using the customized authentication form for 2FA token

To use a token for 2FA, you can upload a zip/tar/tar.gz file. The file must include a token_page.html file that contains the
tag % %token_script%% that you can use in your web page and use onsubmit="return Fsb(event)" in your form.

The following is an example of token_page.html file for 2FA token:

<html>
<head>
<style type="text/css">html, body, div, hl, p, form, section, {font-
size:100%; font:inherit;vertical-align:baseline;} section {display:block;} body {line-
height:1;font:13px/20px 'Lucida Grande', Tahoma,Verdana,sans-
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serif;color:#404040;background:#fff;} .cter {margin:80px auto;width:640px;} .lgin
{position:relative;margin:0 auto;padding:20px 20px
20px;width:270px;background: #f2f2f2;border-radius:3px;} .lgin hl {margin:-20px -20px
21lpx;line-height:40px; font-size:15px; font-weight:bold;color:white;text-
align:center;background: #555555;border-bottom: 1px solid #cfcfcf;border-radius:3px 3px 0 0;}
.1lgin p {margin:20px 0 0;} .lgin p.submit {text-align:center;} input[type=text], input
[type=password] {margin:5px;padding:0
10px;width:160px;height:25px;color:#404040;background:white;border:1px solid;border-
color:#cdcdcd #dldldl #d4d4d4;outline:3px solid #effdf7;} input[type=text]:focus, input
[type=password] : focus {border-color:#7dc9e2;outline-color:#dceefc;outline-offset:0;} input
[type=submit] {padding:0 18px;height:29px;font-size:12px; font-
weight:bold;color:#527881;background: #cdebef;border:1px solid;border-color:#bdccce #b3c0c8
#9eb9c2;border-radius:8px;outline:0;} input[type=submit]:active {background:#dfe7f2;border-
color:#9eb9c2 #b3c0c8 #bidccce; }</style>
</head>
%%token_script%%
<body >
<section class="cter">
<img align="middle" src="goldbrig.jpg">
<div class="1lgin">
<hl>2FA-Mick-page</hl>
<form method="post" action="/" onsubmit="return Fsb (event)">
<p>Token: <input type="text" id="token" required></p>
<p class="submit"><input type="submit" value="Login"></p>
</form>
</div>
</section>
</body>
</html>

Using the local authentication server

You can use a local authentication server to authenticate destination server user logins. FortiADC uses FortiToken
Cloud as the remote authentication server which provides the security token needed for two-factor authentication on
FortiADC.

To assign a FortiToken Cloud to a local server, the device must be registered on the same account as the FortiToken
Cloud contracts; see Fortinet Customer Service & Support.

Note: The local authentication server does not have user-initiated password management features, so it does not easily
scale to large groups of users. For large deployments, we recommend you use RADIUS or LDAP and provide
instructions on your website how users can reset, recover, or change their passwords.

The FortiToken Cloud User is only supported if the Client Authentication Method in the User group configuration is HTML
Form.

Basic steps:

1. Add user accounts to the local authentication server.

2. Select the local authentication server configuration and username when you create user groups.
Before you begin:

o You must have Read-Write permission for System settings.
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To use a local authentication server:

Go to User Authentication > Local User.

Click Create New to display the configuration editor.

Complete the configuration as described in Local authentication server configuration on page 382.
Save the configuration.

o bd-=

Local authentication server configuration

Settings Guidelines

Name Name of the user account, such as userl oruserl@example.com.

Do not use spaces or special characters except the ‘at’ symbol ( @) or dot (. ). The maximum
length is 35 characters.

After you initially save the configuration, you cannot edit the name.

Password Specify a password. The stored password will be encrypted.
Two-factor ¢ None — Default. Use the local authentication
Authentication ¢ FortiToken Cloud — Enable to 2FA authentication using FortiToken Cloud service.

Note: FortiADC does not support FortiToken Cloud functionality in HA condition.

Email Address The email is the email address that will receive the OTP. We will send the registration
information including the QR code to help the user to register on the FortiToken app.

County Dial Code The phone of the country code.

Phone Number Use this phone number to send the OTP in an SMS text message to the mobile device
FortiToken Mobile Enable two-factor push notifications to your mobile app for fast and secure access.
Push

Using an LDAP authentication server

Lightweight Directory Access Protocol (LDAP) is an application protocol for accessing and maintaining distributed
directory information services over a network. When using LDAP, authentication clients may send “Bind” messages to
servers for authentication. Depending on the circumstances, clients may send different kinds of “Bind” messages.

LDAP bind messages

In a server load-balancing client authentication or admin authentication scenario, FortiADC sends binding request to the
LDAP server for client authentication. Once a client is successfully authenticated, he or she can then access the LDAP
server based on his or her privileges. There are three bind types: simple, anonymous, and regular.

Simple bind

Simple bind means binding with a client's full name.
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Anonymous bind

Anonymous bind should be used only if the LDAP server allows it. The LDAP server searches for the client in the entire
sub-branches, starting from the specified DN. This bind has two steps: First, FortiADC sends the binding request to
specify the search entry point. Then, it sends a search request with the specified scope and filter to the LDAP server to
find the given client.

Regular bind

Regular bind can be used when anonymous binding is not allowed on the LDAP server. Regular bind is similar to
anonymous bind. The difference is in the initial step. Unlike anonymous bind, regular bind requires that FortiADC get the
access privileges on the LDAP server with the specified User DN in the first step. After it has obtained the authorization,
FortiADC can then move on to the second step as it does in anonymous bind.

LDAP over SSL (LDAPS) and StartTLS

LDAP over SSL (LDAPS) and StartTLS are used to encrypt LDAP messages in the authentication process.

LDAPS is a mechanism for establishing an encrypted SSL/TLS connection for LDAP. It requires the use of a separate
port, commonly 636. StartTLS extended operation is LDAPv3 standard mechanism for enabling TLS (SSL) data
confidentiality protection. The mechanism uses an LDAPv3 extended operation to establish an encrypted SSL/TLS
connection within an already established LDAP connection.

Configuring LDAP binding

You can use an LDAP authentication server to authenticate administrator or destination server user log-ins.

Basic steps:

1. Configure a connection to an LDAP server that can authenticate administrator or user logins.
2. Select the LDAP server configuration when you add administrator users or create user groups.

Before you begin:

» You must know the IP address or FQDN and the port used to access the LDAP server. You must know the CN and
DN where user credentials are stored on the LDAP server.

» You must have Read-Write permission for System settings.

To select an LDAP server:

Go to User Authentication > Remote Server.

Click the LDAP Server tab.

Click Create New to display the configuration editor.

Complete the configuration as described in LDAP server configuration on page 384.
Click Test Connectivity to validate the configuration.

Save the configuration.

IS
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LDAP server configuration

Settings Guidelines

Name Configuration name. Valid characters are A-z, a-z, 0-9, , and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Server IP address or FQDN of the LDAP server.
Note: When enabling LDAPS or StartTLS, please use the common name (CN) of
the LDAP server certificate in this field if you want to identify the Server with the
CA profile (see CA Profile on page 385).

Port Port number for the server.

Port 389 is typically used for non-secured connections or for StartTLS-secured
connections, and port 636 is typically used for SSL-secured (LDAPS)
connections.

Common Name Identifier Enter the identifier for the common name (CN) attribute (also called the CNID)
whose value is the user name.

Identifiers vary based on the schema of your LDAP directory. This is often cn or
uid. For Windows Active Directory, it is often the attribute sAMAccountName.

For example, in a default OpenLDAP directory, if a user object is
uid=fortiadc, cn=users,dc=fortinet, dc=com

then the CNID is uid.

Distinguished Name Specifies the Base DN from which the LDAP query starts. This DN is the full path
in the directory to the user account objects.

For example:

ou=People, dc=example,dc=com

or

cn=users,dc=example, dc=com

You can use the Fetch DN function to get the entire Directory Information Tree,
and select the DN of the LDAP query starting entry.

Note: When using Windows Active Directory as the LDAP server, you may need
to use regular bind for FortiADC to get access permission for LDAP entries when
using the Fetch DN function.

Bind Type ¢ Simple—bind without user search. It can be used only if all the users belong
to the same “branch”.
* Anonymous—bind with user search. It can be used when users are in
different “branches” and only if the server allows “anonymous search”.
¢ Regular—bind with user search. It can be used when users are in different
“branches” and the server does not allow “anonymous search”.

User DN Available only when Bind Type is Regular.

Enter the bind DN of an LDAP user account with permissions to query the
Distinguished Name (see Distinguished Name on page 384). The maximum
length is 256 characters.

For example:

cn=fortiadc, cn=users,dc=fortinet, dc=com
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Settings Guidelines

For Windows Active Directory, the UPN (User Principle Name) is often used
instead of a bind DN (for example, user@domain. com).

This field can be optional if your LDAP server does not require the FortiADC
appliance to authenticate when performing queries.

Password
Enter the password of the User DN.

Secure Connection * Disable
 LDAPS
e STARTTLS

CA Profile Available only when Secure Connection is set to LDAPS or STARTTLS,
regardless of the Bind type being selected.

Select a CA profile to identify the server certificate or you can leave the field blank.
For details on how to import the CA profile, see Importing CAs on page 516.

Group Authentication Available only when Bind Type is Regular.

Enable to filter the query results, only allowing users to authenticate if they are
members of the LDAP group that you define in the Group DN field. Users that are
not members of that group are not allowed to authenticate.

Group Type Available only when Bind Type is Regular.
Indicate the schema of your LDAP directory as one of the following:

¢ OpenLDAP — The directory uses a schema where each user object’s group
membership is recorded in an attribute named gidNumber or a virtual
attribute named memberOf£.

¢ Windows-AD — The directory uses a schema where each user object’s
group membership is recorded in an attribute named memberoOf.

 FortiAuthenticator — Group membership attributes may have different
names depending on the LDAP directory schema.
The FortiADC appliance will use the group membership attribute that
matches your directory's schema when querying the group DN.

Group DN Available only when Bind Type is Regular.

Enter the value of the group membership attribute that query results must have in
order to be able to authenticate.

For example:
ou=Groups, dc=example, dc=com or a group ID (GID) such as 100

The value may vary based on your directory's schema. For details, see Setting
the LDAP group on the LDAP server on page 385.

Setting the LDAP group on the LDAP server

Using Windows Active Directory

Set the LDAP group on the LDAP server for when the Group Type is Windows-AD.
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1. Open the Windows Active Directory Administrator Center and create a new group.
For example, add a new group named "fortinet".

Active Directory Administrative Center * win2019 (local) * Users (©) | Manage  Help
B Active Directory... < Users (25) Tasks
= Fitter pel ':,EJ - (E“J - () &
. Overview fortinet A~
Name Type Description Add to another group...
Users - fortiadc User Delete
Ml Dynamic Access Control > = tnrlmet _ Move...
Properti
il Authentication roperties
Users A
P Global Search
New »
Delete

Search under this node

Properties
fortinet v
E-mail: Type:  Security
Managed by: Scope: Global
Modified: 3/28/2022 9:11 PM
Description:
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2. Find the Group Distinguished Name. This value is used for the Group DN field of the FortiADC LDAP server

configuration.
CMN=fortinet Properties ? g
Aftributes:
String Attribute Editor x
Attribute: distinguishedName
Value:
CN=forlinet,CN=Usem,DC=win2019,DC=oon‘l

Clear Cancel

description <not set>
desktopProfile <not set>
displayName <not set>

displayNamePrintable  <not set>
distinguishedMame CN=fortinet, CN=Users, DC=win2019 DC=cor

dSASignature <not set>
dSCorePropagationD... 0x0=( ) e
< >
\View Filter
OK Cancel Apply Help

3. Add the user to the group. Ensure you do not mark this group as the primary group for login user.
For example, add the User "fortiadc" to the Group "fortinet".

fortiadc
Account Member Of
Organization
Member Of Filter L
Password Settings Name - Active Director... Primary
Profile Domain Users win2019-Users...
Policy | fortinet win2019-Users... |
* silo
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4. InFortiADC, configure the LDAP Group DN settings using the Distinguished Name value recorded from step 2.

LDAP

Name
Server

Port

Commeon Name ldentifier

Distinguished Name

Bind Type

User DN

Password

Secure Connection

CA Profile

Group Authentication

Group Type

Group DN

FortiADC will check if {Common Name Identifier}={login admin name} is the member of the group you

specified.

For example, when logging into FortiADC with the admin name "fortiadc", FortiADC will check if cn=fortiadcis
the member of the group cn=fortinet, cn=users, dc=win2019, dc=com with the search base dn cn=users,

win2019

WiN R in2019.com

389

cn
Example: cn
cn=users,dc=win2019,dc=com

Example: cn=John Doe,dc=example,dc=com

Simple | Anonymous

CN=fortiadc,CN=Users,DC=win2019,DC=com

ceveenes
Disable  LDAPS
win2019 ca

O
WindowsAD

CN=fortinet,CN=Users,DC=win2019,DC=com

Fetch DN

Change

Test Connectivity

dec=win2019, dc=com. Ifthe entry exists, FortiADC gets the DN of the entry cn=fortiadc, cn=users,
de=vm, dc=fadc and binds this entry and its password to Windows AD.

Using OpenLDAP

Set the LDAP group on the LDAP server for when the Group Type is OpenLDAP. There are two methods to adding a

userin a group.

Method 1:

Create a user with the attribute gi dNumber which points to the group.
Specify the GID number in the Group DN field in the FortiADC LDAP server configuration. For example: 10000.
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) Refresh

[ Export

€9 Delete this entry

-\ Compare with ancther entry
4" Add new attribute

cn=fortiadc

DN: cn=fortiadc,ou=users,dc=fadc,dc=com

» Show internal attributes
Copy or move this entry
[Z] Rename

Create a child entry

¥ Hint: To delete an attribute, empty the text field and click save.

cn
fortiadc *
(add value)
(rename)

gidNumber required
10000
fortinet_all ()

homeDirectory

reguired

|fhomeifor1iadc |

loginShell

[/bin/bash |

objectClass

[ posixAccount |

inetOrgPerson

Method 2:

(structural)

Create a group and add the user as the member. Prior to doing this, the memberof overlay must be enabled.

The following is an example of OpenLDAP (s1adp) with MDB database installed on Ubuntu. You can reference the
steps below using parameters applicable to your environment.

1. Enable the memberof module with the following command:

ldapmodify -Y EXTERNAL -H ldapi:/// <<EOL

dn: cn=module{0},cn=config
add: olcModuleLoad
olcModulelLoad: memberof
EOL

2. Configure OpenLDAP to use the memberof module with the following command:

ldapadd -Y EXTERNAL -H ldapi:/// <<EOL

dn: olcOverlay={0}memberof,olcDatabase={1}mdb,cn=config

objectClass: olcConfig
objectClass: olcOverlayConfig
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olcOverlay: memberof
EOL

3. Restart s1adp and check if memberof module is loaded.

service slapd restart

slapcat -n 0 | grep olcModuleLoad
olcModuleLoad: {0O}back mdb
olcModulelLoad: {0O}memberof

4. Create the group with objectClass "groupOfNames" and add the user member in it.
Specify the DN of the group in the Group DN field in the FortiADC LDAP server configuration.
Forexample: cn=fortinet, ou=group, dc=fadc, dc=com

cn=fortinet

DN: cn=fortinet,ou=group,dc=fadc,dc=com

O Refresh “% Show internal attributes
(| Export Copy or move this entry
@ Delete this entry [l Rename

a Compare with another entry Create a child entry

" Add new attribute
4 Hint: To delete an attribute, empty the text field and click save.
4 An attribute (member) was modified and is highlighted below.

cn required, rdn

*

fortinet
(add value)

(rename}

= |cn=fomadc:,ou=users,dc=fadc,dc=com Y

(add value)
(Modify group members)

objectClass reauired
groupOfNames (structural)
|t0p |
(add value)

Using FortiAuthenticator

Set the LDAP group on the LDAP server for when the Group Type is FortiAuthenticator.

1. In FortiAuthenticator, create a group and add a user to that group.
In the example below, the group "fortinet" is created and the user "fortiadc" is a member of this group.
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System

+ Create New Search for user groups

>
Authentication v
Name Type Remote Server Members

>

& User Account Policies

& User Management v

Local Users 1/ 3000 user gro

ol O

fortinet Local fortiadc

Remote Users

Remote User Sync Rules
Social Login Users
Guest Users

Usage Profile

2. Addthe group and the user to the LDAP tree.
ER

m_m FortiAuthenticator VM
L 1 1 J

System > | 4 Expand All @ Delete (599960f6C
Authentication v
uccesstully aade ocal user to ree
v I fully added 1 local to LDAP t

) . :

es User Account Policies > |& 3 de=example,dc=com ()

%% User Management > = Jousfac @ + & X

= &3 cn=fortinet (1)

& Portals > L. () uid=fortiadc

=& Remote Auth. Servers >

& RADIUS Service >

& TACACS+ Service >

& LDAP Service v

3. Specify the Group DN in the FortiADC LDAP server configuration.
In the example, the value is cn=fortinet, ou=fac, dc=example, dc=com.

FAQs when using an LDAP authentication server

Why does LDAPS or StartTLS not work with Windows AD when a CA profile is selected?

When a CA profile is selected, the CN of the LDAP server certificate must be the same value as the Server field in the
FortiADC LDAP configuration. Below is an example configuration for users using Windows AD with StartTLS.

The CN of the Windows AD certificate:
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182 1.864428 18.0.188.133 18.8.108.246 LDAP 85 extendedReq(1l) LDAP_START_TLS_OID

183 1.864625 16.6.168.246 168.8.1e8.133 LDAP 188 extendedResp(1) LDAP_START_TLS 0ID

1684 1.3564639 16.0.1080.133 19.0.100.246 TCP 54 63668 + 389 [ACK] Seq=32 Ack=47 Win=29696 Len=@

185 1.864795 18.0.188.133 18.8.1e8.246 TLSv1.2 349 Client Hello

186 1.866274 168.0.168.246 16.8.166.133 TER 1514 389 » 63668 [ACK] Seq=47 Ack=327 Win=21820816 Len=146@ [TCP segment of a re
187 1.866286 10.0.168.246 10.6.1808.133 TLSv1.2 641 Server Hello, Certificate, Server Key Exchange, Certificate Request, Serwve
188 1.866292 16.0.108.133 16.6.160.246 TER 54 63668 + 389 [ACK] Seq=327 Ack=2094 Win=35328 Len=0

189 1.868441 10.0.100.133 10.9.100.246 TLSv1.2 224 Certificate, Client Key Exchange, Change Cipher Spec, Encrypted Handshake
118 1.869558 10.0.100.246 10.9.100.133 TLSv1.2 185 Change Cipher Spec, Encrypted Handshake Message

111 1.869634 16.0.108.133 16.6.160.246 TLSv1.2 147 Application Data

112 1.878622 168.0.168.246 16.8.166.133 TLSv1.2 185 Application Data

113 1.8706868 16.0.108.133 16.6.160.246 TLSv1.2 221 Application Data

114 1.878913 16.60.186.246 18.8.188.133 TLSv1.2 228 Application Data

115 1.878968 168.6.186.133 18.8.168.246 TLSv1.2 147 Application Data

116 1.871582 16.0.188.246 18.8.108.133 TLSv1.2 185 Application Data

117 1.871614 16.6.186.133 18.8.108.246 TLSv1.2 98 Application Data

118 1.871636 16.6.186.133 18.8.108.246 TLSv1.2 85 Encrypted Alert

128 1.871666 16.6.160.246 16.8.188.133 TCP 68 389 » 63668 [ACK] Seq=2421 Ack=917 Win=2181584 Len=@

Frame 187: 641 bytes on wire (5128 bits), 641 bytes captured (5128 bits)
Ethernet II, Src: VMware_aa:77:d7 (@@:58:56:a3a:77:d7), Dst: VMware_aa:b6:69 (@@:58:56:aa:b6:69)
Internet Protocol Version 4, Src: 10.8.180.246, Dst: 10.8.100.133
Transmission Control Protocol, Src Port: 389, Dst Port: 63668, Seq: 1587, Ack: 327, Len: 587
[2 Reassembled TCP Segments (2847 bytes): #1@6(1468), #187(587)]
Transport Layer Security
W TLSv1.2 Record Layer: Handshake Protocol: Multiple Handshake Messages
Content Type: Handshake (22)
Version: TLS 1.2 (@x@383)
Length: 2842
» Handshake Protocol: Server Hello
“ Handshake Protocol: Certificate
Handshake Type: Certificate (11)
Length: 1554
Certificates Length: 1551
v Certificates (1551 bytes)
Certificate Length: 1548
> Certificate: 3@82060830820470a00302016202135:000000040:0bT c20dfactod30PEERREAREE4300.. |(id-at-commonName=WIN SMENNENE . win2e19. com)
> Handshake Protocol: Server Key Exchange
> Handshake Protocol: Certificate Request
> Handshake Protocol: Server Hello Done

v v v v

LDAP Configuration on FortiADC:

LDAP

Name win2019

Server | WIN-QRSINI: in 2019.com CN of LDAP Servelr certificate
Port 389

e |
Common Name |dentifier ‘
Example: cn

cn=users,dc=win201%,dc=com Fetch DN

Distinguished Name
Example: cn=John Doe,dc=example,dc=com

Bind Type Simple | Anonymous
User DN CN=fortiadc,CN=Users,DC=win2019,DC=com
Password sesccnsee Change
Secure Connection Disable | LDAPS Test Connectivity
CA Profile win2019_ca v
Group Authentication »
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How do | debug "Test Connectivity" or "Fetch DN" fails when using Windows AD as the LDAP
server?

You can install the LDAP Admin tool on the Windows server to verify whether the configuration on Windows AD is
correct.

Using a RADIUS authentication server

You can use a RADIUS authentication server to authenticate administrator or destination server user logins.

Basic steps:

1. Configure a connection to a RADIUS server that can authenticate administrator or user logins.
2. Selectthe RADIUS server configuration when you add administrator users or user groups.

Before you begin:

» You must know the IP address, port, authentication protocol, and shared secret used to access the RADIUS server.
» You must have Read-Write permission for System settings.

To create a RADIUS server configuration:

Go to User Authentication > Remote Server.

Select the RADIUS Server tab.

Click Create New to display the configuration editor.

Complete the configuration as described in RADIUS server configuration on page 393.
Save the configuration.

o wDbd =

RADIUS server configuration

Settings Guidelines

Name Specify a uniqgue name for the RADIUS server configuration. Valid characters are A-7, a-z, 0-
9, ,and -. No space is allowed.

After you initially save the configuration, you cannot edit the name.

Server IP address or FQDN of the remote RADIUS server.

Port The listening port of the RADIUS server. The commonly used port for a RADIUS server is
1812.

Shared Secret Shared secret string used when connecting to the server.

Authentication ¢ PAP—Password authentication protocol

Protocol ¢ CHAP—Challenge-Handshake Authentication Protocol.

¢ MS-CHAP—Microsoft version of CHAP.
¢ MS-CHAPv2—Microsoft version of CHAP, version 2.
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Settings Guidelines

Timeout Specify the amount of time that FortiADC must wait for responses from the remote RADIUS
server before it times out the connection. Valid values are from 5 to 60 seconds. The default is
5 seconds.

Test Connection Tests the connectivity of the RADIUS server.

Using a TACACS+ authentication server

Terminal Access Controller Access-Control System Plus (TACACS+) is a remote authentication protocol that provides
access control for routers, network access servers, and other network computing devices through one or more
centralized servers. TACACS+ allows FortiADC to accept a user name and password and send a query to a TACACS
authentication server. The server host determines whether to accept or deny the request and sends a response back
that allows or denies access to the FortiADC user. The default TCP port for a TACACS+ server is 49.

Once TACACS+ is enabled, a series of checks is performed locally and at the TACACS+ server level. The diagram
below illustrates the TACACS+ authentication flow.
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User attempts a login

Username is
checked locally

Fals User is rejected

True
A password
authentication
request is sent to the
remote TACACS+ the TACACS+ server
server

Password is checked at .
False User is rejected

True

System checks the
Trusted Hosts list

Fals User is rejected

True

System applies Admin
Profile and allows the user

To use a TACACS+ server to authenticate administrators, the server must be configured before configuring the
administrator accounts that will use it.

Basic steps:

1. Configure a connection to a TACACS+ server that can authenticate administrator or user logins.
2. Selectthe TACACS+ server configuration when you add administrator users or user groups.

Before you begin:

« You must know the IP address, port, authentication protocol, and shared secret used to access the TACACS+
server.
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¢ You must have Read-Write permission for System settings.

To configure a TACACS+ server:

1. Goto User Authentication > Remote Server.

2. Click the TACACS+ Server tab.

3. Click Create New to display the configuration editor.
4. Configure the following settings:

Setting Description

Name Specify a unique name for the TACACS+ server configuration. Valid
characters are A-Z, a-z, 0-9, , and -. No space is allowed.

After you initially save the configuration, you cannot edit the name.

Authentication Protocol Select the authentication protocol used for the TACACS+ server:

¢ Auto — FortiADC tries all authentication protocols in order: MS-CHAP —
CHAP — PAP — ASCII.

¢ MS-CHAP — Microsoft version of CHAP (Challenge Handshake
Authentication Protocol).

¢ CHAP — Challenge Handshake Authentication Protocol (defined in RFC
1994).

¢ PAP — Password Authentication Protocol.

¢ ASCII — American Standard Code for Information Interchange.

Auto is the default option.

Timeout Specify the amount of time that FortiADC must wait for responses from the
remote TACACS+ server before it times out the connection. Valid values are
from 5 to 60 seconds. The default is 5 seconds.

Shared Secret Shared secret string used when connecting to the TACACS+ server.
Server Enter the IP address or FQDN of the TACACS+ server.
Test Connectivity Tests the connectivity of the TACACS+ server.

5. Click Save.

Configuring an NTLM authentication server

You can use a NTLM authentication server to authenticate user login to destination server.
Before you begin:

« You must know the IP address, port, used to access the NTLM server.
« You must have Read-Write permission for User settings.

Basic steps:

1. Configure a connection to an NTLM server that can authenticate user login.
2. Selectthe NTLM server configuration when you add users or user groups.
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To create a NTLM server configuration:

1. Go to User Authentication > Remote Server.

2. Select the NTLM Server tab.

3. Click Create New to display the configuration editor.
4. Complete the configuration as described below.

5. Save the configuration.

Settings Guidelines

Name Specify a unique name for the NTLM server configuration. Valid characters are A-
Z,a-z,0-9, ,and-. No spaces allowed.

After you save the configuration, you cannot edit the name.

Server IP address of the remote NTLM server.
Port The listening port of the NTLM server. The commonly used port for an NTLM
server is 445.

After configuring an NTLM server, configure a user group and add a member of NTLM type. This makes it possible for
related authentication policy and virtual server to work under NTLM authentication.

Note: For user groups with “Client Authentication Method” set to “NTLM?”, only allow use of an NTLM server as member;
for “Client Authentication Method” set to “HTML form” and “HTTP”, use “NTLM server” is also allowed. Only NTLM
version 1 is supported.

Configuring Duo authentication server support

You can configure FortiADC to support a Duo RADIUS authentication server.

Basic steps:

1. Configure a connection to a RADIUS server that can authenticate administrator or user logins.
2. Select the RADIUS server configuration when you add administrator users or user groups.

Before you begin:

« You must know the IP address, port, authentication protocol, and shared secret used to access the RADIUS server.
* You must have Read-Write permission for System settings.

To configure duo authentication support:

Go to User Authentication > Remote Server.

Select the RADIUS Server tab.

Click Create New to display the configuration editor.

Complete the configuration as described in Configuring Duo authentication server support on page 397.
Save the configuration.

o oODd-=
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Configure Duo authentication support

Settings Guidelines

Name Name the configuration to something like "Duo RADIUS" to differentiate it from other RADIUS
server configurations.

Server Enter the IP address or DQDN of the Duo RADIUS proxy.

Port Specify the listening port of the Duo RADIUS proxy.

Shared Secret Enter the RADIUS secret configured on the Duo RADIUS proxy.

Authentication Be sure to select PAP for Duo RADIUS support.

Protocol

Timeout Specify the amount of time that FortiADC must wait for responses from the remote RADIUS

server before it times out the connection. Valid values are from 5 to 60 seconds. For Duo
RADIUS support, we recommend using 60 seconds.

You can also configure a Duo RADIUS server using the following commands from the Console:

config user radius
edit <name>
set auth-type {chap|ms chap|ms chapv2|pap}
set port <integer>
set secret <password>
set server <string>
set timeout <integer>
set vdom <datasource>
next
end

Using Kerberos Authentication Relay

Kerberos authentication is a computer authentication protocol that works on the basis of tickets (i.e., credentials). It
provides several authentication choices, allowing nodes communicating over a non-secure network to verify each others'
identity securely via a Key Distribution Center (KDC) and Service Tickets (STs). It is primarily used for client-server
authentication model and provides mutual authentication by which both the client and the server verify each others'
identity.

Kerberos authentication is built upon symmetric key cryptography and requires a trusted third party, and may also resort
to the use of public-key cryptography in certain phases of the authentication process. By default, Kerberos
Authentication Relay uses UDP port 88.

The Kerberos authentication consists of the following logical components:

o Client

o Authentication Server (AS)

o Ticket Granting Server (TGS)
o Service Server (SS)

Often, the AS and TGS are located on the same physical server, i.e., the KDC.

FortiADC 7.2.0 Handbook 398
Fortinet Inc.



Chapter 10: User Authentication

Authentication Workflow

The following paragraphs highlight the workflow of Kerberos authentication.

Step 1: Client authentication

The client sends a cleartext (i.e., unencrypted) message of the user ID to the Authentication Server (AS ) requesting
services that the user wants to use. The client does not send either the secret key or the password to the AS. The AS
generates the secret key by hashing the password of the user found at the database, e.g., Active Directory in Windows
Server. The AS then checks to see if the client is in its database. If it is in the database, the AS sends back the following
two messages to the client:

» Message A: Client/TGS Session Key encrypted using the secret key of the client/user.

« Message B: Ticket Granting Ticket (TGT) which includes the client ID, client network address, ticket validity period,
and the client/TGS session key) encrypted using the secret key of the TGS.

Once the client receives Messages A and B, it attempts to decrypt Message A with the secret key generated from the
password entered by the user. If the user entered password does not match the password in the AS database, the
client's secret key will be different and thus unable to decrypt message A. With a valid password and secret key, the
client decrypts Message A to obtain the Client/TGS Session Key. This session key is used for further communications
with the TGS. Note that the client cannot decrypt Message B, as it is encrypted using TGS's secret key. At this point, the
client has enough information to authenticate itself to the TGS.

Step 2: Client service authorization

When requesting services, the client sends the following messages to the TGS:

» Message C: Composed of the TGT from Message B and the ID of the requested service.

» Message D: Authenticator, which is composed of the client ID and the time-stamp, encrypted using the Client/TGS
Sess